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Introduction
Trademarks
MatchWare, MindView, MeetingBooster and MatchWare ScreenCorder are trademarks or
registered trademarks of MatchWare A/S.
Mind Map and Mind Mapping are registered trademarks of the Buzan Organisation.
Microsoft, Microsoft Office, Microsoft SharePoint, Microsoft OneDrive, Microsoft Word, Microsoft
PowerPoint, Microsoft Excel, Microsoft Project, Microsoft Outlook, Microsoft FrontPage, Microsoft
Windows, Windows Media Player, Windows Explorer and Internet Explorer are trademarks or
registered trademarks of Microsoft Corporation.
The 2007 Microsoft Office Fluent User Interface is subject to protection under U.S. and international
intellectual property laws and is used by MatchWare A/S under license from Microsoft.
WorldCat and the WorldCat logo are trademarks/service marks of OCLC Online Computer Library
Center, Inc.
Nuance, the Nuance logos, the Dragon logos, Dragon NaturallySpeaking, NaturallySpeaking,
DragonBar and Select-and-Say are trademarks or registered trademarks of Nuance
Communications, Inc. or its affiliates in the United States and/or other countries.
YouTube and Google Drive are trademarks of Google Inc.
Certain portions of Word Prediction copyright © Texthelp Ltd 2015
Other brand or product names are trademarks or registered trademarks of their respective holders.
This Product is copyrighted © 2002-2017 by MatchWare A/S. All rights reserved.
Information given in this documentation can be changed and represents no obligation on
MatchWare, its Publishers or Agents. This documentation is copyrighted © 2002-2017 by
MatchWare A/S. All rights reserved. This documentation is not to be copied, photocopied,
reproduced, translated or transferred to an electronic media or machine sensible form without a
written authorization from MatchWare or its Publishers.
IMPORTANT You should read the following MatchWare License Agreement (EULA) carefully. If
you install, copy, download, or use this software Product, you agree to be bound by the terms of
this agreement. If you do not agree with the conditions, you are not entitled to install and use the
software, and should immediately return the software package and all other material in this package
along with proof of payment, to the authorized dealer from whom you obtained it for a full refund of
the price you paid. Do not make any illegal copies.
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MatchWare License Agreement
USE
This is a legal agreement between you, the end user, and MatchWare A/S ("MatchWare"). The
enclosed software program ("Product") is licensed, not sold, to you by MatchWare for use under the
term of this license.
Prior to using the license to the Product you must assign it to a device, which becomes the
"licensed device". A hardware partition, blade, external hard drive, Flash drive etc. is considered to
be a separate device.
You may install and use one copy of the Product on the licensed device. Further, the primary user
of the licensed device may install and use another copy of the Product on a second device.
The Product license can be reassigned to another computer or user, but not within 90 days of the
last assignment, so long as there is no possibility of it being used by more than one person.
However, in the event of a permanent hardware failure, it can be reassigned sooner. You may
make one (1) backup copy of the Product.
When using Remote Desktop technologies you may access and use the Product provided that only
the primary user of the device hosting the remote desktop session accesses and uses the Product
with a remote access device. You are not permitted to use the Product on both the device hosting
the remote desktop session and the access device at the same time.
You may not rent, lease, loan or license this Product or any copy.
You may not reverse-engineer, disassemble, decompile, modify or create derivative work of this
Product.
TERMINAL SERVER / NON-ACTIVATION KEYS
A Terminal Server is a computer allowing other Client computers to run applications on the
Terminal Server such as but not limited to a Microsoft Terminal Server and a Citrix Server. If the
Product is installed on a Terminal Server you need a license for each user who has access to the
Product.
A Named User means a license to 1 individual person. You may add users by paying for a separate
license for each user you wish to add. When installing the Product on a server which allows
multiple, concurrent users to access and run the Product, you must license (purchase) additional
licenses for each named user.
If you are a Government entity or approved organization that has been granted a Non-Activation
key that does not require activation you must purchase a license for each named user of the
Product.
If you are using a Terminal Server /Non-Activation key then you are required to sign a “Terminal
Server Solution and Non-Activation License Key Program Agreement”. Please contact MatchWare
to enroll.
Upon reasonable notice by MatchWare, MatchWare reserves the right to request an audit of any
and all users accessing the Product deployed on a Terminal Server or via a Non-Activation key on
a quarterly basis. This number of audited users must be in accordance with the number of licenses
purchased by you. You are required to record the number of named users utilizing the Product.
Upon reasonable notice by MatchWare, you shall grant MatchWare, at MatchWare’s expense,
reasonable access to your premises, but no more than once per calendar year, for the purpose of
conducting an audit of the use of the Product pursuant to the terms of this Agreement. If such audit
reveals improper use of the Product by you, then MatchWare shall be entitled to invoice you for
such unauthorized use in accordance with MatchWare’s standard fees and legal rights at the time
of the completion of such audit.
ACTIVATION
Mandatory activation is required when using the Product. When activating the Product certain
information about the Product and the device will be sent to MatchWare. This information includes
version, language, product ID of the Product, device internet protocol address and hardware
configuration. By using the Product you consent to the transmission of this information.
MATCHWARE USER EXPERIENCE IMPROVEMENT PROGRAM
The MatchWare User Experience Improvement program can optionally be enabled in certain
versions of the Product if you select "Send anonymous usage statistics" during installation or from
the options dialog. When this feature is enabled, the Product will track your usage of the user
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interface and certain features and send the information anonymously to MatchWare. MatchWare
uses this information to customize, measure and improve its products and services.
EDUCATIONAL LICENSES
Commercial use of Educational Licenses of this Product is prohibited.
Some educational multi-user licenses offer home use rights for teachers (and students). Any
additional licenses purchased to facilitate such home use may not be installed or used on the
respective educational institution premises, buildings or campus.
If you are enrolled in the educational subscription program for the Product, the use of the Product is
subject to the Subscription Agreement and this License Agreement.
TRANSFER OF THE PRODUCT
You may transfer all of your rights to use the Product to another person, provided that you transfer
to that person the entire Product package, DVDs, documentation, and this statement, and transfer
or destroy all copies in any form. Once you transfer the Product you no longer have any rights to
use it. Only the person to whom the Product is transferred may use it in accordance with the
copyright law, international treaty and this statement.
If you have purchased an upgrade version of the Product, it constitutes a single product with the
MatchWare Product that you upgraded. For instance, the upgrade and the Product that you
upgraded cannot both be available for use by two different persons at the same time and cannot be
transferred separately.
OEM VERSIONS OF THE PRODUCT
An OEM version is a license of the Product that is distributed with a hardware device by the device
manufacturer. An OEM version of the Product is identified as an OEM version either on the cover of
the DVD (or CD) and/or in the main title bar within the Product.
You may transfer all of your rights to use the OEM version of the Product to another party only with
the licensed hardware device, provided that you transfer to that person the entire Product package,
DVDs, documentation, and this statement, and transfer or destroy all copies in any form. Once you
transfer the Product you no longer have any rights to use it. The OEM version of the Product may
not be transferred separately without the hardware device.
COPYRIGHT
All intellectual property rights in the Product and user documentation are owned by MatchWare A/S
or its suppliers and are protected by United States copyright laws, other applicable copyright laws
and international treaty provisions. MatchWare A/S retains all rights not expressly granted.
CLIPART
This Product may contain clipart ("Clipart") such as images and icons etc. All intellectual copyright
for the Clipart is owned by MatchWare A/S or licensed by MatchWare A/S.
MatchWare grants you a non-exclusive, non-sublicensable right to use the Clipart in presentations
or web sites created with this Product, including in runtime versions of the Product. There is no
royalty due for such use to MatchWare. The Clipart may not be sublicensed or made available to
any person or entity that does not have a legal license of this Product.
USING MINDVIEW PUBLIC MAPS LIBRARY
When publishing documents to MindView Public Map Library, you accept and agree to the Terms of
Service to the Public Map Library (http://link.matchware.com/tos_publicmaps). You understand and
agree that the documents published and shared on the Public Map Library are viewable for
everyone and can be downloaded and used by other users according to the Terms of Service.
LIMITED WARRANTY
MatchWare warrants the physical media and physical documentation provided by MatchWare to be
free of defects in materials and workmanship for a period of ninety (90) days from the original
purchase date. MatchWare will replace defective media or user documentation at no charge,
provided you return the item within the warranty period. If MatchWare is unable to replace defective
media or user documentation, MatchWare will refund the amount you paid for the Product. These
are your sole remedies for any breach of warranty.
LIMITATION OF LIABILITY
The entire and exclusive liability and remedy for breach of the foregoing limited warranty shall be
limited to replacement of defective media or documentation. In no event shall either party be liable
to the other party for any special, indirect, consequential, exemplary, punitive, incidental, or similar
damages, including but not limited to, loss of profit, data, or use of the Product, even if MatchWare
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has been advised of the possibility of such damages. MatchWare makes no representation or
warranty that the Product or documentation are "error free" or meet any of the user's particular
standards, requirements, or needs. In no event shall MatchWare's liability exceed the aggregate
amounts paid by you pursuant to this Agreement. To the extent that applicable law does not allow
the exclusion or limitation of implied warranties or limitation of liability for incidental or consequential
damages the above limitation or exclusion may not apply to you.
INTELLECTUAL PROPERTY INDEMNITY
MatchWare will, at its expense, indemnify, defend and hold Customer harmless against any and all
action brought against you to the extent that it is based on a claim that the MatchWare Product or
any part thereof or any MatchWare trademark used in relation thereto, when used within the scope
of this Agreement, infringes any trademark, copyright, trade secret, patent or other intellectual
property right, and MatchWare will pay any costs, damages and/or attorneys' fees awarded against
you in such action or payable pursuant to a settlement agreed to by MatchWare. The foregoing
obligation shall be subject to you notifying MatchWare promptly in writing of the claim, giving
MatchWare the exclusive control of the defense and settlement thereof, and providing all
reasonable assistance in connection therewith.
SUGGESTIONS
MatchWare will have worldwide, irrevocable, royalty-free, perpetual license to use, develop and
include in the Product any suggestions, recommendations or improvement requests or feedback
from you, including users, to the Product.
CUSTOMER REFERENCE
Either party may include the other party in a customer or vendor list. You also agree to consider the
following upon request from MatchWare: (i) participate in case studies and in Return of Investment
studies, (ii) serve as a reference, link exchange and use of your logo as reference on MatchWare’s
website, (iii) collaborate on press releases announcing the relationship.
U.S. GOVERNMENT RESTRICTED RIGHTS
This Product and documentation are provided with RESTRICTED RIGHTS. The Product and
documentation are developed at private expense and no part of them is in the public domain. Use,
duplication, or disclosure by the Government is subject to restrictions as set forth in subparagraph
c(1) and (2) of the Commercial Computer Software Restricted Rights clause at FAR 52.277-19 or
subparagraph c(1) (ii) of the Rights in Technical Data and Computer Software clause at DFARS
252.227 - 7013. Manufacturer is MatchWare A/S, P. Hiort-Lorenzens Vej 2A, 8000 Aarhus C,
Denmark.
GENERAL TERMS
Entire Agreement
This Agreement sets forth the entire agreement and understanding of the parties relating to the
subject matter herein and supersedes all prior discussions between them. No modification of or
amendment to this Agreement, nor any waiver of any rights under this Agreement, shall be effective
unless in writing signed by both parties.
Neither this Agreement nor any of the rights, interests or obligations of either party shall be
assigned or transferred by either party without the prior written consent of the other party, provided,
however, that either party may assign this Agreement pursuant to a merger, acquisition, or similar
transaction. All of the terms and conditions of this Agreement shall be binding upon, inure to the
benefit of, and be enforceable by the respective successors and any permitted assigns of the
parties.
Notices
Notices under this Agreement shall be sufficient only if personally delivered, delivered by a major
commercial rapid delivery courier service, delivered by facsimile transmission confirmed by first
class mail, or mailed by certified or registered mail, return receipt requested, to a party at its
address set forth herein or as amended by notice pursuant to this subsection. If not received
sooner, notice by mail shall be deemed received seven (7) days after deposit.
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Governing Law and Who You Are Contracting With
Who you are contracting with depends on where you are domiciled along with the Governing Law
and Jurisdiction:

Domicile

MatchWare Entity

Send Notices
to:

Governing Law

MatchWare Inc.
North, South or
Central America,
Australia and New
Zealand

311 S. Brevard
Ave.
Tampa, FL 33606

Legal
Department
Fax: + 1-813254-6654

Florida and
controlling United
States Federal
Law

USA
MatchWare A/S
Scandinavia

P. Hiort-Lorenzens
Vej 2A, st. th.
8000 Aarhus C

Legal
Department
Fax:
+4587303501

Danish Law

Denmark
MatchWare GmbH
Germany, Austria,
Switzerland

Beim Strohhause
31
20097 Hamburg

Legal
Department
Fax:
+4940543789

German Law

Germany
MatchWare Ltd.
9-11 The Quadrant
UK, France and Rest
of the World

Richmond, Surrey
TW1 1BP

Legal
Department
Fax:
+442083322170

UK Law

UK
Relationship of the Parties
The parties hereto are independent contractors. Neither party is, nor shall claim to be, a legal
agent, representative, partner or employee of the other; neither shall contract in the name of the
other nor assume or create any obligations, debts, or liabilities for the other. Neither party relies on
any promises, inducements or representations made by the other except as expressly provided in
this Agreement. This Agreement is not intended to constitute, create, give effect to or otherwise
recognize a joint venture, partnership, or formal business entity of any kind between the parties.
Either party may include the other party in a customer or vendor list. You also agree to consider the
following upon request from MatchWare: (i) participate in case studies and in Return of Investment
studies, (ii) serve as a reference, link exchange and use of your logo as reference on MatchWare's
website, (iii) collaborate on press releases announcing the relationship.
No Waiver
No waiver of any term or condition of this Agreement shall be valid or binding on either party unless
the same shall have been mutually assented to in writing by both parties. The failure of either party
to enforce at any time any of the provisions of this Agreement, or the failure to require at any time
performance by the other party of any of the provisions of this Agreement, shall in no way be
construed to be a present or future waiver of such provisions, nor in any way effect the ability of
either party to enforce each and every such provision thereafter.
Attorneys' Fees
The prevailing party in any legal action brought by one party against the other and arising out of this
Agreement shall be entitled, in addition to any other rights and remedies it may have, to
reimbursement for its expenses, including court costs and reasonable attorneys' fees.
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Welcome
Welcome to MatchWare® MindView™, the perfect tool for businesses, educators and students
who need to organize information! Easy to learn and easy to use, MindView is a highly effective
way of brainstorming, developing and structuring ideas visually. Ideal for use by individuals,
small teams or large groups, MindView generates illustrated mind maps® which you can use in
presentations, reports, web sites and more. With a comprehensive range of export options to
Microsoft® Office applications, HTML and other formats, MindView is an effective and versatile
concept development tool.
Mind maps are illustrated frameworks of organized, prioritized, linked ideas that develop or relate to
a subject or concept.

Mind maps have been demonstrated to help individuals and businesses achieve higher levels of
performance by increasing productivity and organization skills.

Outlining written documents
Using the Mind Mapping technique makes it very easy to outline your written documents such as
meeting agendas, proposals and marketing plans. MindView allows you to brainstorm ideas for
your main topics in a completely free and non-linear way. One of the great benefits of using
MindView, as opposed to brainstorming on a piece of paper, is that MindView allows you to
reorganize your ideas in the right order by dragging and dropping them in the mind map once you
have finished listing them.
When you export your mind map to Microsoft® Word, you can choose from a variety of creative
templates designed to give your document a professional look instantly. Main ideas are exported as
main headings, sub-ideas are exported as sub-headings and so on. All the text notes, comments,
pictures and other elements which you have placed on the mind map are also exported. This
means that you can actually start writing your report while brainstorming in MindView, as the
complete text is included in the exported Word document.
Once you start developing your document in Word, you may realize that you have forgotten some
key ideas that you would like to brainstorm in MindView first. All you need to do in that case is to
import your Word document back into MindView, add the new ideas to your mind map, and then reexport to Word.

Working with numbers
The Calculation module of MindView allows you to add numerical values to the branches of your
mind map, for example sales numbers, costs, exchange rates and so on, as well as formulas to
carry out calculations on the values. Built-in functions allow you to display values automatically
rolled up from lower sub-branches to higher ones. You can also insert text values to add important
information to your branches.
If for instance you have created a mind map to track worldwide sales, you can then export it as an
Microsoft® Excel spreadsheet in order to continue working directly in Excel.
Conversely, you can also import an Excel spreadsheet in MindView. Numerical values and formulas
(provided they are supported by MindView) will be preserved in the mind map created by this
process.
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Working with task lists
Use Mind Mapping to brainstorm, visualize and organize your tasks. Then convert your mind map
into a detailed implementation plan by adding task information such as dates, resources, priorities
and completion percentages.
Task lists can be created in an instant and displayed in the Outline view or exported to Microsoft®
Outlook. You can also import task lists from Outlook and synchronize information between
MindView and Outlook to eliminate redundancies.

Working with project plans
The MindView Gantt view is a specialized view, dedicated to the creation, editing and management
of project plans according to the rules of project management.
MindView lets you build, view and manage complex project plans in the Gantt view. Setup
deadlines, milestones and dependencies while keeping an eye on the critical path to ensure your
team delivers on time every time.
If necessary, you can easily export your project plan to Microsoft® Project to take advantage of its
advanced project management capabilities. You can also import existing project plans directly from
Microsoft Project or via the Microsoft Project XML format if you prefer to use the easy-tounderstand, visual MindView interface.
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Working with timelines
The MindView Timeline view is a great way of displaying time-related information such as company
history, marketing plans, production plans and historical data. Simply add dates or times to your
branches and switch to the Timeline view to see the information displayed along a horizontal time
axis. Different timescales (for example standard, weekly or daily) let you tailor the timeline to suit
your needs. You can zoom in or out, expand or contract the timeline scale, and condense empty
stretches of the timeline by inserting break marks.

Working on presentations and web sites
MindView has been optimized for storyboarding and planning web sites and multimedia
presentations, which you can then export to Microsoft® PowerPoint or HTML:
When storyboarding presentations, an idea in your mind map represents a slide (PowerPoint) in
your presentation, a sub-idea represents a sub-slide and so on.
You can attach files to branches (ideas) in the mind map, such as Flash files, pictures, text,
sounds and videos. These files are included when you export to PowerPoint or HTML and
displayed on their respective pages.
MindView lets you create hyperlinks, branch connections and other interactivity that is also
included when exporting.
The Export Wizards include a range of ready-made templates with built-in navigation, which you
are free to customize and save for further use.
MindView allows basic web editing during the HTML export. You can for instance place the
various elements where required on each individual page. No coding or scripting necessary!
Once exported, you can import your PowerPoint presentation back into MindView if you need to
storyboard more pages or slides.

Using the ready-made templates
MindView provides you with detailed business templates for use in the standard Mind Mapping
views, as well as ready-made project plans specific to the Gantt view, covering a range of common
business activities.
11

You can base your own documents on any of these templates, and customize them as required to
meet your particular needs. Comments and suggestions for expansion are given in their notes and
pop-up comments.
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What's new in MindView 7
MindView 7 has many new features which are fully described in this documentation. Here is a
brief description of the most important enhancements.

Interface
Office 2016 user interface: MindView uses the same user interface as Microsoft Office 2016,
giving you a familiar and intuitive environment for working with mind maps. This includes the Tell
Me bar which allows you to quickly find features and perform actions by entering word or phrases.
For more information, see "Getting help".
High-resolution icons: The user interface handles high-resolution icons, improving the graphics of
computers with high screen resolutions.

View
New Icons panel with Agile project management icons: MindView now includes an Icons panel
that makes it easier to find, select and replace icons in your mind maps. The panel includes several
new icons; among them Agile project management icons which you can use to identify project
sprints in your mind map and facilitate project reporting. For more information, see "Inserting icons".
Viewing task link connections in Mind Mapping views: You can now view task link connections
in the Mind Mapping views (Mind Map, Top Down and Left/Right). For more information, see "Using
links".
Improved viewing and selection tools in mind maps: With the Show/Hide button, you can
quickly select which data you want to show in your mind maps and on individual branches, toggling
elements such as project management data, branch connections and calculation fields on or off.
You can also use the Select command to select mind map elements based on items such as
legends, icons or task status, or using custom filters. For more information, see "Viewing a mind
map".
Page color option for text notes: MindView now includes the option to set a default background
color for text notes. This allows visually impaired users to achieve optimal contrast between text
and background. For more information, see "Setting up your preferences".

Project management
Project baselines in Gantt view: You can now define one or more baselines for your projects,
making it easier to track project progress. Baselines are also used in project reports and in several
new calculation functions. For more information on inserting baselines, see "Saving a project
baseline" in "Enhancing a project plan".
Fixed cost for tasks: You can now specify a fixed cost for tasks, facilitating management of tasks
where the cost is known in advance. For more information, see "Entering and editing tasks".
New columns showing total work and total cost: Two new columns give you a quick overview of
the total work and total cost incurred by resources assigned to your projects. For more information,
see "Assigning resources".

Editing and formatting
Several new calculation functions: MindView 7 includes many new functions that you can use in
calculation values. Many of the new functions make project management easier, for example by
referencing the default baseline you have selected for the project. For more information on using
functions, see "Entering formulas" in "Inserting calculation values". For a complete list of functions
available, see "List of calculation functions".
MP3 audio notes save storage space: You can now save audio notes as MP3 format files, saving
storage space. For more information, see "Inserting audio notes".
Many new symbols in Picture Catalog: The Picture Catalog includes several new symbols, giving
you an even wider selection of illustrations you can use in your mind maps. For more information,
see "Inserting pictures".
New map, timeline and Gantt styles: New styles for mind maps, outlines, timelines and Gantt
charts are included in MindView 7.
13

Format context tab for milestones in Gantt charts: Gantt chart milestones now have a Format
context tab, making it easier to format them. For more information on formatting Gantt chart
elements, see "Using the Gantt view".

Collaboration
Google Drive and Microsoft OneDrive: MindView can now open and save files on Google Drive
and Microsoft OneDrive. For more information, see "Opening and saving online documents".

Import and export
Publishing mind maps: You can now publish your mind maps on the MindView online mind map
library, making them available to the general public and allowing you to share them with anyone.
For more information, see "Publishing a mind map".
Improved Microsoft Excel export: The Excel export feature now supports row grouping, allowing
you to export branch hierarchies as grouped rows. You can also export a legend with fixed data and
select to have text notes exported as comments or in a separate column. For more information, see
"Exporting to Microsoft Excel".
Improved Microsoft PowerPoint export and import: Numbering schemes and ALT tags for
images are now included when exporting to Microsoft PowerPoint, and you can now export and
import PowerPoint presentations in MindView without having PowerPoint installed. For more
information, see "Exporting to Microsoft PowerPoint" and "Importing from Microsoft PowerPoint".
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Important terms
Many of the terms used in MindView belong to the standard Windows terminology. Some terms,
however, are specific to MindView or related to the Mind Map concept and may be unfamiliar to
you.
Attachments and hyperlinks
MindView allows you to attach various objects to the root or branches of your mind map, such as
text documents, pictures, videos, sounds, Flash™ files or URL links, which you can activate from
within the mind map. These objects are listed in the MindView Object list, and can all be exported
when exporting your map to a different format. See "Attaching objects" and "Creating hyperlinks" for
more information.
Branch connections
A branch connection is used to indicate visually that two branches are conceptually related. This
relationship is identified on a map by an arrow-headed line joining the source branch to the end
branch. See "Creating branch connections" for more information.
Calculation values
MindView allows you to add values to the branches of your mind map, for example sales numbers,
costs, exchange rates and so on, as well as formulas to carry out calculations on the values. You
enter values using the Calculation panel, accessed from a tab on the right of the workspace.
For more information, see "Inserting calculation values".
Comments
Comments are short notes that you can add to the root of your map, to a branch or to the
workspace itself. See "Inserting comments" for more information.
Document
Each MindView document you create opens in a separate tab bearing the name of the document. A
MindView document can contain several maps. You can also keep several documents open at the
same time in MindView. MindView documents are saved with the extension .mvdx. See "Creating a
mind map" for more information.
Export
Once you have finished the design of your document, you can export it to other formats, such as a
Microsoft® PowerPoint presentation, a Microsoft® Word or .RTF document, a Microsoft® Excel
spreadsheet, a Microsoft® Project document, a Microsoft® Outlook task list or a picture. You can
also export to HTML and XML.
See the section "Exporting" for more information.
Gantt view
The MindView Gantt view is dedicated to the creation, editing and management of project plans
according to the rules of project management. The Gantt view is made of two parts, an Outline on
the left which represents the project plan as a hierarchical list of tasks, and a Gantt chart on the
right, which shows the tasks as horizontal bars arranged against a background calendar display.
See "Using the Gantt view" for more information about project plans and project management. See
also the definition of a project plan in this topic.
Import
Not only can you export your document to PowerPoint, Word, Excel, Outlook or Microsoft Project,
but you can re-import the exported document into MindView as a new document, while preserving
much of the additional work you might have done on the document in these external applications.
You can also import into MindView documents originally created in PowerPoint, Word, Excel or
Microsoft Project as well as task lists from Outlook and XML documents.
See the section "Importing" for more information.
Icons
MindView lets you place icons on the branches of your mind map to attract attention or illustrate a
particular idea. Using icons, you can for instance represent visually the status of a particular topic,
its importance, and so on. See "Inserting icons" for more information.
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Left/Right view
This view represents your mind map as a list of topics placed either on the right of the root (Right
view) or on the left of the root (Left view). It is a good choice when you need to present data in a list
form and want to be able to fully explore each point in the list before going on to the next point. See
"Using different views" for more information.
Main branch
The main branches are the branches that are directly connected to the root. They represent the
main topics related to the subject of your mind map. See "Inserting branches" for more information.
Mind Map
A mind map is made up of its root, all its branches and sub-branches and all inserted elements
(icons, comments, text notes and so on) and attached objects (text files, picture files, video files,
hyperlinks and so on). Note that MindView allows you to create several different maps in the same
document.
Mind Map view
This is the default view when creating a new mind map. It represents the map with the root in the
center, and all the main branches radiating from it in a clockwise direction. This is a good view to
use when brainstorming ideas for a mind map without worrying about evaluating or structuring
them. See "Using different views" for more information.
Outline view
The Outline view represents the map as a hierarchical list which you can expand and collapse as
required. It allows easy navigation through the document from top to bottom and gives you another
way to brainstorm ideas. For detailed information about working in the Outline view, see "Using the
Outline view".
Pack & Unpack
This feature allows you to distribute your mind map to other users very easily. With a few mouse
clicks, you can create a packed map containing all the pictures and files you may have attached to
it, ready to be accessed over the network or distributed by email. See "Packing a mind map" for
more information.
Pre-branch
A pre-branch is a branch that you insert before the currently selected branch. See "Inserting
branches" for more information.
Project plan
A project plan is a series of interdependent tasks that need to be performed in a particular order. A
project plan has a specific start date, corresponding to the start of the first task, and a specific end
date, corresponding to the end of the last task and the completion of the project. If one task runs
late, all the tasks that are dependent on the delayed task are affected and their dates are
automatically recalculated. MindView lets you build, view and manage complex project plans in the
Gantt view. See "Using the Gantt view" for more information about project plans and project
management.
MindView also supports the creation of task lists, which are much simpler than project plans. See
the definition of a task list in this topic.
Root
The root is the central block that appears when you create a new mind map. It represents the
subject of the map. Any branch that you attach directly to the root is a main branch. See "Inserting
branches" for more information.
Sub-branch
Any branch belonging to a main branch is called a sub-branch. Each sub-branch can have its own
sub-branches. Sub-branches represent various levels of sub-topics. See "Inserting branches" for
more information.
Task list
A task list is a series of individual tasks which are not connected to each other. If one task is
delayed, this has no effect on any of the other tasks. MindView lets you add task information such
as dates, priorities and resources to the branches of your document in order to create simple task
lists. See "Inserting task data" for more details.
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MindView also lets you build and manage project plans, which are more complex than task lists.
See the definition of a project plan in this topic.
Templates
MindView comes with a large number of educational, business and personal templates on which
you can base your own mind maps. You can also save your own mind maps as templates for future
use. See "Saving a mind map" for more information. Templates are saved with the extension .mvtx.
Text notes
Text notes, unlike comments, are comprehensive notes that you can enter using the Text Note
editor and associate with the root or any branch of your map. See "Inserting text notes" for more
information.
Timeline view
The Timeline view lets you see all the branches of your mind map that contain time information
displayed in chronological order along a horizontal time axis. Different timescales (for example
standard, geological and historic) let you tailor the timeline to suit your needs. For more information
on the Timeline, see "Using the Timeline view".
Top Down view
This view represents your mind map as a hierarchical pyramid, with the root at the top, the main
branches underneath, the sub-branches below the main branches and so on. It is a useful
representation for structured data which needs to be viewed in a hierarchical manner, in other
words from the higher level to the lowest levels. See "Using different views" for more information.
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Installation
Stand-alone installation
MindView comes as an installation package (*.exe file) that you download to your computer.
Double-click the installation package.
Follow the instructions on the screen when the MindView Install program starts.

Administrative installation (system administrators only)
The Windows® Installer can perform an administrative installation of an application or product to a
network for use by a workgroup. Alternatively, you can extract the contents of the .exe file so that
you or the users in your organization can install MindView using the .msi file.
After performing an administrative installation or extracting the .msi file, you can push the
installation to client computers in the domain using Group Policies or a different installation
methodology.
To find out more about Windows® Installer and administrative installations, please refer to the
Microsoft web site.

Creating an administrative installation
You can create an administrative installation from the command line as follows. The procedure
extracts a complete source image of the application (similar to the source image found on a DVD).
Choose Start | Run.
On Windows 10, you can hold down the Windows button and press R.
Use the Browse button to locate the downloaded MindView installation package.
Insert the command line option /a // after the path to the installation package as in the
example below:
C:\downloaded files\mindview7_<language>_<build>.exe /a //
Click OK to start the Administrative Installation Wizard.
Specify the following in the dialog that appears:
Where you want to unpack the package
The user name and company name to use as default
The serial number
(optional) Check 'Force activation when MindView is run' if you want MindView to be
automatically activated the first time the program runs.
(optional) Check 'Automatically activate during installation' if you want to activate MindView
during installation.
(optional) Check 'Use simplified interface for younger students' if you want MindView to enable
the simplified interface as default.
These three activation options are "silent" (i.e. they do not display any messages).
The above options are stored in a file called "admin.ini" in the destination folder. You can edit
this file using a text editor like Notepad if you want to change the options without making a new
administrative installation.

Extracting the .msi file and additional content
You can extract the .msi file and .cab file from the installer package using the command line option
/extract.
Choose Start | Run, and locate the downloaded MindView installation package as described
above.
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Insert the /extract command line option after the path to the installation package. The
examples below assume that you have downloaded the package to the Temp folder:
c:\temp\mindview7_<language>_<build>.exe /extract – extracts the package
contents to the same folder as the .exe file
c:\temp\mindview7_<language>_<build>.exe
/extract:c:\temp\msipackage – extracts the package content to a different folder
In the second example, it is important to create the msipackage folder before running the
command, as it will not be created automatically.

Troubleshooting
Changing the location of the activation file
By default, the activation data is stored in:
C:\ProgramData\mwas\MindView7.0.mwas
In some rare situations, client computers may be setup with restricted access to the above folder,
and this will cause the activation file not to be saved. If you have a client server system setup in this
way, you can move the activation file to another location by adding an entry to the admin.ini file as
follows:
[Activation]
mwas=c:\different folder with write access\MindView7.0.mwas

Storing several activation files on the server
You can store several activation files in the same folder of the server by adding an entry to the
admin.ini file as follows:
[Activation]
mwas=\\server\activations\MindView7.0_%COMPUTERNAME%.mwas
Where:
server = the name of the server
activations = the share name on the server
%COMPUTERNAME% will be replaced with the client computer name
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Support
Getting help
The MindView documentation is provided as online help in the program.

Online Help
You can access the online help system by pressing F1 or by clicking the small question mark
on the top right of the MindView window.
To obtain help on a particular dialog, click the small question mark
dialog in question.

on the top right of the

Tell Me bar
You can use the Tell Me bar to the right of the ribbon to quickly find and use features, or to get help
on a particular feature.

Enter a command you want to find, or a command or feature you want more information about.
Select a search result in the drop-down that appears.

If you select to get help, the online help system opens and lets you select from one or
more help topics dealing with your search term.
If you select a command from the drop-down (for example Apply Branch Focus in the
example shown above), the command is executed.
You can only access and execute commands that are currently available to you. For
example, you will not be able to access the Branch command if you have not selected a root
or branch. Commands that are not available to you are grayed out in the search results.

Quick Start panel
You can access tutorial videos and other content from MatchWare's YouTube channel from the
Quick Start panel. For more information on showing and hiding MindView panels, see "Setting up
your workspace".

The FAQ Knowledge Base
For additional information, please refer to our FAQ Knowledge Base:
http://faq.matchware.com/en/
As well as answering the most commonly asked technical questions concerning the MatchWare
products, this database allows you to post comments and send questions to MatchWare.

Service Packs
If you encounter a problem that you are not able to solve by referring to the FAQ, check that you
have installed the latest MindView service pack available. MatchWare releases service packs
regularly to provide enhancements and correct errors reported by its users.
You can find service packs for MatchWare products at:
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http://www.matchware.com/en/support/default.htm

MatchWare Web Site
The MatchWare web site contains extensive information on all the products offered, as well as
tutorials, templates and reviews. Updates are posted regularly. To see what is currently available,
please visit:
http://www.matchware.com/en

Reporting a problem
To report a problem, bug or any other error in MindView, please send a message to MatchWare via
our FAQ Knowledge Base:
http://faq.matchware.com/en/
MatchWare is registered with the Windows® Quality Online Services. In the unfortunate event of an
application failure, the Windows Error Reporting system will capture relevant product data and
enable you to forward this data to MatchWare automatically.
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Quick Start
This Quick Start takes you through all the basic steps required to build a mind map from scratch
and enhance it with design effects, icons, comments, pictures, attachments and so on.
The map we are going to create here is about planning a weekly meeting.

The complete mind map, "Weekly Meeting.mvdx", can be found in the MindView program folder, in
"…\MatchWare\MindView 7.0\QuickStart".
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First step: Creating the mind map
In this first step of our Quick Start example, we are going to create all the branches we require for
our meeting agenda.
We start by creating a new MindView document.
Start MindView and choose Mind Map under New in the Backstage view.
If you have closed the Backstage view, you can re-open it by pressing Ctrl + N.

In this Quick Start, we will use the Mind Map view, which is the default view in MindView.
Your new map appears with the root block ready for you to fill in.

Entering the subject
Type "Weekly Meeting" and press Enter.

The default file name "Weekly Meeting" is now shown on the document tab.

The asterisk to the right of the name indicates that the document contains data which has not yet
been saved.

Inserting the main branches
We are now going to insert a few branches, corresponding to various topics we would like to
include in our agenda, namely:
A section for the opening remarks
A section on budget issues
A section on the upcoming office relocations
A section for the closing remarks
Let's start by inserting the first branch.
Press Enter.
The first branch is now visible. Its default label is "Idea".
Type "Opening remarks" and press Enter.
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Press Enter again to insert the second branch.
Type "Budget" and press Enter.
Insert two more branches by pressing Enter and label them "Relocations" and "Closing
remarks".
As you can see, branches are inserted in a clockwise direction around the root.

Inserting the sub-branches
We now want to insert some sub-branches, corresponding to the sub-topics of our main
topics.
To add the first sub-branch to the Opening remarks topic, click the corresponding branch to
select it and press Insert.
Type "Welcome" and press Enter.
Press Enter again to add the second sub-branch.
Type "Objectives" and press Enter.
Type "Previous minutes" and press Enter.
Now select the "Budget" branch and press Insert to add its first sub-branch.
Continue in the same way until you have added all the other sub-branches shown below.

To correct typing errors, select the relevant branch and click the label. Then place the cursor at
the required position, press Delete or Backspace to remove the incorrect characters, type the
correct ones and press Enter.

Saving the document
Let us save the work we have done so far before going on to the second step.
Click the Save Document icon

in the Quick Access Toolbar or press Ctrl + S.

In the Save As tab that opens, click Browse to choose a folder, enter a file name for your new
mind map and click Save.
The default file name, derived from the subject of the map, is "Weekly Meeting.mvdx".
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Second step: Enhancing the mind map
In this second step of our Quick Start example, we are going to enhance our meeting agenda by
adding a variety of visual elements and multimedia objects to it.

Choosing a style
MindView contains galleries of predefined layouts and styles, which allow you to apply branch
shapes, branch colors and other coordinated attributes in one step.
Click the Design tab in the main menu.
This tab contains all the design options applicable to the current view, in this case the Mind Map
view.
Browse through the Layouts gallery to choose your preferred layout.
As you browse through the options, MindView shows you an immediate preview of their effect on
the map. To apply a particular option, just click it. As we are designing a standard mind map, we
are going to keep the default layout.
Browse through the Styles gallery to choose your preferred style.
(optional) To further customize the visual aspect of your map, explore the options available in
the Effects and Properties panels.
All the design options you choose here apply to the entire map. You can come back to this Design
tab at any stage to change or add design options to your map. You might even prefer to leave the
design phase to the end, once you have put in place all the contents of your map.
As well as specifying global design options, MindView lets you apply different design effects to
individual branches of the map, as we will see at the end of this Quick Start.

Inserting pictures
It is considered good Mind Mapping practice to insert a picture in the root block to illustrate
the theme of the map, so we are going to do just that:
Click the View tab in the main menu.
Click Show/Hide | Panels and choose Pictures.
The Pictures panel opens.
Click the Search for field of the Pictures panel and type "meeting".
Various pictures appear in the Pictures panel display area.
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Drag the picture of the meeting over the root block and let go of the mouse button.
The root block now contains a picture of a meeting.
This type of picture, which "sits" on the branch to which it belongs, is called a "branch picture".

We also have a picture of a removal truck which we are going to insert as a "floating picture" to
illustrate the Relocations branch.
Click the Relocations branch to select it.
Click the Insert tab in the main menu.
Choose Pictures | Floating Picture.
Browse to "…\MatchWare\MindView 7.0\QuickStart" in the Program Files folder, select the file
"Truck.png" and click Open.
A picture of a truck now appears on the map. You can move this picture wherever convenient by
dragging it with the mouse. Note that a thin line connects it to the branch to which it belongs.
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Inserting icons
Inserting icons on the map is a useful way of attracting attention or illustrating a particular idea.
Click the View tab in the main menu.
Click Show/Hide | Panels and choose Icons.
Note that the Pictures panel disappears; only one right-hand panel can be visible at a time.
Select the Budget branch.
Click the dollar sign icon in the Standard icon palette.

The icon now appears next to the branch label name.

Select the Relocations branch and add the red flag icon to it to indicate that the deadline for the
office move is approaching.

Inserting a text note
The MindView Text Note editor lets you add comprehensive text notes to any branch of your
map.
We want to add a note to the Closing remarks branch to explain why we might want to broaden the
list of attendees for the next meeting.
If it is not already visible, open the Text Note editor by choosing View | Show/Hide | Panels |
Text Note Editor.
Select the Closing remarks branch and type the following text (or any other) in the Text Note
editor.
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As soon as you click the Text Note editor window, an Edit tab appears at the right of the
ribbon to help you format your note.
Format the text to your liking and click outside the Text Note editor.
A paperclip icon
now appears to the right of the Closing remarks branch label, indicating
that this branch contains an object.

Inserting comments
We would also like to insert a couple of shorter comments and reminders in our map.
We start by adding a "floating comment" to the Relocations branch to indicate that the planning
deadline is approaching. Floating comments stay visible on the screen at all times.
Click the Relocations branch to select it.
Choose Insert | Text | Floating Comment in the main menu.
A floating comment box opens with the default text "Insert Floating Comment".
Enter the text of the floating comment as shown below and press Enter.
(optional) Move the floating comment by dragging it wherever convenient.

We are now going to insert a "pop-up" comment in our Opening remarks branch as a reminder to
welcome new staff. Pop-up comments are normally hidden.
Select the Opening remarks branch. This time, rather than using the main menu, press F11
(MindView's more commonly used commands have function key equivalents).
A yellow comment box opens.
Enter the text of the comment as shown below and click outside the yellow box.

The comment box disappears, but a yellow comment icon
now appears next to the branch
label, indicating that this branch contains a pop-up comment. You can view the comment at
any time by moving the mouse pointer over the icon, and edit it by clicking the icon.
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Attaching a file
Since we have developed a spreadsheet to help us plan next year's budget, we are going to
include it as a file attachment on our map.
Click the Budget branch to select it.
Choose Insert | Links | Attachment in the main menu.
Browse to "…\MatchWare\MindView 7.0\QuickStart", select "Budget.xls" and click OK.
A paperclip icon
now appears to the right of the Budget branch label, indicating that this
branch contains attached objects.
To view the attachment, move the pointer over the paperclip icon.
The object pop-up list appears.

Assuming Microsoft® Excel is installed on your computer, all you have to do to view the
spreadsheet is to click the attachment in this list.
The attachment is also listed in the Object list for the branch.
To view the Object list, choose View | Show/Hide | Panels | Object List in the main menu.

Creating a branch connection
Since we want to consider this year's underspent areas when planning next year's budget, we
want to create a visual link between the two topics on the map.
Choose Insert | Links | Branch Connection in the main menu.
The mouse pointer changes shape.
Move the mouse pointer to the Underspent areas branch, click it, drag the pointer to the Next
year branch until it gets highlighted and let go of the mouse button.
A line now joins the Underspent areas branch to the Next year branch, indicating that the two
branches are related.

The paperclip icon appears to the right of the Underspent areas branch, denoting the presence of
the branch connection.
If you select the Underspent areas branch again, you will notice that the branch connection is also
listed in its Object list. By default, it bears the name of the branch where the connection ends.
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Formatting the branches
To finish off our map, we are going to add boundaries around the main branches.
At the start of this topic, we have seen how to choose global design options for the view using the
Design tab.
If required, you can also apply specific design options to individual branches using the Format tab.
Click the Opening remarks branch to select it.
Click the Format tab that appears at the right of the ribbon.
This tab contains all the commands that are specific to the selected object, in this case the
Opening remarks branch.
Click the Boundary icon in the Boundary group.
(optional) To choose a fill color for the boundary, click the small arrow under the Fill Color icon.
This also lets you apply a color gradient, choose the direction of the gradient and change the
start and end color of the gradient.
(optional) To choose an outline style for the boundary, click the small arrow under the Outline
icon. This lets you choose a different color for the outline, a different width or a different line
type.

You can of course also use the Format tab to customize your branches further, by changing their
shape, the color of their background and/or outline, the color and width of the line joining the branch
to its parent branch and so on.
If after experimenting with all these options, you want to restore your branches to the default
style you chose for the view at the start of this topic, just press Reset Style.
Our simple Quick Start example is now complete. In a very short time you have created and
enhanced your first MindView mind map. You have also learnt the most common operations in
MindView. Please refer to the User Guide for more information about any of the features described
here.
30

User Guide
Setting up your workspace
The MindView window is made up of several components:

The File menu is displayed in the upper left corner of the MindView window. It contains
commands affecting the entire document, such as New, Open, Save, Print or Export.
The Quick Access Toolbar is a component of the Microsoft Office interface. It is a
customizable toolbar that is available at all times, regardless of the menu tab currently open on
the ribbon. By default, it is located in the top left corner of the MindView window.
The Ribbon is also a component of the Microsoft Office interface. Its tabs, corresponding to the
main activities in MindView, contain all the necessary commands, options and icons, organized
in groups. It is designed to help you quickly find the commands that you need to complete a
task.
The Design tab that appears at the right of the ribbon is a special tab. It contains all the
design options applicable to the current view.
When a particular branch or map element is selected, a Format tab may appear after the
Design tab. It contains all the commands that are specific to the selected object.
Four Panels can be displayed on the right of the MindView window. Note that only one of these
panels can be visible at a time.
The Workspace is the area you use to design your document.

Customizing the Quick Access Toolbar
The Quick Access Toolbar contains the most frequently used commands. By default, it is located in
the top left corner of the MindView window.

You can customize the Quick Access Toolbar by adding frequently used commands to it, or moving
it closer to the workspace area:
Click the Customize Quick Access Toolbar arrow
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on the right of the toolbar.

Select one or more of the commands listed to add them to the Quick Access Toolbar.
Deselect one or more selected commands to remove them.
Click More Commands to open a dialog where you may choose commands from any
MindView ribbon and add them to the Quick Access Toolbar:
In the field Choose commands from, choose the ribbon tab containing the required
command.
Choose the required command in the Commands field and click Add.
You can also add entire groups to the Quick Access Toolbar. Groups are denoted by a dropdown symbol

.

A quicker way to add a command to the Quick Access Toolbar is to click the ribbon tab
containing the command you want to add, right-click the command and choose Add to Quick
Access Toolbar.
Click Show Below the Ribbon to move the Quick Access Toolbar to under the ribbon.

Minimizing the ribbon
MindView lets you minimize the ribbon to increase the workspace available:
Do one of the following:
Click the arrow

at the far right end of the ribbon

or
Click the Customize Quick Access Toolbar arrow
choose Minimize the Ribbon.

on the right of the toolbar, and

To use the ribbon while it is minimized, click the tab you want to use, and then click the
command you want to use.
As soon as you have made your choice, the ribbon returns to its minimized form.
To restore the ribbon, click the Customize Quick Access Toolbar arrow again and uncheck
Minimize the Ribbon.
You can also minimize the ribbon as follows:
Double-click the current tab.
To restore the ribbon, just double-click any of its tabs.
You can also press Ctrl + F1 to minimize or restore the ribbon.
The layout of the commands, options and icons in the ribbon changes when the width of the
MindView application window is reduced. Controls normally represented by large icons may for
instance now be represented by small icons. If the width of the application window is greatly
reduced, a group may be represented only by its icon.
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To view the contents of such a collapsed group, just click its icon.

Using access keys and shortcut keys
To select a command from the ribbon, all you need to do is click the relevant tab to open it, then
choose the command.
You can also use access keys for this purpose. Access keys are different from shortcut keys.
Access keys are used to navigate through the interface and select its different commands
using the keyboard. Each command shown in the File menu, the Quick Access Toolbar and the
Ribbon has an access key.
Shortcut keys are key combinations such as F1 or Ctrl + O used to perform frequently used
commands. Shortcut keys are not related to the organization of the commands in the interface.
You will find a list of all the shortcut keys used in MindView in "Keyboard shortcuts".
To select a command using an access key, start by pressing the Alt or F10 key. You will now
see the first layer of access keys you can use at that point displayed as small labels
underneath each tab or command.

Press the access key for the tab or command you require to see the second layer of access
keys.
For instance, pressing H above will open the Home tab and display its access keys, as shown
below.

Press the key or keys corresponding to the command you want to select.
For instance, pressing B above will insert a branch in your map.

Using the MindView panels
Four panels can be opened on the right of the MindView window:
The Task/Timeline panel
This panel lets you enter dates, times and other information on the branches of your mind
map to create timelines, task lists or project plans.
For more information on this panel, see "Inserting timeline data" and "Inserting task data".
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The Pictures panel
This panel lets you access the Picture Catalog, an extensive collection of high quality clipart
pictures which you can add to your map to illustrate the topics.
See "Inserting pictures" and "Using the Picture Catalog" for more information.
The Icons panel
This panel lets you insert icons in your map to illustrate the topics.
See "Inserting icons" for more information.
The Calculation panel
This panel lets you enter and modify values on the branches of your mind map, for instance
sales numbers, costs, exchange rates and so on, as well as formulas to carry out calculations
on the values.
See "Inserting calculation values" for more information.
MindView includes other panels which you can show or hide using the View | Show/Hide | Panels
command.
The Text Note editor
The Text Note editor, which is placed by default at the bottom of the workspace, lets you
associate comprehensive notes to the root or any branch of your map.
See "Inserting text notes" for more information.
The Object list
This lists all the objects placed on the currently selected branch of your map.
See "Using the Object list" for more information.
The Properties dialog
This dialog shows the properties of the MindView element currently selected, for example the
root, a branch or a floating comment. If nothing is selected the properties of the current view
are shown.
The Overview panel
The Overview panel allows you to bring the different parts of your map into view.
See "Using the Overview panel" for more information.
The Changes panel
This panel lists all the changes made to your map, by yourself or any other user who has
access to it, provided that change tracking has been enabled.
See "Tracking changes" for more information.
The Timeline Outline
This panel is only used in the Timeline view. It shows all the branches of your map as a
hierarchical list which you can expand and collapse as required.
See "Using the Properties dialog" for more information.
The Quick Start panel
This panel gives you access to tutorial videos and other content from MatchWare's YouTube
channel.

Resizing panels
To resize a panel, move the pointer on one of its edges until it changes to a double arrow and
drag with the mouse in the required direction.

Undocking panels
The Task/Timeline panel, the Pictures panel, the Icons panel and the Calculation panel are always
anchored on the right of the workspace. Only one of these panels can be displayed at a time; when
you open a new panel, the previous one is collapsed.
All the other panels open by default on the left of the workspace, except for the Text Note editor,
which opens at the bottom.
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You can however move any of these panels freely on the workspace or dock them to a different
position:
To undock a panel, just drag its title bar away from its current position until it is completely free,
then let go of the mouse button.
You can also double-click the title bar of the panel to undock it and double-click it again to
redock it. If you want to undock a panel and move it freely on the workspace without it "snapping" to
a docked position, press the Ctrl key and hold it down while dragging the title bar of the panel.

Docking panels
You can dock an undocked panel to the left, top or bottom edge of the workspace as follows:
Drag the title bar of the panel and move it in the direction required until you see the arrow
shapes left

, up

and down

appear on the edges of the workspace.

Drag the panel on top of the required arrow until you see a darker shade of blue outline the new
position. Release the mouse button if you are happy with this new position, else continue
dragging to the required position.
You can also dock a panel above, below or on the side of another panel. To do this:
Drag the title bar of the panel and move it in the direction of the target panel until you see a
three-arrow shape appear.

You now have different possibilities:
Moving the panel over the left, up or down arrow will dock it on the corresponding side of the
underlying panel.
Here for instance, the Object list is being docked to the left of the Properties dialog.
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Moving the panel to the middle square will integrate it as a tab of the underlying panel,
converting it to a multi-tab panel.
Here, the Object list is being integrated with the Properties dialog as a tabbed panel.

To free such a tabbed panel, drag it by clicking its tab, not its title bar.
To separate the Object list from the Properties dialog in the example below, you would
therefore click the Object List tab.

Resetting panels to their default position
If necessary, you can reset all the panels to the default position they had when you first installed
MindView:
Click the File tab.
Choose Options.
Click Preferences on the left.
Set Reset Interface to Yes.
Click OK.
When using this command, note that other components, such as the Quick Access Toolbar or the
list of recently opened files, are also restored to their defaults.
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Setting up your preferences
The MindView Options dialog lets you customize your environment and gives you access to
external web resources.
Click the File tab.
Click Options.
The MindView Options dialog that opens contains several panels, corresponding to different
options.
In addition to the settings below, MindView uses the Windows locale settings for items like date
formats and thousands separators. If you change the Windows locale while MindView is running,
close and restart the application.

Document
This dialog contains options relating to the current document, and are only available if the
document type is Project Management and if a document is open.
Project Management is the default document type in MindView (except for the AT version where
the document type is Task Management) but you may select a different document type from the
Task/Timeline panel. For more information on changing the document type, see "Inserting timeline
data" and "Inserting task data".
For detailed information about these options, see "Project Management options" below.

Proofing
This dialog contains various options which you can set to determine the type of errors reported by
the spellchecker.
It is described in detail in the topic "Spellchecking options".

Save
Create backup of document files: Creates a backup of the MindView file and saves it as a *.bak
file. The *.bak file is a copy of the last saved version of your document. See "Saving a mind map"
for more information on this feature.
Save auto-recovery info: MindView automatically saves a copy of your open documents at regular
intervals in a temporary backup file. If a problem occurs that prevents MindView from closing
properly, you can choose to auto-recover your file from this backup file when next starting
MindView. This field allows you to set the interval between automatic saves.

Preferences
Display options
Enable live preview: When this option is enabled, MindView shows a preview of how particular
choices affect the map as you browse through them. When designing a mind map for instance, you
can browse through the different styles shown in the Styles gallery to choose your favorite style. If
this option is enabled, you see an immediate preview of the result on your mind map as you hover
over each style.
Show Mini Toolbar: When this option is enabled, MindView displays a small floating toolbar above
the right-click menu when you right-click the workspace, a branch or a text note. The toolbar
contains features relevant to the view you are in and saves you having to search for formatting
commands or other options in the ribbon.
Draw map antialiased: Antialiasing improves the appearance of your map by smoothing its edges.
This option is enabled by default. However, antialiasing makes a heavy use of the computer
resources. If your computer has limited power, you might prefer to disable this option to speed up
the display of the map.
Draw text antialiased: This option is disabled by default. However, text looks smoother when it is
antialiased. Enable this option if your computer resources allow it.
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Show Backstage view on startup: If you disable this option, MindView displays an empty
workspace when starting rather than the Backstage view. See "Creating a mind map" for more
information.
Show Interactive Whiteboard Help dialog: This option is only relevant when you are working in
pen mode using an interactive white board. When it is enabled, a help message appears every time
you put a pen back in the tray if the workspace still contains ink data that has not yet been added to
the document. For more information, see "Working in Pen Mode".
Show simplified user interface: This option, of particular interest to novice users and younger
students, restricts the user interface to the most commonly used menus and commands. You can
return to the full interface at any time by disabling it. You can also switch to the simplified interface
by choosing View | Window | Simple Interface.
Maximize MindView window on startup: When this option is set to Yes, the MindView window fills
the entire screen when the program is started. If you set it to No, the MindView window keeps the
size and position on the screen that it had the last time you exited the program.
Setting the option to No will still mean that the MindView window is maximized on startup if it
was maximized the last time you exited the program.
Enable Windows Navigator: When this option is set to Yes, you can use the Windows Navigator
feature to quickly view and switch between active tool windows and files by pressing Ctrl + Tab.
See "Viewing a mind map" for more information.
Reset Picture Catalog: Setting this to Yes restores the original contents of the Picture Catalog.
Your User Area is left unchanged, but all the elements you might have added to any other category
are removed. See "Using the Picture Catalog" for more information.
Reset Interface: Setting this to Yes resets all the panels to their default positions. When using this
command, note that other components, such as the Quick Access Toolbar or the list of recently
opened files, are also restored to their defaults. See "Using the MindView panels" for more
information on resizing and docking panels.
Animation options
These options allow you to disable the animation effects used by MindView if your computer is not
powerful enough to produce a good result. If the animation effects appear slow and jerky rather
than fast and smooth, you can disable them.
Comments: This relates to the way the comment window opens when you insert or edit a
yellow pop-up comment .
Object list pop-up: This relates to the way the Object list pop-up opens when you move the
mouse pointer over the paperclip icon
shown next to the label of any branch containing
attached objects.
The next three options are only available in Windows Vista and above:
Zoom: This relates to the way the map is displayed by increments when zooming in and out.
Animation time: This is the time (in milliseconds) a scroll or zoom animation will take.
Animation distance factor: This factor makes the duration of the scroll or zoom animation
proportional to its distance. For instance, when scrolling from one branch to another branch
placed some distance away on the screen, the higher this factor, the longer the animation will
take.
Text Note editor options
Default font: This field lets you specify a default font, text style, text size and text color for all the
text notes you enter using the Text Note editor. To access these options, just select the field and
click the three dots that appear at its right end. You can of course change these settings for
individual text notes when working in the editor. For more information about the Text Note editor,
see "Inserting text notes".
Page color: This drop-down lets you select the default page color used in text notes. This option
helps visually impaired users read the content of text notes by allowing for greater contrast between
font color and page color. The page color setting is specific to your MindView installation. In other
words, all text notes that you create, view or edit on your own computer are shown with the default
page color you select here, but the same text notes will be shown using a different page color on a
MindView installation with a different page color setting.
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Project Management options
These options control the defaults MindView applies to any new document you create where the
document type is Project Management. For more information on changing the document type, see
"Inserting timeline data" and "Inserting task data".
You can change these options for a particular document by using the Document panel
described above, or the Document Properties dialog (click the File tab and choose Info |
Properties).
Scheduling options
These options relate to the different ways in which MindView can schedule each task.
New tasks are effort-driven: This determines the effect of adding resources or removing
resources from a task on the duration and work value of that task. For more information about
effort-driven scheduling, see the topic "Assigning resources" and in particular the paragraph
"Understanding effort-driven scheduling".
Default task mode: This setting lets you select the default scheduling mode when creating a task.
The default setting is Auto Scheduled. For more information about manual task scheduling, see
"Using scheduling task modes".
Default task type: This setting lets you choose a different default for the task type used by
MindView to schedule each task. For more information about task types, see "Using scheduling
task types".
Default duration unit: This setting lets you choose the duration unit to be used by default when
you create a task.
Update manually scheduled tasks when editing links: This setting lets you choose whether
manually scheduled tasks should be updated when editing links between tasks, for example when
switching from Finish to Start (FS) to Start to Finish (SF). For more information about manual task
scheduling, see "Using scheduling task modes".
Default start time: This setting lets you choose the standard start time for new tasks.
Default end time: This setting lets you choose the standard end time for new tasks.
Currency options
These options relate to the costs you can associate with resources. To find out how to do this, see
"Assigning resources".
Symbol: This field lets you specify the currency symbol to be used when displaying resources
costs on the mind map. You can enter here any currency symbol or any other symbol of your
choice.
Decimal digits: The number of digits after the decimal separator to be used when displaying
resources costs. You can enter any value between 0 and 9.
Placement: Use the drop-down to choose the placement of the currency symbol in the cost fields.
Undo options
The Undo feature lets you reverse any operation you have performed on your map. This gives you
the freedom to experiment, as you can easily undo the last change made by choosing Undo
in
the Quick Access Toolbar (or Ctrl + Z), and reapply the change if necessary with Redo
or (Ctrl
+ Y).
Note that you can also click the arrow to the right of the Undo icon to select a number of changes to
undo. Similarly, the Redo icon allows you to restore the last change or changes undone.
Undo levels: This field lets you specify the maximum number of changes that you want to be able
to undo. If for instance you set the number of Undo levels to 5, you will be able to reverse up to 5
changes by selecting the changes in the Undo list
or pressing Ctrl + Z several times. Note that
increasing the number of undo levels increases the amount of memory used.
Updates options
Check for program updates: This option allows MindView to check automatically for program
updates on the MatchWare web site at the start of the program.
Frequency of the checks: Specify here how often the checks should occur (in days).
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Advanced options
These options allow you to toggle the usage statistics feature (if applicable) and change the
location of various MindView folders and data. Always select a folder or location to which you
always have read/write access.
Send anonymous usage statistics: This option allows you to activate or deactivate the
MatchWare User Experience Improvement Program for your MindView installation. When the
option is set to Yes, anonymous statistics about your use of MindView is collected and sent to
MatchWare in order to improve our products and services.
Depending on your MindView version, this option may not be available.
Maximum Branches for Compacted Maps: This option allows you to set the maximum number of
branches allowed in compacted maps. If the number set here is exceeded, the Compact Map
feature is disabled to preserve application performance. This will improve load times for large mind
maps. For more information, see "Designing a mind map".
Temporary Document folder: This option allows you to select the folder used for temporary
documents.
Default Temp folder: This option allows you to select the folder used for creating temporary files.
User Data location: This option allows you to select the folder for data specific to you.
Picture Catalog location: This option allows you to select where the Picture Catalog and all
associated files should be located.
Picture Catalog User Data location: This option allows you to select where the user data for the
Picture Catalog should be located.

Calendar
This tab is only relevant if you intend to create project plans for use in the Gantt view. It lets you
modify the default calendar settings which provide the basic information about working and nonworking time used by MindView to schedule the tasks of a project plan.
For details about how to use this dialog, see "Defining calendars" in the "Gantt view" chapter. For
general information about the Gantt view, see "Using the Gantt view".

Suggestion Sources
This dialog lets you add, edit and remove suggestion sources for the Predictive Suggestions
feature. For details about how to use this dialog, see "Setting up suggestion sources".

Pen Input
This dialog is only displayed if your operating system supports pen input. It lets you choose different
input options when working in Pen Mode. For more information, see "Working in Pen Mode".

Resources
This dialog lets you access the MatchWare web site and obtain the latest product updates.
It also lets you enter a different serial number, for instance for converting a demonstration version
of MindView to a full version.
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Creating a mind map
When you start MindView, the first screen you see is the Backstage view.

Here you can select various commands to create, open, save and share mind maps and much
more.
You can select whether the Backstage view should be shown when you start MindView in the
MindView Options dialog. See "Setting up your preferences" for more information.
Choose New to create a new mind map document, and select the type of mind map you would
like to create: Mind Map, Top Down, Left/Right, Timeline, Outline and Gantt.
Although the topics in the "Basic tasks" and "Further tasks" sections of this documentation
assume that you are using one of the standard Map views, namely Mind Map, Top Down or
Left/Right, most of the procedures they describe apply equally to all views. Procedures that are
specific to particular views are described in the topics dealing with these views in the Views section
of this documentation. See "Using different views" for more information about each view.
If you have closed the Backstage view, you can also press Ctrl + N.
Once you have created your document, you can display it at any time in another view by choosing
that view in the Home | View or View | View panels in the main menu or by right-clicking the
workspace and choosing View Map As in the local menu or selecting a different view in the floating
toolbar displayed above the local menu.
Going from one view to another only affects the way the document is displayed. The contents of the
document are not modified, unless you edit them yourself while working in the new view.
The only exception to this rule is the Gantt view. Going to the Gantt view automatically enables
project management features. This may have consequences for your data. See "Using the Gantt
view" for more information.
The map appears with the root block ready for you to fill in.

See "Entering a branch label" to find out how to do this.

Using a template
The New from Template option of the Backstage view allows you to create a document based on
one of the many educational, business and personal templates included in MindView, or on one of
your own templates. The curriculum-aligned educational templates cover a range of learning levels
and are supported by over a thousand high quality clipart images created specifically to match all
areas of the curriculum.
MindView also includes various ready-made project plans for common business activities
(organizing a tradeshow, producing a publication, launching a product and so on) for use in the
Gantt view. You can use these for training purposes, or as a basis for your own project plans.
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Once you have created your mind map from one of these templates, you can easily tailor it to meet
your particular needs. Ideas and suggestions for expansion are given in text notes and pop-up
comments.

Selecting a template
Under New from Template, click one of the template category folder icons to browse the
templates contained in it.

You can see a preview of each template. The My Templates folder contains templates that
you have created; for more information on saving documents as templates, see "Saving a
mind map".

Click the desired template to create a document based on it.
You can delete a custom template by clicking the red cross icon at the top right of its thumbnail.
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Saving a mind map
MindView documents are saved as .mvdx files.
To save a document:
Click the File tab.
You can now choose either:
Save to save your document under its existing name and continue working in MindView.
Save As to save your document under a different name, in a different location or as a template;
see below. This is also a way of creating a copy of your document.

To save your document, you can also just click the Save icon
or press Ctrl + S.

in the Quick Access Toolbar

You can get MindView to save the previous version of your document automatically as a .bak
file by enabling Create backup of document files in the Save panel of the MindView Options
dialog. For more information on that dialog, see "Setting up your preferences".
From the Save as dialog, you may also save your document in an online place such as the
MatchWare Shared Workspace. You may also add or manage online places. For more information,
see "Opening and saving online documents" and "Managing online workspaces".

Saving your document as a template
You can also save your document as a custom template for future use. This allows you to
create new documents based on your existing ones. To do this:
Click the File tab.
Choose Save As | Save As Template.
Click Save.
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Your template is saved with the extension .mvtx and is listed in the My Templates folder when you
create a new mind map based on a template. For more information, see "Creating a mind map".
You can create any number of sub-folders in the My Templates folder from the Save As dialog or
Windows Explorer. These sub-folders will be listed in the My Templates folder. You can also
rename or delete sub-folders or templates as necessary from the Save As dialog or Windows
Explorer. Another way of deleting a template is to choose File | New | New from Template, open
the My Templates folder and click the red cross icon at the top right of the custom template.

You can also save your templates elsewhere on your computer or network, but if you do so,
they will not appear in the My Templates folder when you create a new mind map. To use a
template saved in a different location, you will have to browse to this location and open it as a
standard MindView file.

Recovering a backup file (*.bak)
If you save a document after having made some changes which you wish you had not made, you
can restore the previous version of the document as follows:
Click the File tab and choose Open.
Browse to the folder containing your MindView document and enter the file name *.* in the
Open dialog to view the list of all the files contained in that folder.
Select the filename.bak file, where filename is the name of your MindView document and click
Open.
Click the File tab, choose Save As, and save the .bak file in its original location and under its
original .mvdx name to overwrite the incorrect version of the document.

Auto-recovery
By default, a temporary copy of your document is also saved automatically at regular intervals to
allow auto-recovery in the event of a program failure. To disable automatic saving of auto-recovery
information, uncheck Save auto-recovery info in the Save panel of the MindView Options dialog.

44

Opening a mind map
When you start MindView, the first screen you see is the Backstage view. From here, you can
browse for an existing document or select a recently used document.
If you have closed the Backstage view, you can open an existing document as follows:
Click the File tab.
Choose Open.
You can also press Ctrl + O.
From the Open dialog, you may also open documents from online places such as the
MatchWare Shared Workspace, Microsoft OneDrive or a Microsoft SharePoint site. You may also
add or manage online places. For more information, see "Opening and saving online documents"
and "Managing online workspaces".
Note that you can open several mind maps in MindView at the same time. Each one is displayed in
a separate tab in the MindView workspace and is treated as a separate document. The icon shown
on each tab indicates where the document is stored: on your computer or on an online workspace.

An asterisk on the right of the document name indicates that you have made changes to the
document which you have not yet saved.
You can easily go from one document to the other by clicking the relevant tab or pressing Ctrl
+ Tab to open the Windows Navigator. For more information on the Windows Navigator feature,
see "Viewing a mind map".
Notes:
If you are trying to open a password-protected document, you will need to enter the password
before proceeding.
If the document you are opening was saved with a branch focus or a filter to restrict the display
of the map to specific branches, a message warns you that you may be viewing only part of the
map. Click the Clear Branch Focus or Clear Filter button next to the message to see the
entire map. For more information about branch focus and filters, see "Focusing on a branch"
and "Filtering a mind map" respectively.

MindView also lets you open MindManager® files (with extension .mmap) from version X5
onwards.

Opening documents created with previous versions of MindView
MindView 7 lets you open documents created with previous versions of MindView. However, once
you make changes to the document and save it with MindView 7, features and data in the saved
document may no longer be compatible with the previous version. You may therefore lose data if
you then open the saved document in a previous version of MindView.
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Entering a branch label
By default, the root of a newly created mind map contains the label "Subject" and new branches
appear with the label "Idea".

Replacing the default label
Just click the root or branch to select it and start typing.
You can switch on the Predictive Suggestions feature to receive suggestions as you type.
For more information, see "Using predictive suggestions".
When you have finished, press Enter or click outside the root or branch.

Unless your label is quite short, a resizing handle appears when you hover the right side of the
frame surrounding the label. You can use this handle to resize the branch label by dragging it in the
direction required.
By default, the text wraps around automatically when you type long labels. If you want to force
the next part of your label to start on a new line, press Ctrl + Enter at the end of the line. You can
disable the automatic text wrapping by unchecking the relevant property in the View properties. See
"View properties: General tab" for more information.
Your map will be clearer if you keep your root and branch labels short. If you need to enter
longer notes, use the Text Note editor. You can also enter comments to serve as reminders while
you build up your map. See "Inserting text notes" and "Inserting comments" for more information.
Branch labels can be read aloud. To do this, click the branch to select it and choose Review |
Proofing | Narrate
(or press F5). You can stop the narrating by clicking the icon or pressing F5
again. To resume, hold down Ctrl while clicking the icon or pressing F5.
This feature is only available in the Assistive Technology Edition (AT Edition) of MindView.

Editing a label
To replace the existing label, just click the branch to select it and start typing the new label.
You can also edit the existing label. Here are different ways of entering Edit mode:
Select the branch and click the label, or
Select the branch and press F2, or
Right-click the branch and choose Edit Text in its local menu.
Once you are in Edit mode:
Place the cursor at the required position and start typing.
When you have finished, press Enter or click outside the label.
Pressing Esc while in Edit mode will leave the existing label unchanged.
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Inserting branches
MindView lets you insert main branches, sub-branches and pre-branches in your mind map:
A main branch

is a branch directly connected to the root.

Main branches represent the main topics related to the subject of your map.
A sub-branch
level.

is a branch belonging either to a main branch or to a sub-branch of higher

Sub-branches represent the various levels of sub-topics in your map.
A pre-branch

is a branch you insert before a sub-branch.

MindView automatically arranges the main branches, sub-branches and pre-branches as you insert
them to prevent any overlap.
You can however choose to reposition the main branches yourself after their insertion by
disabling Auto-layout mode. See "Moving a branch" for more information.
As soon as you add a branch, sub-branch or pre-branch, the new branch appears with the default
label "Idea". The procedure for replacing the default label is the same as for the root. See "Entering
a branch label" for more information.

Inserting a main branch
To insert a main branch:
Click the root and press Enter or Insert.
You can also:
Double-click the root, or
Click the root and choose Home | Insert | Branch or Home | Insert | Sub-Branch, or
Click the root and choose Insert | Branches | Branch or Insert | Branches | Sub-Branch, or
Right-click the root and choose Insert | Branch or Insert | Sub-Branch in its local menu.

Inserting branches at the same level
To add a branch at the same level as an existing branch:
Click the existing branch and press Enter.
You can also:
Click the branch and choose Home | Insert | Branch, or
Click the branch and choose Insert | Branches | Branch, or
Right-click the branch and choose Insert | Branch in its local menu.
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Inserting a sub-branch
To add a sub-branch to an existing branch:
Click the existing branch and press Insert.
You can also:
Double-click the branch, or
Click the branch and choose Home | Insert | Sub-Branch, or
Click the branch and choose Insert | Branches | Sub-Branch, or
Right-click the branch and choose Insert | Sub-Branch in its local menu.

Inserting a pre-branch
To insert a branch between an existing branch and its parent branch, you can:
Click the branch and press Shift + Enter, or
Click the branch and choose Insert | Branches | Pre-Branch, or
Right-click the branch and choose Insert | Pre-Branch in its local menu.

Formatting a branch
As soon as you insert a branch in the map, a Format tab appears at the right of the ribbon.
This tab lets you perform different operations on the branch, such as changing its shape, choosing
a different fill color, defining a branch boundary, or selecting different text attributes. See
"Formatting a branch" for more information.
To apply the same formatting attributes to all the branches, it is however much easier to use the
Design tab, whose predefined styles and design options apply to the entire map. See "Designing a
mind map" for more information.

Copying branches from an external application
You can easily create a branch structure with main branches and sub-branches by copying several
lines of text from an external document, such as a Microsoft Word document, a Notepad text file or
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a Microsoft Excel spreadsheet, and pasting them into your MindView document. Any line indented
with spaces or tabs in the external application will be inserted as a sub-branch of the higher level
line.
Similarly, you can copy a MindView branch structure to another application by copying it from
MindView and pasting it in the external application.

Expanding and collapsing a branch
As soon as you add a sub-branch to a main branch or to another sub-branch, a small minus sign
appears between it and the higher-level branch. This allows you to hide the newly inserted subbranch and any further sub-branches and concentrate on the higher-level branches. There are
several ways to do this:
Click the minus sign

, or

Right-click the higher-level branch and choose Collapse in its local menu, or
Press Ctrl + Shift + "-".
The sub-branch is now hidden, and the minus sign

changes to a plus sign

.

To redisplay the sub-branch with all its sub-branches, do one of the following:
Click the plus sign

, or

Right-click the higher-level branch and choose Expand in its local menu, or
Press Ctrl + Shift + "+".

Navigating between branches
To select a branch, all you need to do is click its label.
The following keyboard shortcuts allow you to navigate easily from one branch to the other:
Up

Select the branch placed above the currently selected branch.

Down

Select the branch placed below the currently selected branch.

Left

Select the branch to the left of the currently selected branch.

Right

Select the branch to the right of the currently selected branch.

Deleting a branch
There are several ways of doing this:
Click the branch you want to delete and press Delete, or
Click the branch and choose Home | Editing | Delete

in the main menu, or

Right-click the branch and choose Delete | Entire Branch in its local menu.
If a branch contains sub-branches, you can delete it without deleting its sub-branches by choosing
Delete | Branch Section in its local menu. This causes the sub-branches to move up one level in
the hierarchy to become sub-branches of the parent branch.
Remember that if you delete a branch by accident, you can always cancel the deletion by
clicking Undo
in the Quick Access Toolbar or pressing Ctrl + Z.
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Designing a mind map
You can customize the look of your map at any time by applying design options to it.
Most design options give you a live preview of their effect on the map. It is therefore easier to
judge the overall effect once you have entered a few branches and sub-branches in the map.
Click the Design tab at the right of the ribbon.
This tab contains all the design options applicable to the current view.

Browse through the Layouts gallery to choose your preferred layout.
For more information about these views, see "Using different views".
The layouts available depend on the view you are using. If you are using one of the three
Map views for instance, you can choose between the traditional Mind Map layout, the Left or
Right layout or the Top Down layout.
Browse through the Styles gallery to choose your preferred style.
MindView also lets you design your own style, using the Style Designer. For more information,
see "Creating a custom style" below.
(optional) To further customize the visual aspect of your map, explore the options available in
the Effects and Properties panels.
If necessary, you can undo your changes and return the map to the initial style by choosing
Effects | Reset Style.
All the design options you choose here apply to the entire map. You can however apply
different design options to selected branches. To find out how to do this, refer to "Formatting a
branch".
By default, MindView organizes the map so that the bounding areas containing the branches
and their sub-branches do not overlap with each other. For some map layouts, this may create
large empty spaces between branches which make the map harder to overview. In those cases, the
Compact Map option may produce a better layout by bringing the branches as close to each other
as possible, as shown in the examples below. Note however that the compact mode is more
demanding on computer performance; to fine-tune the Compact Map option to your computer, you
can change the maximum number of branches allowed. For more information, see "Setting up your
preferences".
Mind map before compacting:
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Mind map after compacting:

Creating a custom style
You can create your own custom style, for re-use later, as follows:
Choose Custom Style at the bottom of the Styles gallery, and choose New in the menu that
opens.

The Style Designer tab opens.
You can now make design changes applicable to the entire map, as described above. You
can also make changes to specific branch levels, by selecting one branch at that level, and
using the Format tab to choose the relevant attributes.
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You can also customize the branch boundary shown around the first main branch by choosing
a different fill color and outline for it. Just select the branch, click the Format tab, and select
the required options in the Boundary panel. When applying this custom style to one of your
maps in the future, branch boundaries will automatically adopt the boundary style created
here.

Similarly, you can customize the floating comment shown by selecting it, and using the
options of the Format tab. When applying this custom style in the future, all the floating
comments of your map will automatically inherit the attributes you choose here.
When you have finished, click Close Style Designer in the Style Designer tab. A message
appears to ask you if you want to keep your new style.
Once saved, your new custom style appears at the end of the Styles panel of the Design tab,
after all the standard MindView styles. You can now select this custom style to apply it to your
maps just as would chose one of the standard styles.
You can return to your custom style at any time to edit it further by choosing Custom Style | Edit,
or delete it with Custom Style | Delete.

View properties
In addition to the design options available on the Design tab, the view also has properties that you
can edit in the Properties dialog. The Properties dialog always lists all the properties applicable to
the element currently selected in the workspace.
Click the workspace so that no other element is selected.
Choose View | Show/Hide | Panels | Properties to open the Properties dialog.

See "Using the Properties dialog" for a general description of the Properties dialog.
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See "View properties: General tab" in the Reference section for a detailed description of the general
properties applicable the view and "View properties: Branches tab" for a description of the default
properties applicable to branches.
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Viewing a mind map
As your map grows, parts of it may fall outside the display area and no longer be visible.

Scrolling the map
You can use the scroll bars or your mouse scroll button to bring parts of the mind map outside
the display area back into view:
To scroll your map vertically, use the vertical scroll bar or the scroll button of your mouse.
To scroll your map horizontally, use the horizontal scroll bar or press Shift while using the scroll
button of your mouse.

Panning the map
You can also pan the view to reach different areas as follows:
Press the Shift key and drag the area of the view that you want to reposition within the
workspace.
When you pan the view in this way, you will notice that the shape of the mouse pointer changes
from an arrow to a hand.
You can also easily move the map within the workspace by dragging its root to the position of your
choice.
In Touch Mode, you may pan the mind map by using your fingers on the touch screen of the
computer. See "Working in Touch Mode" for more information.

Viewing map details
There are other viewing options available to you:
You can use the Zoom slider
or the Zoom icons of the View tab to
change the level of magnification of your map. See "Zooming in and out" for more information.
You can view the map in full screen mode by choosing View | Zoom | Full Screen
or
pressing F9. To return to normal viewing mode, choose Close Full Screen in the floating Full
Screen toolbar, press Esc or press F9 again.
You can select the root in any map view by pressing Ctrl + Home. This is a convenient way of
returning to the starting point in large mind maps.
You can move the focus between the active tabs, panels or status bars in the mind map by
pressing F6. Each time you press this key, the focus is moved to the next active item; pressing
Shift + F6 moves the focus in the reverse order.
You can also use the Windows Navigator to quickly view and switch between active tool
windows and files; see below.
If you want to present your map to others, you can focus on one branch at a time while you
discuss the issues related to that branch by choosing View | Detail | Focus Mode
or
pressing F3. As soon as you click the branch you want to concentrate on, the map becomes
centered on that branch. If necessary, you can select a different zoom factor for maximum
legibility by clicking the lower part of the Focus Mode icon.
To recenter the map on its root so that you can select other branches that may no longer be
visible, just click anywhere on the workspace.
To return to the normal mode of working at the end of your presentation, click the Focus Mode
icon again to deselect it or press F3.
The Detail Level icons
of the View tab let you collapse the entire mind map to just one level
of branches, two levels, three levels or four levels. To show all levels, click the Show All
Levels icon .
You can also press Ctrl + 1 to display just one level of branches, Ctrl + 2 to show two
levels etc. Ctrl + 5 shows all levels.
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The Apply Branch Focus icon
of the View tab allows you to restrict the display to a
particular branch or set of branches. See "Focusing on a branch" for more information.
The Show/Hide icon of the View and Format tabs lets you select which data to show in the
mind map.
Choose View | Data | Show/Hide , and select the task information and calculation values
that you want to display on all branches in the entire mind map. You can also choose whether
branch connections and task link connections should be visible on the map or not.
Choose Format | Data | Show/Hide , and select the task information and calculation
values that you want to display on the selected branch.
For more information on branch connections and task link connections, see "Creating branch
connections" and "Using links". For more information on calculation values, see "Inserting
calculation values".
The Select icon of the Home tab lets you quickly select branches in your mind map based on
various predefined criteria. Choose Home | Editing | Select , and select the criterion you
would like to use from the menu.

For example, if you select Milestones in the menu, all branches with milestone tasks are
selected in the map, and if you select a particular icon from the Icons submenu, all branches
containing that icon are selected.
You can invert your selection (that is, deselecting all currently selected branches and instead
selecting all branches that were not selected). You can also choose to define a custom filter
and select branches based on this filter. Filters that you define here are also available for
filtering the mind map and using the Filter Highlighter, and vice versa; for more information,
see "Filtering a mind map".
The Bookmarks feature allows you to set bookmarks on your branches, in order to locate them
quickly again in your map. To set a bookmark on a branch, select the branch, click the button
View | Navigation | Bookmarks
and choose Add Bookmark in its drop-down menu (or
right-click the branch and choose Insert | Bookmark in its local menu).
The Bookmark icon appears on the branch, and the branch name is now shown in the list
that opens when you click the Bookmarks button.
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When you are viewing another part of the map, you can now quickly navigate to the
bookmarked branch by clicking again the Bookmarks button and selecting the branch name
in the list. This selects the branch, and re-centers the map on the branch.
To remove a branch from the list of bookmarked branches, select it on the map, click the
Bookmarks button and choose Remove Bookmark (or right-click the branch and choose
Delete | Bookmark in its local menu).
The Windows Navigator feature allows you to get a quick overview of active tool windows and
files, and switch between them.
To open the Windows Navigator, press Ctrl + Tab and hold down the Ctrl key.

While holding down the Ctrl key, select the tool window or file that you want to switch to using
the mouse or the arrow keys. When you release the Ctrl key, the Windows Navigator is
closed, and MindView switches to the selected view.
The icons shown next to the active files indicate whether the files are stored locally
online, for example on the MatchWare Shared Workspace . For more information on
storing files online, see "Opening and saving online documents".

or

The Windows Navigator does not include screen reader feedback and therefore may not
be suitable for visually impaired users. You can disable the Windows Navigator in the
MindView Options; for more information, see "Setting up your preferences". If the Windows
Navigator is disabled, pressing Ctrl + Tab merely switches between the documents currently
open in MindView, if there is more than one.
The Smart Nav feature is a small toolbar containing four convenient options for quickly
navigating large mind maps. It is always displayed on top of all other elements of the MindView
user interface, providing you with easily accessible navigation tools. Smart Nav is only available
in the Mind Map, Top Down, Left/Right and Timeline views.
To show Smart Nav, choose View | Navigation | Smart Nav
displayed on the screen.

. The Smart Nav toolbar is

To move Smart Nav, simply drag it to the desired location on your screen with the mouse. To
hide Smart Nav, choose View | Navigation | Smart Nav again, or click the Close button at
the top right of the Smart Nav toolbar.
To use one of the Smart Nav features, click it on the toolbar:
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Click Home to zoom the map size to 100%. If any other Smart Nav tools are active, they
will be deactivated when you click Home.
Select one or more branches and click Focus Mode to focus the map on the selected
branches. The focus is moved to any branch you select thereafter until you click the icon
again to deactivate Focus Mode.
Click Fence Zoom and define a rectangular area with the mouse to zoom to the defined
area.
Click Search and enter a search text in the text field provided. If you start typing a search
string that matches one or more branch names in the mind map, MindView will show a list of
suggestions, and the branches in question are highlighted. Use the Up, Down and Enter keys
or the mouse to select a suggestion. The map view scrolls to the selected branch or
branches.
The Numbering Scheme icon
of the Home tab lets you apply sequential numbers to the
branches of the mind map (starting from the top right in a clockwise direction) and choose
between various numbering styles.
The Filter icon
of the View tab lets you define criteria, and then locate the branches of your
document that meet these criteria by hiding all the other branches. Using filters, you can for
instance display only branches containing a specific label or timeline events starting at a
specific date. You can also use the Highlight icon
to highlight branches that meet the filter
criteria but still keep the rest of the branches visible.
See "Filtering a mind map" for more information.
The Overview panel allows you to concentrate on particular areas of your map. See "Using the
Overview panel" for more information.
Branch labels, text notes and comments can be read aloud. To do this, select the element and
choose Review | Proofing | Narrate
(or press F5). You can stop the narrating by clicking
the icon or pressing F5 again. To resume, hold down Ctrl while clicking the icon or pressing F5.
This feature is only available in the Assistive Technology Edition (AT Edition) of MindView.

Viewing map statistics
You can also find out general information about your map, such as its total number of branches, its
word count and its character count. You can do this in two ways:
Choose Review | Proofing | Document Statistics

, or

Click the File tab and choose Info | Properties.
The second method gives you additional information, such as the document's author, its creation
date, and other document properties.
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Zooming in and out
This topic describes the zoom features provided by MindView to let you change the level of
magnification of your mind map.
Other MindView options let you focus on particular areas by hiding all the other branches, apply a
filter based on the conditions you define, or choose the number of levels of branches to display. For
a description of these options, see "Viewing a mind map".
The easiest way to change the level of magnification of your map is to use the Zoom slider shown
in the bottom right of the workspace.

In Touch Mode, you may zoom the mind map by using your fingers on the touch screen of the
computer. See "Working in Touch Mode" for more information.

Zooming in
There are several ways of zooming in on an area of your map:
Click the Zoom In icon

of the Zoom slider shown in the bottom right of the workspace, or

Press Ctrl + "+", or
Press Ctrl while scrolling your mouse wheel.
The maximum zoom factor is 400%.

Zooming out
Conversely, you can zoom out in several ways:
Click the Zoom Out icon

of the Zoom slider shown in the bottom right of the workspace, or

Press Ctrl + "-", or
Press Ctrl while scrolling your mouse wheel.
The minimum zoom factor is 10%.

Viewing the map at 100%
To view the map in its default zoom factor of 100%:
Choose View | Zoom | 100%

in the main menu.

Fitting the map to the workspace
To make the best possible use of the space available, you can resize the map so that it completely
fills the workspace:
Choose View | Zoom | Fit All

, or press F4.

Selecting a zoom factor
You can also choose a predefined zoom factor or enter your own zoom factor as follows:
Choose View | Zoom | Zoom

in the main menu.

The Zoom dialog opens.
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Choose one of the predefined zoom factors or enter your own value.
Fit all resizes the map so that it completely fills the workspace.
Fit selection resizes the map so that the selected branch together with its sub-branches
completely fills the workspace.
You can also open the Zoom dialog by clicking the left part of the Zoom slider
.

Viewing the map in full screen mode
To give your map as much screen space as possible, you can temporarily hide all the menus and
panels by viewing the map in full screen mode:
Choose View | Zoom | Full Screen

, or press F9.

To return to normal viewing mode, choose Close Full Screen in the floating Full Screen
toolbar, press Esc or press F9 again.
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Inserting text notes
The MindView Text Note editor is a powerful tool which lets you add comprehensive text
notes to the root and any branch or sub-branch of your map. You can add as many different text
notes as you like to any of these elements.
If the Text Note editor is not already visible, choose View | Show/Hide | Panels | Text Note
Editor to open it.
You can resize, dock and undock the Text Note editor according to your needs. See "Using the
MindView panels" in the topic "Setting up your workspace" for more information.
In addition to text notes, you can also associate brief comments to the branches of your map.
For more information on comments, see "Inserting comments". You can also attach an entire text
file to a branch by using the Home | Insert | Attachment command. For more information on
attaching text files, see "Attaching objects".
Once created, a text note can be read aloud. To do this, click the Text Note editor window
containing your note and choose Review | Proofing | Narrate
(or press F5). You can stop the
narrating by clicking the icon or pressing F5 again. To resume, hold down Ctrl while clicking the
icon or pressing F5.
This feature is only available in the Assistive Technology Edition (AT Edition) of MindView.

Creating a text note
The easiest way to add a text note to a root or branch is as follows:
Select the root or branch to which you want to add a text note.
Click the Text Note editor window (or press F8) and start entering your note.
As soon as you click the Text Note editor window, an Edit tab appears at the right of the ribbon to
help you format your note.

You can now type text, paste text from the clipboard or even import text from an RTF file using
the local menu.
You can use the Predictive Suggestions feature to look up suggestions for single words or
entire phrases. See "Using predictive suggestions" for more information.
If necessary, click Undo
change(s) made.

in the Quick Access Toolbar (or press Ctrl + Z) to undo the last

Once you have finished editing your text, simply click outside the Text Note editor or select
another branch.
Once you are out of text editing mode, clicking Undo will undo all the changes made in the text
note since entering text editing mode.
As soon as you select another branch or element in the map, the text note is automatically saved
and added to the Object list of the root or branch. A paperclip icon
also appears to the right of
the root or branch label to indicate the presence of an attached object. Moving the mouse pointer
over the icon displays a pop-up list of all the objects attached.
Text notes may also be added using the Capture toolbar; for more information, see "Capturing
text and images".
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Adding a text note
You can attach an additional text note to a root or branch as follows:
Click the New Text Note tab

at the bottom of the Text Note editor or press Ctrl + F8.

When the Text Note editor is not visible, you can also enter a text note by selecting the relevant
root or branch and choosing Home | Insert | Text Note | New or Insert | Text | Text Note | New in
the main menu or Insert | Text Note | New in the local menu.

Formatting a text note
Text editing in MindView works in the same way as with most word processors and you will
recognize many of the commands below.
If you right-click the text note during editing, a floating toolbar with the most commonly used
formatting tools will appear above the right-click menu. You can use the commands in the floating
toolbar to format your text note without having to search for the right command in the ribbon.

To see what a particular icon does, place the mouse pointer over it until you see its descriptive
label appear.
To select the entire contents of your text note, press Ctrl + A.
The Paste button lets you insert the content of the Clipboard in the text note. Click the down
arrow below the button to access the Paste Special command which lets you choose whether the
Clipboard content should be inserted as unformatted text or in another format such as Rich Text
Format (RTF).
The Format Painter button lets you copy the formatting from one text section to another. Place
the cursor in the text whose formatting you want to copy, click the Format Painter button, and then
select the text you want to apply the formatting to.
These fields let you view and change the font and font size of the
currently selected text.
Note that you can set a default font, text size, text color and page color for all the text notes you
enter in the MindView Options dialog as follows:
Click the File tab.
Choose Options.
Click Preferences on the left.
Choose the required options in the Text Note editor section.
For more information, see "Setting up your preferences".
These icons let you increase and decrease the font size from their current values. If a piece
of text is selected, the size of each character is increased (or decreased) individually from its
current value.
These icons help you set and remove formatting attributes in the usual
way. You can set the selected characters as superscript or subscript by clicking the relevant icon.
The first of these icons let you change the color of the background of the selected
text so that it looks highlighted. The second icon lets you change the color of the text itself. The
third icon removes all formatting from the selected text, leaving only plain text.
Use these icons to create bulleted lists or numbered lists. Place the pointer in the
relevant paragraph or at the beginning of a new line and click the appropriate icon. Clicking the
arrow next to the icon lets you choose between different bullet styles and numbering formats.
Clicking the icon again removes the formatting.
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Use these icons to increase or decrease the indent level of the selected paragraph.
To adjust margins and indents, click the ruler icon (if the ruler is not already displayed). Drag
the margin markers
at the left and right ends of the ruler to change the left and right
margins. Drag the indent marker (which by default is shown directly below the left margin marker on
the ruler) to set the indent margin. To indent an entire paragraph (including the first line), set the
indent marker to the required position and type a tab character at the beginning of the paragraph.
You can insert standard tab stops by clicking the ruler and then dragging them into position. To
remove tab stops, drag them away from the ruler.
These icons let you align the current paragraph within the text note. You can align
it to the left margin, center it, align it to the right margin or justify it so that it is aligned with both left
and right margins.
Clicking this icon displays all the special marks and symbols within your text note, such as line
feeds and spaces. Click it again to hide these symbols.
Click this icon to insert a picture in the text note.

Creating a hyperlink
To convert the selected text to a hyperlink, click
or press Ctrl + H. This lets you create a
link between the selected text and an external element such as a URL.
If you want to link to an online workspace instead, click the Browse button
in the
Hyperlink dialog and select the workspace you would like to link to in the submenu. A dialog
opens where you may enter login credentials for the online workspace.
To edit the hyperlink, press Ctrl + H again or choose Edit Hyperlink in its local menu.
To delete a hyperlink, choose Delete Hyperlink it its local menu.
To activate a hyperlink, press Ctrl while clicking the link.
You can set the format of the selected hyperlink as default for all hyperlinks by choosing Default
Hyperlink Style in its local menu.

If you select No change, the hyperlink keeps the current italic, bold or underline attribute.
Set applies the relevant formatting (e.g. italic, bold or underline) to the hyperlink.
Clear removes the relevant formatting from the hyperlink.
You can also select a font, size and color for the text by choosing a value and checking the box to
the left of the relevant option to apply it.
The Change All button allows you to apply the options selected to all the existing hyperlinks.
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Creating a table
The next group of icons relates to tables.

To insert a table in your text note, click the Table icon and choose the initial number of rows
and columns required. The table is inserted at the cursor position. To change the height of table
rows, or the width of table columns, drag the row or column dividers. You can add and remove
rows and columns later using the Insert commands.
To delete the entire table, click the upper part of the Delete icon.
To delete the selected cell(s), row(s) or column(s), click the arrow in the lower part of the Delete
icon and choose the relevant command.
To insert a row or column, place the cursor at the point of insertion, and choose the relevant
Insert command.
To change the interior color of the selected cell(s), choose Shading and select your preferred
color.
To add and remove borders or change the border color, choose Borders.
You can also change the interior and border colors of the cells by choosing Borders and
Shading to open the dialog below.

You can assign a background color to all the cells in the table or to the selected cells only.
You can also assign a border width and color to the left, right, top or bottom edges of the
entire table or to each of the selected cells. To keep the current border width, just leave the
Width field empty. Similarly, to keep the current colors, leave the Color field(s) unchanged
(diagonal line on a white background).
To merge cells, select them and choose Merge Cells.
To split a cell into two, select it and choose Split Cell.

Adding a citation
MindView lets you add citations in your text notes to refer to the bibliography sources you have
been using. For more information on this, refer to "Using sources" and "Using citations".
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Spellchecking a text note
To check the spelling of the text contained in your text note, choose Spelling.
Clicking the lower part of the icon will enable you to choose a different language and set the
spelling options. See "Using the spellchecker" for more information about this feature.

Selecting a text note
When several text notes are attached to a root or branch, you can display the one you want to view
as follows:
Click the tab corresponding to the required text note at the bottom of the Text Note editor, or
Move the mouse pointer over the paperclip icon
click the required text note in the pop-up list, or

to the right of the root or branch label and

Click the required text note in the Object list of the root or branch.

Deleting a text note
To delete a text note, move the mouse pointer over the paperclip icon
to the right of the root
or branch label, select the required text note in the pop-up list and choose Delete in its local
menu.
You can also select it in the Object list and press Delete or choose Delete in its local menu.
Remember that if you delete a text note by accident, you can always cancel the deletion by
clicking Undo
in the Quick Access Toolbar or pressing Ctrl + Z.
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Inserting comments
MindView lets you associate comments with the elements of your map, including the workspace
itself, the root and any branch or sub-branch. There are two kinds of comments:
Floating comments
Pop-up comments
In addition to these types of comments, you can also associate longer text notes with the
branches of your map. For more information on text notes, see "Inserting text notes".
Once created, both types of comments can be read aloud. To do this, click the comment
window and choose Review | Proofing | Narrate
(or press F5). You can stop the narrating by
clicking the icon or pressing F5 again. To resume, hold down Ctrl while clicking the icon or pressing
F5.
This feature is only available in the Assistive Technology Edition (AT Edition) of MindView.

Floating comments
Floating comments are brief notes that stay visible on the screen at all times. You can add as
many floating comments as you like to the workspace itself, the root or any branch of your map.

Inserting a floating comment on a root or branch
Select the root or branch to which you want to add a floating comment and choose Insert | Text
| Floating Comment in the main menu or Insert | Floating Comment in the local menu.
A small window opens to let you type your comment, and a Format tab specific to the
comment appears at the right of the ribbon.

By default, the text wraps around automatically after a certain number of characters. If
you want to force the next part of the comment to start on a new line, press Ctrl + Enter at
the end of the first line.
Once you've finished typing, press Enter or click outside the comment window.
A thin line now connects your new comment with the root or branch you attached it to.
If necessary, you can move your comment to a more convenient place by dragging it with the
mouse or by using the arrow keys of the keyboard.
(optional) Click the Format tab at the right of the ribbon.
This tab contains formatting options applicable to the floating comment.
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Browse through the options available in the different panels, checking their effect on your
floating comment as you go.
As well as the Format tab, you can also use the Properties dialog to make changes to the floating
comment.
See "Floating comment properties: General tab" and "Floating comment properties: Text tab" in the
Reference section for a detailed description of the properties applicable to a floating comment. For
a general description of the Properties dialog, see "Using the Properties dialog".

Inserting a floating comment on the workspace
Right-click the workspace and choose Insert | Floating Comment in its local menu.
When you add a floating comment to the workspace in this way, the comment is not attached to
anything and no connecting line is visible.
If necessary, you can then move your comment by dragging it with the mouse or by using the arrow
keys of the keyboard. You can even connect it to a particular branch by moving it on top of its label.

Editing a floating comment
To replace the existing comment, just click it to select it and start typing the new comment.
You can also edit the existing comment. As for branch labels, there are several ways of entering
Edit mode:
Select the comment and click its text, or
Select the comment and press F2, or
Right-click the comment and choose Edit Text in its local menu.
Once you are in Edit mode:
Place the cursor at the required position to edit the existing comment.
When you have finished, press Enter or click outside the comment window.
Pressing Esc while in Edit mode will leave the existing comment unchanged.

Detaching a floating comment
To detach a floating comment from a root or branch, select the comment and choose Detach in
its local menu.
The comment now belongs to the workspace itself rather than to the root or any of its branches.

Deleting a floating comment
To delete a floating comment, select it and do one of the following:
Press Delete, or
Choose Home | Editing | Delete

in the main menu, or

Choose Delete in its local menu.

Pop-up comments
By contrast with floating comments, pop-up comments are normally hidden. You can add a
pop-up comment to the root or to any branch of your map, but not to the workspace itself. This type
of comment can be very useful as a "designer note" while you build your map. You could for
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instance insert a pop-up comment on a branch to list all the elements that you still need to add to
that branch.

Inserting a pop-up comment
Select the root or branch to which you want to add a pop-up comment choose Insert | Text |
Comment in the main menu or Insert | Comment in the local menu.
You can also just press F11.
The comment window opens to let you type your comment.
(optional) Resize the comment window by placing the mouse pointer on one of its edges or
corners and dragging in the required direction.
Once you've finished typing, press Esc, click outside the comment window or click the Close
icon in the top right corner of the comment window.
A yellow comment icon
now appears next to the branch name, indicating that there is a
comment associated with this branch. Moving the mouse pointer over this yellow comment icon reopens the comment window so that you can read the comment. As soon as you move the mouse
pointer away from it, MindView hides the comment window again.
If necessary, you can easily move your comment to a more convenient place by dragging its title
bar with the mouse.

Editing a pop-up comment
There are several ways of entering Edit mode:
Click the yellow comment icon on the right of the root or branch name, or
Move the mouse pointer over the yellow comment icon and click the comment window, or
Right-click the root or branch containing the pop-up comment and choose Insert | Edit
Comment in its local menu.
You can also just press F11.

Deleting a pop-up comment
There are two ways of doing this:
Right-click the branch containing the comment and choose Delete | Comment in its local menu.
Right-click the title bar of the comment window and choose Delete in its local menu.

67

Inserting icons
MindView lets you place icons on the branches of your mind map to attract attention or illustrate
a particular idea.
You could for instance use the Team icons
for all the topics of your map involving a discussion
with others, or the Clock icon
for all topics associated with a deadline. Make sure, however, that
you use such icons consistently and sparingly to avoid overloading the map.
You can also insert Agile project management icons to identify project sprints in your mind map. For
more information, see "Using Agile project icons" below.

Inserting a MindView icon on a branch
Select the branch to which you want to add an icon.
Click the Icons panel, or choose View | Show/Hide | Panels | Icons to open it.
Click the required icon.

The selected icon appears on the left of the branch name.
You can choose as many icons as you like in the Standard set. However, you can only choose
one icon in each of the other sets. If for instance you have attached a Priority 3 icon to your branch,
choosing a Priority 5 icon for the same branch will remove the Priority 3 icon and replace it with the
Priority 5 icon.
Once you have inserted an icon from a set other than the Standard set on a branch, clicking
that icon on the branch replaces it with the next icon in the set. If for instance you have inserted a
Priority 3 icon on a branch, clicking it replaces it with the Priority 4 icon and so on until Priority 9,
then Priority 1 again. You can also replace an icon with another icon in the same set by selecting
the icon on the branch, right-clicking it, choosing Replace Icon in its local menu, and selecting the
icon you want instead.
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Deleting an icon
You can delete an icon in three ways:
Click the icon to select it, then choose Delete Icon in its local menu.
You can also choose Delete All Icons to remove all the icons from the branch.
Right-click the branch, choose Delete | Icons and select the icon to be deleted, or choose All to
remove all icons.
Select the branch, then click the icon you want to delete in the Icons panel.

Managing your own sets of icons
MindView also lets you create and modify your own sets of icons.
Click Custom Icons at the bottom of the Icons panel.
The Manage Custom Icons dialog appears.

Click the Create Set icon

to create a new set of icons.

(optional) If you want your new icon set to contain mutually exclusive icons (meaning that a
particular branch can only contain one icon from the set), check Define as set of mutually
exclusive icons.
Click the Add Icon icon

to browse through your folders and select an icon to add to the set.

(optional) To rename your custom icon, right-click it and choose Rename.
Your new set of icons now appears in the Icons panel.
If you distribute to other users a mind map in which you have inserted custom icons, the other
users will be able to view the custom icons as usual when they open the mind map on their
computer. The custom icons are added to the bottom of the Icons panel in a special set called
"Other Icons".

Using Agile project icons
If you are using Agile project management methods in your projects, you can insert icons identifying
various branches as project sprints in your mind map.
Branches identified as sprints in this way are included in the Agile section when you create project
reports. For more information, see "Creating project reports".
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Inserting pictures
MindView lets you add pictures to the workspace itself, the root and any branch or sub-branch.
As all the research done in this area indicates that the use of pictures significantly enhances
memory retention, you should try to use pictures wherever possible to illustrate your map.
Three different types of pictures are available:
Branch pictures
A branch picture "sits" on the root or branch to which it belongs. You can only add one branch
picture to a particular root or branch.
It is considered good practice to insert a branch picture on the root to illustrate the subject of a
map, as shown below.

Floating pictures
Unlike branch pictures, floating pictures can be moved wherever convenient on the
workspace. Floating pictures can be connected to the root or particular branches, or just
"float" freely on the workspace.

Attached picture files
MindView also allows you to attach various objects to the root and branches of your map,
such as text files, picture files, video files, Flash files and so on. Not only can you activate
these objects from within MindView, but you can also choose to include them when exporting
your map to a different format, such as HTML. See "Attaching objects" for more information
on attached picture files.

Inserting a picture
Inserting a branch picture on a root or branch
Select the root or branch to which you want to add a branch picture and choose Insert |
Pictures | Branch Picture in the main menu or Insert | Branch Picture in the local menu.
You can also choose Home | Insert | Branch Picture in the main menu.
Choose the picture required in the Open dialog.
The picture is now inserted by the root or branch label, at a position determined by the style
applied to the map.

70

You can also paste a branch picture from the clipboard: select the root or branch, then
choose Paste or press Ctrl + V. Branch pictures may also be inserted using the Capture
toolbar; see "Capturing text and images" for more information.
(optional) Resize the picture as necessary: first click the picture itself to select it, then move the
mouse pointer on the required edge until it changes to a double arrow and drag with the mouse
until the picture reaches the correct size.
If necessary, you can reset the picture to its original size by using its aspect ratio property.
See "Picture properties" below.
You can also change the position of the branch picture with respect to the branch label, so that
instead of being shown above the branch label for example, the picture is shown on its right or on
its left:
Click the branch picture to select it, then drag it over the branch label, using the preview shown
in the bounding area to determine its new position. Drop the picture in one of the blue areas on
the right or on the left of the branch label to position it accordingly.

Dropping the picture in the left part of the blue area shown below the branch label converts it
to a floating picture.

Dropping the picture in the right part of the blue area shown below the branch label converts it
to an attached picture file.

You can also use this method to drag the branch picture to a different branch.

Inserting a floating picture on a root or branch
Select the root or branch to which you want to add a floating picture and choose Insert |
Pictures | Floating Picture in the main menu or Insert | Floating Picture in the local menu.
Choose the picture required in the Open dialog.
The picture appears on the screen, scaled down from its original size if necessary.
(optional) You can resize the picture as described above. You can also move the picture to a
more convenient place by dragging it with the mouse or by using the arrow keys of the
keyboard.
A thin line now connects your new picture with the root or branch you attached it to.
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Inserting a floating picture on the workspace
Click the workspace and choose Insert | Pictures | Floating Picture in the main menu or
Insert | Floating Picture in the local menu.
Choose the picture required in the Open dialog.
When you add a floating picture to the workspace in this way, the picture is not attached to anything
and no connecting line is visible.
(optional) As above, you can resize or move the picture as necessary. You can even connect it
to a particular branch by moving it on top of the branch.

Dragging a picture
Instead of using the MindView commands described above, you can also add a picture by dragging
it from the Pictures panel, Windows Explorer or the Windows Desktop.
For a full description of the Pictures panel and the Picture Catalog, see "Using the Picture
Catalog".

Dragging a picture on a root or branch
Just drag the picture from the Pictures panel, from Windows Explorer or from the Windows
Desktop and drop it on the relevant root or branch when it becomes highlighted.
By default, this creates a branch picture. If necessary, you can convert this branch picture to a
floating picture by right-clicking the branch picture and choosing Detach | Branch Picture in
its local menu.

Dragging a picture on the workspace
Just drag the picture from the Pictures panel, from Windows Explorer or from the Windows
Desktop and drop it on the workspace at the required position.

Moving a picture
If necessary, you can easily move a picture from one branch to another branch:
To move a branch picture to another branch, click the branch picture to select it, drag it to the
other branch, and drop it in one of the blue areas of the preview bounding area described
above, on the left, on the right or above the branch label.
You can also convert the branch picture to a floating picture by dropping it in the left part of
the blue area shown below the branch label, or convert it to an attached picture file by
dropping it in the right part of the blue area shown below the branch label.
Dragging a branch picture away from its branch and dropping it on an empty area of the
workspace will create a freely floating picture not belonging to any of the branches.
To move a floating picture from one branch to another branch, click the floating picture to select
it, drag it to the other branch until the pointer changes shape, and drop it in the left part of the
blue area shown below the branch label.
You can also convert the floating picture to a branch picture by dropping it in one of the blue
areas on the left, on the right or above the branch label, or convert it to an attached picture file
by dropping it in the right part of the blue area shown below the branch label.

Detaching a picture
Detaching a branch picture
To detach a branch picture and convert it to a floating picture, select the branch to which it
belongs and choose Detach | Branch Picture in its local menu.

Detaching a floating picture
To detach a floating picture from a root or branch, select the picture and choose Detach in its
local menu.
The picture now belongs to the workspace itself rather than to the root or any of its branches.
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Replacing a picture
Replacing a branch picture
You can replace a branch picture by another picture as follows:
Select the branch to which the picture belongs.
Press the Ctrl key while double-clicking the branch picture.
The Open dialog appears, letting you choose a different picture.

Replacing a floating picture
Double-click the floating picture.
The Open dialog appears, letting you choose a different picture.

Deleting a picture
Deleting a branch picture
You can delete a branch picture in two ways:
Start by selecting the branch to which the picture belongs, and then either:
Click the branch picture itself (resizing handles appear around it) and press Delete, or
Choose Delete | Branch Picture in the branch local menu.
If you press the Delete key by mistake, the whole branch will be deleted. You can restore it by
clicking Undo
in the Quick Access Toolbar or pressing Ctrl + Z.

Deleting a floating picture
To delete a floating picture, select it and do one of the following:
Press Delete, or
Choose Home | Editing | Delete

in the main menu, or

Choose Delete in its local menu.

Picture properties
Pictures have properties, which you can edit with the Properties dialog.
Branches containing branch pictures have an extra Picture tab in their Properties dialog containing
the picture properties. See "Branch properties: Picture tab" for a detailed description of the
properties applicable to branch pictures.
See "Floating picture properties: General tab" and "Floating picture properties: Picture tab" for a
detailed description of the properties applicable to floating pictures.
See "Using the Properties dialog" for a general description of the Properties dialog.
If the Properties dialog is not visible, choose View | Show/Hide | Panels | Properties to open
it.
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Inserting task data
MindView lets you enter task and time-related information on any of the branches of your
mind map in order to create different types of documents, such as timelines, task lists and project
plans.
This topic explains how to enter task data on the branches of your document to create a simple task
list or a project plan. For information about entering time data for a timeline, see "Inserting timeline
data".
Although you can also enter task data directly in other views such as the Outline view (task lists and
project plans) and the Gantt view (project plans only), the Task/Timeline panel described here
allows you to enter task data on your branches while brainstorming your document in one of the
standard Mind Mapping views.

Building a task list
Click the Task/Timeline tab on the right of the workspace or choose View | Show/Hide |
Panels | Task/Timeline Panel to open the panel.
Make sure the document type is set to Task Management.
Select a branch for which you want to add task data.
(optional) Enter a Start date.
(optional) Enter an End date.
(optional) Choose a Priority level.
(optional) Choose a percentage value to indicate how far the task has progressed to
Completion.
(optional) Assign Resources to the task by typing their names separated by semi-colons.
You can also click the Resources button to the right of the field to open the Task Resources
dialog. See "Assigning resources" in the "Gantt view" chapter for details about using this
dialog and information on how to create a global resources list.
Repeat the procedure to add task data to other branches.
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(optional) To display, directly on the branches of the mind map, the task data you just entered,
choose View | Data | Show/Hide (or right-click the workspace and choose Show/Hide) and
check the fields you want to see in the sub-menu.
You can hide or show the fields on individual branches with the Show/Hide icon of the
Format tab (or the Show/Hide option in the branch local menu).
It is also possible to format the task data displayed on the map in different ways. For more
information, see "Formatting a branch".
You can delete the time information inserted on a branch at any time by selecting it and clicking the
Delete Times button.
Once you have finished brainstorming your task list, you can display it in grid format in the Outline
view for a better overview and faster editing. You can also obtain a chronological display of the
tasks along a horizontal axis by switching to the Timeline view. See "Using the Outline view" and
"Using the Timeline view" for more information on these two views.
You can also import an existing task list from Microsoft Outlook or export your task list to it, as well
as synchronize different versions of the same task list stored in both programs.
For more information on the procedures involved, see "Exporting to Microsoft Outlook" and
"Importing from Microsoft Outlook".

Building a project plan
A project plan is a series of interdependent tasks that need to be performed in a particular order.
The MindView Gantt view is dedicated to the creation, editing and management of project plans
according to the rules of project management. It is the best view to use when working on a project
plan, since it allows you to visualize immediately the consequences on the overall plan of any
changes you make.
There are two important differences between the way in which MindView handles a simple task list
and the way in which it handles a project plan:
In a project plan, all parent branches become summary tasks. The start dates, end dates and
durations of summary tasks are calculated automatically from their sub-tasks and cannot be
edited.
In a project plan, tasks are only scheduled during working time, as defined by the project and
resources calendars.
For a full description of the Gantt view, including how to set up, create and manage a project plan,
see "Using the Gantt view" and the topics that follow it in the "Gantt view" chapter.
The Task/Timeline panel described here gives you an alternative way of viewing and editing the
information associated with the tasks of your project plan. It is useful if you want to brainstorm your
project plan in one of the standard Mind Mapping views rather than using the Gantt view. Once you
have finished brainstorming, switching to the Gantt view will enable you to take advantage of the full
capabilities of the project management features offered by MindView.
Click the Task/Timeline tab on the right of the workspace or choose View | Show/Hide |
Panels | Task/Timeline Panel to open the panel.
If you are creating a new project plan, make sure the document type is set to Project
Management.
Select a branch for which you want to add task data.
(optional) Enter a Duration, using the drop-down list on the right to choose between different
duration types (minutes, hours, days, weeks, months).
For detailed information about the different ways of entering a duration and how MindView uses this
value to schedule tasks in a project plan, refer to the paragraph "Entering a task duration" in
"Entering and editing tasks" (Gantt view).
Although you can add start dates and end dates to your project tasks, it is not recommended unless
you understand the implications of doing so. It is normally better to let MindView calculate the start
and end dates of the tasks automatically with reference to the project start date, the task durations,
and the task links that you might have set up in the Gantt view. For detailed information about how
MindView handles start and end dates in a project plan, refer to the paragraph "Specifying start and
end dates" in "Entering and editing tasks" (Gantt view).
(optional) Choose a Priority level.
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(optional) Choose a percentage value to indicate how far the task has progressed to
Completion.
(optional) Assign Resources to the task by typing their names separated by semi-colons.
You can also click the Resources button to the right of the field to open the Task Resources
dialog. See "Assigning resources" (Gantt view) for details about using this dialog and
information on how to create a global resources list.
Repeat the procedure to add task data to other branches.

(optional) To display, directly on the branches of the mind map, the task data you just entered,
choose View | Data | Show/Hide (or right-click the workspace and choose Show/Hide) and
check the fields you want to see in the sub-menu.
You can hide or show the fields on individual branches with the Show/Hide icon of the
Format tab (or the Show/Hide option in the branch local menu).
It is also possible to format the task data displayed on the map in different ways. For more
information, see "Formatting a branch".
MindView lets you export your project plans to Microsoft Project for further work. You can also
import existing Microsoft Project plans into the Gantt view, directly from Microsoft Project or via the
Microsoft Project XML format.
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For more information on exporting and importing directly from Microsoft Project, see "Exporting to
Microsoft Project" and "Importing from Microsoft Project". For the export and import options using
the XML format, see "Exporting to XML" and "Importing from XML".
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Inserting timeline data
MindView lets you enter time-related information on any of the branches of your mind map in order
to create different types of documents, such as timelines, task lists and project plans.
This topic explains how to enter time information on the branches of your document in order to
create a timeline.
For information about how to enter time information for a task list or a project plan, see "Inserting
task data".
Entering time information on the branches of your document allows you to display these branches
as chronological events along a horizontal axis in the Timeline view, as shown here:

For a full description of the Timeline view, see the topic "Using the Timeline view". This topic also
explains how you can present and export your timelines.
Although you can work directly in the Timeline view when creating a timeline, the Task/Timeline
panel described here allows you to enter time information on your branches while brainstorming
your document in one of the standard Map views.

Choosing a timescale
Regardless of whether you are working in one of the Map views or in the Timeline view, the first
thing you need to do when you are creating a timeline is to define the timescale of your document.
Click the Task/Timeline tab on the right of the workspace or choose View | Show/Hide |
Panels | Task/Timeline Panel to open the panel.
Choose the document type Timeline in the first field.
Select a timescale for the document. The default timescale is Standard.

MindView lets you choose between several timescales to cater for different timeline projects:
Standard: Use this timescale for normal dates and times. It is also suitable for historical times
where you do not need to show BC dates. You can specify the year, month, day and time. The
range is 1 AD to 3,000 AD.
Historic: Use this timescale for historical dates. You can specify the year (BC or AD), month and
day (not the time). The range is 5,000,000 BC to 3,000 AD.
Geological: Use this for plotting astronomical, geological or prehistoric events. You can specify
dates in thousands or millions of years. Decimal numbers are allowed. The range is
±20,000,000,000.
Daily: Use this timescale to plot time by day number, without reference to specific dates or days of
the week. For example, you could use it to chart the life cycle of an insect or to map out a process.
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You can specify day number and time: Day 1 is the first day, Day 17 the seventeenth, Day -3 the
third day before the first day, and so on. The range is ±1,000,000.
Weekly: Use this timescale to plot time by week number, without reference to specific dates. You
can specify week number, day (Monday to Sunday) and time. The range is ±100,000.
It is worth taking trouble to choose the timescale that is most appropriate for your subject. If you
change the timescale later, you will have to re-enter the time information on all the branches.

Entering dates and times
Select a branch for which you want to add time information.
Click the button at the right of the Start time field in the Task/Timeline panel (or press F12).

Specify a Start time for the event in the dialog that opens. You do not have to make selections
in all the boxes. For example, if you are using the Standard timescale, you can choose just a
year, or just a year and month, without specifying an exact date or time.
If you make a mistake or enter a date that in hindsight is too specific for your needs, you can
click Reset one or more times to undo your choices one by one. If for instance, you specify a
date by selecting '2001', 'January' and '22', clicking Reset will remove the information about
the day to leave the date as 'January 2001'.
Alternatively, you can just type in the date and time directly in the Start time field. You can
use various shortcuts and abbreviations, depending on the timescale.
MindView interprets what you type and shows the results in pop-ups as you type: at any time
you can click one of these to select it.
Here are some examples (displayed dates will depend on your machine’s settings and so may
be different from those shown here):
Standard:
'12 25 11', '12/25/11', '12-25-11' and '122511’ all become Dec 25, 2011 (US settings);
'25 12 11', '25/12/11', '25-12-11' and ‘251211’ all become 25 Dec 2011 (UK settings);
‘3 3’ becomes 3 Mar of the current year;
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You can also specify a time after the date, separating the date and the time with a space. For
instance, '2:00 pm' becomes 14:00.
Historic: ‘1211’ becomes 1211 AD; ‘-490’ becomes 490 BC;
Geological: ‘100m’ becomes 100,000,000; '-5000' becomes -5,000 (i.e. 5,000 years ago);
‘50t’ becomes 50,000.
Daily: ‘20’ becomes Day 20; ‘-20’ becomes Day -20; ‘2 10:pm’ becomes Day 2, 22:00.
Weekly: ‘3’ becomes Week 3; ‘3.0’ becomes Week 3, Monday; ‘-2.6 3:’ becomes Week -2,
Sunday, 3:00.
Click OK.
If necessary, you can specify an End time by clicking the End time field or pressing Ctrl + F12.
You do not need to specify an end time if your event has no extended duration. For example, to
enter the date of an event that happened on a particular day, all you need to do is to specify the
date as the Start time.
Repeat the procedure to add time information to other branches.
(optional) To display the time information you just entered on the branches of the map, choose
View | Data | Show/Hide (or right-click the workspace and choose Show/Hide) and check
Start/End time in the sub-menu.

icon

You can hide or show the time information on individual branches with the Show/Hide
of the Format tab (or the Show/Hide option in the branch local menu).

It is also possible to format the time information shown on the map in different ways. For more
information, see "Formatting a branch".
You can delete the time information inserted on a branch at any time by selecting it and clicking the
Delete Times button.
As well as using this panel, you can also enter time information on branches from the Outline
view or from the Timeline Outline panel shown in the Timeline view. Just double-click the relevant
Start Time or End Time cell and fill in the time picker as described above.

Advanced options
The End Times Definitions dialog which opens when you click the Advanced button at the bottom
of the panel allows you to specify the way MindView should handle end times. These settings are
only relevant when viewing the document in the Timeline view.

The simplest way to explain how this works is by means of an example. Suppose you are entering
dates for a branch concerning World War II. As start date you specify 1939, so the branch
displayed on the timeline will start at the beginning of 1939. As end date you enter 1945. There are
now two possibilities:
If the setting for End time year on this dialog is set to Is included, the end time will be the end
of 1945. In other words the duration bar for the World War II branch will stretch from the
beginning of 1939 to the end of 1945.
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If the setting for End time year on this dialog is set to Is not included, the end time will be the
beginning of 1945. In other words the duration bar will stretch from the beginning of 1939 to the
beginning of 1945.

The settings for the other time periods, namely month, week and day, work in the same way.
Important: The choices you make in this dialog will apply only to the end times you insert from now
on, and only for the current timeline. The next time you create a timeline, the settings of this dialog
will revert to their default values. You are therefore free to choose different options for different
timelines.
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Inserting calculation values
MindView lets you enter text and numerical data on any of the branches of your mind map. This
allows you to display values, such as sales numbers, costs, exchange rates and so on, to display
text strings such as project names, team members and so on, and to enter calculations. Built-in
functions allow you to display numerical values automatically rolled up from sub-branches.

Entering numerical values on branches
To enter a value for, let us say, 'Units sold' on one or more branches:
Select the branch(es).
Click the Calculation tab on the right of the workspace or choose View | Show/Hide | Panels |
Calculation Panel to open the panel.
In the grid, click <Insert New> under Name and type "Units sold".

If you have entered a value for 'Units sold' on the mind map before, you can skip this step
as the 'Units sold' field will already exist.
In the Value column enter the value, for example 2500.

The value now appears below the branch on your mind map, and the 'Units sold' field (called
a 'calculation field') becomes available for use in other branches.

Calculation fields do not display on the mind map if they are empty. So, if a calculation field is
created but no value is assigned (for example, if you omitted the final step in the above procedure),
it will be available for use but not displayed anywhere. When you give it a value for a branch (other
than zero) it will display on that branch.
Values you add directly on branches will override any default values you may have entered (see
"Entering defaults" below). If you enter a branch value by mistake you can type Ctrl + Z to undo
your entry, or right-click the value and choose Reset to Default.
Rather than adding values (or formulas) branch by branch, it is often quicker to add them using
the Defaults and Formats dialog instead. See "Entering defaults" below.

Entering text values on branches
The default value type in MindView calculation fields is Number. Every time you enter text
values in a calculation field using the following procedure, you will therefore be asked if you want to
convert the value type to Text. To avoid having to do this repeatedly, for example because you
need to enter many different text values, use the Defaults and Formats dialog to define text
values; see "Entering defaults" below.
To enter a text value, let us say to display a salesperson's name, for one or more branches:
Select the branch(es), and go to the Calculation panel as described above.
In the grid, click <Insert New> under Name and type "Salesperson".
In the Value column enter the value, for example "Amy Jones".
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Click Yes in the dialog to confirm that you want to convert the value of the calculation field to
text.
The text value now appears below the branch on your mind map, and the 'Salesperson' field
becomes available for use in other branches.
As with numerical values, calculation fields with text values are not displayed on the mind map if
they are empty, and values that you add directly on a branch will override any default values you
may have entered.

Editing values
To edit values on one or more branches:
Click the Calculation tab to open the Calculation panel.
Select the branch(es).
On the Calculation panel, make the changes in the Value column. Any changes you make will
overwrite existing values on all of the selected branch(es).
Like other branch data, calculation values may also be edited directly under each branch. For
more information, see "Editing branch data directly".

Entering defaults
To save unnecessary typing it is often useful to enter defaults for calculation fields. This is
especially the case if you need to enter several text value fields. To do this:
Click the Calculation tab to open the Calculation panel.
Click Defaults to open the Defaults and Formats dialog.
For each calculation field, use the Type column to indicate whether it is meant to contain
Number or Text values.
Enter values or formulas (see the next section) in the appropriate rows of the Default column.
The values or formulas you enter here will always be used unless you override them by
making different entries for specific branches on the Calculation panel, as described above.
A blank entry in the Default column means that there is no default. For calculation purposes
the value of a blank entry is taken to be zero. An entry explicitly set to zero is not regarded as
blank but as a default set to zero.
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For each Number type calculation field, you can also specify one or more of the following:
In the

column enter text to precede the number, for example "$" to indicate a dollar value.

In the

column enter text to follow the number, for example " 000s" to indicate thousands.

In the

column enter a number to specify the number of decimal places to be displayed.

In the

column, check the box to display thousands separators in large values.

In the
column, check the box to specify that the calculation field should be treated as a
constant value. Constant values are not displayed on the branches of the mind map, but can be
used in calculations using formulas.
In the example below showing a stationery order, a constant called Delivery has been defined
to cover a fixed delivery cost of $10, to be added to the $100 order cost. Using a constant in
this way makes it much easier to update the map if the supplier increases the delivery cost in
the future.

You can add a new calculation field to the mind map by entering its name in <Insert New>, or
delete an existing field by selecting it and clicking Delete.
You can change the order in which the values display on the mind map, by moving the calculation
fields up or down in this list by selecting them and clicking the Move Up or Move Down button.

Entering an automatic sum
You can use the built in function SUM to add up numerical values entered on the outermost subbranches, providing a grand total on the root and sub-totals on the intermediate branches. To do
this for our 'Units sold' calculation field, proceed as follows:
Click the Calculation tab to open the Calculation panel.
Click Defaults to open the Defaults and Formats dialog.
If you haven't yet created 'Units sold', click <Insert New> and type "Units sold".
Type SUM as the default value for 'Units sold'. Alternatively, you can click the sum symbol
the right of the field.
The entry SUM is a simple formula comprising just one function. For more information about
formulas see "Entering formulas" below.
Click OK.
The result is shown below. Values entered for 'Units sold' in the outermost branches are
progressively totaled to a grand total on the root branch.
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Entering formulas
You can enter formulas directly on branches or as defaults. The procedures are the same as those
described above, except that you enter a formula instead of a value.
You type the formula in the usual way, using values and any of the mathematical operators + - * / ().
In addition, you can insert functions by clicking the Function icon

:

Clicking the right-hand section opens a drop-down menu where you can select mathematical
operators and functions to insert. The functions available are divided into separate groups. For
a description of all functions, see "List of calculation functions".
When entering functions with arguments, you need to use the correct list separator, or the
function will not work. If the list separator is a comma, for example (the standard setting in the
US), arguments for the POWER function need to be entered as POWER(56,7), not for
example POWER(56;7). Check your computer's regional settings if you are in doubt.
If you have created other calculation fields, they are shown at the top of the drop-down, and
you can select them to reference them in the new calculation field.

Clicking the left-hand section opens the Insert Function dialog where you can search for the
function you want to insert.

Once you have selected a function, enter function arguments in the Function Arguments
dialog.
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The result of the formula (not the formula itself) is shown in the Value column. You can view or edit
the underlying formula as needed by double-clicking it.
On the mind map itself, the formula never displays, always the result.
If there is an error in a formula you will see the value #NAN or #NULL!:
The value #NAN indicates a division by zero, which leads to an invalid result. Check the
divisor(s) in the formula to ensure that they cannot become zero.
The value #NULL! indicates that a value needed by the formula is missing. This can
happen if you have deleted a calculation field referenced by the formula. If you have just
deleted the field, you can restore it by pressing Ctrl + Z. To help identify missing fields,
they are shown in black, rather than the usual green, in the formula. If you reinstate a
previously deleted field, the error will disappear, but you may have to re-enter values for
the field.
If you reference any other calculation fields, the formula will use their current values at the
relevant points in the calculation (if a field is blank, its value is taken to be zero).
Field names appear in green and enclosed in curly brackets in the formula.
Function names appear in blue capital letters in the formula.

Reviewing values
Current values are displayed directly on the mind map.
The Calculation panel shows further information about the values on a selected branch:
A difference marker at the bottom left of a calculation field alerts you that its value is different
from its default. This is useful because it is easy, while developing a mind map, to mistakenly
overwrite a default value by entering a value or formula directly on a branch.

The difference marker relies on there being a default for the value: if there is no default
(in other words a blank entry on the Defaults and Formats dialog), the marker never appears.
If you move the cursor over an entry in the Values column the hover text will show you the value
and, if it is generated by a formula, the formula as well.

Showing or hiding values
To display or hide calculation fields for the whole mind map:
Click the View tab in the ribbon.
Choose Data | Show/Hide

.

Check (or uncheck) the calculation fields you want to show (or hide).
The menu also allows you to show or hide branch connections and task link connections.
For more information on these, see "Creating branch connections" and "Using links".
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To display or hide calculation fields for a selected branch or branches:
Select the branch(es).
Click the Format tab in the ribbon.
Choose Data | Show/Hide

.

Check (or uncheck) the calculation fields you want to show (or hide). To show all calculation
fields and branch data, select Show all branch data.
It is also possible to format the calculation values displayed on the map in different ways. For more
information, see "Formatting a branch".

Example
Here is an example of part of a mind map that uses calculation fields.

The calculation fields are:
Units sold For the outermost sub-branches, values are added branch by branch. A default
value of SUM creates subtotals for the remaining branches and a grand total for the root.
Cost/unit This is the cost of each unit in dollars: it is displayed only on the outermost subbranches. In most cases the value is $2.30, so this is entered as a default. A different value has
been entered directly on one of the branches. In such cases, and wherever a value is different
from its default, you will see a difference marker in the Calculation panel, as here:

Selling price/unit This the selling price of each unit in local currency: it is displayed only on the
outermost sub-branches. It has no default value.
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Exch rate ($) This the exchange rate that converts local currency into dollars: it is displayed
only on the outermost sub-branches. It has no default value.
Profit On the outermost sub-branches this is calculated by a default formula. An overriding
formula, SUM, is added to each of the remaining branches and the root to create subtotals and
a grand total.
Salesperson For each country, a Text calculation value has been added to show the name of
the responsible salesperson. There is no default value for this field, but it would be possible to
enter a default value (such as Sales Dept or similar) that would then be displayed for all
branches unless overridden.
The default values and calculation field formats, accessed by clicking Defaults on the Calculation
panel, are:

Using Quick Data
The Quick Data area is only useful when you select two or more branches. It shows you the results
of common operations on the calculation field selected in the grid above for the selected branches.
Select two or more branches.
Select a calculation field in the grid at the top of the Calculation panel.
View the results in the Quick Data area. Sum shows the total of the relevant values for the
selected branches, Avg shows the average of the values, Min shows the minimum value, Max
shows the maximum value, and Count shows the number of branches selected.
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Printing a mind map
To print your map:
Click the File tab.
Choose Print.
You can also press Ctrl + P.
This opens the Print Preview window, which shows you what your map will look like on paper.
The preview of the map immediately reflects the changes you make in this window, allowing you to
experiment with the various settings.
The preview area always shows the map exactly as it is shown on the workspace. This means
that if you have restricted the display of the map in some way, for instance by showing only 2 levels
of branches, focusing on a particular branch or using an advanced filter, only the part of the map
shown in the preview area (and the workspace) will be printed. See "Viewing a mind map",
"Focusing on a branch" and "Filtering a mind map" to learn more about these display options.

Customizing the printing
Apart from the usual print operations, the Print Preview window lets you choose settings to optimize
the printing of your map.
Page Spread: These options allow you to spread your map on several pages, which is useful for
large maps. If for instance your map is quite wide (as may be the case in Top Down view), you can
click + Column to add one or more pages horizontally, thereby ensuring that its entire contents will
be easily legible. Similarly, if your map is quite tall, you can click + Row to add one or more pages
vertically. Whenever you increase or decrease the page spread, the map is automatically resized to
occupy all the space available.

Magnification: These options allow you to increase or decrease the map size on the page or page
spread, a handy feature in combination with the Page Spread options. If you click Fit to Page, the
map will be resized so that its entire contents fit on the page or page spread chosen.
You can move the map within the page or page spread by dragging it with the mouse.
Logo: These options let you display a company logo or any other logo on the printed page or page
spread, at the size and position defined by the icons shown to the right of the Logo button.
Info: These options let you display information about the document on the printed page or page
spread, such as its title, its author and the current date, at the position defined by the placement
icons shown to the right of the Info button.
You can customize this information as follows:
Click the down arrow on the right of the Properties field to choose the data you want to display.
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Each new piece of information is added to the right of the string. You can however rearrange the
properties as you wish, and even enter your own free text to separate them. Note that most of the
properties are taken from the data shown in the Document Properties dialog (click the File tab
and choose Info | Properties).
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Formatting a branch
MindView lets you perform various operations on the root of your map or any of its branches, such
as changing their shape, choosing a different fill color, defining a branch boundary, or selecting
different text attributes. All these formatting options help you add visual interest to your map.
Select the root or branch you want to format.
To apply the same formatting attributes to all the branches, it is much easier to use the Design
tab, whose predefined styles and design options apply to the entire map. See "Designing a mind
map" for more information.
You can however select several branches to give them the same formatting attributes. See
"Selecting several branches" below for more information.
Click the Format tab that appears at the right of the ribbon.
This tab contains formatting options applicable to the selected root or branch.

If you right-click the branch, a floating toolbar with the most commonly used formatting tools will
appear above the right-click menu. You can use the commands on the toolbar to format your
branch without having to search for the right command in the ribbon.

Browse through the options available in the Format tab or the floating toolbar, checking their
effect on your branches as you go.
A quick way of copying the formatting attributes from one branch to another is to use the
Format Painter . Select the branch whose formatting you want to copy and choose Home |
Clipboard | Format Painter or press Ctrl + Shift + C. The cursor changes to a paintbrush icon .
Click the branch you want to copy the formatting to. Pressing Ctrl while clicking the branch will let
you continue copying the format to other branches by clicking each one in turn. To return the icon to
its normal shape after the copying, click the Format Painter icon again.
If necessary, you can undo your changes and return the branch to the original map style defined in
the Design tab by choosing Effects | Reset Style.
To return all the branches to the initial style, select them all (Ctrl + A), and choose Effects |
Reset Style in the Format tab.
To return the entire map to the initial style (i.e. not only the branches, but also the global map
properties such as page color or page pattern), choose Effects | Reset Style in the Design tab.

Selecting several branches
Selecting several branches at once allows you to apply the same change to all of them
simultaneously.
Click the first branch, then press and hold down the Ctrl key while clicking the other branches
one by one.
Each of the branches you click becomes highlighted to indicate that it is selected.
To deselect one or more branches simply click them again while holding down the Ctrl key.
You can also select several branches by drawing a frame around them with the mouse. All the
branches contained within the frame become selected.
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Press Ctrl + A to select all branches.
When you select several branches in this way, the header of the Format tab changes to
Multiple Branches, indicating that any changes you make will apply to all the selected branches. If
the branches you selected belong to different levels (for instance, some main branches as well as
some sub-branches), only the options that the different levels have in common are shown in the
Format tab.

Formatting branch data
If you have added information on your branches such as task data or calculation values, you can
display this data directly on the branches:
Choose View | Data | Show/Hide
(or right-click the workspace and choose Show/Hide) and
check the fields you want to see in the sub-menu.
You can hide or show the fields on individual branches with the Show/Hide icon
Format tab (or the Show/Hide option in the branch local menu).

of the

If you have chosen to display resource cost information on the branches (such as Cost, Actual Cost
or Remaining Cost), you can define the currency symbol and the number of decimal digits to be
used for the entire document. See "Currency" in the topic "Setting up your preferences".
You can also specify how this data should be represented.

Select the branch whose data you want to format by clicking it.
Click the block of branch data displayed below the branch.
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Click the Format tab that appears at the right of the ribbon.
This tab contains formatting options applicable to the branch data of the selected branch.

Browse through the options available in the different panels, checking their effect on the branch
data as you go.
You can also give specific text attributes to the different elements of the branch data. To do this,
click the particular element within the block of branch data, and choose the required attributes in the
Format tab.
Once you have formatted the branch data to your liking, you can easily apply that formatting to
the data of all the other branches by clicking the Set as Default icon.

Branch properties
As well as the Format tab, you can also use the Properties dialog to make changes to the selected
root or branch. The Properties dialog always lists all the properties applicable to the element
currently selected in the workspace.
Select the root or branch you want to format, or the block of branch data you want to format.
Choose View | Show/Hide | Panels | Properties to open the Properties dialog.

See "Using the Properties dialog" for a general description of the Properties dialog.
See "Root properties: General tab" and "Branch properties: General tab" in the Reference section
for a detailed description of the general properties applicable to a root or branch.
See "Root properties: Text tab" and "Branch properties: Text tab" for a description of the properties
applicable to the branch label.
See "Branch data properties: General tab" in the Reference section for a detailed description of the
properties applicable to branch data.
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Editing branch data
As described in "Formatting a branch", you may display information such as task data, resource
information or calculation values directly on the branches of your mind map. The information is
displayed in a box underneath the name of the branch, and you can edit much of it directly from this
location.
The following branch data may be edited directly: Start date, End date, Duration (except for
summary branches), Priority, Completion, Resources and Calculation values.
Be aware that branch data in MindView are often dependent on other branch data. For instance,
calculation values may contain formulas that rely on input data from sub-branches, and task
duration data may affect the schedule of the entire project if changed. Changing branch data may
therefore have consequences for other branches in your mind map. Before editing any branch data
in your mind map, make sure that you know how your changes will affect the rest of the mind map.

Editing branch data
Locate the branch data that you want to edit.
Double-click the value next to the branch data label. You can also press Ctrl + Shift + B to
select the block of branch data and use the arrow keys to select the value you wish to edit. The
value becomes editable:
For Priority, Completion and similar task management related data, the value changes
into a drop-down where you may select the desired value.
For Duration and similar project management related data, the value changes into a text
field with a spin button where you can edit the value as needed.
For text fields such as resource names and Text calculation fields, a cursor is inserted
allowing you to enter, update or delete text as needed.
For Number calculation fields, you may select different formulas or enter a different
number value.
If you change a calculation field name, the name change affects all branches using the
same calculation field. See "Inserting calculation values" for more information on creating and
editing calculation values.
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Edit the branch data as desired, and click anywhere outside the editable value to save it. You
can also press Home to save the edited value and select the entire block of branch data;
pressing Home a second time will select the branch containing the branch data.
If you edit branch data by mistake, you can type Ctrl + Z to undo your entry
The value change takes effect immediately and may affect other branches in your mind map.
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Moving a branch
As your map grows and you start analyzing its various topics, you may realize that some of them
don't in fact belong to the branch you first allocated them to, but should be moved to a different
branch.
This topic describes how to perform the following operations:
Moving a main branch or a sub-branch and inserting it at a different hierarchical level in the
mind map
Cutting, copying and pasting a branch in the same document or in another document
Moving a main branch manually to a different position by disabling the Auto-layout mode

Moving a main branch or a sub-branch and inserting it at a different level
You can move an entire branch, including any sub-branches and objects attached to it, to a
different branch of your map. As you work on organizing your ideas, you can for instance decide to
convert a sub-topic to a main topic by moving the corresponding sub-branch to the root, or allocate
a sub-topic to a different main topic by moving the corresponding sub-branch to a different main
branch.
Select the branch you want to move to a different location by clicking it with the left mouse
button.
While keeping the left mouse button down, drag the branch to the required location.
The mouse pointer changes to a different shape and a line shows you where the branch will
be inserted when you let go of the mouse button.
Release the mouse button to insert the branch at the required location.

If you are viewing your map in the Mind Map or Left/Right views, you can also use the Ctrl +
Up and Ctrl + Down keyboard shortcuts to move the currently selected branch up or down in the
map. Similarly, the Ctrl + Right and Ctrl + Left keyboard shortcuts allow you to move a branch
right or left in the Top Down view.

Cutting, copying and pasting a branch
You can apply the standard Cut, Copy and Paste functions to any branch of your mind map. This
allows you to copy or move an entire branch, including all its sub-branches and attached objects, to
a different part of your map, at the same hierarchical level or at a higher or lower level, in the same
document or in a different document.
You can also apply the Cut, Copy and Paste functions to the root itself. This allows you for instance
to copy an entire map from one document and add it as a main branch or a sub-branch in a
different document. This is a very useful feature if you need to consolidate several different
documents into a master document, as described in "Packing a mind map".
To cut a root or a branch with all its sub-branches and attached objects to the clipboard (in
other words to place the root or branch on the clipboard while removing it from your map), you
first need to select it. You can then either:
Choose Home | Clipboard | Cut

in the main menu, or

Choose Cut in the local menu of the branch, or
Press Ctrl + X.
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To copy a root or a branch and all its sub-branches and attached objects to the clipboard (in
other words to place the root or branch on the clipboard while leaving it in place in your map),
you first need to select it. You can then either:
Choose Home | Clipboard | Copy

in the main menu, or

Choose Copy in the local menu of the branch, or
Press Ctrl + C.
To paste a root or a branch and all its sub-branches and attached objects, you first need to
select its new location, either in the same document or in a different document. You can then
either:
Choose Home | Clipboard | Paste

in the main menu, or

Choose Paste in the local menu of the destination branch, or
Press Ctrl + V.
The clipboard root or branch is added as a sub-branch of the destination branch you selected.
If you cut and paste a branch that is the starting point of a branch connection (see "Creating
branch connections"), the branch connection will be moved with the branch. However if you cut and
paste a branch that is the end point of a branch connection, the branch connection is not kept.

Moving a main branch to a different position by disabling Auto-layout
By default, MindView automatically arranges the main branches as you insert them to prevent any
overlap. You can however choose to reposition the main branches yourself after their insertion by
disabling Auto-layout mode.
Click the workspace so that no other element is selected.
Choose View | Show/Hide | Panels | Properties to open the Properties dialog for the view.
Click the Branches tab.
Uncheck Auto-layout.
You can now position the main branches of your map as you wish by dragging them with the
mouse.
Note that this only applies to main branches. MindView always arranges sub-branches
automatically.
Important: If you re-enable Auto-layout mode at any point while still working on your map, the main
branches you repositioned will be placed back in their default position. You can however click Undo
in the Quick Access Toolbar (or press Ctrl + Z) to cancel the re-enabling of Auto-layout and
revert the display of the main branches to your own positioning.
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Focusing on a branch
As your map grows, you might find it useful to concentrate on a particular area by
viewing only a chosen branch or set of branches. This also gives you more workspace to add
comments, text notes, icons and other objects on the particular branch or set of branches you are
viewing.
Click the branch that you want to isolate.
Choose View | Detail | Apply Branch Focus
its local menu.

in the main menu or Apply Branch Focus in

You can also just press Alt + F6.
Now only the branch you selected is shown on the workspace, together with any sub-branches it
may have.
To focus on one of the sub-branches, just select it and click Apply Branch Focus again.

Note that when restricting the display in that way, any branch connections leading to branches
outside the area shown are not represented.
To display the entire map again, you can either:
Click the Clear Branch Focus icon

in the main menu, or

Select the branch again and choose Clear Branch Focus in its local menu, or
Right-click the workspace and choose Clear Branch Focus in its local menu, or
Press Alt + Shift + F6.
If you save and close a document to which you have applied a branch focus to concentrate on a
specific branch or set of branches, next time you open the document, a message warns you that
you may be viewing only part of the map. Click the Clear Branch Focus button next to the
message to see the entire map again.

You can also collapse the entire mind map to just one level of branches, two levels, three levels
or four levels by using the Detail Level icons
of the View tab. The Show All Levels icon
expands the mind map so that it shows all its branches down to the last level.
You can also press Ctrl + 1 to display just one level of branches, Ctrl + 2 to show two levels
etc. Ctrl + 5 shows all levels.
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Filtering a mind map
MindView lets you filter your map to only display branches that meet specific criteria. Using a
filter, you can for instance show only the branches that contain the word "budget", or, if you are
working on a timeline, events starting at a given date. You can also combine different criteria, so
that only the branches that meet all or some of these criteria are shown. Using the built-in filters in
MindView, you can also filter by icons, legends, resources or project management information such
as milestones and tasks, and you may use the Filter Highlighter to focus on specific branches
without hiding branches that do not meet filter criteria.
All the filters you define are saved with the MindView document. It is also possible to import and
export filters for use in other MindView documents.
If you save and close a document to which you have applied a filter to show only specific
branches, next time you open the document, a message warns you that you may be viewing only
part of the map. Click the Clear Filter button next to the message to see the entire map again.

Using the built-in filters
MindView automatically gives you the opportunity to filter by certain items if you have used them in
your document. For example, if you have used icons or legends, there will be a built-in filter
allowing you to filter by the icons or legends you have used. Depending on the items you have used
on the branches of your mind map, you might see the following filters in the Filter menu:
Icons: Allows you to filter by icons used in the mind map. You can select the icon to filter by
in a sub-menu.
Legend: Allows you to filter by legends used in the mind map. You can select the legend to
filter by in a sub-menu.
You may also filter the mind map using legend items from the Legend window. For more
information, see "Working with legends".
Completion: Allows you to filter by the completion status of tasks in your mind map. You can
select the completion level to filter by in a sub-menu.
Priority: Allows you to filter by the priority set for items in your mind map. You can select the
priority to filter by in a sub-menu.
Resources: Allows you to filter by resources assigned to tasks in your mind map.
Milestones: Allows you to filter by project milestones.
Critical Tasks: Allows you to filter by critical tasks, i.e. tasks that are particularly important
to the completion of the project.
Overdue Tasks: Allows you to filter by tasks where the completion value has not reached
today's date.
Auto Scheduled Tasks: Allows you to filter by automatically scheduled tasks.
Manually Scheduled Tasks: Allows you to filter by manually scheduled tasks.
The last two filters are only shown if the project contains both manually and automatically
scheduled tasks. For more information, see "Using scheduling task modes".

Applying a built-in filter
Choose View | Filter and click the down arrow at the bottom of the Filter icon.
Select a filter under the Built-In heading in the sub-menu to apply it.
The mind map now only shows the branches that contain the elements you have filtered by.
The Filter icon stays highlighted to remind you that you are only viewing part of the map.
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Defining a custom filter
Choose View | Filter and click the down arrow at the bottom of the Filter icon.
Choose New

in the sub-menu.

The Filter dialog opens.

Enter a name for your filter in the 'Filter name' field.
Click Add Level to define your first condition.
Click the Property field and choose the branch element that you want to use to filter the map. If
for instance you want to restrict the display to all the branches on which you have placed a
Priority 1 icon, select the entry "Branch icons" in the list.
For a definition of the property "Total slack", see "Reviewing a project plan".
Click the Condition field and choose the required condition. In our example, you would choose
the entry "Equal to" or "Contains" (in case some branches contain more than one icon).
Click the Value field to define the condition to be applied to the branch. In our example, you
would choose the Priority 1 icon in the icon gallery that opens when you click the Value field.
(optional) Click Add Level again to define a second condition, using the And/Or field to indicate
whether both conditions must be met for the branch to display, or whether meeting just one of
the two conditions is enough for the branch to display.
(optional) Continue adding conditions as required and click OK.
The mind map now only shows the branches that meet the criteria you have defined.
The Filter icon stays highlighted to remind you that you are only viewing part of the map.
If necessary, you can add further criteria to the filter by editing it (see below) or define new filters.
The new filter is listed under the Custom heading in the sub-menu when you click the down arrow
at the bottom of the Filter icon. It is also available when you use the Filter Highlighter (for more
information, see below), and when you use the Select command from the Home tab; for more
information, see "Viewing a mind map".
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Clearing a filter
To go back to the full map display, do one of the following:
Choose View | Filter | Filter.
(Custom filters only) Choose View | Filter, click the down arrow at the bottom of the Filter
icon, and deselect the active filter in the sub-menu.
The second procedure is useful if you were not sure which filter was applied to the mind
map, as it allows you to see the filter name.
The Filter icon goes back to its normal state, indicating that the map is no longer filtered.

Applying a custom filter
When you have several custom filters, you can apply any one of them as follows:
Choose View | Filter and click the down arrow at the bottom of the Filter icon.
Click the required filter from the list under the Custom heading in the sub-menu.

Editing a custom filter
Choose View | Filter and click the down arrow at the bottom of the Filter icon.
Choose Edit
in the sub-menu, select the custom filter you want to edit and proceed as
described above.

Deleting a custom filter
You can also delete a custom filter previously defined permanently from the MindView document if
you no longer need it:
Choose View | Filter and click the down arrow at the bottom of the Filter icon.
Choose Delete

in the sub-menu and select the required custom filter.

The built-in filters cannot be deleted.

Using the Filter Highlighter
One drawback of filtering mind map branches is that you may lose sight of the context those
branches appear in. For example, you may want to focus on a branch containing data calculated
from several sub-branches but still want to be able to see those sub-branches. The Filter
Highlighter works in exactly the same way as the regular filter, but keeps all branches visible and
just highlights those that meet the filter criteria.
Choose View | Filter and click the down arrow at the bottom of the Highlight icon.
Select a built-in or custom filter in the sub-menu as described under "Using the built-in filters"
and "Applying a custom filter" above.
The image below shows an example of a mind map with a branch highlighted by the Filter
Highlighter and all sub-branches still visible.

The Filter Highlighter uses the same built-in and custom filters as the regular filter and the Select
command on the Home tab, and you may define, apply, edit and delete filters from the Highlight
sub-menu in exactly the same ways as described above for the regular filter. As the filters used are
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the same, changes to custom filters applied from the Highlight sub-menu or the Select sub-menu
on the Home tab apply to the Filter sub-menu, and vice versa.
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Attaching objects
One of the strengths of MindView is that it allows you to attach objects to the root or any
branch or sub-branch of your mind map. This means that you can enhance your map with a variety
of multimedia features, such as audio notes, video sequences or Flash animations, as well as add
all the relevant backing documents to each of your branches (e.g. Microsoft Excel spreadsheets,
Microsoft Word documents, etc.)
Not only can you activate these objects from within MindView, but you can also choose to include
them when exporting your map to a different format, such as a web site or a Microsoft PowerPoint
presentation.
Although MindView does not apply any restriction on the type of files it is possible to attach to a
branch, you will only be able to open an attached file from the mind map if a program associated
with its file type (e.g. bmp, doc, xls etc.) is installed on your computer.
By default, when you attach a file to a branch in this way, it is added to the mind map as a link
to the file stored on your hard disk. If you intend to distribute your mind map to others, you should
first use the Pack feature to pack all the attached files into the mind map, thereby ensuring that your
colleagues have access to all the files you are using. See "Packing a mind map" for more
information. If you want to send your mind map by e-mail, you can use the Email feature to create
this packed version automatically. See "Sending a mind map" for more information.
MindView also allows you to create a link between a branch and an external element such as a
URL. See "Creating hyperlinks" for more information on links.

Attaching an object to a root or branch
There are two ways of attaching an object:
Select the required root or branch, choose Home | Insert | Attachment in the main menu or
Insert | Attachment in the local menu, and select the object you want to add.
Drag the required file from Windows Explorer and drop it on the root or branch.
You can also attach a picture from the clipboard: select the root or branch, press and keep the
Shift key down, and choose Paste.
As soon as you add an object to a root or branch, a paperclip icon
appears to the right of its
label to indicate the presence of the attached object. Moving the mouse pointer over this paperclip
icon displays a pop-up list of all the objects attached.

The attachment is also added to the Object list of the root or branch, giving you a complete
overview of the objects you have attached to it.

See "Using the Object list" for more information.

Activating an object
Once attached, there are several ways to activate an object:
Double-click the object in the Object list, or
Select the object in the Object list and choose Execute in its local menu, or
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Display the object pop-up list by moving the mouse pointer over the paperclip icon
the object required.

and click

These actions all activate the object, which opens in the viewer associated with its extension type.
For instance, if the attached object is a Word document, it will open in Microsoft Word. If it is a
video, it will open in the video playing software installed on your computer, and so on.

Moving an object
You can easily move or copy an attached object from one branch to another.
To move an object, select it in the Object list of the original branch and drag it to the branch you
want to move it to.
To copy an object, select it in the Object list of the original branch, press the Ctrl key and drag it
to the branch you want to copy it to while keeping the Ctrl key down.

Deleting an object
To delete an object, select it in the Object list and do one of the following:
Press Delete, or
Choose Delete in its local menu.
Remember that if you delete an attached object by accident, you can always cancel the
deletion by clicking Undo
in the Quick Access Toolbar or pressing Ctrl + Z.

Object properties
Objects have properties, which you can edit in the Properties dialog.

See "Attachment properties: General tab" for a detailed description of the properties applicable to
objects and "Using the Properties dialog" for a general description of the Properties dialog.
If the Properties dialog is not visible, choose View | Show/Hide | Panels | Properties to open
it.
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Inserting audio notes
MindView lets you record sounds directly from within the program and add them as audio
notes to the branch or sub-branch of your choice.
Select the root or branch to which you want to add an audio note.
Choose Insert | Links | Audio Note.
The Audio Recording toolbar appears.

Press the Record button to start recording.
MindView records sounds from the default recording device configured on your computer,
such as the built-in microphone or line in connection. Check your computer's device
configuration if you get no sound on the recording.
Press the Play button to play back and check your recording.
When you are satisfied with your recording, press the Save button (on the right) to save it in the
folder of your choice.
You can save audio notes in wave or MP3 format. Wave format files are not compressed
and therefore allow for better dynamics (and sound quality) than MP3 files. As wave format
files are not compressed, however, they are also larger than MP3 files, taking up more disk
space. This may be an important point if you plan to export, publish or share your mind map.
A paperclip icon
now appears to the right of the branch label to indicate the presence of an
attached object. Moving the mouse pointer over this paperclip icon displays a pop-up list of all the
objects attached.
The audio note is also added to the Object list of the root or branch, giving you a complete overview
of the objects you have attached to it.
See "Using the Object list" for more information.

Playing an audio note
Once attached, there are several ways to play back an audio note:
Double-click the audio note in the Object list, or
Select the audio note in the Object list and choose Execute in its local menu, or
Display the object pop-up list by moving the mouse pointer over the paperclip icon
the audio note.

and click

Moving an audio note
You can easily move or copy an audio note from one branch to another.
To move an audio note, select it in the Object list of the original branch and drag it to the branch
you want to move it to.
To copy an audio note, select it in the Object list of the original branch, press the Ctrl key and
drag it to the branch you want to copy it to while keeping the Ctrl key down.

Deleting an audio note
To delete an audio note, select it in the Object list and do one of the following:
Press Delete, or
Choose Delete in its local menu.
Remember that if you delete an audio note by accident, you can always cancel the deletion by
clicking Undo
in the Quick Access Toolbar or pressing Ctrl + Z.
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Audio note properties
Like all objects, audio notes have properties, which you can edit in the Properties dialog.
See "Attachment properties: General tab" for a detailed description of the properties applicable to
audio notes and "Using the Properties dialog" for a general description of the Properties dialog.
If the Properties dialog is not visible, choose View | Show/Hide | Panels | Properties to open
it.
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Creating hyperlinks
The Hyperlink command lets you create a link between a branch and external elements, such
as a URL, an external file or an email address. Once the hyperlink is inserted, activating it
automatically opens the viewer associated with the linked element on your computer (such as
browser, application or email program). You can also create hyperlinks directly to files stored on
online workspaces such as the MatchWare Shared Workspace or Microsoft SharePoint.

Inserting a hyperlink on a root or branch
Select the required root or branch and choose Home | Insert | Hyperlink in the main menu or
Insert | Hyperlink in the local menu.
The Hyperlink dialog opens.

Type a name for your hyperlink. If you export your map, this is the text that will make up the
hyperlink.
Enter the required URL. To enter other elements, click the down arrow at the right of the input
field and choose the required prefix.
If you want to link to an online workspace, click the Browse button
in the Hyperlink
dialog and select the workspace you would like to link to in the submenu. A dialog opens where
you may enter login credentials for the online workspace or add a new one. For more
information on adding online workspaces, see "Managing online workspaces".
You can open this dialog again at any time to change its settings by choosing Edit Link in the
hyperlink local menu.
To insert a web page hyperlink onto a branch, just drag the link from the web page displayed in
your Internet browser. The Hyperlink dialog is then automatically filled in with the URL of the link.
As soon as you add a hyperlink to a root or branch, a paperclip icon
appears to the right of its
label to indicate the presence of the hyperlink. Moving the mouse pointer over this paperclip icon
displays a pop-up list of all the objects attached.
The hyperlink is also added to the Object list of the root or branch, giving you a complete overview
of the objects you have attached to it.
See "Using the Object list" for more information.
If you want to create a link to an online workspace, you can also choose Home | Insert in the
main menu, click the down arrow under the Hyperlink button, and click the name of the workspace
you would like to link to.

Activating a hyperlink
There are several ways of activating a link from within MindView:
Double-click the hyperlink in the Object list, or
Select the hyperlink in the Object list and choose Execute in its local menu, or
Display the object pop-up list by moving the pointer over the paperclip icon
hyperlink.
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and click the

These actions all activate the linked element:
If your hyperlink contains a URL, the web page opens in your default browser.
If your hyperlink contains a path to a file, the application associated with the file type on your
computer opens and displays the contents of the file.
If your hyperlink contains an email address, a message window opens in your default email
program, with the address supplied already filled in.

Moving a hyperlink
You can easily move or copy a hyperlink from one branch to another.
To move a hyperlink, select it in the Object list of the original branch and drag it to the branch
you want to move it to.
To copy a hyperlink, select it in the Object list of the original branch, press the Ctrl key and drag
it to the branch you want to copy it to while keeping the Ctrl key down.

Deleting a hyperlink
To delete a hyperlink, select it in the Object list and do one of the following:
Press Delete, or
Choose Delete in its local menu.
Remember that if you delete a hyperlink by accident, you can always cancel the deletion by
clicking Undo
in the Quick Access Toolbar or pressing Ctrl + Z.

Hyperlink properties
Hyperlinks have properties, which you can edit in the Properties dialog.

See "Hyperlink properties: General tab" for a detailed description of the properties applicable to
hyperlinks and "Using the Properties dialog" for a general description of the Properties dialog.
If the Properties dialog is not visible, choose View | Show/Hide | Panels | Properties to open
it.
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Creating branch connections
MindView allows you to indicate visually that two or more branches of your map are
conceptually related by adding branch connections between them.
You can create two types of branch connections:
Internal branch connections, which connect two branches of the same map, or
External branch connections, which connect two branches belonging to two different maps.
To create an external branch connection, both maps must be open. You must also make sure
that the map where you want the connection to end has already been saved at least once.
By default, branch connections are always visible, but you can choose not to display them
using the Show/Hide command on the View tab. If the branch connections you create do not
appear, check that you have not opted to hide branch connections in the map. For more
information, see "Viewing a mind map".

Creating a branch connection
Choose Insert | Links | Branch Connection.
The mouse pointer changes to a different shape.
Click the branch or sub-branch you want the connection to start from.
A thin line appears connecting the branch you selected and the mouse pointer.
Click the branch where you want the connection to end.
If you are creating an external branch connection, you will first need to click the tab of the
second map in order to display it.
A line ending with an arrow now connects your start branch with your end branch.
A paperclip icon
appears to the right of the start branch label to indicate the presence of an
attached object. Moving the mouse pointer over this paperclip icon displays a pop-up list of all the
objects attached. The branch connection also appears in the Object list of the start branch. By
default, its name is the name of the end branch.

(optional) Click the Format tab that appears at the right of the ribbon.
This tab contains formatting options applicable to the branch connection.
Browse through the options available in the different panels, checking their effect on the branch
connection as you go.
As well as the Format tab, you can also use the Properties dialog to make changes to the branch
connection.
If you have inserted task links in your mind map using the Gantt view, the task links may also be
shown in the Mind Mapping views. To make it easier to differentiate between the two types of links,
it is advisable to format them differently. For more information on task links, see "Using links".
See "Branch connection properties: General tab" in the Reference section for a detailed description
of the properties applicable to branch connections and "Using the Properties dialog" for a general
description of the Properties dialog.
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To create several branch connections quickly, keep the Ctrl key down while connecting the
various branches.

Changing the curve of a branch connection
You can change the curve of a branch connection as follows:
Click the branch connection to select it, either directly on the map or in the Object list of the start
branch.
A handle appears at each end of the connection, made up of a straight line and a square.

Click the square of one of the handles and start dragging it.
The shape of the branch connection changes as you move the handle. As you extend the handle,
the branch connection becomes more curved. Conversely, if you reduce the length of the handle,
the branch connection becomes flatter.
Move each handle in turn until you are satisfied with the shape of the branch connection curve.

Activating a branch connection
If you are working on a large map, you can quickly go to the end point of a branch connection as
follows:
Select the start branch, then:
Double-click the branch connection in the Object list, or
Select the branch connection in the Object list and choose Execute in its local menu.
If the connection ends in a different map, MindView opens it automatically in a separate tab.

Making a branch connection start or end on a different branch
You can easily change the start or end point of a branch connection without having to delete the
existing branch connection and create a new one. To do this:
Click the branch connection to select it, either directly on the map or in the Object list of the start
branch.
To make the branch connection start from a different branch, drag the dot placed at the start of
the connection to the new start branch.
To make the branch connection end on a different branch, drag the arrow placed at the end of
the connection to the new end branch.

Deleting a branch connection
To delete a branch connection, select it in the mind map and press Delete.
Remember that if you delete a branch connection by accident, you can always cancel the
deletion by clicking Undo
in the Quick Access Toolbar or pressing Ctrl + Z.
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Using bibliography sources
If you are working on a research project or writing a paper, you will probably want to include a
bibliography in your finished work. MindView can help you compile and maintain bibliography
entries (known as sources in MindView) that you can use in your maps. When you export a map to
Microsoft® Word, the sources used in the map are also exported and included in the resulting Word
file as a bibliography.
If you want to add citations to particular elements of the map, you will have to create one or more
sources first. It is not, however, necessary to use citations; you may create any number of sources
without necessarily referring to them in any of the map elements, and just use them as a
bibliography when you export your map. See "Using citations" for more information on inserting
citations.
If you use the Capture toolbar to capture text or images from web sites or other documents, the
sources for the text or images that you capture are automatically added to the list of sources. See
"Capturing text and images" for more information on using the Capture toolbar.

Adding sources
Choose Review | Sources and click Add New Source in the submenu.
The Add New Source dialog opens.

You can now search for sources online or enter source information manually.

Searching for sources online
Select the Source Results tab.
Enter search criteria (e.g. an author's name or a publication title) in the search field.
Select the source type and source language to search for on the drop-down lists.
Click Search.
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MindView searches the online library catalog WorldCat. Search results are shown in the
dialog.

The source types found are indicated using icons:
Book
Film
Journal article
Web site
Use the Previous and Next buttons to navigate between result pages, if applicable.
Click the Select button for the source you want to include.
You may also click the WorldCat icon
web site.

to see the entry for the result on the WorldCat

The application switches to the Manual Entry Mode tab where you may add information
about the selected source.
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Click OK to add the source to the map.

Manually entering source information
Click the Manual Entry Mode tab.

Select the source type to add on the Type drop-down list: Book, Film, Web site, Journal
article.
Enter the desired information about the new source in the fields below the drop-down list.
The fields available depend on the source type chosen.
Click OK to add the source to the map.
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Viewing and managing sources
Choose Review | Sources and click Manage Sources in the submenu.
The Sources dialog opens. Sources that have already been added to the map are displayed under
Existing Sources.

Editing a source
Select the source to be edited in the Sources dialog.
Click Edit.
The Add New Source dialog opens on its Manual Entry Mode tab.

Edit the desired information about the source.
The fields available depend on the source type chosen.
Click OK to update the source in the map when you have finished editing all fields.
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Deleting a source
Select the source to be deleted in the Sources dialog.
Click Delete.
If you delete a source that is cited on a branch or other element of the map, the actual citation is
not deleted but the connection between citation and source is lost. If you then export the map to
Microsoft® Word, the exported document will contain an error message because Word cannot find
a source for the citations.

Adding a source
Click Add New and follow the procedure described under "Adding sources" above.

Exporting or importing a source
You can export or import sources in MindView Bibliography (XML) format.
To export the current sources to a bibliography file, click Export and select a location for the
exported file.
To import sources from an exported bibliography file, click Import and select an XML file.
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Using citations
A citation is a reference to a published work. Citations may be handled in a number of ways but the
standard method is to provide a page number and the name or author(s) of the source cited in
parentheses, possibly preceded by a direct quotation from the source in quotation marks as in the
following example:
"Everyday life presents itself as a reality interpreted by men and subjectively meaningful to
them as a coherent world" (Berger & Luckmann, 33)
The text in quotation marks is a quotation while the text in parentheses is a citation. Full details of
the source cited must then be provided in the bibliography (as the basic information provided in
parentheses is not sufficient to properly identify the book (or other work) cited).
MindView cannot automatically insert quotations. If you need to enter a quotation (which is only
possible in text notes), you must enter it manually. MindView can be used, however, to insert
citations in text notes to link your quotation to a source. You can also insert citations directly on the
branches of the map, on attachments and on hyperlinks.
You can also use the Capture toolbar to select text for quotations from documents or web sites.
MindView automatically generates a source (but no citation) for the captured text. For more
information, see "Capturing text and images".
If you export your map to Microsoft® Word, all the citations you have added are automatically
placed in the correct location of the Word document. The full details of the corresponding sources
are included in the Bibliography section located at the end of the Word document.
To insert a citation you must first create a source in the map. See "Using sources" for more
information.

Inserting a citation in a text note
Open the text note where the citation is to be inserted.
Place the cursor at the position where the citation is to be inserted in the note.
(Optional) Type a quotation from the source.
Choose Insert | Links | Citation and click Insert Citation in the submenu.
The Insert Citation dialog opens.
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Select a source in the Existing Sources list.
If you have not created any sources yet, you can click Manage Sources to do so. See
"Using sources" for more information.
(Optional; citations from books or articles only) Insert page numbers in the Page numbers field.
Click Insert.
The citation is now inserted in the note.

Inserting a citation on a branch
You can also insert citations directly on branches.
To do this, select the branch, then follow the procedure described above for text notes.
When inserting a citation on a branch, the citation is not visible on the branch itself. To see a list
of the citations you have inserted on a branch, select the branch, choose Insert | Links | Citation
and click Manage Citations.

Inserting a citation on an attachment or a hyperlink
You can also insert citations on attachments and hyperlinks.
To do this:
Select the branch containing the attachment or hyperlink.
Move the mouse pointer over the paperclip icon
shown on the right of the branch label to
indicate the presence of the attachment or hyperlink.
Right-click the attachment or hyperlink in the pop-up list that opens and choose Citation |
Insert Citation in the local menu.
Follow the rest of the procedure described above for text notes.
As is the case for branches, citations inserted on attachments and hyperlinks are not visible. To
see a list of the citations you have inserted on an attachment or a hyperlink, right-click that
attachment or hyperlink and choose Citation | Manage Citations in its local menu.

Viewing and managing citations
Select the element containing the citation as follows:
For text notes and branches, choose Insert | Links | Citation and click Manage
Citations in the submenu.
For attachments and hyperlinks, choose Citation | Manage Citations in the local menu.
The Manage Citations dialog opens.
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You can now:
Add a new citation by clicking the Add button at the top of the dialog.
Remove a citation by selecting it, then clicking the Delete button at the top of the dialog.
This deletes the citation, but does not delete the corresponding source, which stays
included in the map.
Edit the citation's page numbers (books and articles only).
Click Done to save your changes.
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Capturing text and images
The Capture toolbar in MindView provides you with a quick way of capturing images and
existing text from a variety of sources, including documents and web sites, and adding them to your
mind map. This feature is particularly useful if you need to quote existing text and indicate the exact
source, or if you need to insert an image but do not have access to the image file.
Be aware that text and images found on the internet and in documents are often protected by
copyright legislation. Always check that you have permission to copy and use images or text before
capturing them with the Capture toolbar.
Captured images can be inserted as attachments or as branch pictures that may be moved,
replaced and deleted as normally. Captured text is inserted as text notes that may be edited as
normally. The source of the captured image or text or image is automatically added to your list of
sources.
For more information on working with images, text notes and sources, see "Inserting pictures",
"Inserting text notes" and "Using bibliography sources".

Accessing the Capture toolbar
Select the branch that the captured text or image is to be added to.
Choose Insert | Capture | Capture.
The MindView window is minimized, and the Capture toolbar is displayed in the bottom right corner
of the screen.

The toolbar may be dragged to another position on the screen if desired.
At the bottom of the Capture toolbar, you can see where the captured text or image will be
inserted.
The Capture toolbar remains open until closed manually, or until a capture has been made (see
below).

Capturing an image
Locate the image that you would like to capture, for instance by switching to a different
document window or opening another application.
Click Image on the Capture toolbar.
The computer screen darkens.
Use the mouse pointer to drag out a selection area around the image you would like to capture.
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Release the mouse button.
The Preview dialog opens and shows the captured image.

(Optional) Edit the suggested title and URL of the captured image.
(Optional) Enter keywords for the captured image. Separate all keywords with commas.
Select whether the captured image should be saved as a branch picture or a branch
attachment.
Click Save.
The captured image is inserted in your mind map, and the Capture toolbar is closed.
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Capturing text
Locate the text that you would like to capture, for instance by switching to a different document
window or opening another application.
Click Text on the Capture toolbar.
Use the mouse pointer to select the text you want to capture.

Click Capture text on the Capture toolbar.
The Preview dialog opens and shows the captured text.

(Optional) Edit the suggested title and URL of the captured text.
(Optional) Enter keywords for the captured text. Separate all keywords with commas.
Click Save.
The captured text is inserted as a text note on the selected branch, and the Capture toolbar is
closed.
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Finding and replacing text
MindView lets you search for every occurrence of a specific word or phrase and replace
these automatically with a new word or phrase you specify.
You can find and replace text in the following elements:
Branch names
Floating comments
Pop-up comments
Text notes
Object names

Finding text
Choose Review | Editing | Find/Replace or press Ctrl + F.

Enter the text that you want to search for in the Find what field of the Find dialog.
Select the search options required in the Options group.
Select the elements that you want MindView to search in the Look in group.
Click Find Next.
MindView goes through your document, looking for the text you specified in the elements you
selected. As soon as it finds an occurrence of the text, it selects the element containing the text and
highlights it.
You can now:
Close the Find dialog and continue your work.
Look for the next occurrence of the text by clicking Find Next.
Replace the text with another word or phrase you specify in the Find dialog.

Replacing text
Type the replacement text in the Replace with field.
Click Replace to replace the current occurrence only or Replace All to replace all occurrences
throughout the document.
To cancel a search in progress, press Esc.

Desktop search
MindView supports Windows Search on Windows XP and above, letting you locate specific data
within all the mind maps stored on your hard disk and identify the relevant files instantly. All the
data contained within your MindView documents is searched, including branch text, comments and
searchable embedded files (such as Word documents).
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To search file contents in Windows Vista, perform an Advanced Search and check the option
"Include non-indexed files".
For more information on how to use Windows Search to locate information stored in your
documents, please refer to your Windows help system.
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Using predictive suggestions
One of the great time-saving features of major web search engines is their ability to provide
suggestions as you type. The Predictive Suggestions feature in MindView is a similar feature that
provides suggestions as you type based on suggestion sources that you can define in advance.
Predictive Suggestions can be used when entering branch labels and text notes.

How it works
The Predictive Suggestions feature monitors your keyboard input and searches one or more
sources for suggestions that match that input. These sources may be web sites, databases,
MindView files or XML files.
You may activate or deactivate sources as needed from the MindView Options dialog where you
may also add, edit or delete sources. MindView comes with a set of example sources. For more
information on predictive suggestion sources, see "Setting up suggestion sources".
The example sources listed are only included as a reference. You may need permission to use
the suggestion source examples included in MindView.
The ability to select suggestion sources means that you can set up MindView to show suggestions
based on your current needs. For example, you could set up an XML file containing business
terminology for work projects and a MindView document with baseball statistics for private use.
Depending on what you are using MindView for, you can then enable or disable suggestion sources
as needed and only see suggestions that are relevant to your current activities.
The Predictive Suggestions feature is disabled by default.

Using Predictive Suggestions for branch labels
Choose Review | Predictive Suggestions.
Start typing the branch label.
As you type, suggestions are shown below the branch label.

The suggestions are continuously updated if you keep typing. For example, if you type "mo",
the feature may suggest "mortgage". If you keep typing, adding "on", the suggestions will be
updated to entries including the word "moon".
Use the Up and Down keys or the mouse to select and insert a given suggestion, or keep typing
to disregard suggestions.
To disable Predictive Suggestions, choose Review | Predictive Suggestions again.
You may enable or disable Predictive Suggestions on the fly while typing by pressing Ctrl +
Space.
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Using Predictive Suggestions in text notes
In text notes, Predictive Suggestions cannot be enabled constantly. However, you may use the
feature to actively look for suggestions based on your input.
Open a text note for editing. For more information on this, see "Inserting text notes".
Look up suggestions in one of the following ways:
When typing a word for which you would like suggestions, press Ctrl + Space to see
suggestions based on that word (or part of a word).

Select one or more words and press Ctrl + Space to see suggestions based on those
words.

Use the Up and Down keys or the mouse to select and insert a given suggestion, or keep typing
to disregard suggestions.
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Setting up suggestion sources
You may enable and disable the suggestion sources used by the Predictive Suggestions
feature. You may also add, edit and delete suggestion sources from your MindView installation.
For more information on using the Predictive Suggestions feature, see "Using predictive
suggestions".
There are four types of suggestion source. MindView includes examples of all four source types:
MindView Document: A MindView document located on your computer or a network
location to which you have access. Suggestions are based on the branch names in the referred
document.
Internet: A web site. MindView sends a GET request for data to the web site, and
suggestions are based on the response from the site.
Database: A database located on your computer or a network location to which you have
access. MindView sends a custom SQL query to the database, and suggestions are based on
the response from the database.
XML File: A custom XML file located on your computer or a network location to which you
have access.
You may use the Texthelp suggestion source with no limitations. All example sources listed
below Texthelp, however, are only included as a reference, and you may need permission to use
them.

Accessing the list of suggestion sources
Do one of the following to access the list of suggestion sources:
Choose File | Options, and click Suggestion Sources.
Choose Review in the ribbon, click the down arrow below the Predictive Suggestions button,
and choose Suggestion Sources in the submenu.

Enabling and disabling suggestion sources
To make one or more suggestion sources available to the Predictive Suggestions feature, simply
select them in the list.
The Predictive Suggestions feature bases its suggestions on all selected sources. To filter the
suggestions shown, only select sources that are relevant to your current task. Being shown
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suggestions from a business terminology database, for example, is probably not relevant if you are
creating a document with baseball statistics for your own amusement.

Deleting suggestion sources
To delete a suggestion source entirely from the MindView installation, select it in the list and click
Delete.

Adding and editing suggestion sources
Do not attempt to add or edit internet, database or XML file suggestion sources unless you
understand regular expressions, SQL queries and XML. Users without these skills are advised to
only use the example sources provided or create sources based on MindView documents.
Add or edit a suggestion source as follows:
To add a suggestion source, click New and select the desired suggestion source type in
the submenu.
To edit a suggestion source, select it in the list and click Edit.
In the dialog that opens, enter or update suggestion source settings as needed (see below).
Click OK.

MindView document suggestion sources

Enter the name of the suggestion source.
Enter the path to the MindView document that is to be used as a source.
Always check that the MindView document in question actually contains the strings you
would like to use for suggestions!
Test the suggestion source by entering search text in the Input string field and clicking Test.
Clicking the Advanced Settings button lets you specify XPath and Part settings. Only do this if you
are an advanced user and know what you are doing.
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Internet suggestion sources

Enter the name and URL of the internet suggestion source.
In the Regular expression for 1st match field, define a regular expression to match the
content returned from the web site. You may select a color that indicates the results of the
regular expression in the Response field below.
(Optional) In the Regular expression for 2nd match field, define a regular expression for
substring matching if it is not possible to set up a regular expression that matches the right
entries in the first match. Select a color to indicate results in the Response field below.
Test the suggestion source by entering an input string and clicking Test. Test results (including
color-coding to indicate strings processed by the regular expressions) are displayed in the
Response field.
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Database suggestion sources

Enter the name and connection string for the database suggestion source.
Click Setup to open the Windows Select Data Source dialog to set up a connection to a
database.
Click Test Connection to test the database connection.
Define the SQL query which is sent to the database when typing.
If you need to use a single per cent sign (%), insert it as %%.
Test the suggestion source by entering an input string and clicking Test.
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XML file suggestion sources

Enter the name, path and XPath for the XML suggestion source.
Test the suggestion source by entering an input string and clicking Test.
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Inserting a new root
MindView allows you to create several maps in the same view by inserting several roots in it.
This can be useful if, while working on your map, you have ideas as yet unrelated to your existing
topics (i.e. branches). Once you have decided how they should be related, you can convert your
new maps into branches of your existing map, or even move them to new documents altogether, as
described below.
This procedure is only relevant to the standard Map views, namely Mind Map, Top Down and
Left/Right.

Inserting a new root in the view
You can do this in two ways:
Choose Insert | Branches | New Root in the main menu, or
Right-click the workspace and choose Insert | New Root in its local menu.
You can also create a new map by detaching a branch of your existing map, either to the same
document or to a new document. See "Detaching a branch" for more information.

Attaching a newly created map to an existing map
If you have created a second map in your document by inserting a new root into it, you can
integrate it to your original map as follows:
To attach it as a main branch, drag its root to the original root.
To attach it as a sub-branch, drag its root to the branch or sub-branch you want to attach it to.

Moving a newly created map in a separate document
Select the root of your new map and choose Cut in its local menu or Home | Clipboard | Cut in
the main menu (or press Ctrl + X).
Create a new document (click the File tab and choose New or press Ctrl + N).
Once the new document tab opens, right-click the workspace and choose Paste in its local
menu or Home | Clipboard | Paste in the main menu (or press Ctrl + V).
(optional) Delete the default root created automatically in the new document.
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Detaching a branch
MindView allows you to create several maps in the same view by inserting several roots, as
described in "Inserting a new root". You can also create a second map by detaching an existing
branch of your mind map, either to the same document, or to a new document. This can be useful
when you realize that one of your existing topics (i.e. branch) does not in fact belong to your map,
or if you want to consider a particular branch as the source of a new map.
This procedure is only relevant to the standard Mind Map views, namely Mind Map, Top Down
and Left/Right.

Detaching a branch to the same document
Select the branch you want to detach and choose Detach | Branch in its local menu.

Detaching a branch to a new document
Select the branch you want to detach and choose Detach | Branch as New Document in its
local menu.
In both cases, the selected branch and all its sub-branches, inserted elements and attached objects
becomes a new mind map.
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Setting a password
MindView helps you to prevent unwanted access to your documents by protecting them with
a password. Password-protected documents are also automatically encrypted. Longer passwords
give a stronger level of encryption.
Click the File tab.
Choose Info | Set Password.
The Set Password dialog appears.

Enter the password in the top field.
Click the bottom field and enter exactly the same password. Confirm by clicking OK.
From now on, MindView will prompt you to enter the password every time you try to open the
document.
You can change the password by entering a new password in the dialog.
To remove the password, clear both fields and save the document.
Do not lose your password! It is not possible to open a password-protected MindView
document without entering the correct password.
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Tracking changes
MindView lets you track all the changes that have been made to your document, by yourself
or any other user who has access to it. This is particularly useful if you are sharing your document
with other colleagues or students, or if you are working on an online document, as it allows you to
review all the changes made by other people.
To enable the tracking of changes, choose Review | Track Changes.
(optional) Click the down arrow at the bottom of the Track Changes menu and choose Show
Changes to display the Changes Review panel.
All the significant changes you make to your document from this point are now listed in this panel
as soon as you complete them.

To see on the mind map what branch or MindView element a particular change relates to, just click
its entry in the Changes panel. You can also use the Next
and Previous
icons to navigate
from one change to the other.
By default, new changes are added at the bottom of the Changes panel. You can however resort
the list in reverse date order by clicking the arrow next to the Date header, or sort the list by
Description or User.
As long as the tracking of changes is enabled, any change made to the document by anyone gets
added to the Changes panel, even if the document is closed by its current user and re-opened by
the same user or a different user at a later date. To stop the tracking of changes, you need to click
Review | Track Changes again to disable it.
If you want to reset the list of changes, you can empty it by clicking the down arrow at the bottom of
the Track Changes menu and choosing Delete Changes History.
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Working with legends
Adding a legend to your map can make it much easier to read and interpret. You can for
instance apply a particular color to some of the branches of your map, and then use a legend to
give the meaning of this color.
In the example below showing the tasks to be considered when organizing an event, the tasks that
have been completed have been tagged with a tick icon, and the next tasks that need to be done
urgently have been highlighted using a red outline.

Adding a legend item
Choose View | Navigation | Legend to display the Legend window.
Move the mouse cursor over the Legend window.
Click Add Item.

Choose Add Color or Add Icon depending on whether you want to define your legend item
with a color or an icon.
Choose the required color or icon in the dialogs that are open.
Replace the default label with the label of your choice.
You can now apply that color or icon to the branches that you want to single out.

Applying legend items to selected branches
Once you have defined a color or icon, you can add that color or icon to your branches manually to
improve the mind map. However, you can also do this automatically. This is particularly useful if you
need to single out many branches with the same legend item in one go:
Select the branches in the mind map that should have a specific color or icon defined in the
legend.
In the Legend window, hover the mouse cursor over the legend item to be applied.
Click the formatting brush icon

next to the legend item to apply it to the selected branches.

Use the steps above to remove a legend item from selected branches in the mind map. When you
remove legend colors from branches, the branches go back to using the default background color
of the style used.
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Highlighting and filtering a mind map using legend items
In large mind maps, it can be a challenge to find specific branches, even when they have been
singled out using legend items. You can highlight branches that contain legend items, and you can
filter the mind map by legend items as well.
Hover the mouse cursor over the legend item you want to see in the mind map.
Do one of the following:
Click the highlighting icon
color or icon is used.

next to the legend item to highlight all branches where that

Click the filter icon
next to the legend item to filter the mind map so that only branches
containing the color or icon are shown.
Use the steps above to remove highlighting or a filter from the mind map.
See "Filtering a mind map" for more information on filtering a mind map using various criteria.

Removing a legend item
To remove a legend item, just click the cross
window.

136

shown to the right of its name in the Legend

Presenting a mind map
The MindView presentation mode lets you present your mind map to your audience branch
by branch in full screen mode. To do this:
Choose View | Window | Presentation Mode.
Your mind map is now displayed in full screen mode, and a small toolbar of icons appears.

These icons let you perform the following actions:
Clicking the Back icon
lets you present your mind map in reverse (anti-clockwise) branch
order by displaying the branch preceding the selected branch in the hierarchy.
Clicking the Next icon
lets you present your mind map in normal (clockwise) branch
order by displaying the branch following the selected branch in the hierarchy.
Clicking the Settings icon
Clicking the Exit icon

lets you configure the presentation mode.
lets you return to the normal Mind Mapping design mode.

Configuring the presentation mode
When you click the Settings icon

, the following dialog appears.

Present up to: This field lets you specify the number of branch levels to present when using the
Next and Back icons. For example, if you choose to present your mind map up to Branch level 2,
clicking the Next icon will select all the main branches and their first level of sub-branches, one after
the other, but not their second and further levels of sub-branches.
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Expand sub-branches of the selected branch: This field lets you specify how many levels of subbranches of a particular branch should be displayed when that branch is selected. For example, if
you choose to expand the sub-branches of the selected branch by 2 levels, when you present a
main branch (i.e. that main branch is currently selected), MindView automatically expands its subbranches (the first level) and their own sub-branches (the second level).
Auto-collapse: This field lets you specify how much of the branches of the mind map other than
the selected branch should be visible, in other words how many levels of their sub-branches should
be displayed on the mind map at any time. For instance, if you choose to auto-collapse the
branches to Branch level 3, MindView always displays 3 levels of branches for all the branches
other than the selected branch (whose behavior is controlled by the "Expand sub-branches"
parameter above). Therefore when you enter presentation mode, you will see the root, the main
branches and their first level of sub-branches.
Set zoom level: This setting allows you to adapt the zoom factor used while presenting your mind
map. If for instance you have chosen to present all the levels of sub-branches, lowering the zoom
factor will ensure that all the branches to be presented are always visible on the screen, without any
need for horizontal or vertical scrolling.
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Checking a mind map
Before you export your map to other formats, or send it to colleagues, you may find it useful
to check the list of all the files that you have included in it. This will also help you identify potential
problems, for instance when a data file that you added to a particular branch as an attachment is no
longer located in the folder you indicated when adding it.
Click the File tab.
Choose Info | Data Files to open the following dialog:

This dialog is made up of several columns:
A Warning icon
in the first column highlights a particular problem. Move your pointer on top
of this icon to obtain more information about the problem.
The second column contains icons that represent the nature of the data files that are listed:
branch picture, floating picture, attachment and so on.
The third column lists the names of the data files.
The fourth column lists their respective paths.
To replace a file by another or change its location, select the file in the list and click Replace
File. You can also just double-click the file name in the dialog and browse to the new file or
location.
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Packing a mind map
This feature makes it very easy to distribute your mind map to other users.
With a few mouse clicks, you can create a complete packed version of your mind map, ready to be
sent via email, shared over the network or distributed via DVD or CD-ROM.
Click the File tab.
Choose Info | Pack.
As soon as you click OK in the message dialog that appears, MindView integrates all the external
files that are attached to the mind map document (floating pictures, branch pictures, attachments
and so on) within the .mvdx map file.
Once a map is packed, you can continue working with it as normal. Any attached file you activate
from within the map opens in the relevant external application, letting you edit it as you wish. When
you close this external application, all the changes you have made to the attachment are saved in
the version of the attachment that is integrated to the .mvdx map file.
Notes:
Once you have packed a mind map, all the files you subsequently add to it (floating pictures,
branch pictures, attachments and so on) are automatically packed in the .mvdx map file.
If you have used the Additional Folders command to specify a list of folders to include when
exporting to HTML or packing, all the files contained in these folders are also integrated in the
.mvdx file when packing the map. See "Additional folders" for more information about that
command.
If the MindView view contains several maps (i.e. several roots), they are all packed within the
.mvdx file.
When MindView opens a packed map, it starts by checking all the attached files that are packed
in it. If the original version of any of these files has been updated since you packed the map,
meaning that the version contained in the mind map is no longer the most up to date version, it
displays a message to that effect, giving you the option of updating the mind map to the latest
version.

Unpacking a mind map
Although you can work in a packed map as normal as mentioned above, you also have the
possibility of unpacking it. This may be useful if you want to retrieve the individual files that may
have been attached to it, or to reduce the size of the .mvdx map file.
To do this:
Click the File tab.
Choose Info | Unpack.
Choose a folder in which to place all the files attached to the map.
If you have used the Additional Folders command before packing the map (see above) to
specify a list of folders to include in the packed map, the additional folders are created automatically
in the target folder when unpacking the map and the relevant external files placed in these folders.

Merging packed mind maps in a master map
You can easily merge into a master map several mind maps that have been packed using the Pack
feature:
Open your master map in MindView.
Open each packed map in turn. Each document opens in a separate tab in MindView.
Merge each packed map into your master map by copying its root (Ctrl + C) and pasting it onto
the relevant branch of your master map. See "Moving a branch" for more information about
copying and pasting branches.
While performing this operation, make sure you do not close any of the packed maps before
you have saved the master map.
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Sending a mind map
This feature makes it very easy to send your mind map to other users via e-mail.
Click the File tab.
Choose Share | Email.
A message appears, asking you if you want the map to be packed into a single file before sending
it:
Choose Yes if you want to integrate all the external files that are attached to the mind map
document (floating pictures, branch pictures, attachments and so on) within the .mvdx map file.
For more information about the packing feature, see "Packing a mind map".
Choose No if you only want to send the .mvdx map file, without the files that you may have
attached to it.
A message is created in your default mail program, containing the mind map and a link to a free
MindView viewer in case the recipients of your message do not have MindView installed on their
computer. All you have to do is fill in the name of the recipients and the subject of your mail
message before sending it.
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Publishing a mind map
If you have a MatchWare Shared Workspace account, you can publish your mind map on the
online MatchWare mind map library.
When you publish a map, anyone may view and download the mind map from the mind map library.
You can also share the public map with other users through e-mail and social media.
To create a MatchWare Shared Workspace account, visit https://www.sharedworkspace.com.
Do not publish maps that contain sensitive information, as public maps are available to the
general public. If you are in doubt which rules govern public maps, review the terms of service
under "MatchWare License Agreement". Also be aware that even though you can unpublish a
public map, thereby removing it from the online mind map library, other users may have
downloaded and shared your public map before you unpublished it. Only publish a mind map if you
are certain that the content is fit for publication and sharing.
If you publish a map that you have already published before, the existing public map will be
overwritten. A message is shown to remind you of this when you start publishing the map.

Publishing a mind map
Make sure that you are connected to MatchWare Shared Workspace using the account that you
want to use for publishing the mind map. For more information, see "Managing online
workspaces".
Choose File | Share | Publish

.

Edit the title if desired, and choose a category for your mind map.
Editing the title is particularly useful if you had originally used a generic working title such
as "Subject". A better and more descriptive title increases the likelihood that other users will
find and use the public mind map.
(Optional) Indicate which language is used in your mind map.
(Optional) Provide a description of your mind map.
(Optional) Add tags that describe your mind map by entering the text for each tag (up to 20
characters) in the Additional Tags field and pressing Enter or clicking Add. You can delete an
existing tag by clicking the red cross on the tag

.

The category, language and tag information you enter help users find mind maps that suit
their requirements on the mind map library. The description you provide is shown when users
click a mind map from the search results to view a particular mind map.
Click Publish.
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When the map has been published, you can view it online immediately by clicking the URL
shown or by clicking Open. You can also copy the URL and use it for sharing your public
mind map using social media or e-mail.

Unpublishing a mind map
When you unpublish a public map, it is removed from the MindView online library and is no longer
available to the general public.
Go to http://www.matchware.com/examples, and log in using your Shared Workspace
credentials.
Locate the public map that you want to unpublish.

Click Delete

to remove the mind map from the list of public mind maps.

You can only unpublish maps that you have published yourself.

143

Creating project reports
When working on documents of the Project Management type, you can create a set of HTML
reports, such as Executive Reports, Task Status, Resources Workload and so on.
Create the set of reports by doing one of the following:
Choose File | Export | Project Reports.
(Gantt view only) Choose Gantt Tools | Project | Project Reports.
Choose a folder and file name for the reports.
(Optional) Click Settings and select which pages you want to include in the report. If you do not
do this, all pages are included in the report by default.

The reports file opens in your Internet browser.
Navigate through the options shown on the left-hand bar to display the corresponding report in
the right-hand panel.
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Many of these reports are interactive and let you navigate from one to the other. In many reports for
instance, clicking a summary task in the upper part of the window displays all its sub-tasks in the
bottom part. Similarly, clicking a Task ID in the bottom part opens the Task List, highlighting that
task.
You can use the Back button of your browser to get back to the last report you were viewing at any
point.
Most reports are self-explanatory. The following notes may however be useful:
The Overdue Tasks report relies on Completion (%) data being up to date. For information on
setting completion values, see "Enhancing a project plan".
A task is regarded as on schedule if it is marked as 100% completed, or if it is still in progress
but marked as completed up to today's date (i.e. the date of the report). Otherwise it is
overdue by the number of days between the end of its completion bar and today's date. A
task in progress is also regarded as overdue if it has a deadline prior to today's date.
The Days with Multiple Tasks report lists all the resources that have been allocated more than
one task during the same period. For each day of the period, it shows the details of the multiple
tasks that have been allocated to the resource.
The Resources Workload and Resources Accountability reports show, for each resource,
the hours required to complete the tasks they have been allocated, the hours available
according to the project and resource calendars, and the difference between these two figures.
The Workload Index charted at the top of the report gives a measure of the resource overload
when the number of hours available is less than the number of hours required. The
Accountability report also shows the number of overdue tasks.
The reports under the Baseline heading show project progress compared with the default
baseline defined for the project (if any). For these reports to show the expected results, you
need to make sure that the correct baseline has been set as the default. For more information,
see "Enhancing a project plan".
If you have added Agile project management icons to your project tasks, the Agile [Kanbans]
heading contains a kanban board for each sprint in your project. The tasks are listed (with
icons) in the relevant section of the kanban board (Not Started, In Progress and Completed).
Click the sprint icons above the kanban board to display tasks for each sprint.

For more information on using Agile icons, see "Inserting icons".
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Using the Picture Catalog
The Picture Catalog contains a vast collection of high quality clipart pictures organized in many
different categories or themes.
As well as business and web-related pictures, the Picture Catalog contains a large number of
pictures created specifically to support both the curriculum-aligned templates included in MindView
and your own curriculum-based mind maps.
All Picture Catalog elements are free for you to use in your mind maps.
You access the contents of the Picture Catalog using the Pictures panel on the right of the
MindView window. From the Pictures panel, you can also store your own elements in the Picture
Catalog. This enables you to re-use them whenever needed by dragging them from the Pictures
panel into your mind maps.
Finally, you can connect one or more of your User Area categories to one of your hard disk folders
or to a shared network folder in order to view and use their contents. This feature is particularly
useful when several users want to make use of the same multimedia elements stored on a shared
network folder.
You can for instance connect one of your user categories to a folder containing different types of
elements, such as videos, sounds or Flash files, which you can then drop onto your branches as
attached objects.
Click the Pictures tab on the right of the workspace or choose View | Show/Hide | Panels |
Pictures to open the Pictures panel.

You can resize the Pictures panel by placing the mouse pointer on one of its edges until it
changes to a double arrow and dragging with the mouse.

Overview of the Pictures panel
The Pictures panel displays the contents of the Picture Catalog arranged in several categories. In
addition to folders such as Earth Sciences and Business, which contain images arranged by theme,
the following categories are available:
User Area: This area is reserved for your own use. You can add or drag any element to it,
create as many sub-categories as needed and even connect one or more of your user
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categories to an external folder. See "Adding elements to the Picture Catalog" below for more
information.
Favorites: Place in this category any element you want to be able to find again quickly.
Recent: When you add a Picture Catalog element to your document, this element is
automatically copied to the Recent category. This allows you to quickly find recently used
elements in case you want to use them again.
Search Results: This category only appears once you have done a search in the Picture
Catalog. It shows all the elements of the catalog that correspond to your search criteria.

Browsing the Picture Catalog
To see the contents of a category, select it in the Pictures panel by clicking it or by pressing the
up or down arrow key on the keyboard.
A right-pointing arrow next to a category name indicates that this category contains subcategories.
Click this arrow or press the right arrow key on the keyboard to show the list of sub-categories.

You can collapse a category again by clicking its arrow or by pressing the left arrow key on
the keyboard.
To examine a particular element more closely, place the mouse pointer over it.
This shows an enlargement of the element as well as relevant information such as its name
and size.

To insert a Picture Catalog element in your mind map, just drag it from the Pictures panel.

Using the Favorites category
If you often use the same elements, placing them in the Favorites category allows you to find them
again very quickly. You can do this in two ways:
Right-click the relevant element and choose Add to Favorites in its local menu.
Drag the element from its Pictures panel category to the Favorites category.
The element is now copied to the Favorites category. If you want to remove it from this category at
a later stage, right-click it again and choose Remove from Favorites in its local menu.

Searching the Picture Catalog
If you need a picture related to a particular theme (for instance Europe), you can search the entire
catalog from the Pictures panel for that theme:
Type a search word in the Search for field. For instance, if you are working on a map
describing various countries and want to insert their flags on the map, start typing the word
"flags". As soon as you enter the 3rd character (i.e. the letter "a"), pictures of flags appear in
the Search Results category.
(optional) If you want to restrict the search to a particular category, select this category in the
Search in field and click the Search icon

to restart the search.

Scroll down the Search Results category until you find the flag you require.
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During a search, the Search icon briefly changes to
time by clicking this icon.

. You can interrupt a search at any

Searches in the Picture Catalog are keyword-based. Many different keywords have been
associated with the Picture Catalog elements to help you find rapidly what you need. By way of
example, here is a small selection of the many different keywords you can search for:
people, men, women, children, buildings, symbols, countries, maps, flags, animals, plants,
computing, transport
When you enter the first few characters of a word or a full word in the 'Search for' field, MindView
goes through all the keywords that have been associated with the Picture Catalog elements. All the
elements which have one or more keywords containing the characters you entered appear in the
Search Results category.
You can view the keywords associated to a particular element and even add your own as follows:
Right-click the element in the Pictures panel display area.
Choose Properties in its local menu.
The Properties dialog appears.

Type the new keywords you want to associate with this element, separating them with semicolons.
The Properties dialog also lets you edit or remove unwanted keywords or change the
description that appears when you view an enlargement of the element.
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Adding elements to the Picture Catalog
You can keep your own elements in the Picture Catalog for future use, either in an existing category
or in the User Area. You are also free to create your own categories within the User Area, rename
them or delete them.
Any element you add to one of the existing categories shown in the Pictures panel is identified
by a small shortcut icon, indicating that the element is not actually copied to the Picture
Catalog, but only inserted as a link to the actual element.

Any element you add to one of the User Area categories is identified by a small gray arrow.

There are different ways of adding an element to the Picture Catalog. Here is one of them:
In the Pictures panel, select the category to which you want to add the element.
Right-click the category and choose Add Element in its local menu.
Choose the required element in the Open dialog.
You can also add elements by dragging them from the Windows Explorer or the desktop.

Renaming an element
You can give relevant names to all the elements you add to the Picture Catalog or rename existing
elements as follows:
Right-click the element you wish to rename and choose Properties in its local menu.
Enter a new description for the element.
The new description will appear whenever you view the enlargement of the element.

Deleting an element
You can delete any element you have added to the Picture Catalog as follows:
Right-click it and choose Delete in its local menu or select it and press Delete.

Creating a category within the User Area
You can create your own categories within the User Area as follows:
Right-click the User Area or the sub-category of the User Area in which you want to create a
category.
Choose Create Category in the local menu.
Type the new category name in the white box that appears.

You can also rename or delete any category in the User Area by right-clicking it and choosing
Rename Category or Delete Category respectively in its local menu.

Connecting a category to an external folder within the User Area
MindView allows you to connect one or more of your user categories to one of your hard disk
folders or a shared network folder. This feature is particularly useful when several users want to
make use of the same elements stored on a shared network folder.
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You could also connect one of your user categories to a folder containing different types of
elements, such as videos, sounds or Flash files, which you can then drop onto your branches as
attached objects.
Right-click the main User Area or one of its sub-categories.
Choose Connect to Folder in its local menu.
The Connect Category to Folder dialog appears.

Type the path of the folder you want to connect to or use the Browse button

to locate it.

Choose the required filter. If for instance you only want to view the available videos, choose the
Video filter.
Note that you can also type your own filter, such as *.bmp; *.jpg (separating the formats with a
semi-colon as shown here) to see only pictures using these file formats or *.* to view all the
files contained in the connected folder.
(optional) Check the Include sub-folders option if you also want to see the contents of all the
sub-folders of the connected folder.
A new category is now created within the User Area, filled with all the contents of the connected
folder that match the filter you specified. The new category takes the name of the folder that you
connected it to. It is identified by a special icon to show that it is a connected category.
If the contents of the connected folder are likely to change while you are working with the Picture
Catalog, for instance if the connected folder is a shared network folder to which other users have
access, you can refresh the connected category to make sure you see the latest contents.
Right-click the connected category and choose Refresh in its local menu.
Note that you can also refresh any of the sub-folders of the connected category.
If the connected folder is very large, the Refresh operation may take a long time. You can
interrupt it by right-clicking the connected category and choosing Stop Refresh in its local menu.
Finally you can change the filter used to view the contents or even change the connection by
connecting to a different folder as follows:
Right-click the connected category and choose Modify in its local menu.
Choose a different path and/or a different filter in the Connect to Category Folder dialog as
described above.
You can disconnect a connected category at any time as follows:
Right-click the connected category and choose Disconnect in its local menu.
Disconnecting a connected category removes the link between your User Area and the folder
you connected to, but does not affect the external folder or its contents in any way.

Resetting the Picture Catalog
You can restore the original contents of the Picture Catalog at any time as follows:
Click the File tab.
Choose Options.
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Click Preferences on the left.
Set Reset Picture Catalog to Yes.
Click OK.
This will leave your User Area untouched, but removes all the elements you might have added to
any other category.
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Using the Properties dialog
The Properties dialog shows the properties of the MindView element currently selected, for
example the root, a branch or a floating comment. If nothing is selected the properties of the current
view are shown.
You can use the Properties dialog to make fine-tuning changes to these elements.
Rather than applying properties one by one to enhance the visual aspect of your branches, it is
normally easier to use the Format tab shown at the right of the ribbon when the branch is selected.
Using this tab, you can apply branch shapes, branch colors and other coordinated attributes in one
step. Similarly, the Design tab lets you apply predefined layouts and styles to the entire map in one
step.
Notes:
If the Properties dialog is not visible, choose View | Show/Hide | Panels | Properties to open
it.
The properties described are not always applicable to all views. The Properties dialog only lists
the properties applicable to the selected element in the current view.
You can resize, dock and undock the Properties dialog according to your needs. See "Using
the MindView panels" in the topic "Setting up your workspace" for more information.
The Properties dialog shown below illustrates the general properties applicable to a branch. To see
the properties applicable to the branch label, you would click its Text tab.
For a complete description of all the properties available for the various MindView elements, see
the Reference section.

You can make the same change to several elements at once by selecting all the elements required
first. Let's suppose for instance that you want to change the branch color of three of your 10
branches. All you have to do is to select the three branches before choosing the color with the 'Fill
color' property.

Editing properties in the Properties dialog
The way you edit a property depends on its type as follows:
Label: Type in the new name or edit the existing name in the input field.
Number: Type in the new value in the input field.
Check box: Click the box to select it, click it again to deselect it.
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Path: Type in a new folder and/or file name or edit the existing one, or click the Browse button
on the right side of the input field.
Color: Click the small rectangle and choose the new color in the Windows Color dialog. The
upper left corner of the dialog shows all the predefined colors. To define your own color, click
the required area of the color matrix on the right and use the slider on the extreme right of the
dialog to adjust the color attributes. You can also enter the RGB values (Red, Green, Blue) or
the Hue, Saturation and Luminosity values manually. The easiest way to experiment with
different colors is to press and hold the mouse button and move the mouse pointer around the
color matrix. To save a color for future use, click Add to Custom Colors.
Once you have made the required change, press Enter to save the edited property.
You can also use the Up and Down arrow keys to move between properties and press Enter
to start editing.
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Using the Overview panel
The Overview panel gives you a miniature view of your entire document.
To display the Overview panel, choose View | Show/Hide | Panels | Overview.
The Overview panel is not available in the Outline view or the Gantt view.
You can resize, dock and undock the Overview panel according to your needs. See "Using the
MindView panels" in the topic "Setting up your workspace" for more information.

If your map is very large, the Overview panel can be a very useful tool to reach its different areas.
Move the mouse pointer over the gray rectangle contained in the Overview panel until it takes
the shape of a hand.
Drag it in the direction of the map you want to explore and release the mouse button.
The main view changes to reflect the new position of the gray rectangle. Note that the positions of
the elevators in the workspace scroll bars also change accordingly.
You can achieve the same effect by using the workspace scroll bars, but the Overview panel
has the advantage of giving you a complete representation of your map.
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Using the Object list
The Object list gives you a complete overview of the objects placed on the selected branch. It
allows you to perform various operations on them, such as activating them, deleting them or
displaying their properties in the Properties dialog.
If the Object list is not visible, choose View | Show/Hide | Panels | Object List to open it.

You can resize, dock and undock the Object list according to your needs. See "Using the
MindView panels" in the topic "Setting up your workspace" for more information.

Manipulating objects in the Object list
The Object list allows you to perform the following operations:
Select an object by clicking its name.
The contents of the Properties dialog immediately changes to reflect the properties of the
selected object, which you can then edit as required.
Activate an object by double-clicking its name or choosing Execute in its local menu.
Move an object up or down the list by drag and drop. This is only relevant if you intend to export
your document and want the objects to be exported in a particular order, as it is the order of the
objects in the Object list that dictates the order in which they are exported.
Delete an object by choosing Delete in its local menu.
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Collaborating
Accessing online workspaces
An online workspace is a remote site on the web where you can work collaboratively. Your
documents are stored in the workspace where other users, such as colleagues or fellow students,
can also access them provided they have your permission. You assign permissions (read only
access, read/write access) to other users as necessary.
MindView supports several types of online workspaces:
MatchWare Shared Workspace
This workspace, specific to MatchWare, lets several users access a shared MindView
document at the same time. Changes to the document are updated continuously as you work
so that other users can see the changes you make. If necessary you can assign permissions
to individual branches of your own shared mind maps so that, for example, only particular
users can make changes to particular branches.
The MatchWare Shared Workspace is hosted at: https://www.sharedworkspace.com. It is a
service that is integrated with MatchWare MindView, but subject to its own Terms of Service.
Accounts on the MatchWare Shared Workspace can be purchased from MatchWare as a
yearly subscription. The service is also available as a 30-day free trial.
It is possible for organizations to host their own MatchWare Shared Workspace server. For
more information, please contact MatchWare directly.
Microsoft SharePoint®
When you open a shared document in SharePoint, it is locked so that other users cannot
make changes while you are working on it.
For information about Microsoft SharePoint, see the Microsoft web site.
Google Drive
When you open a shared document on Google Drive, it is locked so that other users cannot
make changes while you are working on it.
For information about Google Drive, see the Google Drive web site.
Microsoft OneDrive
When you open a shared document on OneDrive, it is locked so that other users cannot make
changes while you are working on it.
For information about Microsoft OneDrive, see the Microsoft web site.
In addition, you may be able to use other online workspaces with MindView.
To find out how to open an online document, see "Opening and saving online documents".
To find out how to manage online workspaces, see "Managing online workspaces".
You may also collaborate with others using file synchronization services that synchronize files
on your computer with other computers, web sites and devices. As you are creating, editing and
saving documents on your own computer and rely on the synchronization service to share the files,
such collaboration practices are not covered further by this documentation. See the documentation
for the synchronization service used for instructions.
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Opening and saving online documents
This topic explains how to open MindView documents hosted on an online workspace and
how to save documents on the workspace, whether they were initially located on the workspace or
not.

Opening an online document
Choose File | Open or Share | Open Online.
Choose the relevant workspace. You may have to log in using a web browser.
If necessary, browse to the right folder on the chosen workspace, and select and open the file.
When you are working on an online document, a message reminding you of this is displayed at the
top of the workspace.

Using the MatchWare Shared Workspace
This section describes login and viewing options specific to the MatchWare Shared Workspace. If
your documents are hosted on a different workspace, please see the relevant documentation or
web site for information about how to use the interface.

Providing login information
If you have chosen to work on documents hosted on the MatchWare Shared Workspace but have
not yet provided all necessary login information, the following dialog appears:

Enter your MatchWare Shared Workspace user name and password and click Connect.
If you don't have a user name and password, click Need an account?. This will take you to the
MatchWare Shared Workspace, where you will be able to create an account, provided that you or
your organization are an authorized subscriber to this service. The service is also available as a 30day free trial. If you have set up a user account but have not saved a password, Open in browser
will be shown instead of Need an account?. Clicking this link will also take you to the MatchWare
Shared Workspace where you may log on as normally. You can also enter your password in the
dialog to log on directly from MindView.

Viewing files and folders
From the Backstage view or the dialog shown when you open the document, you can see all
workspace folders which belong to you. You can also see all workspace folders and documents
which belong to other users but have been shared with you. You can also manage files and folders
on the MatchWare Shared Workspace; for more information, see "Managing online workspaces".
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The icon on the left of a folder name in the MatchWare Shared Workspace dialog indicates the
sharing status of the folder:
denotes a folder that is not shared with anyone.
denotes a folder belonging to you, that you have shared with others.
denotes a folder belonging to someone else, but that has been shared by its owner with you.
The name of the owner of the folder or document, and the sharing attributes you have to that
element, are shown in the Owner and Sharing columns respectively.
The access rights (Read Only or Read/Write) you have to the folder or document are shown in the
Access column.
If you see a folder identified as "not shared" listed in the "Shared With Me" section, it means that
although the folder itself is not shared, it contains one or more documents that the owner of the
folder has shared with you specifically. To access these documents, double-click the folder to open
it.
Access rights to documents and folders are managed online from the MatchWare Shared
Workspace. For more information, see the online help available on the workspace itself.
Several users can collaborate on a document stored on the MatchWare Shared Workspace
simultaneously. For more information, see "Collaborating on an online document".
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Saving an online document
Choose File | Save As or Share | Save Online.
Select the relevant workspace as described above.
Select the folder in which to save your document and supply a filename.
Click Save.
A document that is held on the MatchWare Shared Workspace is saved automatically
whenever you make a change to it, so you do not need to save it explicitly, unless you want to save
under a different name or to a different folder. For all other workspaces, you need to explicitly save
the document.
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Managing online workspaces
You may edit or delete existing connection details for online workspaces, or add new ones. All
online workspaces that you add are listed so that you can select them when you open or save a
document online from the File menu or the Share ribbon tab.
You may also add, rename or delete folders on the MatchWare Shared Workspace as needed.
You cannot add, rename or delete folders or files that have been shared with you by another
user. If you have been granted write access to the files, however, you can edit them. For more
information, see "Collaborating on an online document".

Managing or adding connection details
Do one of the following:
Click the File tab, choose Open or Save As, and choose Manage Places.
Click the Share tab, choose Open Online or Save Online, and choose Manage Places.
In the Manage Online Workspaces dialog, do one or more of the following:
To edit or delete an existing workspace entry, select it and click Edit or Delete.
To add a new workspace entry, click Add.

If you click Delete, you will be asked to confirm that you want to delete the workspace. If you
click Add, the Select Type dialog opens where you must select the type of workspace you
want to add or edit.

If you have removed Google Drive or Microsoft OneDrive from the list of default
workspaces shown in the Manage Online Workspaces dialog, these options are shown in
the Select Type dialog. You can only add one Google Drive or Microsoft OneDrive
workspace, as the URL for the workspaces is always the same. By contrast, you can add as
many MatchWare Shared Workspace and Microsoft SharePoint workspaces as you like, as
long as they have different URLs.
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You can also access the Select Type dialog by choosing File | Open or Save As and
clicking Add a Place.
When you have selected a workspace type, or if you clicked Edit, the Edit Workspace dialog
opens where you may enter or change the name, URL, user name and password for the
workspace. Test the connection by clicking Test, and click Save.

Make sure that the URL of the workspace is entered correctly, including the protocol (for
example, HTTP or HTTPS). Using the wrong address or protocol may lead to connectivity
issues.
For Google Drive and Microsoft OneDrive, you only need to provide a name for the
workspace in the Edit Workspace dialog. You will need to log in from a browser window
when you access the workspace to save or load files.
Click OK.
To find out how to open an online document, see "Opening and saving online documents".

Managing folders or files on the MatchWare Shared Workspace
If your documents are hosted on a different workspace, please see the relevant documentation
or web site for information about how to use the interface.
When opening or saving online documents on the MatchWare Shared Workspace from MindView,
you can add, rename or remove folders or files that you have created or uploaded yourself as
necessary.
Choose File | Open or Save As or choose Share | Open Online or Save Online, then click
MatchWare Shared Workspace. If you haven't accessed the workspace already, login in the
dialog that appears. For more information about the connection procedure, see "Opening and
saving online documents".
Manage your folders or files as necessary:
If you accessed the Shared Workspace from the File menu, use the buttons above the
folder pane to add, rename or delete folders, or select one or more files and use the
buttons above the file pane to rename or delete them.

If you accessed the Shared Workspace from the Share ribbon tab, click Create Folder to
add a new folder in the current folder, or select one or more files or folders and click
Delete to delete them. Use the Up and Back commands if necessary to navigate your
folder structure.
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For more information on the MatchWare Shared Workspace, including information on sharing
folders and files with other users, see the online help available on the workspace itself.
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Collaborating on an online document
The procedures described here apply only to mind maps held on the MatchWare Shared
Workspace.
Any document held on the MatchWare Shared Workspace can be worked on from within MindView
by several people at once, provided that the folder containing the document, or the document itself,
has been shared by its owner and that all collaborating users have been given appropriate access
rights.
Each time a user makes a change to the document using MindView, the change is automatically
saved to the workspace and made visible to the other users of the document in MindView.
Consequently, all users see the changes made by others as work progresses.
Access rights to MindView documents and folders are managed online from the MatchWare Shared
Workspace. For more information, see the online help available on the workspace itself. However,
you can also share individual documents with other users directly from MindView as follows.

Inviting others to collaborate on an online document from MindView
Before you can share a document with other users, you must save it on the MatchWare
Shared Workspace; for more information, see "Opening and saving online documents". In addition,
the document must be opened.
Choose File | Share | Collaborate.
You can also choose Share | Share | Collaborate to access the Backstage view and click
Collaborate. This option is not available if the document is not stored on the MatchWare
Shared Workspace.

Do one of the following to share the document with another user:
Enter the e-mail address of the user in the Share file with field, select read or write
access for the user by selecting the relevant option
, and click Add.
Click add contact
to select one or more users from your contact list on the MatchWare
Shared Workspace, select read or write access for each user, and click Invite.

You may filter the list of contacts using the Filter Contacts field.
Click Save to share the document with the users listed.
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The users invited can now open your MindView document from the MatchWare Shared Workspace
and edit it as needed.
When more than one user is working on the shared document at the same time, an icon
is
shown in the status bar. You can hold the mouse pointer over the icon to see which users are
currently working on the document.

Removing users from a shared document
To remove one or more users so that the document is no longer shared with them, select them
on the list, click remove users , and click Save.

Branch locking
As well as determining who can access their folders and documents, the owner of a shared
document can also assign permissions to individual branches of the mind map from within
MindView, so that only particular users can make changes to particular branches.
Such restrictions are denoted by the presence of a Lock icon
to the right of the branch label.
Moving the pointer over this icon gives you additional information about the operations you are
allowed to perform on the branch.

If you are the owner of a shared document, this is how you can assign permissions to individual
branches of the mind map to particular users:
Open the document on the MatchWare Shared Workspace. For more information, see "Opening
and saving online documents".
Select the relevant branch.
Choose Share | Manage Locks.
The Branch Locking dialog opens.
Click Add and select the user or users to whom you want to grant specific branch permissions.
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The Document Access column records the access right that each user has to the
document itself on the shared workspace. This access right must match the branch
permission you are intending to give to the selected users. Let us suppose you intend to grant
a Write permission to user Mike for the branch. If Mike only has Read access to the
document, you can still grant him a Write permission to the branch, but he will not be able to
edit that branch until you give him a Write access to the document.
Click OK.
In the Branch Locking dialog, give each user the appropriate permission, Read Only or Write
(read/write). The permissions you assign apply to the branch you selected and all its subbranches.
If you give a particular user a Write permission on a branch, all the other authorized users
(except for yourself as the document owner) are automatically restricted to a Read Only
permission on that branch. There is therefore no need for you to give them each individually a
Read Only permission.
You can of course grant a Write permission on that same branch, or some of its subbranches, to one or more other users individually, thereby allowing these users to work on the
same branch at the same time, in true multi-editing mode.
As the owner of the document, you are not restricted by any Write permission given to other
users, and are always able to edit the branch.

If a user does not have sufficient access rights to the document itself to grant him or her
the branch permissions you have selected here, a warning icon
appears next to his or her
name. As explained above, MindView allows you to grant such permissions, but they only
become operational once you have given the required access rights to these users.
Click OK.
The Lock icon
now appears to the right of the branch label. Hovering that icon gives you a
reminder of the permissions you have granted.
As owner, you can make changes to the permissions at any time by selecting the branch and
clicking Manage Locks.
You can also remove all permissions on a locked branch at any time by selecting it and clicking
Remove All Locks .

Document locking
As well as locking specific branches, the owner of a document can also apply a lock to the entire
document, by granting a Write permission to the document to a particular user. This will prevent all
the other users from making any changes at all to the document, including inserting pictures and
comments floating freely on the workspace.
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As the owner of the document, you are not restricted by any Write permission given to other users,
and are always able to edit the document.
You can however prevent all the other users from editing the document by giving yourself a Write
permission to it.
The procedure to follow is almost identical to the procedure described above:
Open the document on the MatchWare Shared Workspace.
Click the workspace to make sure no branch is selected.
Choose Share | Manage Locks.
Follow the rest of the procedure described above.
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Managing and tracking tasks
If you are using MindView to create an online task list or project plan, you can distribute the
tasks to all the resources involved via email to the MatchWare Shared Workspace. The resources
can then view and update the status of their tasks directly on the shared workspace as they work
on them. You can then monitor the task status from MindView by re-importing the updated tasks
into your online document.
For information on creating a task list or a project plan, see "Inserting task data".
Note that you can also export your task lists to Microsoft Outlook. For more information on the
procedures involved, see "Exporting to Microsoft Outlook task list".
This procedure assumes that your MindView document is an online document hosted on the
MatchWare Shared Workspace. If this is not the case, you will need to start by saving your
document on the workspace. See "Opening and saving online documents" for more information.
The distribution of tasks via the shared workspace relies on email communication. You therefore
need to enter valid email addresses in the online document for all your resources. For more
information about this, see "Assigning resources".
You can only distribute tasks from an online document if you are the owner of that document.
However, you do not need to be the owner of the document to be able to import tasks into it,
provided that the owner has shared it with you. If the owner of the document has restricted your
access by giving you Read Only status on some branches, the tasks corresponding to these
branches will not be imported. If you are the document owner, all the tasks are imported.

Distributing the tasks to the resources
To distribute the tasks to the resources via the workspace, proceed as follows:
Choose Share | Distribute Tasks to Resources.
There are two distribution modes available:
Quick distribution
The Quick distribution mode allows you to distribute the tasks to the resources straight away,
using the MindView defaults.
Custom distribution
The Custom distribution mode gives you more flexibility about the data to be distributed, as
detailed below.
If you have already distributed these tasks previously, you will be warned that it is safer to start
by re-importing them from the shared workspace into your document, to avoid overwriting any task
updates made online by the resources in the meantime.

Custom distribution options
When you choose Share | Distribute Tasks to Resources | Custom Distribution, the options you
can choose from differ slightly depending on whether your document is a task list or a project plan.
The dialog illustrated below assumes you are working on a Gantt project.
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Include summary tasks: This option only appears if you are working on a Gantt project. Check it if
you also want to distribute the summary tasks to the resources.
Include completed tasks: If this option is not checked, MindView only distributes incomplete
tasks, i.e. tasks whose completion level is less than 100%.
Task properties: Check the task properties that should be visible to the resources on the shared
workspace. For each property, you can also specify whether the resource should be allowed to
modify the property online from the shared workspace or not.
Send emails with a link to the online tasks: If you check this option, MindView automatically
sends a message to each of the resources, containing a link to the shared workspace where they
can view and update their tasks as they start working on them.
Only send emails about new tasks and resources: When this option is checked, MindView only
sends messages to the resources who have been allocated new tasks since the last distribution.
View outgoing emails before sending: If you check this option, MindView will prepare the
messages, but will not send them automatically. This gives you the possibility of checking them and
possibly adding your own message before sending them yourself.
Click OK.
The tasks will now appear in the personal area of each of the resources on shared workspace,
where they will be able to view them and update them. For information about managing tasks on
the shared workspace, see the online help available on the workspace itself.

Importing the tasks from the shared workspace
Once resources start working on their tasks and updating their status online on the shared
workspace, you can periodically re-import these tasks into your MindView document to get an
overview of the overall progress. To do this:
Choose Share | Import Tasks from Resources.
Any task update made online is now imported into your document, letting you review the changes,
make any adjustments needed to tasks or resources, and if necessary, redistribute the tasks.
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Views
Using different views
MindView allows you to view your mind map in different ways, depending on your personal
preference, the nature of your data and the use you want to make of it.

The first four views, collectively referred to as "Map Views", are traditional Mind Mapping views:
The Mind Map view represents the map with the root in the center, and all the main
branches radiating from it in a clockwise direction. See "Using the Mind Map view" for more
information.
The Top Down view represents your map as a hierarchical pyramid, with the root at the
top, the main branches underneath, the sub-branches below the main branches, and so on.
See "Using the Top Down view" for more information.
The Left view represents your map as a list of topics placed on the left of the root. See
"Using the Left/Right view" for more information.
The Right view represents your map as a list of topics placed on the right of the root. See
"Using the Left/Right view" for more information.
The remaining views are specific views adapted to a particular purpose:
The Timeline view lets you display the branches of your map that contain time
information in chronological order on a horizontal time axis. See "Using the Timeline view" for
more information.
The Outline view represents the map as a hierarchical list which you can expand and
collapse as required. See "Using the Outline view" for more information.
The Gantt view is dedicated to the creation, editing and management of project plans
according to the rules of project management. See "Using the Gantt view" and all the topics
that follow it for more information.
Once you have created your document, you can display it at any time in another view by choosing
that view in the Home | View or View | View panels in the main menu or by right-clicking the
workspace and choosing View Map As in the local menu.
Going from one view to another only affects the way the document is displayed. The contents of the
document are not modified, unless you edit them yourself while working in the new view.
The only exception to this rule is the Gantt view. Going to the Gantt view automatically enables
project management features, which may have consequences for your data.
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Mind Mapping views
Using the Mind Map view
This view represents the map with the root in the center, and all the main branches radiating
from it in a clockwise direction. This is a good view to use when brainstorming all the ideas related
to the main subject of the map without worrying about evaluating them or structuring them.

To display your mind map in this view, you can:
Choose View | MapView | Mind Map in the Home or View tabs of the main menu, or
Right-click the workspace and choose View Map As Mind Map in the local menu, or
Press Ctrl + Shift + 1.
To find out how to use this view, refer to the "Basic tasks" and "Further tasks" sections of this
documentation.
You can quickly switch map views by right-clicking the workspace and selecting the desired
view in the floating toolbar that appears above the right-click menu. The floating toolbar also
contains other options relevant to the selected view.
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Using the Top Down view
This view represents your map as a hierarchical pyramid, with the root at the top, the main
branches underneath, the sub-branches below the main branches, and so on. It is a useful
representation for structured data which needs to be viewed in a hierarchical manner, in other
words from the higher level to the lowest levels.

To display your mind map in this view, you can:
Choose View | MapView | Top Down in the Home or View tabs of the main menu, or
Right-click the workspace and choose View Map As Top Down in the local menu, or
Press Ctrl + Shift + 2.
To find out how to use this view, refer to the "Basic tasks" and "Further tasks" sections of this
documentation.
You can quickly switch map views by right-clicking the workspace and selecting the desired
view in the floating toolbar that appears above the right-click menu. The floating toolbar also
contains other options relevant to the selected view.

While in that view, you can change the display so that the sub-branches are displayed
vertically by choosing that display in the Layout gallery of the Design tab.
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Using the Left/Right view
This view represents your map as a list of topics placed on the left or right of the root. It is a
good choice when you need to present structured data in list form (for instance a list of steps) and
want to be able to fully explore each point in the list before going on to the next point.

To display your mind map in this view, you can:
Choose View | MapView | Left/Right in the Home or View tabs of the main menu, or
Right-click the workspace and choose View Map As Left/Right in the local menu, or
Press Ctrl + Shift + 3.
To find out how to use this view, refer to the "Basic tasks" and "Further tasks" sections of this
documentation.
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You can quickly switch map views by right-clicking the workspace and selecting the desired
view in the floating toolbar that appears above the right-click menu. The floating toolbar also
contains other options relevant to the selected view.

While in that view, you can change the display from Right to Left or vice versa by choosing that
orientation in the Layout gallery of the Design tab.
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Timeline view
Using the Timeline view
The Timeline view displays all the branches of your document that contain time information in
chronological order along a horizontal time axis. The different timescales available (standard,
historic, geological, daily and weekly) let you represent a variety of different events, such as the
planning of a product launch, the life cycle of a bee or the rise and fall of an ancient civilization.
The date formats you see in MindView will depend on your computer's settings.

Accessing the Timeline view
You can access the Timeline view in different ways:
To create a new timeline from scratch, click the File tab and choose New | Timeline.
Choose a timescale from your map in the Select Timescale dialog that opens. For information
about the different timescales available, see "Inserting timeline data".
You can also display an existing map in timeline form in the Timeline view. To do this:
Choose Home | View | Timeline or View | View | Timeline in the main menu, or
Right-click the workspace and choose View Map as Timeline in the local menu, or
Press Ctrl + Shift + 4.
Going to the Timeline view from another view only affects the way the mind map is displayed. The
contents of the mind map are not modified, unless you edit them yourself while working in the
Timeline view.
You can quickly switch map views by right-clicking the workspace and selecting the desired
view in the floating toolbar that appears above the right-click menu. The floating toolbar also
contains other options relevant to the selected view.

Elements of the Timeline view
As all the other views, the Timeline view is made up of several components:
The Timeline Outline
This panel, which is displayed by default on the left of the Timeline view, shows all the
branches of your map as a hierarchical list which you can expand and collapse as required.
All the branches are listed, including those that do not contain time information.
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The Timeline Outline works exactly as the main Outline view.
You can close the Timeline Outline by clicking its Close icon
Timeline Outline in the Timeline Tools tab.

. To re-open it, choose View |

You can also click the Auto Hide pin
to make the Timeline Outline only appear
when you hover its tab on the left side of the workspace.
The Timeline
The Timeline area shows all the branches of your map that contain time information, arranged
in chronological order along a time axis.
All the branches and sub-branches that contain time information are represented, regardless
of the hierarchical structure of the map.
Note that if none of your branches contain time information when you switch to Timeline view,
the timeline will be empty.
The Task/Timeline Panel
This panel is displayed on the right of the workspace. It lets you define the timescale of your
document and enter time information on its branches.
Both of these operations are described in detail in the topic "Inserting timeline data".
As well as using the Task/Timeline panel, you can also enter time information for your
branches directly in the Timeline Outline or in the main Outline view.
If the Task/Timeline panel is not visible, click the Task/Timeline tab on the right of the
workspace or choose View | Show/Hide | Panels | Task/Timeline Panel.
The Timeline Tools Tab

This toolbar appears as soon as you switch to the Timeline view. Its icons allow you to
perform various actions on your timeline, as described below.
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Using the Timeline Outline
The Timeline Outline shows all the branches of your map, including those that do not contain time
information. The timeline itself however only shows the branches containing time information.
The branches are listed in the Timeline Outline in their order of creation. This means that if you
created them in another view such as the Mind Map view, they will be listed in the Timeline Outline
in the same order as in the Mind Map view (going clockwise from the top right), rather than in
chronological order.
Selecting a branch in the Timeline Outline automatically selects it on the timeline. If necessary, the
timeline is scrolled to bring the branch into view. Conversely, selecting a branch on the timeline
selects it in the Timeline Outline.
The Timeline Outline looks and works exactly as the main Outline view. When working in the
Timeline Outline, you can for instance:
Add, delete, move, cut, copy and paste branches in exactly the same way as in the main
Outline view.
Add branch pictures, icons, text notes, audio notes and pop-up comments to any of your tasks.
Attach objects such as text files, video files, sound files, hyperlinks and so on.
For a description of the Outline view and how to perform these operations, see "Using the Outline
view".
You can enter time information on a branch from the Timeline Outline by double-clicking the
relevant Start Time or End Time cell (or pressing F12 or Ctrl + F12 respectively) and filling in the
time picker as described in "Inserting timeline data".
Any change you make in the Timeline Outline is immediately reflected on the timeline itself.

Using the Timeline
By default, the timeline shows all the branches of your map that contain time information arranged
in chronological order along a time axis.

Choosing a layout and style
MindView lets you define the visual aspect of your timeline at any time by applying design options
to it.
Click the Design tab at the right of the ribbon.
Browse through the Layouts gallery to choose your preferred layout.
Browse through the Styles gallery to choose your preferred style.
(optional) To further customize the visual aspect of your timeline, explore the options available
in the Properties panel.
(optional) Undo your changes and return the entire timeline to the initial style by choosing
Effects | Reset Style.
Inserting branches
As well as using the Timeline Outline, you can enter events (branches) directly on the timeline itself:
Double-click the workspace.
Fill in the relevant details in the Insert Event dialog and click OK.
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The branch is now inserted at the correct place in the timeline.
Clicking Next instead of OK keeps the dialog open, ready for you to insert more branches.
Moving branches
MindView also lets you move branches on the timeline by dragging them to a different start time.
Note that if an end time had been specified for the branch, this end time is also moved so that the
duration remains the same.

For more precise positioning, double-click the relevant Start Time or End Time cell in the
Timeline Outline (or press F12 or Ctrl + F12 respectively) to open the time picker.
Adding objects and elements
When working in the Timeline view, you can add icons, pictures, text notes, comments and branch
connections on any of the branches displayed in the timeline, just as in all the other views. You can
also attach objects such as text files, video files, sound files and hyperlinks.
Select the required branch on the timeline.
Choose the relevant command, using either the main menu or the local menu of the branch.
For more information on these procedures, see the topics "Inserting icons", "Inserting pictures",
"Inserting text notes", "Inserting comments", "Attaching objects", "Creating hyperlinks" and
"Creating branch connections".
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Viewing the Timeline
Viewing the events
To display the start and end times of the timeline events underneath their label, choose View |
Data | Show/Hide
(or right-click the workspace and choose Show/Hide) and check
Start/End time in the sub-menu.
You can then hide or show the time information on individual branches with the
Show/Hide icon of the Format tab (or the Show/Hide option in the branch local menu).
If you have entered both a start time and an end time for a particular event, you can show the
duration of this event as a bar below the time axis by clicking View | Show Duration Bars in
the Timeline Tools tab.
You can view pop-up comments and attached objects by clicking the comment icon
paperclip icon
just as in the other views.

or

You can use the Bookmarks feature to set bookmarks on your timeline in order to locate
events quickly again. See "Viewing a mind map" for more information.
You can use the Smart Nav toolbar to quickly navigate your timeline using four handy tools.
See "Viewing a mind map" for more information.
The Numbering Scheme icon
of the Timeline Tools tab or Home tab lets you apply
sequential numbers to the branches of the Timeline according to their order in the Timeline
Outline. When your timeline has several levels of branches, it will help you identify which main
branch the different sub-branches belong to.
As in the other views, you can also use the Apply Branch Focus icon
of the View tab to
restrict the display to a particular branch. Click the Clear Branch Focus icon
to view the
entire timeline again.
If the branch you selected does not have any sub-branches, or if its sub-branches do not
contain time information, the timeline will be empty.
For more information about this procedure, see the topic "Focusing on a branch" of the
"Further tasks" section.
Finally the Filter icon
of the View tab lets you hide all the timeline branches that do not meet
the filter criteria you have defined. You can also use the Highlight icon
to highlight
branches that meet the filter criteria but still keep the rest of the branches visible.
For more information about this procedure, see the topic "Filtering a mind map" of the "
Further tasks" section.
Zooming in and out
You can change the level of magnification of your entire timeline as follows:
Click the Zoom In icon of the Zoom slider shown in the bottom right of the workspace (or
press Ctrl + "+") to increase the level of magnification of your timeline.
When you zoom in, everything gets bigger, including the text, the boxes and the pictures
included on your timeline.
Click the Zoom Out icon

(or press Ctrl + "-") to decrease it.

When you zoom out everything gets smaller.
Choose View | Zoom | Fit All

or press F4 to see the entire timeline.

You can also view your timeline in full screen mode, to give it as much screen space as possible:
Choose View | Zoom | Full Screen

or press F9.

To return to normal viewing mode, choose Close Full Screen in the floating Full Screen
toolbar, press Esc or press F9 again.
See "Zooming in and out" for more information on zooming.
Expanding and compressing
You can also increase or decrease the level of detail on the time axis as follows:
To increase the scale on the time axis, click View | Expand in the Timeline Tools tab.
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To decrease the scale, click View | Compress.
Expanding the scale makes the timeline less crowded as a given period of time occupies more
horizontal space. As a result, you may start seeing more detail on the time axis. For instance,
instead of having ticks every 5 years, you might now have a tick for every year. As you continue
expanding the scale, you might see months and days appear on the time axis.
Events on the timeline do not change size when you expand the scale: they move apart
horizontally, and they may also move vertically nearer the time axis as more space becomes
available. Contracting the scale has the reverse effect.
Inserting time breaks
You can also replace empty space on the time axis with one or more break marks by clicking View |
Show Time Breaks in the Timeline Tools tab.
This optimizes the use of the horizontal space when events are not evenly distributed along the
timeline.

To remove these time breaks, just click the icon again.

Exporting the Timeline
When working in the Timeline view, the only export methods available are:
Export to HTML
This export method works in exactly the same way as when you export the document from
one of the standard Mind Mapping views. The only difference is that the Home page of your
web site contains an interactive view of the timeline, allowing you to display each of its pages
with a simple click wherever the mouse pointer changes to a hand. A Timeline button is
inserted in all the pages of the site to let you return quickly to this interactive view.

For more information about this export method, see "Exporting to HTML".
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Export to Microsoft Outlook
For more information about this export method, see "Exporting to Microsoft Outlook task list".
Export to Microsoft Project
For more information about this export method, see "Exporting to Microsoft Project".
Export to XML
For more information about this export method, see "Exporting to XML".
Export to picture
For more information about this export method, see "Exporting as picture".

Printing the Timeline
You can print your timeline in the same way as in the Map views.
MindView enables you to spread your printout on several pages, which is very useful in the case of
timelines. Increasing the horizontal page spread number, for instance, will allow you to create a
legible printout of your entire timeline, spread over several pages.
For a full description of the printing options, see "Printing a mind map".
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Outline view
Using the Outline view
The Outline view represents the map as a hierarchical list which you can expand and
collapse as required. It allows easy navigation through the document from top to bottom and gives
you another way to brainstorm ideas.
It is particularly useful when building a task list, as you can view all the task properties in one
glance and edit them quickly by clicking the relevant cell.

Accessing the Outline view
You can access the Outline view in different ways:
To create a new outline from scratch, click the File tab and choose New | Outline.
To display an existing map in outline form in the Outline view, you can either:
Choose Home | View | Outline or View | View | Outline in the main menu, or
Right-click the workspace and choose View Map as Outline in the local menu, or
Press Ctrl + Shift + 5.

Going to the Outline view from another view only affects the way the mind map is displayed. The
contents of the mind map are not modified, unless you edit them yourself while working in the
Outline view.
You can quickly switch map views by right-clicking the workspace and selecting the desired
view in the floating toolbar that appears above the right-click menu.

Elements of the Outline view
The Outline view shown above is made up of several columns:
A bookmark icon in the first column indicates that the branch has been singled out using the
Bookmark feature so that you can locate it quickly again within your map. For more information
about this feature, see "Viewing a mind map".
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A picture icon
in the next column denotes the presence of a branch picture. Just move the
pointer over the icon to see a preview of the picture. Double-click the icon to display the picture
in the image viewer associated with its file extension on your computer.
A yellow comment icon
in the next column indicates that the corresponding branch contains
a pop-up comment. Just move the pointer over the icon to open the comment window.
A paperclip icon
in the next column indicates that the corresponding branch contains
attached objects (text notes, text files, video files and so on) or that it is linked to another
branch via a branch connection. To view an attached object, move the pointer over the icon to
display the pop-up list of attached objects and click the required object to open it in the
associated viewer.
If you have inserted one or more icons on the corresponding branch, these are shown in the
last column before the branch name.
By default, the columns on the right of the view show the Start and End dates you can
associate with the branch to describe a task, as well as its Priority, Completion level and
Resources. See "Inserting task data" for details about these fields.
If you are working on a project plan, a Duration column also appears, as well as columns
labeled Work and Cost. See "Using the Gantt view" for more information about project plans.
If you are working on a timeline, the columns on the right of the view show the Start Time and
End Time associated with each timeline event. See "Inserting timeline data" for details about
these fields.
You can hide and show the columns of the Outline view as you wish:
Click the Outline Tools tab.
Choose View | Columns.
Select or deselect the column headers as required.
You can also right-click the header at the top of the Outline view and select/deselect the column
headers as required.

Using the Outline
Changing the order of the columns
MindView lets you change the order of the columns by simply dragging and dropping them as
needed.
Click the header of the column you want to move, and hold down the left mouse button.
The mouse pointer changes shape

to indicate that the column can be moved.

While keeping the left mouse button down, drag the column left or right to the required location.

A vertical black bar indicates where the column will be inserted when you let go of the mouse
button.
Choosing a color scheme
MindView lets you apply different color schemes to your outline:
To choose a different color scheme, click the Design tab and check the effect produced by the
different options of the Color Scheme gallery before clicking your preferred option.
Inserting a branch
You can add and delete main branches, pre-branches and sub-branches in the Outline view in just
the same way as in the Map views.
Moving a branch
You can move an entire branch, including any sub-branches and objects attached to it, to a
different branch of your outline. As you work on organizing your ideas, you can for instance decide
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to convert a sub-topic to a main topic by moving the corresponding sub-branch to the root, or
allocate a sub-topic to a different main topic by moving the corresponding sub-branch to a different
main branch.
Select the branch you want to move to a different location by clicking it with the left mouse
button.
While keeping the left mouse button down, drag the branch to the required location.
The mouse pointer changes to a different shape to show you where the branch will be
inserted when you let go of the mouse button.
In the example below, dropping the "Planning" branch at the position shown in red by the
Move icon

will make it a sub-branch of the "Discussion" branch.

=>

Dragging the "Planning" branch to the left until the Move icon reaches the left dot will keep it
at the same hierarchical level (i.e. as sub-branch of "1st Issue") and insert it between
"Discussion" and "Problem solving".
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=>

You can also choose the Indent icon
of the Outline Tools tab (or press the keys Alt + Shift
+ right arrow) to move the selected branch or branches to the next level down in the hierarchy,
so that they become sub-branches of the preceding branch in the Outline.
Conversely, you can choose the Outdent icon
(or press the keys Alt + Shift + left arrow) to
move the selected branch or branches to the next level up in the hierarchy.
Finally, you can choose the Move Up
and Move Down
icons (or press the keys Ctrl +
Up or Ctrl + Down) to move the selected branch up or down within the same level.
Cutting, copying and pasting branches
You can apply the standard Cut, Copy and Paste functions to any branch or set of branches of your
outline, as described in "Moving a branch". You can for instance copy or move an entire branch or
set of branches, including all their sub-branches and attached objects, to a different part of the
outline, at the same hierarchical level or at a higher or lower level.
To perform these operations on a set of branches, you first need to select them:
To select a range of branches listed one after the other, select the first branch, press and hold
down the Shift key and select the last branch in the range.
To select several isolated branches, select the first branch, press and hold down the Ctrl key
and select the other branches one by one.
Adding objects and elements
You can add branch pictures, icons, text notes, audio notes and pop-up comments on a branch in
the same way as in the Map views. For more information on these procedures, see the topics
"Inserting pictures", "Inserting icons", "Inserting text notes" and "Inserting comments" in the "Basic
tasks" section.
You can also attach objects such as text files, video files, sound files, hyperlinks and so on just as
in the Map views. For more information, see "Attaching objects" and "Creating hyperlinks".
There are however some limitations that apply when you work in the Outline view:
You cannot add or view floating pictures.
You cannot add or view floating comments.
You cannot create branch connections, although existing branch connections are listed in the
pop-up list identified by the paperclip icon and can be activated from that list.
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Viewing the Outline
You can choose the text size to be used in the Outline view by clicking one of the Text Size
icons of the Outline Tools tab.

You can show or hide the text notes associated with each branch in the outline itself by
choosing View | Show Text Notes in the Outline Tools tab. Longer text notes can be scrolled
up and down by clicking the small icons
shown at the bottom of the note.
You can expand or collapse a particular branch or set of branches by clicking the small plus
and minus
signs on the left of the branch name or by pressing the keys Ctrl + right arrow to
expand and Ctrl + left arrow to collapse.
The Numbering Scheme icon
of the Outline Tools tab or Home tab lets you apply
sequential numbers to the branches of the outline and choose between various numbering
styles.
As in all the other views, the Detail Level icons
of the View tab let you collapse the entire
outline to just one level of branches, two levels, three levels or four levels. To show all the
branches down to the last level, click the Show All Levels icon .
You can also press Ctrl + 1 to display just one level of branches, Ctrl + 2 to show two
levels etc. Ctrl + 5 shows all levels.
As in the other views, you can use the Apply Branch Focus icon
of the View tab to restrict
the display to a particular branch. Click the Clear Branch Focus icon
to view the entire
outline again.
For more information about this procedure, see the topic "Focusing on a branch" of the
"Further tasks" section.
Finally the Filter icon
of the View tab lets you hide all the branches of the outline that do not
meet the filter criteria you have defined. You can also use the Highlight icon
to highlight
branches that meet the filter criteria but still keep the rest of the branches visible.
For more information about this procedure, see the topic "Filtering a mind map" of the
"Further tasks" section.

Printing the Outline
You can print your outline in the same way as in the Map views.
For a full description of the printing options available, see "Printing a mind map".
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Gantt view
Using the Gantt view
The MindView Gantt view is dedicated to the creation, editing and management of project
plans according to the rules of project management.
A project plan is a series of interdependent tasks that need to be performed in a particular order.
When moving into a new office for instance, you cannot start redesigning the office space before
the lease agreement has been signed. Project plans have a specific start date, corresponding to the
start of the first task (for instance defining the requirements for the new office), and a specific end
date, corresponding to the end of the last task (for instance moving in).
Any change in the timing of a task affects all the tasks that depend on it. If a task runs ahead of
schedule, MindView automatically recalculates the dates of all the tasks that depend on it in order
to take advantage of the time gained. Conversely, if a task is delayed, all the tasks that depend on it
are automatically rescheduled, which may or may not impact the overall end date of the project.
In project management, the Gantt chart is the most common and popular way of visualizing a
project plan. It shows the tasks as horizontal bars, arranged against a background calendar display.
MindView's Gantt view displays the branches of a mind map in this way, each branch or sub-branch
representing a project task.
The date formats you see in MindView will depend on your computer's settings. In this
documentation we use the most common international format, putting the day first, for example 1Sept-2020, or 01/09/20.

By using the Gantt view you can build and manage complete project plans in this standard, welldefined format. You can easily add or remove tasks, set or adjust the duration of tasks (length of
bars), link tasks (for example to make one task follow immediately after another), and add
constraints (for example to specify that a task must end no later than a given date).
To help you get started, MindView includes various ready-made project plans for common business
activities (organizing a tradeshow, producing a publication, launching a product and so on). You
can use these for training purposes, or as a basis for your own project plans.
To access one of these templates, click the File tab, choose New | New from Template, and
browse through the Business category.
To find out how to set up and build a project plan, see "Setting up a project plan".

Accessing the Gantt view
You can access the Gantt view in different ways:
To create a new Gantt project plan from scratch, click the File tab and choose New | Gantt.
To display an existing document in the Gantt view, you can either:
Choose Home | View | Gantt or View | View | Gantt in the main menu, or
Right-click the workspace and choose View Map as Gantt in the local menu, or
Press Ctrl + Shift + 6.
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You can quickly switch map views by right-clicking the workspace and selecting the desired
view in the floating toolbar that appears above the right-click menu. The floating toolbar also
contains other options relevant to the selected view.

Going to the Gantt view automatically converts the document to a Gantt project if this is not the
case already. The main consequences of this are:
All parent branches become summary tasks: their start dates, end dates and durations are
calculated automatically from their sub-tasks and cannot be edited manually any longer. Any
existing time information associated with parent branches is lost.
Tasks are only scheduled during working time, as defined by the project calendars.
Project plans have other important rules regarding links and constraints that are all described in the
following topics.
When you are working on a project plan, these project management rules apply even if you switch
temporarily to another view than the Gantt view, for instance to brainstorm your plan in one of the
Mind Mapping views, or to view it as a timeline in the Timeline view. This means that any change
you make to the project plan tasks while in one of these other views will obey project management
rules.

Elements of the Gantt view
As all the other views, the Gantt view is made up of several components:
The Gantt Outline
This area, shown on the left of the Gantt view, presents all your project tasks as a hierarchical
list which you can expand and collapse as required.
The tasks are listed in creation order, which means that if you created them in a different view
such as the Mind Map view, they will be listed in the Gantt Outline in the same order as in the
Mind Map view (going clockwise from the top right), rather than in chronological order.
The Gantt Chart
The Gantt chart, shown on the right of the view, represents each project task graphically as a
bar stretching from its start date to its end date. Week-ends and other non-working days are
denoted by a hash pattern. Task relationships are represented by links joining the related
tasks.
The Task/Timeline Panel
This panel is displayed on the right of the workspace. It gives you an alternative way of
specifying task data such as duration, priority, completion level or resources.
The Task/Timeline panel is described in detail in the topic "Inserting task data".
If it is not visible, click the Task/Timeline tab on the right of the workspace or choose
View | Show/Hide | Panels | Task/Timeline Panel.
The Gantt Tools Tab

This toolbar appears as soon as you switch to the Gantt view. Its icons allow you to perform
various actions on your project tasks, as described in the next few topics.

Using the Gantt Outline
The Gantt Outline is made up of several columns. Some of these only appear if one or more of the
project tasks contains the corresponding element:
The first column is the Entry column. It shows the unique entry number automatically allocated
to each task. The entry numbers do not necessarily represent the order in which the tasks will
be performed.
187

A bookmark icon in the next column indicates that the branch has been singled out using the
Bookmark feature so that you can locate it quickly again within your map. For more information
about this feature, see "Viewing a mind map".
A picture icon
in the next column denotes the presence of a branch picture. Just move the
pointer over the icon to see a preview of the picture. Double-click the icon to display the picture
in the image viewer associated with its file extension on your computer.
A yellow comment icon
in the next column indicates that the corresponding task contains a
pop-up comment. Just move the pointer over the icon to open the comment window.
A paperclip icon
in the next column indicates that the corresponding task contains attached
objects (text notes, text files, video files and so on) or that it is linked to another task via a
branch connection. To view an attached object, move the pointer over the icon to display the
pop-up list of attached objects and click the required object to open it in the associated viewer.
If you have inserted one or more icons on the corresponding branch, these are shown in the
next column.
The Gantt Outline also contains columns that are specific to project management:
Indicators: If you have applied a constraint to a task, for example to specify that it must end no
later than a given date, a constraint icon
is displayed in the column immediately before the
Task Name column. Constraints are described in detail in "Using Constraints".
If you have made a task inactive to prevent it from affecting the scheduling of the project, the
is displayed in this column. For more information about inactive tasks, see "Making a task
inactive" in the topic "Enhancing a project plan".
Task Mode: This column shows whether a task is scheduled automatically
or manually .
You can switch task mode for a task by clicking the icon in this column and selecting a different
mode on the drop-down list.
This topic assumes that the tasks of your project are scheduled automatically. For
information about manual task scheduling, see "Using scheduling task modes".
Task Name: The name of each task. Tasks that contain one or more sub-tasks are shown in
bold. These tasks (which correspond to parent branches in the Mind Map view) are called
"summary tasks". Ordinary tasks (corresponding to branches without sub-branches in the Mind
Map view) are shown in normal typeface and indented according to their level. See the
paragraph "Grouping tasks" in "Entering and editing tasks".
Duration: The amount of working time the task will take. Time units are indicated by letters:
mins (minutes), hrs (hours), days, wks (weeks), mths (months). The letter e before the time unit
indicates elapsed time, in which case the task will last exactly the time specified, regardless of
what the project calendar defines as working and non-working time. A question mark means
that the figure is still an estimate. By default, MindView assigns a duration of one day to new
tasks or tasks without specified duration. For more information about calendars, see "Defining
calendars".
The task bar of a summary task is automatically set to extend from the beginning of the
earliest of its sub-tasks to the end of the last of its sub-tasks. You cannot change the duration
of a summary task.
When expressed in days, weeks or months, the number shown in the Duration column
(for instance "2 days") is linked to the default number of working hours per day, week of
month set in the Project Calendars Settings dialog (choose Gantt Tools | Project | Project
Calendars).
For more information about durations, see "Entering a task duration" in the topic "Entering
and editing tasks".
Start: The current start date of the task. By default, MindView schedules new tasks to start on
the project start date, as defined in the Project Information dialog (choose Gantt Tools |
Project | Project Information).
Although you can set start dates explicitly, it is best to let MindView set them automatically
according to the dependencies between the various tasks. See "Specifying start and end
dates" in the topic "Entering and editing tasks" for more information.
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The start date of a summary task is automatically set to be the start date of the earliest of its
sub-tasks.
End: The current end date of the task. MindView calculates the end date for a task from its start
date and its duration, paying attention to the working and non-working time specified by the
project calendar. Unless the duration is specified as "elapsed", MindView only schedules tasks
during working time. For more information about calendars, see "Defining calendars".
Although you can set end dates explicitly, it is best to let MindView set them automatically
according to the dependencies between the various tasks.
The end date of a summary task is automatically set to be the end date of the last of its subtasks.
Predecessors: If a task is linked to one or more earlier (predecessor) tasks, this column shows
the entry numbers of those earlier tasks. Task entry numbers are shown in the first column.
See "Using links" for more information on task dependencies.
Completion: The completion level of the task.
Priority: The priority level of the task.
Resources: If you have assigned resources to a task, they are listed in this column. See
"Assigning resources".
Work: If you have assigned resources to a task, this column shows the overall work value for
the task. See "Assigning resources".
Cost: If you have assigned resources to a task and associated a cost with these resources, this
column shows the overall cost of the resources that have been allocated to the task. See
"Assigning resources".
You can hide and show the columns of the Gantt Outline as you wish:
Click the Gantt Tools tab.
Choose View | Columns.
Select or deselect the column headers as required.
You can also right-click the header at the top of the Gantt Outline view and select/deselect the
column headers as required.
The Gantt Outline works exactly as the main Outline view. When working in the Gantt Outline, you
can for instance:
Add, delete, move, cut, copy and paste tasks in exactly the same way as in the main Outline
view.
Add branch pictures, icons, text notes, audio notes and pop-up comments to any of your
branches.
Attach objects such as text files, video files, sound files, hyperlinks and so on.
Choose the text size to be used by clicking one of the Text Size icons of the Gantt Tools tab.

Use the Numbering Scheme icon
of the Gantt Tools tab or Home tab to apply sequential
numbers to the tasks and choose between various numbering styles.
Use the Detail Level icons
visible.

of the View tab to determine how many levels of tasks should be

Use the Apply Branch Focus icon
of the View tab to restrict the display to a particular task
and click the Clear Branch Focus icon
to view the entire project plan again.
Use the Filter icon
of the View tab to hide all the tasks that do not meet the filter criteria you
have defined. You can also use the Highlight icon
to highlight branches that meet the filter
criteria but still keep the rest of the branches visible.
For details on how to perform these operations, see "Using the Outline view".
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Viewing the Gantt Chart
You can manipulate the timescale shown at the top of the Gantt chart to view your tasks with more
or less detail as follows:
Click the Zoom In icon
of the Gantt Tools tab (or press Ctrl + "+") to view your schedule in
more detail, going for instance from a Months/Weeks combination to a Days/Hours
combination.
Click the Zoom Out icon
(or press Ctrl + "-") to show larger increments of time, going for
instance from a Months/Weeks combination to a Years/Quarters combination.
Choose Fit All
or press F4 to let MindView choose the level of detail that allows the entire
project plan to fit on the chart.
You can also view your chart in full screen mode, to give it as much screen space as possible:
Choose View | Zoom | Full Screen

or press F9.

To return to normal viewing mode, choose Close Full Screen in the floating Full Screen
toolbar, press Esc or press F9 again.
You can also choose from a wider variety of combinations of calendar headings as follows:
Double-click the headings (tiers) at the top of the calendar display to open the Gantt Timescale
dialog.

Choose a unit and a label for the top tier (the top heading).
Choose a unit and a label for the bottom tier (the bottom heading).
Note that the choices offered for the bottom tier depend on your choice of top tier.
If the task you want to view falls outside the time range shown on the Gantt chart, you can reveal
that part of the project plan to view the relevant task bar as follows:
Select the task in the Gantt Outline and click the Go to Selected Task icon
Tools tab.

on the Gantt

To view the Gantt chart from the current date onwards, click the Go to Today's Date icon
the Gantt Tools tab.
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Customizing the Gantt Chart
MindView lets you define the visual aspect of your overall Gantt, as well as customize the display of
individual task bars.

Customizing the overall display
To choose a different color scheme for the entire chart, click the Design tab and check the
effect produced by the different options of the Color Scheme gallery before clicking your
preferred option.
(optional) Undo your changes and return the entire chart to the initial style by choosing Effects |
Reset Style.
The Design tab also lets you apply other global effects to the Gantt chart:
To display the task name and/or the resources names after the task bars, check Show/Hide
Task Name and/or Show/Hide Resources.
The Horizontal Grid and Vertical Grid option let you switch the horizontal and vertical grid
lines of the Gantt chart on and off.
To display a vertical line identifying the current date on the Gantt chart, click View | Show
Today's Date on the Gantt Tools tab.
You can change the color of this line in the Properties dialog. See "View properties:
General tab" for more information.
Finally, you can also change the color used to identify the tasks lying on the critical path (View |
Show Critical Path in the Gantt Tools tab) as well as the height of task bars, summary bars
and milestone bars in that same Properties dialog.
Customizing the task bars
The Design tab also lets you modify the shape, fill color, outline color and fill pattern of both
summary task bars and standard task bars in one operation:
Click the Design tab at the right of the ribbon.
Browse through the options shown in the Standard Tasks and Summary Tasks panels to
choose your preferred style.
If you need to distinguish some tasks from others, you can also customize them individually:
Select the task(s) to customize.
Click the Format tab and choose the relevant options.
If necessary, you can undo your changes and return the task bar to the original style defined
in the Design tab by choosing Reset Style.

If you have chosen to display the task name and/or the resource names after the task bars, you can
set different colors for these labels by using the Properties dialog.
For other ways of customizing the representation of your project plan on the Gantt chart, see
"Enhancing a project plan".
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Setting up a project plan
These are the typical steps you should follow when setting up, building, managing and revising a
project plan.
(optional) Start by brainstorming all the tasks that make up your project plan in one of the
standard Mind Mapping views (Mind Map, Top Down or Left/Right), using the Task/Timeline
panel to enter preliminary task data.
Define the project settings, such as its start date, end date and scheduling mode. For more
information, see "Defining the global project settings".
(optional) Define the project calendar. You may be able to bypass this step if you have already
set up appropriate calendar defaults. See "Defining calendars" for more information.
(optional) Create the global resources list. Although MindView lets you define the resources as
you need them, it is usually quicker to start by setting up a global resources list from which you
can then select resources to assign to the various project tasks. See "Assigning resources" for
details.
Enter or edit task names and durations. See "Entering and editing tasks".
Assign resources to tasks. See "Assigning resources".
Create links to specify the dependencies between the project tasks. See "Using links".
Set constraints on the tasks as necessary. See "Using constraints".
Make final adjustments to the project plan, and save a baseline for future use. See "Enhancing
a project plan".
Once the project has actually started, inspect it at regular intervals to detect potential problems
or scheduling conflicts and make any corrections required. See "Reviewing a project plan".
(optional) If you need to expand your project plan further, you can easily export it to Microsoft
Project to take advantage of the advanced project management capabilities of this application.
For more information, see "Exporting to Microsoft Project".
You can also create various HTML reports from your project plan, export it to Microsoft Outlook
as a series of tasks or export it in XML format. For more information, see "Creating project
reports" and "Exporting a project plan".
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Defining the global project settings
Before doing detailed scheduling work on the tasks of your project plan, it is worth
considering its global settings, such as its start date and scheduling mode.
To view these settings, choose Project | Project Information on the Gantt Tools tab.

This dialog contains general project information which is important in determining how the project
tasks are scheduled.
Schedule from: Defines the scheduling mode for your project. The most common way of setting up
a project is to schedule it from its start date. In this mode the default is for tasks to start as soon as
possible, which means that the whole project finishes at the earliest possible date. When you plan
backwards from the project end date, tasks are scheduled to start as late as possible so that the
whole project finishes on the specified end date. Planning from the end date is not recommended
as it does not allow any slack time between tasks. Even when you have a specific deadline for your
project, planning from the start date is the most flexible approach as it ensures that each task is
completed at the earliest possible date, leaving as much slack time as possible to deal with
unplanned problems or delays.
Start date: Specifies the first day of the first task. By default, this field is set to today's date. If your
project is due to start sometime in the future or if you are planning a project that has in fact already
started, indicate the start date of the project in this field.
By default, all the tasks you create will be scheduled to start on the project start date, unless you
assign specific timings to them or link them to other tasks.
If you are scheduling from the start date, MindView calculates the project end date automatically,
based on the duration of the project tasks, their relationships, and the project calendar.
End date: Specifies the last day of the last task. If you are scheduling from the end date, MindView
calculates the start date automatically, also by taking into consideration the duration of the project
tasks, their relationships, and the project calendar.
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Defining calendars
Calendars and calendar settings provide the basic information about working and nonworking time that MindView uses to schedule the tasks of a project plan. MindView does not allow
work to happen on non-working days or at non-working times.
There are three types of calendar:
The default calendar
The default calendar provides the initial settings for any new MindView project you create. By
editing these defaults to values reflecting your company's normal working days and times, you
can minimize the changes needed when you create a new project plan.
The project calendar
Each project plan has its own project calendar. The settings it contains affect the way
MindView schedules the project tasks. To start with, when you create a new file, the project
calendar is identical to the default calendar.
The project calendar is saved with the rest of the project properties whenever you save the
file.
The resource calendars
These control the working and non-working time of the resources working on the project.
Each resource has its own calendar. By default, they are identical to the project calendar.
Any changes you make to the project calendar are automatically transferred to all the
resource calendars. However, specific changes you might have made to the working time of a
particular resource are preserved.
For more about resources and resource availability, see "Assigning resources".
Resource calendars are not taken into consideration by manually scheduled tasks. For
more information about manual task scheduling, see "Using scheduling task modes".

Editing the default and project calendars
You can edit either calendar together with the relevant settings:
To edit the default calendar, click the File tab, choose Options and open the Calendar panel.
Changes you make here only affect the initial settings for new files; they do not affect existing
files.
To edit the project calendar, choose Project | Project Calendars on the Gantt Tools tab.
Changes you make here only affect the current file.
The two dialogs are almost identical: all the options are described below, but only the project
calendar dialogs are illustrated.
Defining the calendar settings
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Hours per day: Defines the number of working hours in a standard working day, for example 8.
You can enter the value as a decimal number (e.g. enter 7.5 to specify 7 hours and 30 minutes).
MindView uses this value to calculate task durations that are specified in days.
Advanced notes: This setting and the next two settings determine the amount of working
time that MindView allocates to a task when you specify a duration in days, weeks or months.
When you enter durations, MindView always converts them to minutes and that is the number
it stores behind the scenes. MindView uses standard values to convert hours to minutes: one
hour equals 60 minutes. However when you specify a duration in days, weeks or months
(provided you have not specified "e" for elapsed) MindView uses the number of working hours
per day, week or month defined here to calculate the corresponding number of minutes to
store.
From the working days and working times allowed by the project calendar it then works out
the number of days required for the task and calculate its end date. For this reason, it is a
good idea to make sure that the values you choose here match the working time allowed by
the calendar as closely as possible, as it will make the entries in the Duration column of the
Gantt Outline match the lengths of the task bars more closely.
Redefining these settings after having entered tasks does not alter their real durations (since
they are stored in minutes) or the lengths of the task bars (since the amount of work has not
changed), but the numbers for days, weeks and months in the Duration column will change.
For more information about durations, start dates and end dates, see "Entering and editing
tasks".
Hours per week: Defines the number of working hours in a standard working week, for example
40. You can enter the value as a decimal number. MindView uses this value to calculate task
durations that are specified in weeks.
Days per month: Defines the number of working days in a standard working month, for example
20. Enter a whole number value. MindView uses this value to calculate task durations that are
specified in months.
Modifying the calendars
Click Project Calendars in the Project Calendars Settings dialog to access the calendar itself
(or Default Calendar in the Calendar panel of the MindView Options if you are viewing the
default calendar settings).

Working days are shown in white and non-working days are shown in grey.
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In the project calendar, a red dot on a particular day indicate that the working hours for that day
are different from those set in the default calendar.
In the default calendar, a red dot indicates that you have made a change to the working hours
of that day since opening the dialog. These red dots disappear as soon as you save the default
calendar.
Note that the distribution of red dots in your project calendars may change if you edit the default
calendar. This does not mean that your project plans have changed, only that the differences
between the default and project calendars have changed.
To see the working hours for a particular day, select the day by clicking it.
The working hours appear in the boxes on the right of the calendar grid.

Displaying a particular day
If the day you want to examine is not currently visible on the calendar grid, you can browse to it in
several ways by using the calendar header:

Click the arrows placed on each side of the header until the correct month and year appear.
Click the year on the header and use the up and down arrows to reach the correct year.
Click the month name on the header and choose the correct month in the drop-down list.

Selecting one or more days
To change the working times defined by the calendar, start by selecting the day or days to be
modified:
To select one day only, just click it.
To select several contiguous days, select the first day and drag the mouse until the last day in
the range. You can also select the first day, press the Shift key and click the last day in the
range.
To select several non-contiguous days, select the first day and press the Ctrl key while
selecting all the other days.
To select all Fridays (for example), click F in the column header. This selection applies to the
whole duration of the project, not just the displayed month. You can select several columns by
Shift- or Ctrl-clicking them.

Editing one or more days
Select one or more days as described above.
If you select several days with different working hours, the boxes on the right show the working
hours of the earliest day in the range.
You can now make changes:
To change the working hours, enter new values in the boxes on the right.
To make the day(s) non-working, click Clear to delete the time entries from the boxes.
To reset the working times to the default calendar values, select "Set selected days as default".

Saving and restoring defaults
To save the current project calendar as the new default calendar, open the Project Calendars
dialog and click Save as Default. Your existing default calendar will be overwritten.
To return all project calendar settings to those of the default calendar, open the Project
Calendars dialog and click Restore Default.
You can return the default calendar to the original MindView settings as follows:
Open the Default Calendar dialog (click the File tab, choose Options and open the Calendar
panel).
Click Import Calendar.
Browse to:
C:\Program Files\MatchWare\MindView 6.0\UserData\Gantt
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Select the file default.xml.
Your current default calendar is overwritten with the original MindView default calendar.
Click Save from the Default Calendar dialog to save the restored default calendar.

Importing and exporting calendars
You can also import calendars from other projects or export your calendars for use by colleagues.
To import a previously saved MindView calendar, click Import Calendar. Existing settings will
be overwritten.
You can also import the calendar of an existing Microsoft Project document by exporting
that document to XML from Microsoft Project, then choosing the exported XML document in
this dialog.
To export your current calendar for use on a different project for instance, click Export
Calendar.
When exported, the MindView calendar is saved the MindView XML format.

Editing resource calendars
Use the drop-down list at the top of the Project Calendars dialog to select the calendar of the
resource you want to edit.
Make the changes required. The steps to follow to edit a resource calendar are exactly the
same as for the project calendar.
For more about resources and resource availability, see "Assigning resources".
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Entering and editing tasks
When working in the Gantt view, you can use the Gantt Outline to work on tasks exactly as in
the main Outline view. You can for instance:
Add, delete, move, cut, copy and paste tasks as in the main Outline view.
Add branch pictures, icons, text notes, audio notes, and pop-up comments to any of your tasks.
Attach objects such as text files, video files, sound files, hyperlinks and so on.
Use the Numbering Scheme icon
of the Gantt Tools tab or Home tab to apply sequential
numbers to the tasks and choose between various numbering styles.
Use the Detail Level icons
visible.

of the View tab to determine how many levels of tasks should be

Use the Apply Branch Focus icon
of the View tab to restrict the display to a particular task
and click the Clear Branch Focus icon
to view the entire project plan again.
Use the Filter icon
of the View tab to hide all the tasks that do not meet the filter criteria you
have defined. You can also use the Highlight icon
to highlight tasks that meet the filter
criteria but still keep the rest of the tasks visible.
For details on how to perform these operations, see "Using the Outline view".
You can also create the tasks of your project plan in other ways:
By importing a task list from Microsoft Outlook and converting it to a project plan.
For more information on the import procedure, see "Importing from Microsoft Outlook".
By importing a project from Microsoft Project, either directly or via the Microsoft Project XML
format.
For more information, see "Importing from Microsoft Project" and "Importing from XML".
By copying a list of tasks from an external application such as Microsoft Excel, Microsoft Word
or Microsoft Project and pasting it into the Gantt Outline.
By default, all tasks that you create in a Gantt project with MindView are given the scheduling
task mode Automatic Scheduling and the scheduling task type Fixed Units. For more information
about task modes and task types, see "Using scheduling task modes" and "Using scheduling task
types". You can change these default settings from the MindView Options dialog; for more
information, see "Setting up your preferences".
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Entering a task duration
By default, automatically scheduled tasks have a duration of one day and are marked with a
question mark, to indicate that the duration is only an estimate. As soon as you edit the duration,
the question mark disappears.
You can modify the duration of a task in various ways:
On the Gantt chart, position the cursor at the end of the task bar until it changes to
the end of the bar to the right or left.

, and drag

In the Gantt Outline, type a number of days in the appropriate cell in the Duration column. You
can follow the number with letter(s) to indicate time units other than days: m (minutes), h
(hours), d (days, the default), w (weeks), mo (months). You can enter the letter e before the
time unit (for instance "3ed") to indicate elapsed time, in which case the task will last exactly the
time specified, regardless of what the project calendar defines as working and non-working
time.
You can indicate that a duration is still an estimate by adding a question mark.
Select the task and choose View | Task Information
on the Gantt Tools tab to open its Task
Information dialog. Enter a value in the Duration field as described above.
You can also open the Task Information dialog by pressing Shift + F2 or by doubleclicking the task bar on the Gantt chart.
Select the task and, in the Task/Timeline panel, enter a value in the Duration field as described
above.
The duration of the task is now indicated on the Gantt chart by a bar extending from its start date to
its end date.
If you are using manually scheduled tasks, you can also enter free text in the task Duration
fields (for instance "a few days") or Start/End fields (for instance "tomorrow") in addition to the
values and time units described above. For more information about manual task scheduling, see
"Using scheduling task modes".
At this stage, although the task has a duration, it does not have any work associated with it,
because you have not yet assigned any resources to it. Work represents the amount of effort the
resource or resources will need to spend on the task to complete it. For more information about
work, and the effect of adding resources to tasks, see "Assigning resources".
Advanced notes: When you enter durations, for example "4 hours", MindView converts them to
minutes and that is the number it stores behind the scenes. MindView uses standard values to
convert hours to minutes: one hour equals 60 minutes. However if you specify a duration in days,
weeks or months (provided you have not specified "e" for elapsed) MindView uses the number of
working hours per day, week or month set in the Project Calendars Settings dialog (choose Project |
Project Calendars on the Gantt Tools tab), to calculate the corresponding number of minutes to
store. See "Defining calendars" for more information about these settings.
While durations determine the amount of working time that you allocate to a task, the length of the
task bar indicates how long the task will actually take. These are not necessarily the same. For
example, because MindView does not schedule work on non-working days, any task bar spanning
a week-end is automatically lengthened to take account of this. Similarly, if your working day is
specified as having 8 hours, but the relevant section of the calendar restricts work to only 4 hours a
day, a task with a duration of one day (8 hours) will actually take two days (4 hours each day) to
complete.
The labels shown in the Duration column, for example "2 days", are calculated from the stored
number of minutes for each task. For durations initially specified in days, weeks or months
MindView uses once more the number of working hours per day, week or month set in the Project
Calendars Settings dialog to convert the stored number of minutes back to days, weeks or months.
Consequently if you redefine the number of working hours in a day, week or month set in that
dialog, the numbers in the Duration column will change, but the underlying number of minutes, and
consequently the length of the bars, will remain the same.
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Specifying start and end dates
Although you might be tempted to enter specific start and end dates for your tasks, it is not
recommended unless you understand the implications of doing so. A better practice is to link tasks
so that they follow on logically from one another, and let MindView calculate the dates
automatically. In MindView and similar project management applications, entering an explicit start
date for an automatically scheduled task is equivalent to setting a 'Start No Earlier Than' constraint.
Similarly, entering a specific end date is equivalent to setting a 'Finish No Earlier Than' constraint.
Although applying constraints in this way is perfectly legitimate if your tasks must indeed obey these
constraints, it is best to avoid them wherever possible as they limit the flexibility of your project plan.
For more information on the different types of constraints and their effects, see "Using Constraints".
If you want to be able to enter start and end dates freely on your tasks, without MindView
applying constraints to them automatically, you can change the mode of these tasks from being
automatically scheduled to being manually scheduled. For more information on manual task
scheduling, see "Using scheduling task modes".
You can enter a specific start date in different ways:
Move the cursor to the center of the task bar and drag the bar to the new position.
Click the Start entry of the task in the Gantt Outline and type or select a date.
Select the task. On the Task/Timeline panel, select a date in the Start date field.
Select the task and choose View | Task Information
Information dialog. Select a date in the Start field.

on the Gantt Tools tab to open its Task

You can also open the Task Information dialog by pressing Shift + F2 or by doubleclicking the task bar on the Gantt chart.
You can enter an end date in the following ways:
Click the End entry of the task in the Gantt Outline and type or select a date.
Select the task. On the Task/Timeline panel, select a date in the End date field.
Select the task and choose View | Task Information
Information dialog. Select a date in the End field.

on the Gantt Tools tab to open its Task

If you are using manually scheduled tasks, you can also enter free text in the task Duration
fields (for instance "a few days") or Start/End fields (for instance "tomorrow"). For more information
about manual task scheduling, see "Using scheduling task modes".
When you enter a specific start or end date for an automatically scheduled task, a constraint
icon
appears next to the task name in the Gantt Outline. Hovering this icon with the mouse
displays a tooltip with details about the constraint.
To remove the constraint set by entering an explicit start or end date:
Open the Task Information dialog and remove the check mark from the Constraint date field.

Specifying a fixed cost for a task
The cost of a task will often depend on the resources assigned to the task. For example, the cost
may depend on the number of working hours spent, or on the amounts of raw materials such as
timber or paint used to accomplish a given task. However, MindView also gives you the option of
specifying a fixed cost for tasks that do not depend on resources. For example, if a subcontractor
has quoted a fixed cost for work to be performed on the project, or if the cost of a task is otherwise
known in advance, this amount could be entered as a fixed cost.
For more information on assigning resources to your project, see "Assigning resources".
You can specify a fixed cost in two ways:
Enter the fixed cost in the Fixed Cost column of the Gantt outline. The Fixed Cost column is not
displayed by default; for more information on showing and hiding columns in the Gantt outline,
see "Using the Gantt view".
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or
Enter the cost in the Cost column without having any resources assigned. The cost is
automatically copied to the Fixed Cost column.

Grouping tasks
You can group tasks together by creating sub-tasks under a parent task, called a summary task.
This allows you to divide your project into logical units, each with its own collection of tasks. The
start dates, end dates and durations of summary tasks are calculated automatically from their subtasks.
A summary task is indicated on the Gantt chart by a solid bar extending from the beginning of the
first sub-task to the end of the last one.

If you add sub-tasks to a task that already has a duration assigned to it, this assigned duration is
automatically replaced by the new duration obtained from the sub-tasks. Once a task becomes a
summary task, it is no longer possible to specify its start date, end date or duration manually. If you
change the timing of a sub-task, the summary task duration is automatically adjusted to reflect the
change. If you want to be able to set the start date, end date or duration of your summary tasks
freely, independently from the timing of their sub-tasks, you can change the mode of these
summary tasks to be manually scheduled. For more information about manual task scheduling, see
"Using scheduling task modes".
The duration of a summary task is the number of available working days between its start and its
end, regardless of whether work is actually happening on any given day. The figure is calculated
from the available working hours between the two dates, as specified on the project calendar, and
the 'Hours per day' figure set in the Project Calendars Settings dialog. For more information about
calendar settings, see "Defining calendars".
Sub-tasks are sub-branches, and you create them in the Gantt view in the same way as in any
other view. The parent task is converted automatically to a summary task when you add its first
sub-task.
You can convert an existing task to a sub-task or move it to a different level in the task hierarchy
just as in the Outline view:
Select the task you want to move to a different location by clicking it with the left mouse button.
While keeping the left mouse button pressed, drag the task to the required location.
The mouse pointer changes to a different shape to show you where the task will be inserted
when you let go of the mouse button.
In the example below, dropping the "3.c" task at the task position shown in red by the Move
icon

will make it a sub-task of the task "3.a".

Dragging the "3.c" task to the left until the Move icon reaches the left dot will keep it at the
same hierarchical level (i.e. as sub-task of "3. Analyze" task) and insert it between the "3.a"
and "3.b" tasks.
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You can also click the Indent icon
of the Gantt Tools tab (or press the keys Alt + Shift +
right arrow) to move the selected task or tasks to the next level down in the hierarchy, so that
they become sub-tasks of the preceding task in the Gantt Outline.
Conversely, you can click the Outdent icon
(or press the keys Alt + Shift + left arrow) to
move the selected task or tasks to the next level up in the hierarchy.
The root of the mind map, the first task in the Gantt Outline, is a summary task extending across
the whole of the project plan. The end of this summary task bar indicates the current end date of
the project.
You can expand and collapse summary tasks just as in the main Outline view. See "Using the
Outline view" for details. Collapsing summary tasks is a useful way of making large project plans
easier to view.

Specifying other task properties
The tasks of your project plan can have many other properties. You can for instance:
Define the task as a milestone.
Set a deadline on the task.
Give the task a priority.
Specify a percentage completion for the task.
Hide the task bar in the Gantt chart.
Make the task inactive.
All these operations are described in detail in "Enhancing a project plan".

Assigning resources
MindView allows you to assign resources to your task lists and project plans. Resources are
the people and materials needed to complete the tasks to be performed.
MindView lets you define two types of resources:
Work resources
Work resources are the people who perform the work.
For each work resource, you can define their availability (i.e. how much of their working day
they can devote to it), and their rate (i.e. how much they will need to be paid per unit of work).
Work resources also have their own calendar, defining their working and non-working
time. By default, resource calendars are identical to the project calendar. For more
information, see "Defining resource calendars" below.
Material resources
Material resources are the consumable items (paper, electricity, nails, sand etc.) that you
need to carry out the project.
You can also associate a unit cost to each material resource, so that you can track the overall
cost of your project in human as well as in material resources.
If you are working on a simple task list in Task Management mode (i.e. when your document
type is set to "Task Management" in the Task/Timeline panel), all resources are assumed to be of
type Work, and you cannot define their availability or rate.
Adding resources to tasks when working in Task Management mode has no effect on the task
duration. If however you are working in Project Management mode (typically on a Gantt project),
adding resources to a task may affect its duration. For more information on this, see
"Understanding effort-driven scheduling" below.
All the resources used in your project are listed in the resource list for the entire project, called the
global resources list. Although it is usually quicker to start by setting up the global resources list,
from which you can then select the resources to assign to the different tasks, you can also create
resources as you need them by assigning them to tasks.
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Assigning resources to tasks
You can assign resources to a task as follows:
Select the task.
In the Task/Timeline panel, type the resource names in the Resources field, separating them
with semi-colons.
If the global resources list for the project already contains resources, a drop-down appears so that
you can select names from it.

Resources that are not already listed in the global resources list and that you create by entering
them in this way are assumed to be of type Work, i.e. human resources. Resources of type
Material need to be created in the global resources list, as described in "Setting up a global
resources list" below.
The resources you have entered above are now assigned to the task, and added to the global
resources list if they are not listed there already.
Where possible, it is better to select rather than type resource names. That way you don't run
the risk of adding wrongly spelled entries to the global resources list.
To de-assign a resource, simply delete it from the field. Note that this removes the resource from
the task, but not from the global resources list.
You can also assign resources to a task from its Task Information dialog:
Click the Resources button

to the right of the Resources field.
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Click an empty row in the Resources dialog and enter the resource by typing it or by selecting it
from the drop-down list.
(optional) If you also intend to use MindView for task distribution and task tracking, enter an
email address for the resource. To know more about these features, refer to "Exporting to
Microsoft Outlook task list" and "Managing and tracking tasks". This only applies to resources
of type Work (i.e. human resources).
Once entered, email addresses can only be edited by clicking Project Resources at the
bottom of the dialog to access the global resources list.
(optional) The Units field indicates how much of the resource's available time is being used to
work on the task. By default, resources are assumed to be able to devote 100% of their working
time on the task. If the resource is only available part of the time, for instance because they
also have other duties, specify here the percentage of their working time that they can spend
on the task. You can also enter a higher value, for instance 300% if your resource is a "virtual"
resource representing a group of three equivalent human resources.
The Units value is based on the availability of the resource as shown in its resource
calendar. By default, all resource calendars are identical to the project calendar. If however
you have modified the calendar of the resource to indicate a different work pattern, the units
value will be based on that modified resource calendar. For more about resource calendars,
see "Defining resource calendars" below.
If the resource is a material resource, enter the number of units that you will need for the task.
The Cost field is a calculated field which shows you the cost of the resource for that task. For
human resources (type Work), it is based on the unit percentage specified in Units, the cost
per unit of the resource (rate), and the duration of the task. For material resources (type
Material), it is based on the number of units and the cost per unit. As the field Cost is a
calculated field, it cannot be edited.
Note that the Cost field is not refreshed automatically when you edit the Units field. It is only
updated when you close the dialog.
To see how to specify the cost per unit of a resource, refer to "Setting up a global resources
list" below.
You can customize the symbol used to represent the cost, its placement and the number
of decimal digits used. For more information, see "Setting up your preferences".
The Units and Cost fields are only available when working in Project Management mode.
To de-assign a resource, select it and click Remove. Note that this removes the resource from the
task, but not from the global resources list.
If you are working on a project plan in the Gantt view, you can also enter resources in other ways:
Select the task and choose Tasks | Assign Resources

on the Gantt Tools tab.

Select the task and choose View | Task Information
on the Gantt Tools tab. Click the
Resources tab in the Task Information dialog that opens.
You can also open the Task Information dialog by pressing Shift + F2 or by doubleclicking the task bar on the Gantt chart.
Click the Resources cell of the task at the far right of the Gantt Outline. Type the resource
name(s), separating them with semi-colons.
Once associated to a task, you can view the details of a particular resource simply by doubleclicking its name in the Resources field of the Task/Timeline panel.

Setting up a global resources list
Although MindView lets you define the resources as you need them as we have just seen, it is
usually more efficient to start by setting up a global resources list from which you can then select
resources to assign to the various tasks.
The global resources list associated with a task list or project plan is saved whenever you save the
file. Each task list or project plan has its own global resources list.
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You can access the global list of available resources in different ways:
Click the Project Resources link at the bottom of the Task/Timeline panel.
Open the Task Information dialog of a task, click its Resources tab and click the Project
Resources button in its bottom left corner.
If you are working on a project plan in the Gantt view, choose Project | Project Resources on
the Gantt Tools tab.
The Project Resources dialog lists all the resources that are currently assigned to tasks, as well as
any that you import or type in directly.

To add a new resource to the list, click the first empty field and enter the resource name.
If you also intend to use MindView for task distribution and task tracking, enter an email
address for the resource. To know more about these features, refer to "Exporting to Microsoft
Outlook task list" and "Managing and Tracking Tasks". This only applies to resources of type
Work (i.e. human resources).
(optional) If you want to be able to track the overall cost of your project, you can specify the cost
per unit of the resource in the Rate field. Although the default time unit is h (per hour), you can
enter other time units: m (per minute), d (per day), w (per week), mo (per month), y (per year).
To specify a rate of $320 per day for instance, you would enter 320/d.

You can customize the symbol used to represent the rate, its placement and the number
of decimal digits used. For more information, see "Setting up your preferences".
(optional) By default, all resources are assumed to be of type Work, i.e. human resources. The
column Type lets you change the type of a resource from Work to Material.
The rate of a material resource is its cost per unit.
If you want to indicate a unit of measurement for a material resource (e.g. tons, cubic meters,
boxes, etc.) you can do so by clicking the Edit button and entering this information in the
Material label field of the dialog box that appears.
The Rate and Type fields are only available when working in Project Management mode.

205

The Project Resources dialog lets you perform other operations:
To view the total working hours and cost accumulated by each project resource, view the
entries in the Total Work and Total Cost columns. These columns are updated automatically
as you assign resources to project tasks.

To delete one or more resources, select them and click Delete.
Use the Shift key to select contiguous resources and the Ctrl key to select noncontiguous resources.
To import a previously exported global resources list, click Import and select the required list.
You can also import the resources list of an existing Microsoft Project document by
exporting that document to XML from Microsoft Project, then choosing the exported XML
document in this dialog.
To export the global resources list for use in other documents or for sharing with colleagues,
click Export, and choose a folder and file name for your exported list.
When exported, the global resources list is saved in the MindView XML format.
To import one or more resources from your Microsoft Outlook Address Book, click Address
Book, select the contact names you want to add as resources in the Outlook dialog, click the
Add button and click OK.
To import one or more resources from the Windows Active Directory database, click Active
Directory. In the dialog box that opens, click the Advanced button, then the Find Now button.
Select the user(s) you want to add as resources in the bottom part of the dialog, and click OK.
The Active Directory is a centralized database maintained by Windows to store information
relating to an organization's network (such as resources, services and users).
If you are working on an online document hosted on the MatchWare Shared Workspace,
clicking Shared Workspace will allow you to select resources from the list of registered users
of the workspace. For more information about the MatchWare Shared Workspace, see "Setting
up an online workspace".

Defining resource calendars
As soon as you create a new resource, MindView creates a resource calendar for it, defining the
working and non-working time of the resource. By default, resource calendars are identical to the
project calendar. If all your resources follow the work pattern defined by the project calendar, you
do not need to edit any of their calendars. If on the other hand some of your resources only work
part-time for instance, you can indicate this in their calendars, so that MindView can take this into
account when scheduling tasks to which they have been allocated.
Resource calendars are not taken into consideration by manually scheduled tasks. For more
information about manual task scheduling, see "Using scheduling task modes".
Any changes you make to the project calendar are automatically transferred to all the resource
calendars. However, specific changes you might have made to the working time of a particular
resource are preserved.
For more information about how to edit a resource calendar, see "Defining calendars".

Understanding effort-driven scheduling
Effort-driven scheduling is only relevant for automatically scheduled tasks. For information
about manual task scheduling, see "Using scheduling task modes".
Before you assign any resources to a task in a Gantt project, the task has no work associated with
it. It is the process of assigning resources to a task that define its work value, which is the amount
of effort the resource or resources will need to spend on the task to complete it.
For each resource, work is defined according to the scheduling formula : Work = Duration x Units.
The overall work value for the task is the sum of the work performed by each resource.
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Therefore if you have just one resource working 100% of their time on the task, the work value for
the task will be the same as the duration, as the example below shows.

In general, the work value will differ from the duration only if you assign more than one resource to
the task, or if the resource does not work full-time on the task.
The example below shows the effect of adding another resource, Bill, also working 100% of their
time, on Task1. As Bill is also going to produce 8 hours of work, the overall work value for the task
goes from 8 hours to 16 hours, but the duration is still only 1 day.

You may however want to produce a different result and expect that by adding another full-time
resource to the task, the amount of work needed to perform the task should remain constant, and it
should therefore be completed in half the time. This scheduling method is known as effort-driven
scheduling. By default, MindView does not apply effort-driven scheduling, but you can choose to
activate this scheduling method on your tasks. With effort-driven scheduling activated, adding Bill to
Task 1 in our 1st example would produce the result below:

You can see that the amount of work has now remained constant at 8 hours, but the duration has
decreased to half a day.
To activate effort-driven scheduling for a task, open its Task Information dialog on its General
tab and check the Effort-driven option.

Effort-driven scheduling only affects the scheduling of a task when you assign or remove
resources from it, and is independent from the scheduling type of the task. For more information
about task types, see "Using scheduling task types".
If you want MindView to apply effort-driven scheduling to all the tasks of the projects you create,
you can specify this in the MindView Options. For more information, see "Setting up your
preferences". You can also choose to activate effort-driven scheduling only for the new tasks of the
open document. To do this, click the File tab, choose Info | Properties and set the New tasks are
effort-driven option to Yes.
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Using scheduling task modes
By default, MindView tasks are automatically scheduled, which means that any change in the timing
of a task affects all the tasks that depend on it. If a task runs ahead of schedule, MindView
automatically recalculates the dates of all the tasks that depend on it in order to take advantage of
the time gained. Conversely, if a task is delayed, all the tasks that depend on it are automatically
rescheduled, which may or may not impact the overall end date of the project.
In some cases, however, you might prefer to insert tasks as "placeholders" without start, end or
duration information, or only with incomplete information, and prevent MindView from moving them.
This is particularly handy in the early phases of a project when the exact details of many tasks are
not yet known. In cases such as this, manual task scheduling provides greater freedom. As it is a
far less automatic way of handling tasks, however, it also requires you to manage the start, end and
duration information of each manually scheduled task in greater detail than is necessary with
automatic scheduling.

Switching to manual scheduling
You can convert any task selected in the Gantt Outline from being automatically scheduled to being
manually scheduled in several ways:
By clicking Manually Schedule
By clicking Task Information
the Task Information dialog

on the Gantt Tools tab
on the Gantt Tools tab and selecting Manually scheduled in

By clicking the icon in the Task Mode column in the Gantt Outline and selecting Manually
Scheduled on the drop-down
Manually scheduled tasks can be converted back to automatically scheduled tasks at any time by
repeating this process but selecting automatic scheduling. See "Converting manually scheduled
tasks to automatic scheduling" below for more information on the consequences of this.
You can set all new tasks to be manually scheduled from the MindView Options dialog. You can
change this default setting for all projects created in MindView or for the current document only. For
more information, see "Setting up your preferences".

Entering start, end and duration information
Manually scheduled tasks are often used as placeholders in the project plan until reliable
information about the tasks becomes available. You therefore do not need to enter start, end or
duration information for manually scheduled tasks, and you have the option of entering free text
such as "a couple of days" or "after the kick-off meeting" in the Start, End and Duration fields.
You can enter start, end and duration information in the same way as for automatically scheduled
tasks, including short date formats such as 1d and 4h. For more information on doing this, see
"Entering a task duration" and "Specifying start and end dates" in "Entering and editing tasks".
Start, end and duration information is not used by MindView to schedule the project if the values
are not in a recognizable format.
When scheduling information has been entered in a recognizable format, start/end markers are
shown in the Gantt chart as shown below. When not, a question mark is shown over the Manually
Scheduled icon in the Task Mode column of the Gantt Outline.

Manually scheduled summary tasks
Summary tasks can also be manually scheduled. When they are, they have the duration you have
entered and do not necessarily summarize the durations of their sub-tasks.
The example below shows a manually scheduled task whose duration is shorter than the manually
scheduled summary bar above it.
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The main summary bar represents the duration of the summary task you entered manually. The
small bar placed underneath the main bar summarizes the sub-tasks in the usual way, to give you
some indication of any possible discrepancy between the duration set by you for the summary task
and the combined duration of its sub-tasks. When the duration of one or more sub-tasks of a
manually scheduled summary task is longer than the duration of the summary task, the small
summary bar turns red to alert you, as shown in the example below.

Effect on links
If you change the start or end time or the duration of a manually scheduled task, this change will
affect all successor tasks (unless they are manually scheduled too). Changing the start or end time
or the duration of a predecessor task of a manually scheduled task, however, has no effect on the
manually scheduled task.
Editing the link between a manually scheduled task and its predecessor (for example, changing the
link type from Start to Finish (SF) to Finish to Start (FS) in the Task Information dialog) will affect
the task if the option Update manually scheduled tasks when editing links has been set to Yes
in the MindView Options dialog. For more information, see "Setting up your preferences".

Resources and calendars
You can assign resources to manually scheduled tasks, but resource calendars have no effect on
manually scheduled tasks. Project calendars (in other words, the working and non-working time
defined in them) do have an effect on manually scheduled tasks.

Constraints and task types
Constraints and task types are not relevant when working with manually scheduled tasks.

Converting manually scheduled tasks to automatic scheduling
Once all information about a manually scheduled task is known, you may want to convert it to
automatic scheduling for easier project management.
If you have provided sufficient recognizable scheduling information about the manually
scheduled task, this information is unchanged when the task is converted.
If you have not provided sufficient recognizable scheduling information, the task is converted to
an automatically scheduled task with a duration of one day starting on the project start date.
Always double-check that the scheduling information of all manually scheduled tasks is correct
before converting them to automatically scheduled tasks. This is particularly relevant for large
projects with many tasks.
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Using scheduling task types
Task types are only relevant for automatically scheduled tasks. For information about manual
task scheduling, see "Using scheduling task modes".
As we have seen in "Assigning resources", it is the process of assigning resources to a task in a
Gantt project that define its work value, which is the amount of effort the resource or resources will
need to spend on the task to complete it.
For each resource, work is defined according to the scheduling formula Work = Duration x Units,
where Duration is the duration of the task and Units is the percentage of availability of the resource
for the task.
The overall work value for the task is the sum of the work performed by each resource.

Understanding task types
Fixed Units tasks
By default, all the tasks you create in a Gantt project with MindView are given the task type Fixed
Units. This means that the percentage of availability of each resource (units) you defined when you
assigned the resources to the task always remains the same, regardless of any changes you might
make to the Duration or Work values.
If for instance you increase the task's duration, the work value will be recalculated and
increased accordingly.
If you increase the task's work value, the duration is recalculated and increased accordingly.
In either case, the percentage of availability of the resources (units) remains unchanged.
Let us consider for instance a task of one day (Duration = 1 day), allocated to John and Bill, each
working at 100% of their availability (Units = 100%).
The Work value of the task is therefore 16 hours (8 hours for John + 8 hours for Bill).

In the first example, we increase the duration from 1 day to 2 days. In consequence, the work
value is increased automatically to 32 hours.

In the second example, we decrease the work value from 16 hours to 8 hours. In consequence,
the duration is decreased automatically to half a day.

In both cases, the units value for John and Bill has remained unchanged at 100%.
This default behavior may however not be what you would want to happen. For this reason,
MindView supports two other task types, Fixed Duration and Fixed Work.
The fact that a task has the type Fixed Units does not mean that you cannot change the
percentage of availability of its resources (units). It only defines what happens when you modify the
other two values in the scheduling formula, i.e. Duration and Work.
Fixed Work tasks
In a Fixed Work task, when you change the task's Units or Duration value, MindView recalculates
the other value accordingly.
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If for instance you increase the percentage of availability of the resource (units), the duration will
be recalculated and decreased accordingly.
If you increase the task's duration, the percentage of availability of the resource (units) is
recalculated and decreased accordingly.
You can still change the Work value of Fixed Work tasks. This task type only defines what
happens when you modify the other two values in the scheduling formula, i.e. Duration and Units.
Let us consider again a task of one day (Duration = 1 day), allocated to John and Bill, each
working at 100% of their availability (Units = 100%).
The Work value of the task is 16 hours (8 hours for John + 8 hours for Bill).

In the first example, we decrease the percentage of availability (units) of both John and Bill to
50%. As the work value must remain fixed, the duration is increased automatically to 2 days.

In the second example, we decrease the task duration from 1 day to 0.5 days. As the work
value must remain fixed, the percentage of availability (units) of both John and Bill is increased
automatically to 200%.

In both cases, the work value has remained fixed at 16 hours.
Fixed Duration tasks
In a Fixed Duration task, when you change the task's Units or Work value, MindView recalculates
the other value accordingly.
If for instance you increase the percentage of availability of the resource (units), the work value
will be recalculated and increased accordingly.
If you increase the task's work value, the percentage of availability of the resource (units) is
recalculated and increased accordingly.
You can still change the Duration value of Fixed Duration tasks. This task type only defines
what happens when you modify the other two values in the scheduling formula, i.e. Units and Work.
Let us consider again a task of one day (Duration = 1 day), allocated to John and Bill, each
working at 100% of their availability (Units = 100%).
The Work value of the task is 16 hours (8 hours for John + 8 hours for Bill).

In the first example, we decrease the percentage of availability (units) of both John and Bill to
50%. As the duration value must remain fixed, the work value is decreased automatically to 8
hours.
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In the second example, we increase the work value from 16 hours to 32 hours. As the duration
value must remain fixed, the percentage of availability (units) of both John and Bill is increased
automatically to 200%.

In both cases, the duration has remained fixed at 1 day.
Summary
The effect of changing units, work and duration on a task of different types can be summarized by
the table below:

Changing the task type
To change the scheduling type of a task, select the task and choose View | Task Information
on the Gantt Tools tab.
You can also open the Task Information dialog by pressing Shift + F2 or by doubleclicking the task bar on the Gantt chart.

Setting a task type to Fixed Work automatically sets the Effort-driven option. Fixed Work tasks
cannot have effort-driven scheduling turned off as their work value must remain fixed. For more
information about effort-driven scheduling, see "Understanding effort-driven scheduling" in the topic
"Assigning resources".
If you want MindView to apply the same task type to all the tasks of the documents you create,
you can specify this in the MindView Options. For more information, see "Setting up your
preferences". You can also choose to apply a particular task type only for the new tasks of the open
document. To do this, click the File tab, choose Info | Properties and set the Default task type
option to your chosen task type.
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Using links
Project plans normally require tasks to be performed in a specific order. For instance, a
publication must be written and proofread before it can be printed. To achieve this, MindView lets
you link tasks so that they depend on each other. By default, tasks are linked in a 'Finish to Start'
relationship (dependency), which means that the first task you select (the predecessor task) must
end before the next task you select (the successor task) can start, and so on.
This is represented on the Gantt chart by lines with arrowheads joining each task to its successor.
The arrowhead indicates the direction of the link: it goes from the predecessor to the successor.

You can also view task links in the Mind Mapping views. For more information, see "Viewing
links in a Mind Mapping view" below.
A task can have more than one predecessor. In this case its start date is determined by the
predecessor link that gives it the latest start date. As dates and times change during the course of
the project, the predecessor link that determines the start date of the task may also change.

Similarly a task can have several successors. In this case the task determines the start date of all
its successor tasks.

When you are scheduling a project plan from its start date (see "Defining the global project
settings"), MindView calculates the end date of the project automatically, on the basis of the task
durations, the task dependencies and the project calendar.
The possibility of linking tasks in this way is what makes project management software particularly
powerful: you can change the duration of one or more tasks, add a task or remove a task from a
chain of linked tasks, and all the dates are recalculated automatically so as to maintain the task
dependencies you have defined.
If your project contains manually scheduled tasks, and you do not want any changes to the links
between those tasks and their predecessors to have an impact on them, you can disable the option
Update manually scheduled tasks when editing links in the MindView Options dialog. For more
information, see "Setting up your preferences".

Linking tasks
You can link tasks in the following ways:
Select the tasks to be linked, in the order you want them to be linked, by Shift-clicking them (for
contiguous tasks) or Ctrl-clicking them (for non-contiguous tasks), then click the Link icon
on the Gantt Tools tab.
You can also just press Ctrl + F2.
Place the pointer on the bar of the predecessor task. When it changes to an icon with four
arrows, drag the pointer downwards (or upwards) until a line emerges from the task bar and a
link icon appears under the pointer. Continue dragging until the line reaches the bar of the
successor task and release the mouse button.
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Select the task to be linked to. Click its Predecessors cell in the Gantt Outline and type the
entry number(s) of the predecessor task(s). Separate multiple numbers by semi-colons.
Select the task to be linked to and choose Task Information
on the Gantt Tools tab to open
its Task Information dialog. Click the Predecessors tab and select the predecessor task(s).
You can also open the Task Information dialog by pressing Shift + F2 or by doubleclicking the task bar on the Gantt chart.
All these methods create the default task relationship, namely 'Finish to Start'. See below to
find out how to create other types of relationships.
In the example below, the proofreading task (successor) has been linked to the writing task
(predecessor). The proofreading task cannot start before the writing ends. If the writing task is
delayed or takes longer than planned, the start date of the proofreading task is recalculated
automatically so that the task relationship is always maintained.

You can link summary tasks in the same way as other tasks, but not to one of their own sub-tasks.
Linking a summary task to another summary task has the same effect as linking its last sub-task to
all of the sub-tasks in the other summary task. To make your project plan easy to read, it is usually
best to link summary tasks only to summary tasks and sub-tasks to sub-tasks (within the same
summary task), like this:

Alternatively you may prefer to restrict linking to regular tasks. Links from summary tasks to regular
tasks tend to confuse the display.
A summary task can only be linked to its predecessors with a 'Finish to Start' or 'Start to Start'
relationship.

Unlinking tasks
You can unlink tasks in the following ways:
Select the tasks by Shift- or Ctrl-clicking them, then click the Unlink icon
tab.

on the Gantt Tools

You can also just press Ctrl + Shift + F2.
On the Gantt chart, right-click the link you want to remove and choose Edit Link in its local
menu. This opens the Task Information dialog. Select the predecessor task you want to remove
and click Delete.
Select the task whose predecessors you want to remove. Click its Predecessors cell in the
Gantt Outline and delete the number(s) of the predecessor(s) you want to remove.
Select the task whose predecessors you want to remove and choose Task Information
on
the Gantt Tools tab to open its Task Information dialog. Click the Predecessors tab, select each
predecessor task you want to remove and click Delete.

Defining lead or lag time
By adding a lead or lag time you can extend a link backwards or forwards so that the successor
task starts earlier or later than it otherwise would. For a default 'Finish to Start' link, this either
introduces an overlap (lead time), so that the successor task starts before its predecessor ends, or
it introduces a delay (lag time) that makes the successor task start some time after its predecessor
ends.
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When planning the production of a marketing brochure for instance, you could use lead time to
make the creation of artwork start a few days before the writing phase is over. The two tasks are
however still linked, which means that a delay of the writing phase will also delay the creation of the
artwork.
Select the successor task and choose Task Information

to open its Task Information dialog.

Click the Predecessors tab.
In the Lag column for the task, enter the appropriate lead or lag time. A positive value indicates
a lag time (a delay); a negative value indicates a lead time (an overlap). You can follow the
number with letter(s), for example w for weeks, as described in the paragraph "Entering a task
duration" in "Entering and editing tasks".
You can also enter percentage values, for example if you enter "-25%" the task will start 75%
of the way through the predecessor task. Note that percentages relate to the duration of the
predecessor task.
In the following example, we start with three linked tasks (to save space, the Start and End columns
are not shown):

Notice that the Predecessors column shows the number of each task's predecessor. Experience
shows that we can actually start applying undercoat when surface preparation is three quarters
complete, in other words when only 25% remains to be done. To give the desired overlap (lead
time) we enter a lag of -25%, as described above:

Because surface preparation has currently been allocated 4 working days, the undercoat task starts
after the third working day. As usual, no work is scheduled during non-working days. Notice that the
Predecessors column now includes the type of link (FS, or 'Finish to Start'), and the amount of
lead time (-25%).
Now we want to allow a 1-day gap after the undercoat task to ensure that the undercoat is fully dry
before the top coat is applied. To give the desired delay we enter a lag of 1 day, as described
above:

If we now have to change the duration of the surface preparation task to 8 days, everything moves
out. However, the 25% overlap (which now represents 2 working days) and the 1-day delay are
preserved:
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Although the example above shows tasks linked by the default 'Finish to Start' relationship, you can
apply lead or lag time to any type of task relationship.
Moving linked bars by dragging does not set lead or lag times, but instead sets constraints
which override the linking. See "Using constraints" for more information.

Using other task relationships
MindView supports four different relationships (dependencies) between tasks:
Finish to Start (FS) - the default: The task cannot start before its predecessor ends, although
it may start later. This is the most common type of relationship and the only link you can create
by clicking the Link icon , as described above. Typically the successor starts as soon as the
predecessor is complete. You can introduce an overlap or delay by using lead and lag times,
but still, if the end date of the predecessor task moves, so will the start date of the successor.
Start to Start (SS): The task cannot start until the predecessor starts, although it may start
later. This can be useful if you have a task whose start date depends on the start date of
another task.
Finish to Finish (FF): The task cannot end before the predecessor ends, although it may end
later.
Start to Finish (SF): The task cannot end before the predecessor starts, although it may end
later. This task relationship is rarely used.
To change the relationship between two tasks:
Select the successor task and choose Task Information

to open its Task Information dialog.

You can also just double-click the link between the predecessor and the successor task
on the Gantt chart.
Select the predecessor on the Predecessors tab.
In the Type column, select the new relationship type.

Example
The following project plan for the preparation of a publication illustrates all these kinds of
relationships.

In this example:
The writing task follows on directly from the planning task. If the end date of planning changes,
so will the start of writing. This is the normal Finish to Start relationship.
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The editing task starts some way through the writing task. The writers and the editors work
together as a team until the text is complete. Their tasks effectively end at the same time. If the
end date of writing changes, so will the end date of editing. This is a Finish to Finish
relationship.
The creation of artwork depends on the start of writing. In this case a lag has been introduced
so that it doesn't start exactly when writing starts. Even so, if the start of writing changes, so will
the start of artwork creation. This is a Start to Start relationship.
The final changes task depends on the end of artwork creation, but an overlap is included so
that it actually begins two working days before the end date of artwork creation. If artwork
creation is delayed, so will be the start of final changes. This is the normal Finish to Start
relationship.
Printing starts after final changes are complete. This is also a Finish to Start relationship.
The transferring of paper from the warehouse to the printers must be complete in order for
printing to start, but is not related to any of the preceding tasks. The printers have limited
storage capacity and do not want the paper to arrive until it is needed, so the start of printing
drives the delivery of paper. If the start of printing changes for some reason, so will the end
date for getting paper to the printers. This is a Start to Finish relationship.
Here each task has a single predecessor, the simplest arrangement. However, a task can have
several predecessors. In such situations you will need to think carefully about possible undesirable
consequences. For example, if you added another predecessor to the "Paper to printers" task
above, it would be possible for that predecessor to push out "Paper to printers" so that its end date
was later than the start of printing.

Viewing links in a Mind Mapping view
When you have defined a task link in the Gantt view, you can view it in the Mind Mapping views
(Mind Map, Top Down and Left/Right). Task links are displayed as lines connecting the two
branches representing the linked tasks. By default, a label indicating the task relationship is shown
next to the connection line.

Task link connections are not visible by default, but you can display them using the Show/Hide
command on the View tab. For more information, see "Viewing a mind map".
Task link connections shown in the Mind Mapping views are similar to branch connections, and you
can edit them in a similar way:
You can use the Format tab and the Properties dialog to format a task link connection.
You can change the curve of a task link connection.
You can delete a task link connection. Please note that by doing so, you delete the task link
entirely (in all views including the Gantt view), not just the connection line.
For more information on these editing options, see "Creating branch connections" and "Task link
connection properties: General tab". See "Using the Properties dialog" for a general description of
the Properties dialog.
If your map also contains branch connections, it is advisable to format the task link connections
differently to make it easier to differentiate between the two types of links.
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Using constraints
Constraints are only relevant for automatically scheduled tasks. For information about manual
task scheduling, see "Using scheduling task modes".
Constraints define the degree of flexibility available to MindView when scheduling or rescheduling a
task by imposing restrictions on its start or end date.
MindView supports 8 types of task constraints, offering different degrees of flexibility.

Constraint types
Two "constraints" are actually so flexible that they are not generally regarded as constraints at all:
As Soon As Possible (ASAP): This is the default constraint when you schedule your project
from its start date, as is normally the case (see "Defining the global project settings"). You
should try to keep this default whenever possible as it gives MindView the most scheduling
flexibility. If you apply this constraint to an unlinked task, the task will be scheduled to start at
the project start date. If you apply it to a linked task, it will start as soon as the dependencies
with its predecessor tasks will allow.
As Late As Possible (ALAP): This is the default constraint when you schedule your project
from its end date. If you apply this constraint to an unlinked task, the task will be scheduled so
that its end date coincides with the end date of the overall project. If you apply it to a task linked
to a successor task, the task will be scheduled to end when the successor needs to start. On
the whole, you should avoid this constraint as it does not leave any slack time to deal with
possible problems. Any delay on the task is likely to impact the overall end date.
The following constraints all restrict MindView's flexibility when scheduling tasks. Although you
might be tempted to use them if you are new to project management, you need to make sure you
understand the implications. Keeping their use to a minimum (especially the last two) will allow you
to take full advantage of MindView's automatic scheduling possibilities.
Start No Earlier Than (SNET) : This means that the task, whether linked or not, may not
start before the given date. However, MindView still has the flexibility to start the task later than
the given date.
If you change a task's start date, for instance by typing a new date in the Gantt Outline or
by moving its task bar on the Gantt chart, this constraint is automatically applied.
If you drag a linked task backwards, a SNET constraint is set for the start date
corresponding to the new position of the task bar, but the bar immediately moves back to its
original position. This is because the start date determined by the link comes later than the
SNET date. The SNET date is therefore applied, but does not change the original scheduling
of the task.
Start No Later Than (SNLT) : This means that the task, whether linked or not, may not start
later than the given date. However, MindView still has the flexibility to start the task earlier than
the given date.
When you are scheduling your project from its end date, changing a task's start date
automatically applies this constraint.
Finish No Earlier Than (FNET) : This means that the task, whether linked or not, may not
end before the given date. However, MindView still has the flexibility to end the task later than
the given date.
If you change a task's end date, this constraint is automatically applied.
Finish No Later Than (FNLT) : This means that the task, whether linked or not, may not end
later than the given date. However, MindView still has the flexibility to end the task earlier than
the given date.
When you are scheduling your project from its end date, changing a task's end date or
moving its task bar on the Gantt chart automatically applies this constraint.
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Must Start On (MSO)
: This rigid constraint means that the task, whether linked or not,
must start on the given date. Even if the preceding task is completed earlier, MindView cannot
pull in the constrained task to take advantage of the time gained.
Must Finish On (MFO)
: This rigid constraint means that the task, whether linked or not,
must end on the given date. As above, even if the preceding task is completed earlier,
MindView cannot pull in the constrained task to take advantage of the time gained.
When you apply one of these constraints to a task, a constraint icon appears next to its name in the
Gantt Outline. Hovering this icon with the mouse displays a tooltip with details about the constraint.

If you decide to apply one of these constraints to a task, it is good practice to attach a note or a
comment to the task to explain why you did so. If the constraint causes scheduling conflicts later on
as your project evolves, you will be able to refer to the note to decide whether to keep the
constraint, change it or remove it altogether. Such notes also allow you to distinguish easily
between the tasks you have constrained yourself deliberately and the tasks you may have
constrained inadvertently by moving their task bar or editing their start or end date manually.
You can sometimes avoid using constraints by setting deadlines instead (see "Setting deadlines" in
the topic "Enhancing a project plan"). If you have an important date to meet, it is usually better to
set a deadline on the task rather than a constraint such as 'Must Finish On'. Not only this type of
constraint restricts MindView's scheduling flexibility, but it may in fact increase the likelihood of
missing the deadline, as the example below shows.
The effect of a constraint is not always obvious when you schedule your project plan from its
end date, so take care to check that it does give the result you want.
Example
The following example shows some tasks in the preparation of a brochure for a mail shot. The mail
shot is scheduled for September 14th. The tasks are linked, but we have set a 'Must Finish On'
constraint on the printing task for September 11th, the latest date that will allow the mailing to go
ahead on the following Monday, September 14th. The constraint, as usual, overrides the link. By
setting a 'Must Finish On' constraint for September 11th, we have effectively moved the task out so
that it ends exactly on September 11th, regardless of whether it could have been completed earlier
or not.

The problem with this is that if the printing task takes longer than expected, the mailing date will be
missed. It would be much better to take advantage of the unused time after the end of the
corrections task to get started with printing. However, we still need to keep an eye on the
September 11th deadline. To do this, we remove the constraint from the printing task, so that the
link will determine its start date, and add a deadline marker instead.
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Now there is a useful gap between the end of printing and the deadline, and the deadline is clearly
indicated. The printing task is now much less likely to appear on the critical path, and the deadline
indicator will warn us if the task moves past its deadline.

Interaction between task dependency links and constraints
Constraints combine with task dependency links to affect the timing of tasks. In some cases,
applying a constraint to a task in addition to a task relationship may create a scheduling conflict.
When such a conflict arises, the constraint always takes precedence over the task dependency.
Let us consider the example below. Here the "Print" task is linked to the "Final changes" task with
the default 'Finish to Start' relationship. The "Final changes" task ends on Oct 1st. In normal
circumstances, this would mean that the "Print" task cannot start before Oct 2nd. However,
because you imperatively need the printed materials on Sept 28th for a training session, you have
set a 'Must Finish On' constraint on the "Print" task for Sept 28th, as evidenced by the constraint
indicator. Since the constraint set on a task always overrides any relationship it may have with other
tasks, the start date of the "Print" task has been rescheduled automatically to end on Sept 28th.

In this case the constraint has led to an illogical relationship with the predecessor task: printing is
now scheduled to start before final changes are complete. Note that MindView conveniently flags
this as a possible problem using the
icon, which shows that a link has been overridden by a
constraint.
If you later decide to remove the constraint, for instance because the training session has been
postponed, the task dependency link is enforced again, as shown here:

For more information about how to detect and solve potential scheduling conflicts, see "Reviewing a
project plan".

Setting a constraint
You can apply a constraint to a task as follows:
Select the task and choose Task Information

to open its Task Information dialog.

Select the constraint type. For constraints other than 'As Soon as Possible' or 'As Late As
Possible', you also need to set the constraint date required.

As mentioned above, changing a task's start date by editing it in the Gantt Outline or moving its task
bar on the Gantt chart applies a 'Start No Earlier Than' constraint automatically (assuming you are
scheduling from the project start date). Changing a task's end date applies a 'Finish No Earlier
Than' constraint.
When scheduling from the end, changing a task's start date applies a 'Start No Later Than'
constraint. Changing a task's end date applies a 'Finish No Later Than' constraint.
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To remove a rigid constraint, select 'As Soon as Possible' in the Task Information dialog (or
'As Late As Possible' if you are scheduling from the end).
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Enhancing a project plan
There are various things you can do to make your project plan easier to use. For example:
You can add explanatory notes to tasks. This is especially useful for tasks that have constraints.
Constraints override links and can lead to illogicalities or schedule conflicts in the plan, so you
will need to keep an eye on them.
You can highlight the critical path in order to see at a glance the tasks that are currently directly
affecting your project end date.
You can set milestones or deadlines to mark key dates.
You can give tasks priorities.
You can show a percentage completion for any task, visible on the task bar.
You can prevent some tasks from appearing on the Gantt chart by hiding their task bar.
You can make some tasks inactive, so that they no longer affects the scheduling of the project.
You can customize the display of the project plan on the Gantt chart.
You can save one or more project baselines for future use.
All these operations are described in detail below.

Adding notes
You can add notes and comments to any task, just as in all the other MindView views. See
"Inserting text notes" and "Inserting comments".

Viewing the critical path
In a project plan, the critical path corresponds to the tasks or chain of linked tasks that cannot be
delayed without delaying the entire project. A task lies on the critical path if a change to its start
date or duration affects the end date of the project (or the start date if you are scheduling from the
end of the project).
Keeping a close eye on the status of your critical tasks at any time is therefore key to good project
management. If the overall project duration is too long, the only way to make it shorter and bring in
its end date is to shorten the critical path.
To toggle the critical path on or off, click Show Critical Path
on the critical path are highlighted in red.

on the Gantt Tools tab. Tasks

You can change the color used to highlight the critical tasks from the Properties dialog. See
"View properties: General tab" for more information.

Setting milestones
A milestone is a task with zero duration. It appears on the Gantt chart as a solid diamond.
Milestones are generally used to indicate important dates on the project plan, often key events or
goals. For example, you might use milestones to mark desired completion dates, or project review
meetings.

As with any task, a milestone can be linked to other tasks. However, milestones are generally used
as fixed markers and are therefore not normally linked.
To enter a milestone:
Create a task and give it a duration of 0.
To convert a task to a milestone:
Select the task and give it a duration of zero, or
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Select the task and choose Task Information
on the Gantt Tools tab to open its Task
Information dialog. Check the option Set task as milestone.
To convert a milestone to a task:
Select the milestone and give it a non-zero duration.

Setting deadlines
You can add a deadline marker to any task. This does not affect any of MindView's Gantt
calculations, but places a visible marker on the Gantt chart as a reminder.

If the task end date moves past the deadline, a missed deadline icon appears in the Indicators
column of the Gantt Outline.

To add a deadline to a task:
Select the task and choose Task Information
Deadline field, select the deadline date.

to open its Task Information dialog. In the

To remove a deadline from a task, you open the Task Information dialog again and remove the
check mark from the Deadline field.

Assigning priorities
You can assign a priority to a task in the following ways:
Select the task and choose Task Information
priority number in the Priority field.

to open its Task Information dialog. Enter a

Select the task. On the Task/Timeline panel, enter a priority number in the Priority field.
Priorities can range from 0 to 1000, where 0 is lowest and 1000 is the highest priority. You do not
need to use the full range of this scale but can use any range convenient, for example from 1 to 10.

Setting completion values
You can indicate the progress that has been made towards completing a task by entering a %
completion value. A thick line on the task bar indicates progress.

You can enter or modify a % completion value for a task in the following ways:
Select the task and use one of the Completion Level icons
Tools tab.

of the Gantt

Move the cursor to the left of the task bar (or to the right end of the completion line if the task
already has a completion value) until it changes to
the appropriate completion position is reached.
Select the task and choose Task Information
value in the Completion (%) field.

and drag rightwards or leftwards until

to open its Task Information dialog. Select a

Select the task. On the Task/Timeline panel, select a value in the Completion (%) field.

Hiding the bar of a task
If you are working on a large project plan, with many tasks, you might want to hide some of the task
bars from the Gantt chart to improve its legibility and allow you to concentrate on some of the more
important tasks.
To prevent the bar of a task to be displayed on the Gantt chart:
Select the task and choose Task Information
option Hide task bar in chart.

to open its Task Information dialog. Check the

The task stays listed in the Gantt Outline, but its bar is no longer shown in the Gantt chart.
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Making a task inactive
If you want to keep a task in your project plan, but prevent it from affecting its scheduling, you can
make it inactive. This can be useful for instance if you are forced to remove some tasks from your
project for budget or deadline reasons, but want to keep a record of them, in case you may be able
to re-introduce them later if you get additional funding or extra time.
Once inactive, a task is no longer taken into account by the scheduling engine, which means that its
dates, duration and any resources allocated to it no longer have any impact on any of the other
tasks of the project plan.
You can inactivate a task in different ways:
Select the task and click the Inactivate Task icon
Select the task and choose Task Information
option Inactive.

of the Gantt Tools tab.
to open its Task Information dialog. Check the

Right-click the task name in the Gantt Outline and choose Inactivate Task in its local menu.
To reactivate an inactive task, just repeat one of these operations.
Inactive tasks are identified by a special indicator
appears in white on the Gantt chart.

in the Gantt Outline, and their task bar

Inactivating a summary task automatically inactivates all its sub-tasks.
Be careful when inactivating a task that is linked to other tasks. If you inactivate a task with
successors, the successors will be re-scheduled as if that task had been deleted. If you want to
keep the link between two tasks after inactivating their connecting task, you will need to re-link the
two tasks manually.

Customizing the Gantt chart display
For more information about this, refer to the paragraph "Customizing the Gantt Chart" in the topic
"Using the Gantt view".

Saving a project baseline
Once your project plan is ready, you can save a project baseline. A baseline is a snapshot of your
project including the original scope, cost and schedule. Saving an accurate baseline before the
project starts (in other words, before any work has been done on it) gives you a reference point for
tracking project progress later.
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Choose Gantt Tools | Project | Project Baselines

, and click Create.

(Optional) Click the baseline name to edit it.
If you have created more than one baseline, select one baseline as the default by selecting it in
the list of baselines and clicking Set as Default.
This is important if you use project reports to track project progress or use calculation
functions that rely on information from the selected baseline. For more information, see
"Creating project reports", "Inserting calculation values" and "List of calculation functions".
You can create as many project baselines as you want, but be aware that adding many baselines
will increase the file size of the mind map.
For more information about project baselines and tracking project progress, see "Reviewing a
project plan".
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Reviewing a project plan
It's a good idea to review your project plan regularly in order to locate conflicts or other problems.
You can then make appropriate changes to remove them.

Checking deadlines
Have any tasks overshot their deadline? If so, you will see warning markers in the Indicators
column:

To overcome the problem you may need to reschedule tasks. Alternatively, if the overshoot is
acceptable, you can change the deadline by opening the Task Information dialog (double-click the
task bar) and assigning a new date. To remove the deadline altogether, remove the check mark
from the Deadline field.

Checking the project end date
Is the project on course? Check that the end date of your project looks reasonable.
When you are scheduling a project plan from its start date (see "Defining the global project
settings"), MindView calculates the end date of the project automatically, on the basis of the task
durations, the task dependencies and the project calendar.
You can check the project end date in several ways:
View the end date of the first task in the project plan, either in the Gantt Outline or in the Gantt
chart. This is the root summary task that covers the whole project.

View the end date of the last task in the project plan, either in the Gantt Outline or in the Gantt
chart.
If the task bar of the last task is not visible in the Gantt chart, select the task in the Gantt
Outline and click Go to Selected Task
on the Gantt Tools tab.
Choose Project | Project Information on the Gantt Tools tab to view the start and end date of
the overall project.
If the end date is too late, and the suggestions described in the following paragraphs cannot help,
you may need to apply more resources to one or more tasks. For example, if you assign two people
rather than one to a task, you should be able to halve its duration.
If the project end date is no longer realistic, and you need to postpone the entire project, you
can use the Move Project command. For more information, see "Moving the project" below.

Checking the project start date
If unconstrained tasks start later than you expect them to, check the project start date (choose
Project | Project Information on the Gantt Tools tab).
In the following example, Task1 and Task2 actually start on the project start date, as they should.
However, Task3 has a 'Must Start On' constraint that is earlier than the project start date. This
effectively extends the project backwards before its official start date. This also happens when a
task is given a lead time that pushes its start date before the project start date.
The project start date is nevertheless maintained, and any new task you add is scheduled to start
on the official start date.
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Checking the dependencies
Are all the links between tasks necessary? By unlinking tasks that don't actually depend on each
other, you will make use of all the slack time available, thereby shortening your schedule and
maximizing its flexibility.
Alternatively, consider whether some tasks could overlap each other to reduce the overall duration
of the project. If so, assign appropriate lead times (see "Defining lead or lag time" in the topic
"Using links"). Another possibility is to redefine some of your 'Finish to Start' relationships to either
'Finish to Finish' or 'Start to Start' if the logic of your schedule allows it.

Checking the constraints
Are the constraints working as you expect? Look in the Indicators column of the Gantt Outline for
tasks that have constraint markers
. If you have been adding an explanatory note to every
constraint you set, read the notes to check that your intentions are still being met. And look for
tasks that have a constraint but no note: these may have been created inadvertently and be
causing trouble.
Do the tasks that have constraints fall where you expect them to? Do they fit logically with the other
tasks around them? Check that their start and end dates are neither too early nor too late.
Look for unexpected overlaps or gaps (see below) between linked tasks: often this is caused by a
rigid constraint on one or other of the tasks, in which case you should see a constraint marker in the
Indicators column. However, remember that overlaps and gaps can also be caused by intentional
lead or lag times. Displaying the Predecessors column in the Gantt Outline will allow you to check
for the presence of lead or lag time.
Because constraints override links, they can introduce schedule conflicts, identified by the icon
in the Indicators column. For example, in the following case, final changes are taking longer than
expected, but the 'Must Finish On' constraint set on the printing task prevents it from moving out.
The result is that printing is now scheduled to begin well before the final changes are complete.

To resolve this problem, assuming that you want to maintain the end date of Sept 28th for printing:
Double-click the task bar for the printing task to open its Task Information dialog.
Remove the rigid constraint by unchecking the Constraint date checkbox and revert to the
default 'As Soon As Possible' constraint. The link from "Final changes" will now determine the
start of printing.
In the Deadline field, select September 28 to put a deadline marker on the printing task so that
you are reminded of the required completion date. The deadline marker is simply a marker: it
does not apply a constraint of any sort. Click OK to close the dialog.
Shorten the time allowed for final changes (or one of its predecessor tasks), for example by
assigning more people to the task, so that printing finishes on or before the deadline.
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Looking for gaps
Are there any gaps where work could be allocated but has not been? Gaps can occur when a rigid
constraint has been applied to a task. The task's predecessor finishes early, leaving a gap (slack
time). Because of the constraint, the task cannot move backwards to take advantage of the slack.

To overcome problems like this, and make use of the slack time, consider removing the rigid
constraint and replacing it by the default 'As Soon As Possible'.

Checking the critical path
Are there tasks on the critical path that should not be there? A task is on the critical path if it directly
contributes to the duration of the project. Removing a task from the critical path will shorten the
overall project.
Choose Show Critical Path

to highlight in red the tasks that are on the critical path.

In this example, the "Paper to printers" task is on the critical path, but actually it could be done in
parallel with the other tasks. The printing task is overshooting its deadline (green arrow), hence the
exclamation mark indicator. Taking the "Paper to printers" task off the critical path reduces the
overall duration of the project and meets the deadline for completion of printing:

Redefining a 'Finish to Start' relationship to either a 'Finish to Finish' or a 'Start to Start' relationship
is also a useful way of taking a task off the critical path.

Comparing with a project baseline
If you created a project baseline after setting up the project plan (as described under "Saving a
project baseline" in "Enhancing a project plan"), you can compare the current status of the project
with this baseline.

228

Viewing the baseline in the Gantt chart
Choose Design | Show/Hide | Show Baseline

.

If you have created more than one baseline, select the baseline you want to show on the
drop-down.

The selected baseline is now shown as a grey line underneath each individual task, allowing you to
quickly see if your tasks are on track, too early or too late as compared with the initial plan.
Defining more baselines to document progress
During the course of your project, it can be useful to create new baselines at regular intervals to
document project progress. For example, you might want to create new baselines every week or
every month. The updated baselines will show how the project plan has evolved over time, for
example as you add, edit, update and remove tasks in the project.
To add more project baselines, follow the procedure described in "Enhancing a project plan".
Remember to select the right default project baseline for use in project reports (see below).
Give your baselines meaningful names (such as "23 March project follow-up") so that you can
easily tell them apart and quickly select the right baseline for tracking progress in the Gantt chart.
Using the default baseline in project reports
The default project baseline is used for tracking project progress in project reports. For more
information, see "Creating project reports".

Filtering the tasks
One useful way of reviewing a project is to filter its tasks by appropriate criteria. For more
information about how to define a filter, see "Filtering a mind map".
Using the Filter function, you can for instance display only the tasks that have a specific start or end
date, duration, deadline, constraint, priority or completion level. You can also filter the project so
that it only shows tasks involving particular resources. You can also use the Highlight feature to
highlight tasks that meet the filter criteria but still keep the rest of the tasks visible.
The Total slack parameter lets you list only the tasks that are on the critical path (by specifying a
value of zero), or tasks that have some slack in them, in other words that could be extended or
delayed without affecting the end date of the project. To give an example, the condition "Total slack
greater than 4" would only show you the tasks which could be delayed by 5 days or more without
affecting the end date of the project. This could be very useful in helping you optimize the resource
allocation, for instance by moving resources from tasks that have the most slack to more critical
tasks.

Moving the project
You can move the entire project by selecting a new start or end date. This is a quick way of
rescheduling an entire project without having to update each individual task.
Choose Gantt Tools | Project | Move Project.
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Select a new project start date.
If the project is scheduled from the project end date, you will have the option to select a
new project end date instead. For more information, see "Defining the global project settings".
(optional) If you do not want to update project deadlines, deselect the Move deadlines
checkbox.
The start and finish dates for all project tasks are adjusted to match the new start and end dates.
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Exporting a project plan
All the export methods are available when working on a project plan. The export methods that are
particularly relevant to project plans are the following:
Creating reports: Choosing this option lets you create a number of different HTML reports, such
as Top Level Tasks, Critical Tasks, Tasks in Progress and so on. See "Creating project reports" for
more information.
Export to HTML: This export method is only available when you are viewing your project plan in a
view other than the Gantt view. It lets you export your project plan as a standard web site. See
"Exporting to HTML" for more information.
Export to Microsoft Outlook Task List: This allows you to export your project plan as a series of
tasks in the Outlook folder of your choice. For more information, see "Exporting to Microsoft Outlook
task list".
Export to Microsoft Project: This allows you to take advantage of Microsoft Project's advanced
project management capabilities to develop your project plan further. See "Exporting to Microsoft
Project" for more information.
Export to XML: This method lets you export your project plan in two different XML formats, namely
MindView XML and Microsoft Project XML. For more information, see "Exporting to XML".
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Printing a project plan
You can print your project plan in the same way as in the Map views.
MindView enables you to spread your printout on several pages, which is very useful in the case of
project plans. Increasing both horizontal and vertical page spread values, for instance, will allow
you to create a legible printout of your entire plan, spread over several pages.
For a full description of the printing options, see "Printing a mind map".
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Spellchecking
Using the spellchecker
MindView allows you to find and correct spelling errors in your entire document as well as in
the currently selected element. The MindView spellchecker is able to detect misspelled words and
automatically correct common misspellings in the following elements:
Branch names
Floating comments
Pop-up comments
Text notes
Object names
In addition to looking up words in its own dictionaries, the spellchecker also references custom
dictionaries to determine whether a particular word is correctly spelt or not. You can customize
these dictionaries by adding, replacing or deleting words.
The spellchecker also uses an AutoCorrect list to correct common mistakes automatically. Again,
you can customize this list by adding, replacing or deleting word pairs.
Finally the spellchecker allows you to spellcheck your documents in several languages, including
American and British English, French, German, Italian, Spanish, Dutch and Danish.

Spellchecking as you type
By default, MindView checks for spelling errors as you type, underlining in red any mistakes found.
You have the option of correcting the mistake straight away by right-clicking the misspelled word.
This opens the local menu, in which you can choose any of the following commands:
Corrections
This lets you choose one of the suggestions listed, which then replaces the misspelled word.
Ignore All
Choose this command to ignore the currently highlighted occurrence of the word and all other
such occurrences in the document and any other document opened during this MindView
session.
Add to Dictionary
Choose this command to add the underlined word to your default custom dictionary, thereby
making it a valid word which the spellchecker will no longer report as a mistake. See the topic
"Spellchecking options" for more information on custom dictionaries.
AutoCorrect
This lets you choose one of the suggestions listed. In addition, the misspelled word and its
corrected equivalent will be added to the AutoCorrect list. This means that whenever you type
this misspelled word in the future, it will be automatically replaced by its corrected equivalent.
See the topic "Spellchecking options" for more information on the AutoCorrect list.
Spelling
This opens the Spelling dialog, which allows you to spellcheck the entire selected element.

Spellchecking the document
Choose Review | Proofing | Spellcheck Document or press F7.
MindView goes through your document, examining branch names, floating comments, pop-up
comments, text notes and object names for spelling mistakes. As soon as it detects a spelling
mistake in one of these elements, MindView selects the element containing the mistake and opens
the Spelling dialog.
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The top field shows the phrase containing the misspelling, with the first misspelled word highlighted.
The bottom field shows a list of suggestions from which you can choose an alternative spelling for
the highlighted word.
You can choose one of the following options:
Ignore Once
This will ignore the currently highlighted occurrence of the word.
Ignore All
This will ignore the currently highlighted occurrence of the word as well as any other such
occurrences during the entire MindView session.
Add to Dictionary
This will add the misspelled word to your default custom dictionary.
Change
If you have edited the misspelled word in the top field, this replaces it with the edited word.
Otherwise the misspelled word is replaced by the alternative spelling chosen in the
Suggestions field. Only this occurrence of the misspelled word is corrected. If you also want
all following occurrences of the word replaced, click Change All.
Change All
If you have edited the misspelled word in the top field, this replaces it with the edited word.
Otherwise the misspelled word is replaced by the alternative spelling chosen in the
Suggestions field. This replaces all the occurrences of the misspelled word in the entire
document.
AutoCorrect
This replaces the misspelled word by the alternative spelling chosen in the Suggestions field.
In addition, the misspelled word and its corrected equivalent are added to the AutoCorrect list.
Dictionary language
This lets you choose a different language for the spellchecker to use to check your document.
Options
This opens the Spellchecking Options dialog, which lets you set various options to control the
way the spellchecking is done. See the topic "Spellchecking options" for a full description of
this dialog.

234

Spellchecking the currently selected element
Choose Review | Proofing | Spellcheck Selection or press Ctrl + F7.
MindView goes through the currently selected element, looking for spelling mistakes. As soon
as it detects a spelling mistake, MindView selects the phrase containing the spelling error,
highlights the error and opens the Spelling dialog described above.

Choosing a different dictionary
Choose Review | Proofing | Set Language and select the language dictionary you would like
to use to spellcheck your document.
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Spellchecking options
This dialog contains various options which you can set to determine the type of errors
reported by the spellchecker.
You can access it in several ways:
By choosing Review | Proofing | Spelling Options.
By clicking Options in the Spelling dialog.
By clicking the File tab, then Options and Proofing.

Check spelling as you type: If you disable this option, the misspelled words will not be
automatically underlined in red as you type them. You will need to use the Spellcheck commands to
spellcheck your mind map at a later stage.
Ignore words in uppercase: When enabled, this option causes any word written entirely in upper
case to be ignored by the spellchecker and skipped. It is useful to keep this option enabled if your
document contains many acronyms.
Ignore words with numbers: When enabled, this option causes any word containing numbers to
be ignored by the spellchecker and skipped. It is useful to keep this option enabled if your
document contains many words or symbols including numbers, such as Q4.
Ignore Internet and file addresses: When enabled, this option causes any words that appear to
make up an Internet domain name, a URL or an email address to be ignored and skipped.
Phonetic suggestions (English only): When enabled, this option causes suggestions to be made
on the basis of their phonetic similarity to the misspelled word. This option tends to improve
suggestions for badly misspelled words.
Typographical suggestions: This is the default option. It causes suggestions to be made on the
basis of the similarity of their spelling to that of the misspelled word. Note that the spellchecker
does not offer suggestions if you disable both this option and the 'Phonetic suggestions' option.
Case sensitive: When enabled, this option causes the spellchecker to distinguish between
capitalized and non-capitalized letters. The word "europe" for instance would be considered as a
mistake. If you disable this option, "europe" and "Europe" would be considered identical and both
regarded as correct.
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Enforce accented uppercase in French: When enabled, this option causes the spellchecker to
flag as incorrectly spelt any word starting with an upper case letter which should have been
accented.
AutoCorrect: If you disable this option, even if a misspelled word is included together with its
correct equivalent in the AutoCorrect list, the misspelled word will not be automatically replaced by
its equivalent.
Correct two initial capitals: If you type the first two letters of a word in upper case, this option
causes the 2nd letter to be automatically converted from upper case to lower case. The word
"EUrope" for instance would be automatically replaced by "Europe".
Capitalize first letter of sentences: Automatically converts the 1st letter of a sentence to upper
case.
You can also click AutoCorrect List or Custom Dictionaries to open the corresponding dialogs.
Both dialogs are described below.
Default language: This lets you choose the default language which you want the spellchecker to
use to check your documents.

Using the AutoCorrect list
This list contains all the misspelled words which you have corrected by using the AutoCorrect
feature described above. Each line is made up of the originally misspelled word in the 'Replace'
column on the left, together with the suggestion you chose to replace it with in the 'With' column on
the right.

If you work with different languages, the spellchecker maintains one such AutoCorrect list per
language.
You can customize the AutoCorrect list in various ways:
You can add new AutoCorrect pairs by typing a commonly misspelled word in the 'Replace' field
followed by its correct equivalent in the 'With' field and clicking Add.
You can replace the correct equivalent of a misspelled word by selecting this misspelled word in
the 'Replace' list, typing the new equivalent in the 'With' field and clicking Replace.
You can delete an AutoCorrect pair by selecting the corresponding row in the list and clicking
Delete.
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Using the custom dictionaries
This dialog contains a list of all your custom dictionaries as well as several buttons allowing you to
customize them.

Custom dictionaries contain all the words reported as misspelled by the spellchecker that you
decided to accept as valid by clicking Add to Dictionary during spellchecking. This means that a
word included in any of the custom dictionaries is no longer reported as a misspelling by the
spellchecker.
The Custom Dictionaries dialog allows you to:
Modify one of the custom dictionaries by clicking it, then selecting Modify. You can then add
new words to the dictionary or remove existing words.
Set one of the custom dictionaries as default by selecting it and clicking Default. Any new word
you now accept as valid by clicking Add to Dictionary while spellchecking will be automatically
added to this dictionary.
Create a new custom dictionary by clicking New.
Add an existing custom dictionary by clicking Add.
Remove an existing custom dictionary by selecting it and clicking Remove.
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Exporting
Introduction
MindView lets you export your document to other applications, including Microsoft® Word,
Microsoft® PowerPoint, Microsoft® Excel, Microsoft® Outlook and Microsoft® Project. You can also
export it to HTML or XML, as a picture, or as a PDF or RTF document.
These export possibilities mean that you can use MindView to brainstorm your ideas, organize
them visually and collect all the associated material, and then convert the map into the format you
require. In this way, you immediately obtain a professional-looking document, which you can
process further if necessary using tools such as FrontPage® (for HTML export), Microsoft® Word,
Microsoft® PowerPoint, Microsoft® Project and so on.
Once you have exported your document and worked on it in one of these applications (for instance
Word, PowerPoint, Excel, Outlook or Project), you can re-import it back into MindView if necessary,
while preserving much of the work done in the external application. The branch structure, layout
and contents of the original mind map is also preserved as far as possible. For more information
about importing a document into MindView, see the "Importing" section of this documentation.
The export options offered by MindView are all described in detail in the next topics.
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Additional folders
When you export your document to one of the export formats available, MindView
automatically includes and references all the files you have used in the document.
If however you have created a particular folder structure for the external files used by your
document, you can ensure that MindView preserves this structure when exporting to HTML or
packing your document by specifying the list of folders that need to be included in the export folder
or the packed map as follows:
Click the File tab.
Choose Info | Additional Folders to open the following dialog:

Click the Add button and select the first folder you wish to include.
Repeat for all the folders you would like to include.
Note that you can enlarge the dialog by dragging one of its corners if the folder paths are not fully
visible.
In the exported version of your document, all references to external files are automatically modified
to point to the correct output folder.
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Exporting to Microsoft Word
This export method lets you export your mind map as a Microsoft® Word document. If for
instance you have created a mind map to brainstorm the structure of a report, this export mode
provides you with a ready-made outline of your map as a Word document, which you can then turn
into a fully blown report by working directly in Word.
If after working for some time on your Word document, you realize you need to review the structure
of your map in MindView before doing any further work in Word, you can re-import it back into
MindView without losing any new text or formatting you might have added in Word. See "Importing
from Microsoft Word" for more information.
You do not need to have Microsoft Word installed on your computer in order to use this export
mode. However, on versions of Windows prior to Windows 7, you need Word 2007 and above to
open the exported document. You can also open the document in an earlier version of Word if you
have installed the Microsoft Office Compatibility pack, available free from the Microsoft web site.
From Windows 7 you can open .docx files directly in the default editor in Windows without having
Word installed, although some of the more advanced content of the docx file cannot be shown.
Each branch is exported as a paragraph heading at the relevant level, in other words Heading 1 for
main branches, Heading 2 for sub-branches, Heading 3 for sub-sub-branches and so on, using
hierarchical numbering (unless you disable it in Custom Export). Attached objects and inserted
elements are listed below the heading.
As Microsoft Word only supports 9 heading levels, any MindView branch deeper than 9 levels
is exported as Heading 9.
By default, MindView automatically includes an overall picture of your map on the first page of the
document, followed by a Table of Contents.
If you add new headings to the document when working directly in Microsoft Word, you can
easily update this Table of Contents by right-clicking it and choosing Update Field in the Word local
menu. If you don't need the Table of Contents, you can delete it by selecting it and pressing Delete.
The branches of the map are exported to Word in the order in which they are displayed in the Mind
Map view, starting from the top right in a clockwise direction.
You can however exclude entire branches and sub-branches from the export by disabling their
'Include in export' property in the Properties dialog.

Only the branches displayed on the workspace when you start the export procedure are
exported. This means that if you are focusing on a particular branch or set of branches (see
"Focusing on a branch") or if you are filtering the map to display only branches that meet specific
criteria (see "Filtering a mind map"), only the branches visible on the workspace will be exported.
To export the entire map, you need to go back to the full display by clearing the branch focus or
filter applied.

Export modes
There are two export modes available:
Quick Export
The Quick Export mode allows you to export your map quickly using the MindView defaults or
the last Custom Export settings you chose if you have already used that mode.
Custom Export
The Custom Export mode allows you to choose a template for your Word document. You can
also specify the elements of your map to be exported and how they should be treated.
The export settings you choose in Custom Export are saved with the MindView document and
re-used next time you export your map using Quick Export or Custom Export. This means you
do not have to redefine them every time you make a small alteration to your map and want to
export it again to Word.
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When exporting a mind map to Word, MindView inserts bookmarks in the Word document to
keep track of how the various elements should be re-imported back into MindView if you choose to
do so. You should take care not to delete these bookmarks, which are hidden by default. To make
them visible while you work, check 'Show bookmarks' in the Advanced panel of the Word Options
dialog.

Relationship between MindView and Word elements and objects
The following table indicates how MindView treats the various inserted elements and attached
objects contained in your map when exporting it to Microsoft Word.
MindView element
Branch name

Exported to Word as
Heading at relevant level with hierarchical numbering
(3 levels by default)
Hierarchical numbering can be disabled in Custom Export.

Text note

Text inserted under the branch heading
Some formatting attributes may not always be transferred to
Word as expected. In those cases, make sure your text notes
are unformatted before exporting

Branch picture
Floating picture

Picture inserted under the branch heading
If connected to a branch, inserted under the branch heading
If not connected to a branch, not exported

Floating comment

As for Floating picture

Pop-up comment

Word comment on the branch heading

Branch connection

Cross-reference prefixed by "See" under the start branch
heading, pointing to the end branch heading

MindView object

Exported to Word as

Text file

Hyperlink

Picture file

Picture inserted in the Word document
In Custom Export, you can choose instead to insert the file as a
hyperlink.

Video file

Hyperlink

Sound file

Hyperlink

Hyperlink

Hyperlink

Flash file

Hyperlink

Using Quick Export
Click the File tab.
Choose Export | Microsoft Word | Quick Word Export.
If your MindView view contains several maps (i.e. several roots), choose the map you want to
export in the 'Select Map to Export' dialog and click OK.
Specify a folder and a file name for the new Word document in the Save As dialog.
MindView starts exporting your mind map to Microsoft Word and displays a message
informing you that export is complete.
Click OK in that dialog to open the document in Word.
Word then displays the following message, indicating that it needs to update the Table of
Contents.
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Click Yes to update the Table of Contents.
You are now ready to work in your Word document.

Using Custom Export
Click the File tab.
Choose Export | Microsoft Word | Custom Word Export.
If your MindView view contains several maps (i.e. several roots), choose the map you want to
export in the 'Select Map to Export' dialog and click OK.
Choose your preferred template in the Templates tab of the Custom Microsoft Word Export
dialog or browse for one of the templates supplied with Microsoft Word or one of your own
templates.

The APA and MLA templates supplied with MindView are designed to help you format your
documents according to the APA (American Psychological Association) and MLA (Modern
Language Association) standards, commonly used in the United States. The MLA template
contains further styles which you can use when finalizing your document, such as "block
quotes" and "works cited".
You can easily define your own Word template to be used when exporting from
MindView. All you need to do is to define the Title style as well as styles for Headings 1 to 9
and save the document as a Word template (.dotx or .docx). You must also make sure the
template does not contain any text.
In the General tab, choose the required general export settings and specify which elements of
your map you want to export.
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The export of bibliography sources and citations is only supported from Microsoft® Office
2007. For more information about this topic, see "Using sources" and Using citations".
If you exclude some elements from the export by deselecting them here, none of the
elements of this type will be exported, regardless of the value of their individual 'Include in
export' property in the Properties dialog. Let's suppose for instance your map contains a
floating picture whose 'Include in export' property is enabled. If you choose to exclude floating
pictures from the export here, your floating picture will not be exported. Conversely, if you
specify here that floating pictures should be exported, only the floating pictures whose
'Include in export' property is enabled will be exported.

Choose the required export settings for any attached object in the Attached Objects tab.
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Click Export.
Specify a folder and a file name for the new Word document in the Save As dialog.
If you had left the option Embed attached files above checked and your map contains
attached files that cannot be embedded in the Word document, you will be prompted to
choose a folder where to copy these attached files to avoid overwriting files with the same
name in the destination folder.
As for Quick Export, MindView starts exporting your mind map to Microsoft Word as a new
document and displays the same messages once the export is complete.
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Exporting to Microsoft PowerPoint
This export method lets you export your mind map as a Microsoft® PowerPoint presentation.
If for instance you have created a mind map to brainstorm the structure of a business presentation,
this export mode allows you to transfer it to PowerPoint in order to refine it further before delivering
it to your audience.
If after working for some time on your PowerPoint presentation, you realize you need to review the
structure of your map in MindView before doing any further work in PowerPoint, you can re-import it
back into MindView without losing the layout work done in PowerPoint. See "Importing from
Microsoft PowerPoint" for more information.
MindView 7 uses the Office Open XML file format (.pptx). You can view or edit the exported
document using any application compatible with this file format, for example Microsoft PowerPoint
or a third-party application.
The root makes up the first slide, with the root label as the slide heading, followed by a list of the
main branches.
Each branch is then exported as a slide, with any sub-branches listed below the slide heading.
Inserted elements and hyperlinks are placed on the right side or at the bottom of the slide.
The branches of the map are exported to PowerPoint in the order in which they are displayed in the
Mind Map view, starting from the top right in a clockwise direction.
You can however exclude entire branches and sub-branches from the export by disabling their
'Include in export' property in the Properties dialog.

Only the branches displayed on the workspace when you start the export procedure are
exported. This means that if you are focusing on a particular branch or set of branches (see
"Focusing on a branch") or if you are filtering the map to display only branches that meet specific
criteria (see "Filtering a mind map"), only the branches visible on the workspace will be exported.
To export the entire map, you need to go back to the full display by clearing the branch focus or
filter applied.

Export modes
There are two export modes available:
Quick Export
The Quick Export mode allows you to export your map quickly using the MindView defaults or
the last Custom Export settings you chose if you have already used that mode.
Custom Export
The Custom Export mode lets you choose a PowerPoint template for your presentation. It
also allows you to specify the elements of your map to be exported and how they should be
treated.
The export settings you choose in Custom Export are saved with the MindView document and
re-used next time you export your map using Quick Export or Custom Export. This means that
you do not have to redefine them every time you make a small amendment to your map and
want to export it again to PowerPoint.
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Relationship between MindView and PowerPoint elements and objects
The following table indicates how MindView treats the various inserted elements and attached
objects contained in your map when exporting it to PowerPoint.
MindView element

Exported to PowerPoint as

Branch name

Slide heading

Text note

Text object
Due to PowerPoint limitations, if the text note contains tables or
bulleted lists, these elements will be exported as regular text.
Similarly, if the text note contains a hyperlink, the formatting of
the hyperlink will be preserved, but not the link itself.

Branch picture

Picture on the right of the slide
In Custom Export, you can choose instead to insert the branch
picture as a hyperlink.

Floating picture

If connected to a branch, inserted as a picture on the right
or at the bottom of the slide
If not connected to a branch, not exported

Floating comment

If connected to a branch, inserted on the slide as a
PowerPoint comment
If not connected to a branch, not exported

Pop-up comment

PowerPoint note in the bottom Notes pane

Branch connection

Hyperlink in a text object

MindView object

Exported to PowerPoint as

Text file

Hyperlink in a text object

Picture file

Picture on the right or at the bottom of the slide
In Custom Export, you can choose instead to insert the file as a
hyperlink in a text object

Video file

Hyperlink in a text object
In Custom Export, you can choose instead to embed the video
directly on the slide

Sound file

Hyperlink in a text object

Hyperlink

Hyperlink in a text object

Flash file

Hyperlink in a text object

Using Quick Export
Click the File tab.
Choose Export | Microsoft PowerPoint | Quick PowerPoint Export.
If your MindView view contains several maps (i.e. several roots), choose the map you want to
export in the 'Select Map to Export' dialog and click OK.
MindView starts exporting your mind map to Microsoft PowerPoint as a new presentation, and
displays a message once the export is complete. You can then start working directly in PowerPoint
on your new presentation and save it with the name of your choice.
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Using Custom Export
Click the File tab.
Choose Export | Microsoft PowerPoint | Custom PowerPoint Export.
If your MindView view contains several maps (i.e. several roots), choose the map you want to
export in the 'Select Map to Export' dialog and click OK.
Choose your preferred template in the Templates tab of the Custom Microsoft PowerPoint
Export dialog or browse for one of the templates supplied with Microsoft PowerPoint.

In the General tab, choose the required general export settings and specify which elements of
your map you want to export.
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If you exclude some elements from the export by deselecting them here, none of the
elements of this type will be exported, regardless of the value of their individual 'Include in
export' property in the Properties dialog. Let's suppose for instance your map contains a
floating picture whose 'Include in export' property is enabled. If you choose to exclude floating
pictures from the export here, your floating picture will not be exported. Conversely, if you
specify here that floating pictures should be exported, only the floating pictures whose
'Include in export' property is enabled will be exported.

Choose the required export settings for any attached object in the Attached Objects tab.
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Click Export.
As for Quick Export, MindView starts exporting your mind map to PowerPoint as a new
presentation, and displays a message once the export is complete.
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Exporting to Microsoft Excel
This export method lets you export your mind map as a Microsoft® Excel spreadsheet
document (*.xlsx).
If for instance you have created a mind map to track worldwide sales, this export mode provides
you with a ready-made version of your map as an Excel spreadsheet, which you can then turn into
a fully blown report by working directly in Excel.
After working in Excel you can of course re-import the spreadsheet back into MindView: the reimported mind map will reflect the changes you made in Excel. See "Importing from Microsoft
Excel" for more information.
You must have Microsoft Excel 2003 or above installed on your computer in order to use this
export mode. If you are using Excel 2010 or newer, you need to have the Microsoft .NET Client
Framework 4.0 installed. If neither of these items are installed on your computer, you can export
using the Microsoft Excel XML spreadsheet format; for more information, see "Exporting to XML".
Branch text, text notes, pop-up comments and calculation values are exported (see "Inserting
calculation values" for information about calculation values; Number calculation values are exported
as numbers, and Text calculation values are exported as text). If you use the Custom Export option,
you can also export any or all of the standard task data fields such as Start, End, Duration,
Completion, Priority, Resources and so on (see "Inserting task data" for more information on this
topic).
The following are not exported: pictures, floating comments, attached objects, and dates before
1900 (which are not supported by Excel).
If you are focusing on a particular branch or set of branches (see "Focusing on a branch") or if
you are filtering the map to display only branches that meet specific criteria (see "Filtering a mind
map"), only the branches visible on the workspace will be visible in the Excel spreadsheet created.
The same applies if you deselect the 'Include in Export' property in the Properties dialog for one or
more branches. The branches that are not visible on the workspace are exported (because they
may contain data needed by calculations on the visible branches), but the rows containing them are
hidden. You can display these rows using the standard Excel procedures, for example in Excel
2007 select the rows above and below the hidden one(s) then, in the Home tab, choose Format and
Hide & Unhide | Unhide Rows.

Export modes
There are two export modes available:
Quick Export
The Quick Export mode allows you to export your map quickly using the MindView defaults or
the last Custom Export settings you chose if you have already used that mode.
Custom Export
The Custom Export mode allows you to choose a template for your Excel spreadsheet
document. You can also specify the elements of your map to be exported and a layout for the
output.
The export settings you choose in Custom Export are saved with the MindView document and
re-used next time you export your map using Quick Export or Custom Export. This means you
do not have to redefine them every time you make a small alteration to your map and want to
export it again to Excel.

Using Quick Export
Click the File tab.
Choose Export | Microsoft Excel | Quick Excel Export.
If your MindView view contains several maps (i.e. several roots), choose the map you want to
export in the 'Select Map to Export' dialog and click OK.
Specify a folder and a file name for the new Excel document in the Save As dialog.
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MindView starts exporting your mind map to Microsoft Excel and displays a message informing you
that export is complete.
Click OK in that dialog to open the document in Excel.

Using Custom Export
Click the File tab.
Choose Export | Microsoft Excel | Custom Excel Export.
If your MindView view contains several maps (i.e. several roots), choose the map you want to
export in the 'Select Map to Export' dialog and click OK.
Choose your preferred template in the Templates tab of the Custom Microsoft Excel Export
dialog.

In the General tab, choose a layout for the Excel spreadsheet:
In the Numbered layout, numbers in the leftmost column indicate the mind map hierarchy.
In the Structured layout, branch text is put into different columns according to the
hierarchy of the branches in the mind map.
You can also specify the branch data and calculation values you want to export. In the
Include box, select if you want to include a legend explaining the fixed data defined in your
mind map, whether sub-branches should be grouped using the row grouping feature in Excel,
and whether text notes should be included in the exported file (and if so: whether you want to
include them as comments or in a separate column).
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When exporting to Microsoft Excel, the root branch is normally listed first at the top of the
spreadsheet, with the main branches listed before their sub-branches. This means that
subtotals and totals appear above the data they are calculated from, like this:

If you want to see subtotals and totals below the data they are calculated from, select Show
subtotals at bottom of group. The result looks like this:
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The Show subtotals at bottom of group option is only active when your mind map
contains calculation data.
Click Export.
Specify a folder and a file name for the new Excel document in the Save As dialog.
MindView starts exporting your mind map to Microsoft Excel and displays a message informing you
that export is complete.
Click OK in that dialog to open the document in Excel.
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Exporting to Microsoft Outlook task list
MindView lets you export your document to a Microsoft® Outlook task list. If, for instance, you
have brainstormed a task list in the Mind Map view or the Outline view, you can then export it to
Microsoft Outlook if you prefer to track tasks from there.
As well as exporting the tasks into your own Outlook task folder, you can also choose to have them
distributed automatically via email to the Outlook task folders of the other resources involved in the
tasks, who can then accept or refuse them. This lets you use Outlook to track the status of all the
exported tasks, just as you would if you had created the tasks directly in Outlook.
You can export your document to Microsoft Outlook even if the branches do not contain dates or
other task information. This lets you brainstorm the task names in MindView and only add the rest
of the task information once the document is transferred to Outlook.
Only the branches displayed on the workspace when you start the export procedure are
exported. This means that if you are focusing on a particular branch or set of branches (see
"Focusing on a branch") or if you are filtering the map to display only branches that meet specific
criteria (see "Filtering a mind map"), only the branches visible on the workspace will be exported.
To export the entire map, you need to go back to the full display by clearing the branch focus or
filter applied.
MindView also lets you import task lists from Microsoft Outlook. For more information, see
"Importing from Microsoft Outlook".
You must have Microsoft Outlook 2000 or above installed on your computer in order to use this
export mode.

Procedure
Click the File tab.
Choose Export | Microsoft Outlook Task List | Export as New Tasks.
If you have already exported the MindView document to Outlook previously, or if you
have created the MindView document by importing an Outlook task list, you will be given the
option of synchronizing the MindView document with the Outlook folder you specified at that
time rather than creating new tasks. See below for more information on this procedure.

(optional) Check Distribute tasks to resources if you want the tasks to be sent automatically
via email to all the resources involved, who can then accept or refuse them, as they would any
other task allocated to them directly from Outlook.
As task distribution relies on email, you need to ensure that you have specified an email
address for each resource. If a resource has several email addresses, this needs to be their
default email address. For more information about entering email addresses for resources,
see "Assigning resources".
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When choosing this option and depending on the security settings of your computer, you
may get a warning from Outlook which you will need to acknowledge to enable the procedure
to complete.
(optional) Indicate whether you want to export all the tasks (i.e. branches), or only those that
contain resources.
(optional) Indicate whether you want to export the summary tasks of your Gantt projects, or only
the tasks themselves.
Select the Outlook task folder or sub-folder where you want to export the tasks.
If you have chosen to distribute the tasks to the resources, you need to export the tasks to
the Outlook default task folder, and not a sub-folder. If you export the tasks to a task subfolder, Outlook will not be able to track the status of the tasks.
MindView exports your document to Microsoft Outlook as a series of tasks in the task folder you
specified, and displays a message once the export is complete.
You can exclude any branch from the export by disabling its 'Include in export' property in the
Properties dialog.

Tasks with multiple resources
One limitation of Outlook is that it is not able to track the status of tasks that are allocated to more
than one person. For this reason, if some of your tasks are allocated to several resources,
MindView displays a dialog asking you to choose how these tasks should be processed.

You have several choices:
If you don't need to track the status of the tasks with Outlook, you can choose to export those
tasks with all their resources anyway. All the resources will be listed in your Outlook task folder,
but the tasks will not be sent to the resources themselves.
When processing a task with multiple resources, you can get MindView to choose automatically
the first resource listed for the task and send the task to that resource.
You can also get MindView to let you choose which of the resources the task should be sent to.
If you choose that option, MindView displays a further dialog listing all the tasks that have
multiple resources, so that you can choose the resource to use in each case.

Limitations
When a MindView branch contains sub-branches, only the sub-branches are exported. Parent
branches are not exported.
Only the elements of the MindView document that are supported in Microsoft Outlook are exported:
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Task names (i.e. branch names), dates, durations, priority and completion values are exported
in the Outlook task list.
Text notes are exported as Outlook task notes.
Pop-up comments are not exported.
Other elements of the MindView document that are not supported by Microsoft Outlook (such as
branch pictures, icons, attached objects and so on) are not exported.

Synchronizing the MindView document and the Outlook task list
Once you have exported a MindView document to Microsoft Outlook, or conversely imported an
Outlook task list into MindView, you can continue making changes to the tasks in MindView or in
Outlook. You can even continue working on the task list in both applications independently. If at
some point you want to re-align the two versions to make sure they contain identical data, you can
use MindView's synchronization feature.
If you have made changes to your task list in MindView after having exported it to Outlook, you can
export these latest changes to the Outlook version of the task list as follows:
Click the File tab.
Choose Export | Microsoft Outlook Task List | Synchronize Tasks.
The Synchronization from MindView to Microsoft Outlook dialog opens.

The top part of the dialog determines what will happen when the same task exists in both the
MindView document and the Outlook task list in two different forms.
To copy the task from the MindView document to the Outlook task list (thereby overwriting any
other task information associated with the task in Outlook with the MindView version), check
Update the tasks in Outlook.
The bottom part of the dialog lets you specify what should happen if a task present in the MindView
document cannot be found in the Outlook task list. You have three choices:
Copy the task from the MindView document to the Outlook task list
If you choose this option, you have the same choices listed at the bottom of the dialog as
when exporting a MindView document to Outlook as a set of new tasks. See above for a
description of these options.
Delete the task from the MindView document, so that it does not exist any longer in either
version
Leave things as they are
If conversely you have made changes to your task list in Outlook after having exported it from
MindView, you can re-import these changes into your MindView document. For more information
about this procedure, see "Importing from Microsoft Outlook".
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Exporting to Microsoft Project
MindView lets you export your document as a Microsoft® Project file (*.mpp). This may be
useful when, for instance, having built and fine-tuned a project plan in the MindView Gantt view,
you now want to take advantage of Microsoft Project's advanced project management capabilities.
All the task and scheduling information contained in the MindView project plan is exported to
Microsoft Project.
This export method is only available when you are working on a project plan. See "Inserting
task data" and "Using the Gantt view" for more information about project plans.
MindView also lets you import documents from Microsoft Project. For more information, see
"Importing from Microsoft Project".
MindView does not support versions of Microsoft Project prior to 2003. You need to have
Microsoft Project installed on your computer in order to use this export method. If Microsoft Project
is not installed on your computer, you can export using the Microsoft Project XML format; for more
information, see "Exporting to XML".

Procedure
Click the File tab.
Choose Export | Microsoft Project.
Choose a file name and a destination for the exported file and click OK.
MindView starts exporting your document to Microsoft Project as a new project plan, and displays a
message once the export is complete.

Notes
Only the elements of the MindView project plan that are supported by Microsoft Project are
exported:
Branch pictures, icons, attached objects and so on are not exported.
Text notes are exported as Microsoft Project task notes.
Number calculation values are exported as numbers, and Text calculation values are exported
as text. For more information on calculation values, see "Inserting calculation values".
Pop-up comments are not exported.
The property 'Include in export' of the Properties dialog is ignored when exporting to Microsoft
Project.
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Exporting to HTML
Overview
This export method lets you export your mind map as a set of web pages in HTML format. It
allows you to obtain a professional-looking web site very quickly, without having to worry about web
design techniques.
Although you do not need to have a web browser installed on your machine in order to use this
export method, you obviously need one to view the web site created. Among the web browsers
supported by the MindView HTML export are Internet Explorer version 6.0 or above and Firefox 3.0
and above.
The exported HTML pages are placed in a sub-folder named 'MVHtmlExport' in the folder of your
choice.
All the pictures you have included in your document are placed in a sub-folder of 'MVHtmlExport'
named 'img', whereas the picture files used by the MindView export template are placed in a subfolder named 'mvfiles'. All other external files used in your document are placed directly in
'MVHtmlExport'. As it creates the HTML pages, MindView automatically modifies all the references
to external files contained in your document so that they point to the correct output folder.
Each branch, including the root, is exported as a HTML page of the same name as the branch, and
each page contains a menu of all its sub-branches and optionally, a menu of the main branches.
By default, a Home button taking you back to the root page is included on each HTML page. A Site
Map button containing a link to an interactive picture of your entire map and a 'You are here' locator
showing you the complete path from the root are also included on each HTML page.
Unless you define a different arrangement in the Export Wizard, all the objects attached to a branch
are exported below each other and left aligned on the page.
The branches of the map are exported to HTML in the order in which they are displayed in the Mind
Map view, starting from the top right in a clockwise direction.
You can however exclude entire branches and sub-branches from the export by disabling their
'Include in export' property in the Properties dialog.

If you are filtering the map to display only branches that meet specific criteria (see "Filtering a
mind map"), only the branches visible on the workspace will be exported. To export the entire map,
you need to go back to the full display by clearing the filter applied.
If you want a specific description to appear when the user hovers a picture from your map in
the browser, you can enter this description in the Name property of the relevant picture (root
picture, branch picture, floating picture or attached picture file). This description is then converted
by MindView to an HTML Alt tag during the export.

Export modes
There are two export modes available:
Quick Export
The Quick Export mode allows you to export your map quickly using the MindView defaults or
the last export settings you chose.
Custom Export
The HTML Export Wizard lets you choose from a number of professional ready-made
templates with various navigation layouts which you can customize to your liking. You can
also specify the elements of your map to be exported and how they should be treated.
Moreover, if you have created a particular folder structure for the external files used by your
document, you can ensure that MindView preserves this structure when exporting to HTML by
specifying the list of folders that need to be included in the export folder. Finally the Export
Wizard lets you export you map as a SCORM (Sharable Content Object Reference Model)
compatible package and specify its characteristics such as name, title, description, keywords
and manifest identifier.
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The export settings you choose are saved with the MindView document and re-used next time
you export your map to HTML. This means that you do not have to redefine them every time
you make a small alteration to your map.

Relationship between MindView and HTML elements and objects
The following table indicates how the various MindView elements and objects are exported on the
HTML page.
MindView element

Exported to HTML as

Branch name

Page title

Text note

Inserted as text

Branch picture

Inserted as picture

Floating picture

If connected to a branch, inserted as a picture
If not connected to a branch, not exported

Floating comment

If connected to a branch, inserted as text
If not connected to a branch, not exported

Pop-up comment

Inserted as text

Branch connection

Depending on your choice in the export dialog, inserted as a
button link or as a hyperlink

MindView object

Exported to HTML as

Text file

Depending on your choice in the export dialog, inserted as a
button link or as a hyperlink

Picture file

Inserted as a picture

Video file

Inserted as a Media Player object

Sound file

Depending on your choice in the export dialog, inserted as a
button link or as a hyperlink

Hyperlink

Inserted as a hyperlink

Flash file

Inserted as a Flash file (embedded)
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Exporting to HTML: Quick Export
Click the File tab.
Choose Export | HTML | Quick HTML Export.
If your MindView view contains several maps (i.e. several roots), choose the map you want to
export in the 'Select Map to Export' dialog and click OK.
The HTML Quick Export dialog appears.

Choose a path for your new web site.
MindView will create a sub-folder named 'MVHtmlExport' in the folder you specify, and place
all the files making up your web site in this sub-folder.
Choose whether to use:
The template you last used in the Export Wizard if you have already used that export
mode for your map.
The MatchWare predefined export template (with top and side navigation menu)
(optional) Click Options to define further export options:
The Select Objects tab allows you to specify the elements of the map to include in the
export.
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If you exclude some elements from the export by deselecting them here, none of the
elements of this type will be exported, regardless of the value of their individual 'Include in
export' property in the Properties dialog. Let's suppose for instance your map contains a
floating picture whose 'Include in export' property is enabled. If you choose to exclude floating
pictures from the export here, your floating picture will not be exported. Conversely, if you
specify here that floating pictures should be exported, only the floating pictures whose
'Include in export' property is enabled will be exported.

The Select Link Types tab only appears if your map contains branch connections and/or
attached sound files or text files. It lets you choose whether these elements should be placed
on HTML hyperlinks or buttons.

Click Export.
Once the export is completed, MindView displays a dialog giving you the choice of immediately
viewing your web site in your default browser or uploading it to Internet using the MatchWare FTP
Upload Manager. For more information on this tool, see "FTP Upload Manager".
To open your exported web site from within Windows Explorer at a later date, double-click the
file index.htm in the sub-folder 'MVHtmlExport'.
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Exporting to HTML: Export Wizard
Click the File tab.
Choose Export | HTML | Custom HTML Export.
If your MindView view contains several maps (i.e. several roots), choose the map you want to
export in the 'Select Map to Export' dialog and click Next.
The Export Wizard now displays a series of dialogs, the first of which is the Select Template
dialog.

Selecting a template
This dialog allows you to select a navigation layout for the pages of your web site.

Predefined Templates: This lets you choose one of the professional MindView export
templates with ready-made top and side navigation.
These templates are available in the following navigation styles :
Tree List: With this design, the list of side links is shown as a tree whose levels you can
expand and collapse as in Windows Explorer. All the pages of the web site are available from
the Tree List.
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Level List: With this type of navigation, you only see a maximum of three levels of links on
the side: the current page, any pages at the level just above it, and any pages at the level just
below it.

Buttons: In this design, the side bar contains a list of links, where each link represents a subbranch of the branch corresponding to the current page.

To see a larger preview of the templates shown on the right of the window, just place the
mouse pointer over the relevant thumbnail. Note that you will be able to go back to this step of
the wizard at any time to choose a different template if you are not satisfied with your original
choice.
User Templates: This lets you choose one of your own previously saved export templates. See
further down for information on how to save your own export template.
Select a template on the right and click Next.
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Preview
The Export Wizard opens the Preview dialog, which lets you customize the various areas of the
navigation layout chosen in the first step.

You can customize each area in turn by clicking the Customize buttons, namely:
General
Top Bar
Side Bar
Content Area
Feel free to experiment with the various customization options. At any time, you can obtain a full
size preview of your design reflecting any changes made by clicking the Preview button. Note
however that this Preview does not allow you to navigate the site.
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Customizing the General properties (optional)
Click General in the Preview dialog.

This dialog gives you the following options:
Include 'Home' button: This inserts a Home hyperlink or button on each of your web pages,
allowing you to return to the page corresponding to the root of your map in just one click.
This option is not available if you have chosen a Tree List design, as this design always allows you
to return to the root of your map in one click. A 'Home' button is therefore superfluous in this case.
Include 'Site Map' button: This inserts a Site Map hyperlink or button on each of your web pages.
Clicking it will display an interactive picture of the entire web site.
Include 'Timeline' button: This option is only available if you are exporting a document from the
Timeline view. It inserts a Timeline button on each of your web pages. Clicking it will display an
interactive representation of the timeline as shown in the Timeline view. For more information about
working with timelines, see "Using the Timeline view".
Include 'You are here' locator: This inserts a dynamic link on each page of the web site to show
the complete path from the root web page to that particular page.
You can also enter meta-tags for your web site as follows:
Description: Any text entered here will be inserted in the <description> tag of each of the HTML
pages created.
Keywords: Similarly, any keywords entered here (separated by commas) will be inserted in the
<keywords> tag of each of the HTML pages created.
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Customizing the Top Bar (optional)
Click the Top Bar button or double-click the top bar area in the Preview dialog.
The Top Bar Properties dialog opens on its Title tab.

By default, the title displayed on each web page is the branch name. Here you can change the font,
attributes and color for this title or even enter your own title, which will be displayed on all the pages
of the web site.
Click the Background tab.

This tab lets you select a plain color or a different background picture for the top bar.
If you want to change the background picture, the best approach is to make a copy of the existing
picture and edit its design to suit your requirements, making sure that the picture size stays
unchanged so that it still fits the template.
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Click the Links tab.

The Links tab is only available if the top bar of the template chosen contains buttons or
hyperlinks.
This tab lets you select different colors for the top bar links depending on their state, i.e. "Normal",
"Pressed" (the link is clicked) or "Hovered" (the mouse pointer is placed on the link).
You can also choose to make all the links the same width, or have their width vary according to the
length of their label.
Customizing the Side Bar (optional)
Click the Side Bar button or double-click the side bar area in the Preview dialog.
The Side Bar Properties dialog opens on its Background tab.

This tab lets you select a plain color or a different background picture for the side bar.
As for the top bar, the best approach if you want to change the background picture is to make a
copy of the existing picture and edit its design to suit your requirements.
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The second tab of the Side Bar Properties dialog varies depending on the type of navigation
template you chose in the first screen of the Export Wizard. The three possibilities are:
Tree list
Level list
Links
We will now look at each of these possibilities in turn.
Tree List

This is the tab displayed if you have chosen a Tree List design in the first step of the Export Wizard.
With this design, the list of side page links is shown as a tree whose levels you can expand and
collapse as in Windows Explorer. All the pages of the web site are available from the Tree List.
This tab lets you modify the default font, attributes, size and color of the links.
Level List

This tab is displayed if you have chosen a Level List design.
With this type of navigation, you only see a maximum of three levels of links on the side: the current
page, any pages at the level just above it, and any pages at the level just below it.
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The Level list tab lets you choose how many levels the list should show. You can also define the
font and color of the links.
Links

This tab is displayed if you have chosen a Buttons design in the first screen of the Export Wizard.
With this design, the side bar contains a list of links, where each link represents a sub-branch of the
branch corresponding to the current page. The Links tab lets you select different colors for the side
bar links depending on their state, i.e. "Normal", "Pressed" (the link is clicked) or "Hovered" (the
mouse pointer is placed on the link).
Customizing the Content Area (optional)
Click the Content Area button or double-click the middle area in the Preview dialog.
The Content Area properties dialog opens on its Background tab.

This tab lets you select a plain color or a different background picture for the body of the page. Feel
free to experiment with the image placement options by checking the effect in the Full Size Preview.
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Click the Link Type tab.

If your map contains branch connections, sound files or attached text documents, this tab lets you
decide whether you want to place these objects on hyperlinks or on buttons.
Click the Link Style tab.

This tab lets you choose styles for any buttons or hyperlinks created on your web pages.
Define the hyperlink style required by selecting a font, attribute and size. You can also define
different colors depending on the state of the hyperlink, i.e. "Normal", "Pressed" (the link is
clicked) or "Hovered" (the mouse pointer is placed on the link).
Scroll through the various buttons available to choose the type you like best.
Previewing the customized template (optional)
Click the Preview button in the Preview dialog to obtain a 800x600 real-time preview of your
design reflecting any changes made so far.
Check how your web site will look in different browser resolutions by resizing the window.
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Reducing the window size might for instance cause the top buttons or hyperlinks to spread
onto two rows. Conversely enlarging the window might cause them to arrange themselves on
one row only.
Saving the customized template (optional)
You can save your customized export template for later use by clicking the Save Template
button of the Preview dialog. The Save User Template dialog that opens contains a list of the
export templates you have already saved. Enter the name of your new export template and
click Save.
Once you are satisfied with the design of all the page components, click Next.

Selecting the objects to export
The Export Wizard now opens the Select Objects to Export dialog.

Select the MindView objects which you want to export to HTML.
If you exclude some elements from the export by deselecting them here, none of the
elements of this type will be exported, regardless of the value of their individual 'Include in
export' property in the Properties dialog. Let's suppose for instance your map contains a
floating picture whose 'Include in export' property is enabled. If you choose to exclude floating
pictures from the export here, your floating picture will not be exported. Conversely, if you
specify here that floating pictures should be exported, only the floating pictures whose
'Include in export' property is enabled will be exported.

If you have created a particular folder structure for the external files used by your document, you
can ensure that MindView preserves this structure when exporting to HTML by specifying the list of
folders that need to be included in the export folder as follows:
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Click the Select Folders button to open the following dialog:

Click the Add button and select the first folder you wish to include in the export.
Repeat for all the folders you would like to include.
Note that you can enlarge the dialog by dragging one of its corners if the folder paths are not fully
visible.
As it creates the HTML pages, MindView automatically modifies all the references to external files
contained in your document so that they point to the correct output folder.
Click Next.

Placing the objects on the page
The Export Wizard now opens the Select Placement dialog, which allows you to define where the
various objects attached to each branch should be placed on the corresponding HTML page.
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You can either:
Choose a default placement of Left, Center or Right and click Next. In that case, the objects will
be placed one after the other on each page according to their order in the Object list, either on
the left, the center or the right of the page.
Choose a default placement, and then click the Place Objects button to arrange the objects
manually on the page as you wish.
If you have already exported your map to HTML, you can check Only show updated
pages. In that case, the Export Wizard only shows you the pages which you have edited
since the last export. If your map contains a large number of branches, this saves time as you
do not have to review the object positioning on all the unchanged pages.
Positioning the objects manually (optional)
If you have chosen to place the objects manually by clicking 'Place Objects' in the previous dialog,
the Export Wizard now shows the Object Positioning window.

This is based on a default grid containing 5 columns, each representing 20% of the width of the
HTML page, and divided in a number of cells.
All the objects associated with the first branch of your map are identified on the grid by a small icon
bearing their name, in the default position chosen in the previous dialog. You can now reposition
these objects or resize them by manipulating the grid cells as follows:
To move an object on the page, drag it from one cell to the other.
To resize a column on the grid, drag its edge until it reaches the required size.
To merge two or more cells so that the object is stretched across them, select the cells by
dragging the mouse pointer across them and click the Merge Cells button (or right-click and
choose Merge Cells in its local menu).
To split a cell made up of merged cells, select it and click Split Cells (or right-click it and
choose Split Cells in the local menu).
To align objects horizontally or vertically within a cell, select the relevant cells by dragging the
mouse pointer across them, right-click and choose Alignment in the local menu. Then select
an Alignment option by clicking a square in the menu (these represent top left alignment, top
center alignment, top right alignment and so on). Note that you can also perform this operation
on empty cells before moving objects into them.
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To add an empty row, right-click the row above which you want to insert a row and choose Add
Row in its local menu.
To delete a row, right-click it and choose Delete Row in its local menu.
To increase or decrease the space between each cell, click the up or down arrows of the 'Cell
spacing' option.
All the objects that are excluded from the export, either because you have disabled their 'Include in
export' property or because you have chosen to exclude them in the 'Select Objects to Export'
dialog described above, are listed in the 'Exclude from export' area in the bottom left of the grid.
You are free to drag any of these objects back onto the HTML page.
You can also exclude particular objects from the export by dragging them to the 'Exclude from
export' area, and drag them back to the HTML page later if you change your mind.
Click Preview to visualize the effect of your changes on the actual page.
When you are satisfied with the positioning of the objects on the page, click the right double
arrow button to go to the next page, or choose another page in the Branch list shown on the left
of the dialog.
Repeat the operation until you have reviewed all the pages that needed revisiting.
Once you have reviewed all the pages, click Finish.

Exporting
You are now ready to export your map to HTML.

Choose a destination folder for your new web site.
(optional) You can optimize your pictures for web export by checking the option Automatically
optimize pictures. This has two effects:
All .bmp pictures used on your map are converted to .jpg to reduce their file size.
Any .bmp or .jpg picture used on your map that is larger than the dimensions allocated to
it on the HTML page is scaled down to these dimensions.
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(optional) To export the map as a SCORM package, check Create SCORM Package and
select the relevant SCORM version.
(optional) Click SCORM Settings.
The SCORM Manifest Settings dialog opens to let you specify additional information about
the package.

The SCORM Manifest file is automatically created by MindView. Among other things, it
includes details about the package that enable students and teachers to search for specific
learning content with the use of keywords.
Catalog name: This specifies the name of the Learning Management System (LMS) group or
category of courses (e.g. Maths, Physics, Chemistry, etc.) in which the SCORM package
should be placed.
Course title: This specifies the name used to identify the course within the LMS.
Course description: This is used to provide a description of the course, and its intended use.
Comma separated keywords: This field can be used to enter keywords (which must be
separated by commas) which the students and teachers will be able to use to locate the
package once it is deployed on the LMS.
Manifest identifier: This compulsory ID uniquely identifies the package among all the other
packages deployed on the LMS.
The output of the export will be a zip file containing all the HTML content and other SCORM
related helper files. This package can then be uploaded to the LMS (which must be SCORM
1.2 or SCORM 2004 compliant). How the package is placed on the LMS depends on the
specific LMS, but generally it is done by a teacher using the web-based interface of the LMS.
Please refer to the documentation of the LMS in question for information about this.
Click Finish.
Once the export is completed, MindView displays a dialog giving you the choice of immediately
viewing your web site in your default browser or uploading it to Internet using the MatchWare FTP
Upload Manager. For more information on this tool, see "FTP Upload Manager".
To open your exported web site from within Windows Explorer at a later date, double-click the
file index.htm in the sub-folder 'MVHtmlExport'.
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FTP Upload Manager
To help you get your HTML site on the web as quickly and effortlessly as possible, MindView
comes with a built-in FTP program, the MatchWare FTP Upload Manager.

Starting the FTP Upload Manager
Before you can use the FTP Upload Manager you must export your MindView document to HTML
(see "Exporting to HTML: Quick Export" or "Exporting to HTML: Export Wizard"). At the end of the
export the following dialog appears:

To open the FTP Upload Manager click Upload with FTP.
The FTP Upload Manager dialog appears.

In the FTP server address field, enter the FTP upload address that you have received from
your Internet Service Provider (ISP).
Enter your User name and Password in their respective fields.
If you do not have an FTP address, user name or password or have lost them, contact
your ISP.
Clicking the Browse button next to Destination folder will connect you to the Internet. Once
online, search for the remote folder you wish to upload your web site to.
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Select the folder required and click OK to return to the Upload Manager dialog.
If you would like to upload the web site to a new folder, click New Folder to create a new
remote folder on the server. Click OK to return to the Upload Manager dialog.

To quickly create a new remote folder enter a forward slash and the name of the new folder in
the Destination folder field.

If your Internet connection goes down often, you are advised to check the option Attempt to
reconnect in the Upload Manager dialog to guarantee a successful upload.

You can also set the number of reconnection attempts you want the Upload Manager to perform for
a given file. If upload is still unsuccessful after this number of attempts, it is cancelled.

Uploading your web site
If you are uploading your web site for the first time, click Upload entire project to connect to
the FTP server and upload all the files.
You can follow the progress of the upload in the Upload dialog.
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If upload is completed successfully, the following dialog appears:

Click Close to return to MindView.
The FTP Upload Manager remembers your FTP address, Username, Password and Destination. If
you make changes to your web site and would like to upload it again, click Update existing project
to upload only the files that have changed since your last upload.
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Exporting to PDF
This export method lets you export your mind map in PDF format.
It works in exactly the same way as the Microsoft Word export method. For more information, see
"Exporting to Microsoft Word".
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Exporting to RTF
This export method lets you export your mind map in RTF format. This may be useful if you
want to process your document further in a word processor, but do not have Microsoft Word
installed on your computer.
Each branch is exported as a paragraph heading at the relevant level, in other words Heading 1 for
main branches, Heading 2 for sub-branches, Heading 3 for sub-sub-branches and so on, using
hierarchical numbering (unless you disable it in Custom Export). Attached objects and inserted
elements are listed below the heading.
By default, MindView automatically includes an overall picture of your map on the first page of the
document.
The branches of the map are exported to RTF in the order in which they are displayed in the Mind
Map view, starting from the top right in a clockwise direction.
You can however exclude entire branches and sub-branches from the export by disabling their
'Include in export' property in the Properties dialog.

Only the branches displayed on the workspace when you start the export procedure are
exported. This means that if you are focusing on a particular branch or set of branches (see
"Focusing on a branch") or if you are filtering the map to display only branches that meet specific
criteria (see "Filtering a mind map"), only the branches visible on the workspace will be exported.
To export the entire map, you need to go back to the full display by clearing the branch focus or
filter applied.

Export modes
There are two export modes available:
Quick Export
The Quick Export mode allows you to export your map quickly using the MindView defaults or
the last Custom Export settings you chose if you have already used that mode.
Custom Export
The Custom Export mode allows you to specify the elements of your map to be exported and
how they should be treated.
The export settings you choose in Custom Export are saved with the MindView document and
re-used next time you export your map using Quick Export or Custom Export. This means that
you do not have to redefine them every time you make a small amendment to your map and
want to export it again to RTF.
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Relationship between MindView and RTF elements and objects
The following table indicates how MindView treats the various inserted elements and attached
objects contained in your map when exporting it to RTF.
MindView element
Branch name

Exported to RTF as
Heading at relevant level with hierarchical numbering
(3 levels by default)
Hierarchical numbering can be disabled in Custom Export.

Text note

Text inserted under the branch heading

Branch picture

Picture inserted under the branch heading

Floating picture

If connected to a branch, inserted under the branch heading
If not connected to a branch, not exported

Floating comment

As for Floating picture

Pop-up comment

Text under the branch heading

Branch connection

Cross-reference prefixed by "See section" under the start
branch heading, pointing to the end branch heading

MindView object

Exported to RTF as

Text file

Object name followed by hyperlink to file

Picture file

Picture embedded in the RTF document
In Custom Export, you can choose instead to insert the file as
an object name followed by a hyperlink to the file.

Video file

Object name followed by hyperlink to file

Sound file

Object name followed by hyperlink to file

Hyperlink

Object name followed by hyperlink to file

Flash file

Object name followed by hyperlink to file

Using Quick Export
Click the File tab.
Choose Export | RTF | Quick RTF Export.
If your MindView view contains several maps (i.e. several roots), choose the map you want to
export in the 'Select Map to Export' dialog and click OK.
Specify a folder and a file name for the new RTF document in the Save As dialog.
Once the export is complete, MindView lets you view the document in the viewer associated with
the .RTF extension on your computer.
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Using Custom Export
Click the File tab.
Choose Export | RTF | Custom RTF Export.
If your MindView view contains several maps (i.e. several roots), choose the map you want to
export in the 'Select Map to Export' dialog and click OK.
In the General tab, choose the required general export settings and specify the elements of the
map to export.

If you exclude some elements from the export by deselecting them here, none of the
elements of this type will be exported, regardless of the value of their individual 'Include in
export' property in the Properties dialog. Let's suppose for instance your map contains a
floating picture whose 'Include in export' property is enabled. If you choose to exclude floating
pictures from the export here, your floating picture will not be exported. Conversely, if you
specify here that floating pictures should be exported, only the floating pictures whose
'Include in export' property is enabled will be exported.
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Choose the required export settings for any attached object in the Attached Objects tab.

Click Export.
As for Quick Export, MindView starts exporting your mind map to RTF as a new document. Once
the export is complete, MindView lets you view the document in the viewer associated with the
.RTF extension on your computer.

284

Exporting to XML
This export method lets you export your document in XML format.
MindView supports several XML export file types:
MindView XML: This file type allows MindView documents to be converted to other application
formats after implementation of a transformation file.
Microsoft Project XML: This file type allows you to create a version of your MindView
document that can be opened in Microsoft® Project with the standard File | Open command of
that application. You can use the Microsoft Project XML export method even if you do not have
Microsoft Project on your computer. It is therefore a useful alternative to exporting directly from
MindView to Microsoft Project in the .mpp format, for which you do need to have Microsoft
Project installed on your computer.
Only the elements of the MindView project plan that are supported by Microsoft Project are
exported. This means that branch pictures, icons, attached objects and so on are not
exported. Text notes are exported as Microsoft Project task notes. Pop-up comments are not
exported.
Outline Processor Markup Language (OPML): This file type allows you to export your
MindView document in OPML format, a general outline format supported by MatchWare.
In addition, you may export your MindView document in XML formats compatible with MatchWare
OpenMind 2 and Microsoft Excel.

Procedure
Click the File tab.
Choose Export | XML.
Choose a file name and a destination for the exported file.
Choose the required export file type in the Type field.
Click OK.
The property 'Include in export' of the Properties dialog is ignored when exporting to XML.
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Exporting as picture
This export method lets you save your mind map as a picture file.
Click the File tab.
Choose Export | Picture.
The following dialog appears to let you choose the required export settings.

Enter the path and file name for the picture in the 'Save as' field or click the Browse button to
choose an existing path.
If you do not want to display branch connections, floating pictures and floating comments in the
picture, clear the corresponding check mark.
Since this export method creates a picture of your entire map, all elements chosen above
are displayed on the picture, regardless of the value of their individual 'Include in export'
property in the Properties dialog. Similarly, all branches will be visible, regardless of the value
of their individual 'Include in export' property.
If you want to display the object indicator
and/or the comment indicator
next to each
branch containing attached objects and/or comments, click the relevant check box.
Choose the required picture format.
If you choose the .jpg format, you can use the 'JPG quality' slider to define the level of quality
needed. Note that decreasing the level of quality increases the level of compression, and
therefore reduces the file size.
(optional) Preview the effect of your settings on the picture by clicking Preview.
Click Export.
Note that icons and branch pictures are always displayed and that it is not possible to display text
notes.
The export settings you choose are saved with the MindView document. This means that you will
not have to specify these settings again if you make changes to the map and want to re-export it as
a picture.
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Importing
Introduction
MindView lets you import documents from other applications, including Microsoft® Word,
Microsoft® PowerPoint, Microsoft® Excel, Microsoft® Outlook and Microsoft® Project. You can also
create MindView documents by importing XML files.
The import options offered by MindView are all described in detail in the next topics.
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Importing from Microsoft Word
MindView lets you import Microsoft® Word documents.
This is particularly useful when:
You have a Word document which you would like to restructure using the brainstorming
capabilities and features of MindView before exporting it again to Word.
You have exported a MindView mind map to Word, developed some of the topics in Word, but
then realized you need to review the structure of your map in MindView before doing any
further work in Word.
In both cases, MindView allows you to import the Word document into a new mind map, preserving
the text added in Word together with its formatting as far as possible. Pictures, comments and
hyperlinks added in Word are also preserved wherever possible.
If the Word document was created by exporting a MindView mind map to Word, the new mind map
will have the same branch structure and layout as the original mind map.
If you then re-export the new mind map to Word after having made the required changes in
MindView, any elements added in MindView are exported to the new document.
For more information about the elements that MindView is not able to preserve, see "Limitations"
below.
You do not need to have Microsoft Word installed on your computer in order to import a Word
document into MindView. MindView can import documents created with Microsoft Word 2007 and
above in the .docx format. If you are using an earlier version of Word, you can use the free
Microsoft Office Compatibility pack to convert the document from its .doc format to the newer .docx
format prior to importing.
Although MindView can import any Word document, a useful branch structure can only be created if
the document is organized in paragraphs containing headings defined with the Microsoft Word
heading styles "Heading 1" through to "Heading 9".
MindView imports each paragraph of the Word document as a branch at the relevant level. In other
words paragraphs with a Heading 1 title become main branches, paragraphs with a Heading 2 title
become sub-branches, paragraphs with a Heading 3 title become sub-sub-branches and so on.
If the Word document starts with a main heading with the style "Title", then this heading is used as
the root name. Otherwise the name of the Word document is used as the root name.

Procedure
Click the File tab.
Choose Import | Microsoft Word.
Select the Word document you want to import.
Specify a destination folder and file name for the MindView document to be created.

Click Import.
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There may be elements of the Word document that MindView is not able to import. If this is the
case, MindView displays a Warning dialog listing these elements. See "Limitations" below for more
information.

When exporting a mind map to Word, MindView inserts bookmarks in the Word document to
keep track of how the various elements should be re-imported back into MindView if you choose to
do so. You should take care not to delete these bookmarks, which are hidden by default. To make
them visible while you work, check 'Show bookmarks' in the Advanced panel of the Word Options
dialog.

Relationship between Word and MindView elements and objects
The following table indicates how MindView converts the various elements of your Word document
to MindView elements and objects.
Word element
Title
(with Title style)

Imported in MindView as
Root of the mind map
If the Word document does not contain a Title heading at its
very top, the name of the Word document is used as root
name.
If the Word document contains more than one Title heading,
each such heading is imported as a text note of the
corresponding higher level branch.

Heading 1

Main branch

(with Heading 1 style)
Heading 2

Sub-branch of the corresponding higher level branch

(with Heading 2 style)
and so on until…
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Heading 9

Sub-branch of the corresponding higher level branch

(with Heading 9 style)
Regular text

If the document was created in Word, imported as a text
note of the corresponding branch
If the document was created by exporting an original
MindView mind map, imported as text note or floating
comment of the corresponding branch as in the original
document

Picture embedded in
paragraph heading
Picture embedded in
body text

Floating picture of the corresponding branch
If the document was created in Word, imported as a picture
embedded in a text note of the corresponding branch
If the document was created by exporting an original
MindView mind map, imported as branch picture, floating
picture or attached picture file of the corresponding branch
as in the original document

Comment

Pop-up comment for the corresponding branch

Intra-document cross
reference to heading
with style Title or
Heading 1 to 9

Branch connection between the relevant branches

Hyperlink

Hyperlink in text note of the corresponding branch

Limitations
The following limitations apply when importing a Word document into MindView:
Indexes, tables of contents, tables of authorities, tables of figures, headers and footers are not
imported.
Note that you can choose to have the Table of Contents regenerated automatically when reexporting the mind map to Word.
Sounds and videos that are embedded in the Word document are not imported in MindView. To
import such elements in the MindView mind map, make sure they are inserted in the Word
document as hyperlinks.
Mathematical symbols are not imported.
In addition, if you are importing a document created from an original MindView mind map, the
following limitations apply:
Pop-up comments will not retain their original size and position.
Pictures embedded in the Word document as a result of the export from MindView do not retain
their file name information. When re-importing the document, MindView creates new files for
these pictures.
If you chose to include a picture of the whole mind map in the Word document when exporting
from MindView, this picture is not re-imported back into MindView.

290

Importing from Microsoft PowerPoint
MindView lets you import Microsoft® PowerPoint presentations from the Office Open XML file
format (.pptx).
This is particularly useful when:
You have a PowerPoint presentation which you would like to expand using the brainstorming
capabilities and features of MindView before exporting it again to PowerPoint.
You have exported a MindView mind map to PowerPoint, worked on the layout in PowerPoint,
but then realized you need to review the structure of your map in MindView before doing any
further work in PowerPoint.
In both cases, MindView allows you to import the PowerPoint presentation into a new mind map,
preserving as much of the layout and contents of the PowerPoint presentation as possible.
If the PowerPoint presentation was created by exporting a MindView mind map to PowerPoint, the
new mind map will have the same branch structure and layout as the original mind map.
If you then re-export the new mind map to PowerPoint after having made the required changes in
MindView, any elements added in MindView are exported to the new presentation.
For more information about the elements that MindView is not able to preserve, see "Limitations"
below.

Procedure
Click the File tab.
Choose Import | Microsoft PowerPoint.
Select the PowerPoint presentation you want to import.
Select the destination folder, i.e. the folder for the MindView document created from the
PowerPoint presentation.
(optional) If you want to import the bullet lists that may be included on the PowerPoint slides as
sub-branches of the corresponding branches, check Import bullets as branches. If you leave
this box unchecked, the bullet lists that may be included on the PowerPoint slides are inserted
as text notes on the corresponding MindView branches.

Click Import.

Import modes
The Import operation has two modes depending on how the PowerPoint presentation was created:
The PowerPoint presentation was originally created in PowerPoint
In this mode, the title of the first slide becomes the root name of the new MindView document.
If you have checked the 'Import bullets as branches' option, each bullet list item of that first
slide becomes a new main branch. If not, the entire bullet list is imported as a text note for the
root.
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All the other slides are imported as further main branches. If you have checked the 'Import
bullets as branches' option and some of those slides contain bullet lists, each bullet list item
becomes a sub-branch of the corresponding MindView branch. If not, the entire bullet list is
imported as a text note for the branch.
The PowerPoint presentation was created by exporting a MindView document
In this mode, the original branch structure of the MindView document is preserved, provided
that you have not removed any slide. If you have added new slides, they are imported as
main branches.

Relationship between PowerPoint and MindView elements and objects
The following table indicates how MindView converts the various elements of your PowerPoint
presentation to MindView elements and objects.
PowerPoint element

Imported in MindView as

Slide

Branch

Slide title

Branch title

Slide sub-title

Text note

Slide body text

Text note

Slide bullet list

If the presentation was created in PowerPoint and you
checked 'Import bullets as branches' in the Import dialog,
each bullet is imported as a sub-branch. If you didn't check
'Import bullets as branches', the entire bullet list is imported
as a text note for the branch.
If the presentation was created by exporting an original
MindView document, the branch structure of the mind map
is recreated from the slide titles, not from the bullet list. The
text of the bullet list is therefore ignored.

Slide comment

Floating comment

Slide notes

Pop-up comment

Embedded picture

If the presentation was created in PowerPoint, imported as
an attached picture
If the presentation was created by exporting an original
MindView document, imported as a branch picture or
floating picture as in the original document

Autoshape

Attached picture

Linked picture

Attached picture object pointing to the original path

Embedded video

Attached video object pointing to the original path

Embedded sound

Attached sound

Link to slide

Branch connection

Limitations
The following limitations apply when importing a PowerPoint presentation into MindView:
The formatting of the slide title and of any slide notes included is not preserved.
If the layout of the PowerPoint slide contains more than one bullet list, only the first bullet list is
taken into account by the import.
When importing bullets as branches, indented bullets within the main bullet list are imported as
branches of the same level as the main bullets, not as sub-branches.
PowerPoint master slides are not taken into account by MindView. Their contents are therefore
not imported into the MindView document.
Although hyperlinks contained in PowerPoint text objects are imported into the corresponding
MindView text note, only their formatting is preserved. The links themselves are not preserved.
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Shapes, diagrams, OLE controls and objects are not imported.
Tables are imported as plain text; rows and columns are not preserved.
Text with text effects (WordArt) is imported as text notes without formatting.
In addition, if you are importing a presentation created by exporting a MindView document, the
following limitations apply:
If you delete one or more slides while working in PowerPoint, MindView is not able to recreate
the branch structure exactly as in the original mind map:
If you delete the slide corresponding to the root branch, all the slides are imported as main
branches, as if you had created the presentation from scratch in PowerPoint.
If you delete slides corresponding to branches with sub-branches, MindView cannot
recreate the structure of these sub-branches.
Similarly, if you rearrange the slides in a different order in PowerPoint, MindView does not take
the new order into account.
Since MindView uses the PowerPoint slide titles to recreate the branch structure, any changes
you make to the bullet list text in PowerPoint will not be preserved in MindView.
Pop-up comments will not retain their original size and position.
Pictures embedded in the PowerPoint presentation as a result of the export from MindView do
not retain their original file name or path information.
If you chose to include a picture of the whole mind map in the PowerPoint presentation when
exporting from MindView, the slide containing this picture is not re-imported back into
MindView.
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Importing from Microsoft Excel
MindView lets you import Microsoft® Excel spreadsheets (*.xslx). The spreadsheet might be
one that was previously exported from MindView, or one that you are bringing into MindView for the
first time.
You must have Microsoft Excel 2003 or above installed on your computer in order to use this
import mode. If you are using Excel 2010 or newer, you need to have the Microsoft .NET Client
Framework 4.0 installed. If neither of these items are installed on your computer, you can import
from the Microsoft Excel XML spreadsheet format; for more information, see "Importing from XML".
To ensure a successful import, your spreadsheet should have one of the following layouts:

If your spreadsheet does not follow one of these layouts, Mind View will nevertheless attempt to
import it, following information you supply on the Import dialog (see below).
In addition to the layouts above, MindView is also able to re-import mind maps exported to
Microsoft Excel using the "Show subtotals at bottom of group" option." See "Exporting to Microsoft
Excel" for more information about this feature.
The diagrams above show how the contents of the spreadsheet will be imported to a mind map. For
example, the contents of the cell labeled 'Root' provides the label for the root of the imported mind
map. Whatever is in the cells labeled 'Main' in the diagram will be imported as main branches, and
whatever is in the cells labeled 'Sub' will be imported as sub-branches. The contents of the cells
labeled 'Data' will be imported as branch data, with the contents of the cells labeled 'Heading 1',
'Heading 2' and so on providing the labels for the data or calculation fields. If the headings are
standard MindView task data headings (Start, End, Duration, Completion, Priority or Resources) the
data will be imported to the appropriate locations in MindView. If the headings are not standard
MindView headings the data will be imported as calculation values. See "Inserting task data" and
"Inserting calculation values" for more information on these topics).
In the Numbered layout you use the second column to contain the text that will become branch
labels, while the numbers in the first column (which must also be formatted as text) indicate the
hierarchy. The numbers take the form number.number.number…, the dots marking a change of
level in the hierarchy. The following diagram shows how cells in an Excel document (left) import
to a mind map (right):

The root is not included in the numbering scheme.
294

In the Structured layout you use the columns on the left to contain the text that will become
root and branch labels, and also indicate the hierarchy. The first column contains the root, the
second column the main branches, the third column first level sub-branches, and so on.
In the Flat layout, the leftmost column contains the text that will become branch labels. After the
root, each entry is imported as a main branch. No sub-branches are created.
If your spreadsheet does not have one of these layouts, you may nevertheless be able to import it
by indicating manually on the import dialog which areas of the spreadsheet represent branch text,
which represent data fields and so on (see below).

Procedure
Click the File tab.
Choose Import | Microsoft Excel.
You will see a dialog box reminding you of the preferred layouts, described above.
Select the Excel document you want to import and click OK.

If necessary, adjust the colored areas that indicate how the spreadsheet contents will be
mapped to the mind map. To do this, select an area and click the appropriate color button. You
can resize the dialog if you need to.
The contents of the orange cell in the top left becomes the title of the mind map.
The contents of the cells in the light blue area become the root and branch labels. By
adjusting this area you can choose to import all branches or a subset of branches, but the
area must not contain any blank rows. If the leftmost column in the area contains just one
filled cell, the content of that cell becomes the root label. If the leftmost column in the area
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contains more than one filled cell, the contents of those cells become first level branches
under a root whose label is taken from the title cell.
The contents of the cells in the yellow area become data values or calculation values,
depending on the column headings (see below). By adjusting the yellow area you can
specify which data columns are to be imported.
The contents of the dark blue area are headings for the data columns. If the headings are
standard MindView task data headings (such as Start, End, Duration, Completion,
Priority, Resources and so on) the data will be imported to the appropriate locations in
MindView. If the headings are not standard MindView ones the data will be imported as
calculation values. See "Inserting task data" and "Inserting calculation values" for more
information on these topics).
If you select an area that MindView cannot interpret, you will see a message "Invalid branch
layout". Common reasons for this message are:
You have data in cells that should be empty.
You have empty cells, for example blank rows, where data is expected.
In a structured layout, you have skipped one or more levels.
In a numbered layout, the first column does not contain text in the form of number(s)
separated by dots. Every number in this column must be in text format, not in number
format.
In a numbered layout, the cell to the left of the root label is not blank.
To overcome the problem adjust one or more of the colored areas, or click Cancel, adjust the
layout of the source spreadsheet, and try importing again.
To reset the areas to their state when you opened the dialog, click Reset.
Click OK.
The imported spreadsheet opens in the Mind Map view.
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Importing from Microsoft Outlook
MindView lets you import Microsoft® Outlook task lists. This is particularly useful when for
instance:
You have started a task list in Microsoft Outlook which you would like to expand using the
brainstorming capabilities and features of MindView.
You have exported a MindView task list to Microsoft Outlook, started adding tasks or editing
existing ones, but then realized you need to review the structure of your task list in MindView
before doing any further work in Microsoft Outlook.
In both cases, MindView allows you to import the Microsoft Outlook task list as a new document in
the Mind Map view.
Once you have made the required changes in MindView, you can either re-export the task list to
Outlook as a new series of tasks, or synchronize the edited MindView version with the original
Outlook version. For more information on exporting and synchronizing from MindView to Outlook,
see "Exporting to Microsoft Outlook task list".
You must have Microsoft Outlook 2000 or above installed on your computer in order to use this
import mode.

Procedure
Click the File tab.
Choose Import | Microsoft Outlook | Import as New Document.
Select the Outlook task folder whose tasks you want to import.
If the Outlook folder contains tasks that you have already imported to a MindView
document or exported from a MindView document previously, you might prefer to find the
MindView document in question and synchronize the task folder with it rather than creating a
new MindView document.
The imported task list opens in the Mind Map view.

Limitations
Only the elements of the Microsoft Outlook task list that have an equivalent in MindView are
imported and shown in the Task/Timeline panel:
Task names, dates, durations, priorities and completion levels are all imported.
Other information corresponding to features that are not supported in MindView, such as status,
reminders, categories and so on, as well as any user-defined field, is not imported.

Synchronizing the Outlook task list and the MindView document
If you have made changes to your task list in Outlook after having exported it from MindView, you
can import these latest changes to the MindView version of the task list as follows:
Click the File tab.
Choose Import | Microsoft Outlook | Synchronize Tasks.
The Synchronization from Microsoft Outlook to MindView dialog opens.
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The top part of the dialog determines what will happen when the same task exists in both the
Outlook task list and the MindView document in two different forms.
To copy the task from the Outlook task list to the MindView document, check Update the tasks
in MindView.
The bottom part of the dialog lets you specify what should happen if a task present in the Outlook
task list cannot be found in the MindView document. You have three choices:
Copy the task from the Outlook task list to the MindView document
Delete the task from the Outlook task list, so that it does not exist any longer in either version
Leave things as they are
If conversely you have made changes to your MindView document after having exported it to
Outlook, you can export these latest changes to the Outlook version of the task list. For more
information about this procedure, see "Exporting to Microsoft Outlook task list".
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Importing from Microsoft Project
MindView lets you import Microsoft® Project plans (*.mpp). This is particularly useful when for
instance:
You have started a project plan in Microsoft Project which you would like to expand using the
brainstorming capabilities and features of MindView.
You have exported a MindView project plan to Microsoft Project, starting adding tasks or editing
existing ones, but then realized you need to review the structure of your plan in MindView
before doing any further work in Microsoft Project.
In both cases, MindView allows you to import the Microsoft Project plan as a new project plan in the
Gantt view.
MindView does not support versions of Microsoft Project prior to 2003. You need to have
Microsoft Project installed on your computer in order to use this import method. If Microsoft Project
is not installed on your computer, you can import from the Microsoft Project XML format; for more
information, see "Importing from XML".

Procedure
Click the File tab.
Choose Import | Microsoft Project.
Select the Microsoft Project plan you want to import.
The imported project plan opens in the Gantt view.

Limitations
The MindView Gantt view does not support all the project management features offered by
Microsoft Project. This means that only the elements of the Microsoft Project that have an
equivalent in MindView will be imported:
Task names, task types, dates, durations, lead and lag times, resources, work units, costs,
priorities, completion levels, links, constraints and so on are all imported.
Project and resource calendars are imported.
Milestone tasks are imported, but their duration is set to zero.
Task notes are imported as text notes.
Other Microsoft Project information corresponding to features that are not supported in
MindView (such as baselines, task calendars, work contours and so on) is not imported.
Information derived from tracking and leveling operations in Microsoft Project is not imported.
In most cases, the tasks dates and scheduling information will be identical in MindView and in
Microsoft Project. They may differ if advanced operations not supported by MindView (such as
leveling or tracking) have been performed on the project in Microsoft Project.

299

Importing from XML
This import method lets you create MindView documents by importing files in various XML
formats into MindView.
MindView supports the following XML import file types:
MindView XML: This file type allows you to open MindView documents previously exported in
the MindView XML format.
Microsoft Project XML: This file type allows you to create a MindView project plan by
importing a Microsoft® Project plan exported from Microsoft Project in the XML format. You can
use the Microsoft Project XML import method even if you do not have Microsoft Project on your
computer. It is therefore a useful alternative to importing a Microsoft Project plan in the .mpp
format, for which you do need to have Microsoft Project installed on your computer.
The same limitations apply when importing a Microsoft Project XML file as when importing a
Microsoft Project .mpp file. For more information, see "Importing from Microsoft Project".
MindView does not support versions of Microsoft Project XML prior to 2003.
MindManager XML: This file type allows you to create a MindView document by importing a
MindManager® document exported from MindManager in the XML format. You can use the
MindManager XML import method even if you do not have MindManager on your computer.
Note that elements of the MindManager file that do not have an equivalent in MindView are
not imported. MindView supports MindManager XML files from versions X5 and 6.
MindManager MMAP: This file type allows you to create a MindView document by importing a
MindManager® document in the .mmap format. You can use the MindManager MMAP import
method even if you do not have MindManager on your computer.
Note that elements of the MindManager file that do not have an equivalent in MindView are
not imported.
Outline Processor Markup Language (OPML): This file type allows you to import a document
in OPML format, a general outline format supported by MatchWare.
In addition, you may import documents in XML formats compatible with MatchWare OpenMind 2,
FreeMind, Visual Mind and Microsoft Excel.

Procedure
Click the File tab.
Choose Import | XML.
Locate the file you want to import.
Choose the required import file type in the Type field.
The Autodetect XML file type presented by default lets MindView detect automatically the
type of the XML file you specify, provided that it is one of the supported XML file types.
Click OK.
The imported file opens in the Mind Map view.
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Importing from other applications
MindView lets you import documents from other Mind Mapping applications, namely Mindjet
MindManager (from version X5 onwards) and FreeMind, so that you can develop them further in
MindView.
Click the File tab.
Choose Import | Other Mind Mapping Applications.
Choose Import from Mindjet MindManager or Import from FreeMind.
Select the document you want to import.
Specify a destination folder and file name for the MindView document to be created.
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Pen Mode
Working in Pen Mode
MindView supports pen input as well as standard keyboard/mouse input, letting you insert
digital ink data such as handwritten text and hand-drawn pictures on your branches. Although
MindView's pen input features let you treat your computer mouse as a pen, they are designed for
use with dedicated pen input devices such as tablet PCs, external digitizers, touch screens and
interactive whiteboards. The only requirement is that the operating system on which MindView is
installed must also support pen input.
Once attached to a branch, the ink data is treated just as any other branch element.
You can use pen input only in the standard Mind Map views, namely Mind Map, Top Down and
Left/Right.
MindView also offers a dedicated Touch Mode for computers with touch screens. For more
information, see "Working in Touch Mode".

Enabling pen input
Before you can use your mouse or pen as input device, you must enable pen input.
If your computer supports pen input, the MindView Options dialog contains an extra panel for the
pen input options.
To access this tab:
Click the File tab.
Choose Options.
Click the panel Pen Input.

302

Enable pen input: Check this box to enable pen input. When pen input is enabled, a Pen Mode
button appears in the bottom right corner of the MindView status bar, allowing you to set Pen Mode
on and off.

Enable gestures: When this option is enabled, you can perform the MindView actions listed in the
paragraph "Using gestures" below by making the corresponding gesture with your input device.
Defaults for hand-drawn branch labels: When you use your pen to draw text for your branch
labels, it is often easier to write using large characters. You can use the Size (%) field to define a
factor which MindView will automatically use to reduce your hand-drawn text before inserting it on
the branch as branch label. Conversely, when you click a hand-drawn branch label to edit it,
MindView automatically expands the label if necessary to allow for easier editing. You can use the
Width and Line Height fields to define the initial size of this edit box. If the hand-drawn branch
label is wider or taller than the size chosen here, MindView automatically adjusts the size of the edit
box to the size of the label.
Default picture size for hand-drawn floating pictures: When you use your pen to draw floating
pictures, it is often easier to make large drawings. You can use this field to define a factor which
MindView will automatically use to reduce your hand-drawn pictures before attaching them to the
selected branch.
Default edit box size for hand-drawn pictures: When you double-click a hand-drawn picture to
edit it, MindView automatically expands it to allow for easier editing. You can use the Width and
Height fields to define the initial size of this edit box. If the hand-drawn picture is wider or taller than
the size chosen here, MindView automatically adjusts the size of the edit box to the size of the
picture.

Using Pen Mode
When pen input is enabled, a Pen Mode button is shown in the bottom right corner of the status
bar.
Click it to enable Pen Mode.
The Ink Tools tab appears in front of the Home tab on the ribbon.

You can now use your input device to start writing or drawing on the free space available in the
view (i.e. not on top of a branch, floating comment, floating picture or other MindView element).
Before you start writing or drawing, you can use your input device to select the branch to which
you want to add the ink data. After your first stroke, you are free to draw anywhere on the
workspace, including on top of branches or other MindView elements.
As you start writing or drawing, MindView attempts to interpret the ink data as text and displays
the result in the "Ink to Text" field shown just below the ribbon. This lets you correct any
misinterpretation by deleting the last stroke or strokes until you obtain the required result. You can
also click the down arrow shown at the right of the field to view all the possible interpretations of the
ink data and choose the relevant one. If you write more words than one, more fields may be shown.

When trying to interpret the ink data, MindView assumes that you are writing in the same
language as that defined as your input language in the Windows settings of your computer. If you
want your ink data to be interpreted using a different language, set your input language to that
language in the Windows Control Panel.
The Ink to Text feature only works if the correct modules are installed on your computer. See
"Getting help" for more information.
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Here is a short description of the tools contained in the Ink Tools tab:
As in the Home and Insert tabs, the Branch icon
the selected branch, and the Sub-Branch icon
branch.

lets you add a branch at the same level as
lets you add a sub-branch to the selected

The Select icon in the Pens group lets you select and/or move branches with your input device
rather than write or draw. The other icons contained in the Pens group let you choose the pen
to be used to write or draw: Ballpoint Pen lets you draw in black thin ink, Felt Tip Pen uses a
thicker red, and the Erase Tool lets you select and delete any of the strokes.
Rather than trying to select the stroke to be deleted, an easier way of using the Erase tool
is to drag the mouse across the workspace as you would use a rubber until the pointer hits
the stroke. Unlike a rubber however, the Erase tool deletes the entire stroke.
The icons contained in the Add Ink to Selected Branch group let you convert and transfer the
ink data to different elements of the map. Some of them are only enabled when you have
selected a branch and drawn at least one stroke:
Branch Label: Using this icon, you can choose to convert the ink data to text and use it as
branch label for the selected branch (Branch Label as Text) or to keep the ink data and use
it unchanged as branch label (Branch Label as Ink). If you choose to keep the ink data as is,
you can convert it to text at any time by selecting the branch and clicking Convert Branch Ink
to Text.
Comment: Click this icon to convert the ink data to text and add it to the selected branch
as pop-up comment.
Floating Comment: Click this icon to convert the ink data to text and add it to the selected
branch as floating comment. You can then move the floating comment on the workspace just
as you would in standard mouse input mode.
Text Note: Click this icon to convert the ink data to text and add it to the selected branch
as text note.
Branch Picture: This icon lets you convert the ink data to a picture (.png) and insert it on
the selected branch as branch picture.
Floating Picture: This icon lets you convert the ink data to a picture (.png) and add it to
the selected branch as a floating picture. The picture is reduced by a predefined factor, which
you can modify in the MindView Options dialog as described above in the paragraph
"Enabling pen input". You can then move the floating picture on the workspace just as you
would in standard mouse input mode.
In large or crowded maps, it is not always easy to find enough free space to draw. If this is
the case, it may be easier to click the Branch Picture or Floating Picture icon before starting to
draw. This causes MindView to open an edit box on top of the selected branch, in which you
can draw freely. When you have finished, just click outside the box. The ink data is then
automatically added to the branch.
The Color and Weight icons of the Format group let you redefine respectively the color and the
width of the pen.
To delete the last stroke drawn, click the Delete Last Stroke icon

.

The Delete All Strokes icon
removes from the workspace all the ink data that has not yet
been converted to a MindView.

Using gestures
As well as using the commands above, you can use pen movements, also called "gestures", to
perform particular actions on MindView elements (branches, sub-branches and so on). For this to
work, you must enable gestures in the MindView Options dialog, as described above in the
paragraph "Enabling pen input".
To use a gesture:
Select the relevant MindView element. For example, if you want to insert a sub-branch select
the parent branch; to delete a picture (which may have created by converting a pen tool
drawing), select the picture.
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Use the pen tool to draw the gesture.
Gestures are only recognized when done as a first stroke. They are not available when you are
editing ink data.
Here is a list of the gestures you can use:
Gesture

Name

Action

Drawing Method

Scratch-out

Delete

Draw at least 3 strokes, as
horizontal as possible.

Curlicue

Cut

DoubleCurlicue

Copy

Draw the double-curlicue at
an angle, from bottom left
to top right.

Caret

Paste

Draw both sides with
equal length, with a sharp
angle. You can draw in
either direction.

Left-semicircle

Undo

Draw the semicircle from
right to left. The two ends
should be on the same
horizontal line.

Rightsemicircle

Redo

Draw the semicircle from
left to right. The two ends
should be on the same
horizontal line.

Right

Insert Branch

Draw a single line from left
to right.

Down-right

Insert SubBranch

Start with the down stroke,
without lifting the pen. Draw
the two sides with equal
length and at a right angle.

Square

Insert New Root
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Draw the curlicue at an
angle, from bottom left to
top right.

Draw the square from the
upper left corner, without
lifting the pen. You can
draw in either direction.

Using the Tablet PC Input Panel
As well as using your pen to input text into MindView, you can also use the Windows built-in Tablet
PC Input Panel. On Microsoft Vista and Windows 7, this panel can also be used to edit existing text.
The Tablet PC input panel is not available on all Windows versions.

If for instance you use your pen to select a part of a branch label that you want to edit, the text will
be shown in the Windows Tablet PC Input Panel. Conversely any change you make to the text
shown in the panel is reflected on the branch label.
You can use the same method for text notes, comments and anywhere else in MindView where you
can input text, including all edit fields.

Using an interactive whiteboard
MindView is able to detect and support interactive whiteboards. All the operations described above
are supported.
If you are using a SMART Board, MindView automatically switches to Pen Mode when you pick up
a pen from the pen tray. In addition, MindView automatically sets its pen color and width to the color
and width of the pen you picked up. Picking up the SMART Board eraser automatically selects the
Erase Tool in MindView. When no pen has been picked up, a default black color is used.
The pen can also be used to navigate the MindView ribbon and menus in the same way as when
using a mouse.
To do a right click, you can press the right click button of the pen tray, use the SMART Board Tools
menu, or do a slow click with the pen by pressing it and holding it down for a few seconds.
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Speech Mode
Working in Speech Mode (AT Edition only)
This feature is only available in the Assistive Technology Edition (AT Edition) of MindView.
MindView is compatible with the speech recognition software Dragon NaturallySpeaking, letting you
use your voice to create and edit your mind maps.
For more information about the standard keyboard and mouse navigation speech commands
supported by Dragon NaturallySpeaking, refer to the documentation of your version of the
NaturallySpeaking software or the Nuance support web site page:
http://support.nuance.com/usersguides/default.asp?UsersGuidesProduct=naturallyspeaking
You will find below a list of all the additional commands you can speak to control MindView.

MindView navigation commands
To open the File menu, say Click File or Show Main Menu.
To select a ribbon tab, say "Click [tab name]".
To click a button or command in the ribbon, say "Click [button name]" or "Click [command
name].

Commands from the File menu
Speech command
New Mind Map
New Map
New Top Down
New Left Right
New Timeline
New Outline
New Gantt
New From Template

Description

Open
Save
Save As
Save As Template

Open an existing MindView document
Save the current MindView document
Save the current MindView document with a different name
Save the current MindView document as a template

Open Online
Save Online
Manage Online
Workspaces
Manage Places

Open a MindView document online
Save the MindView document online

Set Password
Properties
Additional Folders
Pack
Unpack
Data Files

Define a password for the current MindView document
View and edit the document properties
Specify a list of folders to include in HTML export and packing
Pack the document into a single file containing all the files attached to it
Unpack all the files included in the document in a folder of your choice
List all the files used in the document and replace them if necessary

Create a new document in the Mind Map view
Create a new document in the Top Down view
Create a new document in the Left/Right view
Create a new document in the Timeline view
Create a new document in the Outline view
Create a new document in the Gantt view
Create a new document based on a ready-made template

Manage the online workspaces and add new ones
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Send
Email

Send a copy of the MindView document in an email message as an
attachment

Quick Export to Word
Custom Export to Word
Quick Export to
PowerPoint
Custom Export to
PowerPoint
Quick Export to Excel
Custom Export to Excel
Export to Outlook
Synchronize Tasks with
Outlook
Export to Project
Quick Export to HTML
Custom Export to HTML
Quick Export to PDF
Custom Export to PDF
Export to Project
Reports
Quick Export to RTF
Custom Export to RTF
Save As Picture
Save As XML

Export to Microsoft Word using defaults or last settings used
Export to Microsoft Word using customized settings
Export to Microsoft PowerPoint using defaults or last settings used
Export to Microsoft PowerPoint using customized settings
Export to Microsoft Excel using defaults or last settings used
Export to Microsoft Excel using customized settings
Export to Microsoft Outlook as a set of new tasks
Synchronize and update the tasks from MindView to Microsoft Outlook
Export to Microsoft Project
Export to HTML using defaults or last settings used
Export to HTML using customized settings
Export to PDF using defaults or last settings used
Export to PDF using customized settings
Create HTML reports for the project plan
Export to RTF using defaults or last settings used
Export to RTF using customized settings
Save the current MindView document as a picture
Export the current MindView document in the XML format

Import from Word

Create a MindView document by importing a Microsoft Word document
Create a MindView document by importing a Microsoft PowerPoint
Import from PowerPoint
presentation
Import from Excel
Create a MindView document by importing a Microsoft Excel spreadsheet
Import from Outlook
Create a MindView document by importing a Microsoft Outlook task list
Synchronize Tasks with
Synchronize and update the tasks from Microsoft Outlook to MindView
MindView
Import from Project
Create a MindView document by importing a Microsoft Project plan
Import from XML
Create a MindView document by importing an XML document
Import from
Create a MindView document by importing a Mindjet MindManager
MindManager
document
Import from FreeMind
Create a MindView document by importing a FreeMind document
Print
Close
MindView Options
Exit MindView

Preview and print the current MindView document
Close the current MindView document
View and modify MindView options and access online resources
Quit the application

Commands from the Home tab
Speech command
Paste
Cut
Copy
Copy Format

Description
Paste the contents of the Clipboard
Cut the selection from the document and put it on the Clipboard
Copy the selection and put it on the Clipboard
Copy the formatting from one element using the Format Painter
308

Paste Format
Insert Branch
Add Branch
New Branch
Branch
Insert Sub-Branch
Add Sub-Branch
New Sub-Branch
Sub-Branch
New Text Note
Text Note
Text Note Editor
Insert Comment
Add Comment
Insert Branch Picture
Add Branch Picture
Insert Attachment
Add Attachment
Insert Hyperlink
Add Hyperlink

Paste the formatting using the Format Painter

Add a new branch at the same level as the selected branch

Add a new sub-branch to the selected branch
Add a text note to the selected branch
Toggle between selected branch and Text Note editor
Show and hide the Text Note editor window
Add a pop-up comment to the selected branch
Add a branch picture to the selected branch
Add a file to the selected branch
Add a hyperlink to the selected branch

Zoom 100 Per Cent
Fit All
Full Screen
Zoom In
Zoom Out

Zoom the document to 100%
Zoom the document so that it fills the workspace
Display the document in full screen mode
Zoom in on the document
Zoom out on the document

Focus Mode
No Numbering Scheme
Numbering Scheme 1
Numbering Scheme 2
Numbering Scheme 3
Numbering Scheme 4
Numbering Scheme 5
Numbering Scheme 6
Numbering Scheme 7
Start Numbering from
Root

Center the map on the selected branch
Do not apply automatic numbering to the branches of the document
Choose numbering scheme 1
Choose numbering scheme 2
Choose numbering scheme 3
Choose numbering scheme 4
Choose numbering scheme 5
Choose numbering scheme 6
Choose numbering scheme 7

Show as Mind Map
Show as Top Down
Show as Left Right
Show as Timeline
Show as Outline
Show as Gantt

Display the document in the Mind Map view
Display the document in the Top Down view
Display the document in the Left Right view
Display the document in the Timeline view
Display the document in the Outline view
Display the document in the Gantt view

Select All
Indent
Outdent

Select all the branches in the document
Indent the selected branch or task
Outdent the selected branch or task

Start numbering the branches from the root of the document
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Commands from the Review tab
Speech command
Spellcheck Document
Narrate
Find and Replace

Description
Spellcheck the entire document
Read out the selected branch label, comment or text note
Find and replace text in the document

Commands from the View tab
Speech command
Show Detail Level 1
Show Detail Level 2
Show Detail Level 3
Show Detail Level 4
Show All Levels
Add Bookmark
Remove Bookmark
Show Smart Nav
Show Legend
Presentation Mode
Simple Interface

Description
Only show the root and the main branches
Only show the root, the main branches and one level of sub-branches
Only show the root, the main branches and two levels of sub-branches
Only show the root, the main branches and three levels of sub-branches
Show the root, the main branches and all their sub-branches
Bookmark the selected branch to be able to find it again quickly
Remove the bookmark from the selected branch
Show and hide the Smart Navigation toolbar
Show and hide the Legend panel
Present the map branch by branch in full view mode
Switch to a simplified interface showing only the most commonly used
commands

Other viewing commands
Speech command
Show Main Menu
Show Backstage
Toggle Backstage
Click File
Show Task Timeline
Panel
Task Timeline Panel
Toggle Task Timeline
Panel
Click Task Timeline
Show Pictures Panel
Pictures Panel
Toggle Pictures Panel
Click Pictures
Show Multimedia
Catalog
Multimedia Catalog
Toggle Multimedia
Catalog
Click Multimedia
Catalog
Show Icons Panel
Icons Panel
Toggle Icons Panel
Click Icons
Show Calculation panel
Calculation Panel
Toggle Calculation

Description
Open the File menu

Show the Task/Timeline panel

Show the Pictures panel

Show the Icons panel

Show the Calculation panel
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Panel
Click Calculation
Focus Outline
Focus Timeline
Focus Gantt
Task Information
Project Information
Project Calendars
Project Resources

Focus on the Outline
Focus on the Timeline
Focus on the Gantt chart
Open the Task Information dialog
View and modify the global project settings
View and modify the project calendars
View and modify the list of all the resources available for the project

Other editing and navigation commands
Speech command
Capture
Home
Select Root
Begin Edit
Edit Label
Edit Branch
Edit Name
End Edit
Delete
Undo
Redo
Collapse
Expand
Left
Right
Up
Down
Next window
Previous window

Description
Capture text and images and place them on the selected branch
Select the root of the map

Edit the selected text
Leave the editing mode
Delete the selected element
Undo the last action performed
Redo the last action undone
Collapse the selected branch
Expand the selected branch
Go left
Go right
Go up
Go down
Move focus forwards between document, open panels and the ribbon
Move focus backwards between document, open panels and the ribbon
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Touch Mode
Working in Touch Mode
MindView supports touch screen technology and includes a number of features that increase user
friendliness when using the application on a computer with a touch screen. You can access these
features by switching to Touch Mode.
The default setting in MindView is Mouse Mode.

Switching to Touch Mode
Click the Touch/Mouse Mode icon on the Quick Access Toolbar, and select Touch in the
submenu.
If the command is not visible on the Quick Access Toolbar, customize the toolbar to show it.
See "Setting up your workspace" for more information on how to do this.
The user interface switches to Touch Mode.

Features in Touch Mode
The following features are available in Touch Mode:

Zoom
You can zoom the mind map using two fingertips.
To zoom in, place two fingertips close together on the touch screen, and drag them apart.
To zoom out, place two fingertips apart on the touch screen, and move them together.

Pan
You can pan your mind map using two fingertips.
Place two fingertips close together on the touch screen, and drag them sideways.

Context menu access
You can tap with two fingers on branches and other mind map elements to open a context menu
with relevant commands.
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Ribbon Touch mode
The ribbon is larger than in Mouse Mode, making it easier to accurately hit the icons with your
fingertips.
This setting differs from the simplified user interface in that all icons are still visible but are
larger. This makes the workspace slightly smaller; when not working on computer with a touch
screen it is therefore advisable to work in Mouse Mode. For more information on switching to the
simplified interface, see "Setting up your preferences".

Switching back to Mouse Mode
Click the Touch/Mouse Mode icon on the Quick Access Toolbar, and select Mouse in the
submenu.
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Reference
Reference
The reference section contains a description of the following MindView features:
Properties
These topics give a full description of the properties applicable to each of the MindView
elements, such as the view itself, the root, the branches and the various objects.
Calculation functions
This topic lists and describes all functions available in MindView calculation values.
Shortcuts
This topic lists all the keyboard shortcuts provided by MindView.
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Properties
Overview
The Properties dialog shows the properties of the MindView element currently selected, for
example the root, a branch or a floating comment. If nothing is selected the properties of the current
view are shown.
You can use the Properties dialog to make fine-tuning changes to these elements, as described in
"Using the Properties dialog."
Rather than applying properties one by one to enhance the visual aspect of your branches, it is
normally easier to use the Format tab shown at the right of the ribbon when the branch is selected.
Using this tab, you can apply branch shapes, branch colors and other coordinated attributes in one
step. Similarly, the Design tab lets you apply predefined layouts and styles to the entire map in one
step.
The topics of this section describe in detail the properties shown in the Properties dialog for the
various MindView elements.
Notes:
If the Properties dialog is not visible, choose View | Show/Hide | Panels | Properties to open
it.
The properties described are not always applicable to all views. The Properties dialog only lists
the properties applicable to the selected element in the current view.
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View
View properties: General tab
When you click the workspace (in other words away from the root or any branch), the following
properties are shown in the Properties dialog.

Page Color: Click the small rectangle to choose a new color for the workspace.
Word Wrap Text: Check this box if you want the text to wrap automatically to the next line when
you enter long branch names. This setting applies to all the branches of your document.
Show Duration Bars: (Timeline view only) If you have entered both a start time and an end time
for a particular event, you can use this property to show the duration of the event as a bar below the
time axis.
Show Bar Text: (Timeline view only) Check this box to display the label of each branch at the end
of the corresponding bar on the timeline. This option is only available for timeline designs showing
duration bars under the time axis.
Show Title: (Timeline view only) By default, the timeline displays the root name as title, or, if you
are focusing on a particular branch, the name of that branch. You can use this property to change
the title position or to remove the default title altogether.
Show Time Breaks: (Timeline view only) You can use this property to replace any empty space on
the time axis with one or more break marks. This optimizes the use of the horizontal space when
events are not evenly distributed along the timeline.
Critical Path Color: (Gantt view only) Click the small rectangle to choose a different color for the
tasks highlighted when viewing the project's critical path (to display the critical path, choose Gantt
Tools | View | Show Critical Path).
Today's Date Color: (Gantt view only) Click the small rectangle to choose a different color for the
vertical line displayed on the Gantt chart to highlight the current date (to display the current date,
choose Gantt Tools | View | Show Today's Date).
Task Bar Height: (Gantt view only) Enter a value between 1 and 40 to set the height of all task
bars in the Gantt chart.
Summary Bar Height: (Gantt view only) Enter a value between 1 and 40 to set the height of all
summary bars in the Gantt chart.
Milestone Bar Height: (Gantt view only) Enter a value between 1 and 40 to set the height of all
milestone bars in the Gantt chart.
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View properties: Branches tab
The Branches tab of the View properties dialog allows you to define default properties for the
branches of your map.

Vertical Branch Gap: This value represents the vertical spacing between each set of branches.
The default value depends on the view used.
Horizontal Branch Gap: This value represents the horizontal spacing between each set of
branches. The default value depends on the view used.
Show Branch Connections: This box is checked by default. Uncheck it if you do not want branch
connections to be visually represented on your map. See "Creating branch connections" for more
information.
Show Task Links: This box is unchecked by default. Check it to display task link connections on
your map. See "Using links" for more information.
Auto-Layout: By default, MindView automatically arranges the main branches as you insert them
to prevent any overlap. You can however choose to reposition the main branches yourself after
their insertion by unchecking this box to disable the auto-layout mode. See "Moving a branch" for
more information.
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View properties: Branch Data tab
The Branch Data tab of the View properties dialog allows you to define the default properties of the
branch data shown on the branches of your map.
The branch data is the block of data that may be displayed below particular branch labels on your
map (containing for instance task details, timeline information or calculation values).

These properties behave in the same way as the properties of the branch itself. For more
information, see "Branch properties: General tab" and "Branch properties: Text tab".
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Root
Root properties: General tab
When you select the main root or any other root contained on your map, the following properties
are shown in the Properties dialog.

Text: This property shows the label of the currently selected root. You can edit it or enter a new
label by typing in the input field. If you have split a long label on several lines by pressing Ctrl +
Enter at the end of each line when creating the branch (rather than let the label wrap
automatically), this field will not be editable and will only contain the first line of the label.
Fill Type: Choose the fill type required for the space enclosed by the root outline.
Fill Color 1: Click the small rectangle to choose a new fill color.
Fill Color 2: This property only appears if you have chosen a gradient fill type. It lets you choose
the end color for the gradient.
Fill Mode: This property only appears if you have chosen a gradient fill type. It lets you choose the
direction of the gradient.
Outline Color: Click the small rectangle to choose a new outline color.
Outline Width: This value defines the width of the outline.
Task Active: (Gantt projects only) Uncheck this option to make the task inactive, so that it no
longer affects the project schedule. See the paragraph "Making a task inactive" in the topic
"Enhancing a project plan" for more information.
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Root properties: Text tab
The Text tab of the Root properties dialog allows you to define all the properties related to the root
label.

Font Name: Click this field to choose a new font for the label.
Font Size: Use this field to specify the font size.
Bold/Italic/Underline/Strikethrough: Check the relevant box to enable the corresponding effect.
Text Highlight Color: Click the small rectangle to choose a new color for the label background.
Text Color: Click the small rectangle to choose a new color for the label.
Alignment: This property lets you right-align, left-align or center the label within the root shape.
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Root properties: Picture tab
The Properties dialog of the root only contains a Picture tab if you have inserted a branch picture on
the root. The Picture tab allows you to define the properties related to the branch picture.

Picture Name: By default, this field shows the name of the picture file. You can however replace it
with a name of your choice.
If you export your document to HTML, this picture name will also be inserted in the Alt meta-tag
for the picture in the .html file. When viewing the HTML page in the browser and moving the
mouse pointer over the picture, you will therefore see the name of the picture appear in a small
frame under the picture.
Path: This shows the path of the picture. Enter a new folder and/or file name or click the Browse
button
to choose a different picture.
Width: This field shows the current width of the picture. You can resize the picture by entering a
different value.
Height: This field shows the current height of the picture. You can resize the picture by entering a
different value.
Aspect Ratio: This box is checked by default. Uncheck it if you do not want to preserve the
proportions of the picture (in other words, the ratio between its width and its height) when resizing it.
To reset the picture to its initial size, uncheck the box and check it again.
Opacity: By default, this field has the value 100, which means that the picture is 100% visible. You
can give it a transparency effect by entering a lower value, thereby decreasing its opacity. The
value 1 means that the picture is completely transparent.
Include in Export: This box is checked by default. Uncheck it if you intend to export your map to
another format (HTML, Word and so on) but do not want the branch picture to be exported.
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Branch
Branch properties: General tab
When you select a branch or sub-branch on your map, the following properties are shown in the
Properties dialog.

Text: This property shows the label of the currently selected branch. You can edit it or enter a new
label by typing in the input field. If you have split a long label on several lines by pressing Ctrl +
Enter at the end of each line when creating the branch (rather than let the label wrap
automatically), this field will not be editable and will only contain the first line of the label.
Fill Type: Choose the fill type required for the space enclosed by the branch outline.
Fill Color 1: Click the small rectangle to choose a new fill color.
Fill Color 2: This property only appears if you have chosen a gradient fill type. It lets you choose
the end color for the gradient.
Fill Mode: This property only appears if you have chosen a gradient fill type. It lets you choose the
direction of the gradient.
Outline Color: Click the small rectangle to choose a new outline color.
Outline Width: This value defines the width of the outline.
Task Name Color: (Gantt view only) Click the small rectangle to choose a new color for the task
name displayed after the task bar.
Task Resources Color: (Gantt view only) Click the small rectangle to choose a new color for the
task resources names displayed after the task bar.
Bar Height: (Gantt view only) Enter a value between 1 and 40 to specify the height of the selected
task bar in the Gantt chart.
Bar Hidden: (Gantt view and Timeline view only) Check this option to hide the bar representing the
task or event from the chart or timeline. See the paragraph "Hiding the bar of a task" in the topic
"Enhancing a project plan" for more information.
Line Color: Click the small rectangle to choose new color for the line connecting the branch to its
parent branch.
Line Width: Enter a value between 1 and 5 to specify the width of the line connecting the branch to
its parent branch.
Boundary: Check this box to show a boundary around the branch and all its sub-branches.
The next fields only appear if you have checked the Boundary property.
Boundary Fill Type: Choose the fill type required for the space enclosed by the boundary.
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Boundary Fill Color 1: Click the small rectangle to choose a new fill color.
Boundary Fill Color 2: This property only appears if you have chosen a gradient fill type. It lets
you choose the end color for the gradient.
Boundary Fill Mode: This property only appears if you have chosen a gradient fill type. It lets you
choose the direction of the gradient.
Boundary Outline Color: Click the small rectangle to choose a new color for the boundary outline.
Boundary Outline Width: Enter a value between 1 and 5 to define the width of the boundary.
Boundary Outline Roundness: Enter a value between 1 and 50 to define how rounded the
corners of the boundary should be.
Boundary Outline Dash Style: Click the down arrow to choose a style for the boundary.
Include in Export: This box is checked by default. Uncheck it if you intend to export your map to
another format (HTML, Word and so on) but do not want the branch and all its sub-branches to be
exported.
Task Active: (Gantt projects only) Uncheck this option to make the task inactive, so that it no
longer affects the project schedule. See the paragraph "Making a task inactive" in the topic
"Enhancing a project plan" for more information.
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Branch properties: Text tab
The Text tab of the Branch properties dialog allows you to define all the properties related to the
branch label.

This tab is identical to the Text tab of the root. See "Root properties: Text tab" for more information.
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Branch properties: Picture tab
The Properties dialog of a particular branch only contains a Picture tab if a branch picture has been
inserted on the branch. The Picture tab allows you to define the properties related to the branch
picture.

This tab is identical to the Picture tab of the root. See "Root properties: Picture tab" for more
information.
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Branch Data
Branch data properties: General tab
When you select the block of data displayed below a particular branch label on your map (such as
task or timeline information, or again calculation values), the following properties are shown in the
Properties dialog.

These properties behave in the same way as the properties of the branch itself. For more
information, see "Branch properties: General tab" and "Branch properties: Text tab".
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Text note
Text note properties: General tab
When you select a text note in the Object list of a branch, the following properties are shown in the
Properties dialog.

Name: This shows the default name of the text note. You can edit it or enter a different name to
help you identify the text note.
Include in Export: This box is checked by default. Uncheck it if you intend to export your map to
another format (HTML, Word and so on) but do not want the text note to be exported.
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Floating comment
Floating comment properties: General tab
When you select a floating comment on the workspace, the following Properties dialog is shown.

Text: This shows the contents of the comment. You can edit it by typing in this field.
Fill Type: Choose the fill type required for the space enclosed by the comment outline.
Fill Color 1: Click the small rectangle to choose a new fill color.
Fill Color 2: This property only appears if you have chosen a gradient fill type. It lets you choose
the end color for the gradient.
Fill Mode: This property only appears if you have chosen a gradient fill type. It lets you choose the
direction of the gradient.
Outline Color: Click the small rectangle to choose a new color for the frame surrounding the
comment.
Outline Width: Edit this field to increase or decrease the width of the frame surrounding the
comment.
The next properties only appear if the floating comment is connected to a branch.
Line Color: Click the small rectangle to choose a new color for the line connecting the comment to
the branch.
Line Width: Edit this field to increase or decrease the width of the line connecting the comment to
the branch.
Show Icon: This box is checked by default. Uncheck it to prevent the display of the pin icon on the
left side of the comment field
Include in Export: This box is checked by default. Uncheck it if you intend to export your map to
another format (HTML, Word and so on) but do not want the floating comment to be exported.
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Floating comment properties: Text tab
The Text tab of the Floating comment properties dialog allows you to define all the properties
related to the comment text.

Font Name: Click this field to choose a new font for the comment.
Font Size: Use this field to specify the font size.
Bold/Italic/Underline/Strikethrough: Check the relevant box to enable the corresponding effect.
Text Highlight Color: Click the small rectangle to choose a new color for the comment
background.
Text Color: Click the small rectangle to choose a new color for the comment text.
Text Wrap Width: This defines the length of text that can be typed before wrapping onto the next
line.
Alignment: This property lets you right-align, left-align or center the text of the floating comment
within its frame.
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Floating picture
Floating picture properties: General tab
When you select a floating picture on the workspace, the following properties are shown in the
Properties dialog, provided that the floating picture is connected to a branch. If the floating picture is
not connected to any branch, the Properties dialog only shows the Picture tab.

Line Color: Click the small rectangle to choose a new color for the line connecting the floating
picture to the branch.
Line Width: Edit this field to increase or decrease the width of the line connecting the floating
picture to the branch.
Include in Export: This box is checked by default. Uncheck it if you intend to export your map to
another format (HTML, Word and so on) but do not want the floating picture to be exported.
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Floating picture properties: Picture tab
Clicking the Picture tab of the Floating picture properties dialog shows the following dialog.

This tab is identical to the Picture tab of the root. See "Root properties: Picture tab" for more
information.
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Attachment
Attachment properties: General tab
When you select an attachment in the Object list of a branch, the following properties are shown in
the Properties dialog.

Name: By default, this field shows the name of the attached file. You can however replace it with a
name of your choice to help you identify the attachment.
If the attachment is a picture file, the name is also used as descriptive label when exporting to
HTML:
If you export your document to HTML, this picture name will also be inserted in the Alt meta-tag
for the picture in the .html file. When viewing the HTML page in the browser and moving the
mouse pointer over the picture, you will therefore see the name of the picture appear in a small
frame under the picture.
Path: This shows the path of the attached file. Enter a new folder and/or file name or click the
Browse button
to choose a different file.
Export As: By default, the attachment is exported in the format you define during the export
procedure for all attachments of this type. This property however gives you the option to export the
selected attachment in a different format. If for instance you choose during the HTML export
procedure to export all text attachments as buttons, you can override this choice for the selected
attachment, and choose instead to export it as a hyperlink.
Include in Export: This box is checked by default. Uncheck it if you intend to export your map to
another format (HTML, Word and so on) but do not want the attached file to be exported.
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Hyperlink
Hyperlink properties: General tab
When you select a hyperlink in the Object list of a branch, the following properties are shown in the
Properties dialog.

Text: By default, this field shows the name of the hyperlink. If you export your map, it is the text that
will make up the hyperlink. You can replace it with any other text as required.
URL: This shows the URL of the hyperlink. You can edit this field as required or enter a new URL.
Export As: By default, hyperlinks are usually exported as hyperlinks. This property gives you the
option to override this default export format for the selected hyperlink, and export it instead as a
button.
Include in Export: This box is checked by default. Uncheck it if you intend to export your map to
another format (HTML, Word and so on) but do not want the hyperlink to be exported.
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Branch connection
Branch connection properties: General tab
When you select a branch connection in the Object list of a branch, the following properties are
shown in the Properties dialog.

Name: This shows the name given to the branch connection, which by default is the name of the
end branch.
Line Color: This defines the color of the branch connection. Click the small rectangle to choose a
new color.
Line Width: Edit this field to increase or decrease the width of the branch connection.
Active Color: This defines the color of the branch connection when hovered.
Dash Style: This field lets you choose between various line styles.
Show Label: This box is unchecked by default. Check it to show the branch connection label.
Include in Export: This box is checked by default. Uncheck it if you intend to export your map to
another format (HTML, Word and so on) but do not want the branch connection to be exported.

334

Task link connection
Task link connection properties: General tab
When you select a task link connection in one of the Mind Mapping views, the following properties
are shown in the Properties dialog.

Line Color: This defines the color of the task link connection. Click the small rectangle to choose a
new color.
Line Width: Edit this field to increase or decrease the width of the task link connection.
Active Color: This defines the color of the task link connection when hovered.
Dash Style: This field lets you choose between various line styles.
Show label: This box is checked by default. Uncheck it to hide the task link connection label.
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Calculation functions
List of calculation functions
The sections below provide an overview of all calculation functions available in MindView. For more
information on using functions in calculation values, see "Entering formulas" in "Inserting calculation
values".

Functions in the Sub-Branches group
The functions in the Sub-Branches group automatically calculate a value based on values in the
sub-branches:
AVG gives the average of the values for this field from the sub-branches one level below the
current one.
COUNT gives the number of sub-branches one level below the current one.
MAX([argument],[argument]) gives the maximum value for this field from the sub-branches
one level below the current one. If you specify two arguments (optional), the function returns
the largest value of the two arguments.
MIN([argument],[argument]) gives the minimum value for this field from the sub-branches one
level below the current one. If you specify two arguments (optional), the function returns the
smallest value of the two arguments.
SUM gives the total created by adding the values for this calculation field, from the subbranches one level below the current one. It is useful for creating sub-totals throughout your
mind map.

Functions in the Project Management group
The functions in the Project Management group are all related to Gantt projects and are therefore
only available when you are working in Project Management mode (i.e. when your document type is
set to "Project Management" in the Task/Timeline panel). For more information about Gantt
projects, see "Using the Gantt view", and in particular "Assigning resources".

The MindView date-time format
Several functions in the Project Management group and elsewhere return results in the MindView
date-time format. This is a numerical format which shows how many seconds have elapsed from
the year 1 until the date and time specified. As a consequence, numbers in the MindView date-time
format are often quite large; for example, the MindView date-time value for 16 December 2018 is
63,680,515,200. Such numbers make little sense in themselves and are cumbersome to type. If you
need to use a MindView date-time number as an argument in a function, it is more convenient to
insert a function that provides the number you need.
For example, if you need to check the number of working days between the current time and the
task end time, you can use the functions END and NOW (both of which provide the data you need
in the MindView date-time format) as arguments for the WORKDAYS function and type
WORKDAYS(END,NOW).
Conversely, a number of functions (such as MINUTE and YEAR) convert MindView date-time
figures to date and time information. Again, typing MindView date-time figures as arguments for
these functions would be cumbersome. Instead, consider using another function as an argument
when using these functions; for example, YEAR(BASELINESTART) returns the year of the baseline
start date of the current task.

Functions that rely on the default baseline
A number of functions in the Project Management group return the baseline values for start and
end times, duration, work and cost for the selected task. These baseline values are retrieved from
the default baseline defined for the project.
If a default baseline has not been defined, functions that return results in the MindView date-time
format return 1. Functions that return results in other formats (for example BASELINEDURATION
and BASELINECOST) return 0.
For more information on setting a default baseline, see "Saving a project baseline" in "Enhancing a
project plan".
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ACTUALCOST gives you the cost incurred so far by the current task, on the basis of the overall
fixed cost and resources cost and the percentage of completion of the task.
ACTUALWORK gives you the amount of work performed so far, on the basis of the overall
amount of work and the percentage of completion of the task.
BASELINECOST gives you the baseline cost of the current task (fixed cost plus the total cost of
all resources (human and material) allocated to the current task).
BASELINEDURATION gives you the baseline duration of the current task in seconds.
BASELINEEND gives you the baseline end time of the current task as a number in the
MindView date-time format.
BASELINESTART gives you the baseline start time of the current task as a number in the
MindView date-time format.
BASELINEWORK gives you the baseline amount of work to be performed on the current task
by all its resources.
COMPLETION gives you the completion percentage of the current task (from 0 to 100).
COST gives you the overall cost of the current task (fixed cost plus the total cost of all
resources (human and material) that have been allocated to the current task).
DURATION gives you the duration of the current task in seconds.
END gives you the end time of the current task as a number in the MindView date-time format.
FIXEDCOST gives you the total fixed cost of the current task; in other words, cost not
associated with resources.
NUMRESOURCES gives you the number of resources (human and material) assigned to the
current task.
PRIORITY gives you the priority of the current task (from 0 to 1000, where 1000 is high priority).
REMAININGCOST is the difference between the overall cost of the task (fixed cost plus
resources cost) and the actual cost.
REMAININGWORK is the difference between the overall amount of work and the actual work.
START gives you the start time of the current task as a number in the MindView date-time
format.
WORK gives you the overall amount of work to be performed on the current task by all its
resources.
The four work values are calculated and expressed in seconds.
If you are viewing your Gantt project in one of the standard Mind Map views, you can display
these values directly on the branches of the mind map as explained under "Showing or hiding
values" in "Inserting calculation values". You can also define the currency symbol and the number
of decimal digits to be used. See "Currency" in the topic "Setting up your preferences".

Functions in the Math & Trig. group
The functions in the Math & Trig. group calculate a value based on values or field references which
you enter:
ABS(number) returns an absolute value, in other words a negative value becomes positive. For
example, ABS({payment}) returns the value 200 if the value in the field {payment} is 200 or 200.
CEILING(number,[significance]) returns the value rounded up to the nearest multiple of
significance. If you do not specify significance, in other words the value that the multiple should
be calculated from, the number is rounded up to the nearest integer by removing any decimals.
For example, CEILING(56.78) returns 57, as significance was not specified, and 56.78 is
therefore rounded up to 57. CEILING(56.78,11) returns 66, as 56.78 is rounded up to the
nearest multiple of 11, or 66.
FLOOR(number,[significance]) returns the value rounded down to the nearest multiple of
significance. If you do not specify significance, the number is rounded down to the nearest
integer by removing any decimals. For example, FLOOR(56.78) returns 56, as significance was
not specified, and 56.78 is therefore rounded down to 56. FLOOR(56.78,11) returns the value
55, as 56.78 is rounded down to the nearest multiple of 11, or 55.
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INT(number) rounds down the number to the nearest whole number, or integer. For example,
INT(3.9) returns the value 3.
LN(number) returns the natural logarithm (log to base e) of a number. For example LN(123.4)
returns the value 4.82.
LOG(number,[base]) returns the logarithm of a number. You can specify the base of the
logarithm; if you do not, 10 is used. For example LOG(123.4) returns the value 2.09 (base 10),
and LOG(123.4,5) returns the value 2.99 (base 5).
MOD(number,divisor) returns the remainder after a number has been divided by a divisor. For
example, MOD(14,3) returns the value 2; the remainder after dividing 14 by 3.
POWER(number,power) returns the result of a number raised to a power. For example,
POWER(6,2) returns the value 36 which is six squared.
SQRT(number) returns the square root of a number. For example, SQRT(2) returns the value
1.41, the square root of two.

Functions in the Financial group
The functions in the Financial group also calculate a value based on values or field references
which you enter:
EFFECT(nominal_rate,npery) returns the effective yearly interest rate based on the nominal
interest rate and the number of compounding periods in the year. Nominal_rate is the nominal
interest rate and must be entered as a decimal figure. Npery is the number of compounding
periods per year. For example, if you have a field called Rate that contains an interest rate of
0.05 (5%) and a field called Periods that contains 12, the number of compounding periods in
the year, then EFFECT({Rate},{Periods}) returns 0.0511 (5.11%). In other words, an annual
rate of 5% compounded monthly is equivalent to 5.11% if only a single annual interest payment
is made. This function is the reverse of NOMINAL, below.
FV(rate,nper,pmt,[pv],[type]) returns the future value of a series of equal payments at a
constant interest rate. Rate is the interest rate per period. It can be entered as a decimal figure
(for example, entering 2.5% as 0.025) or as the result of an operation (for example, entering
quarterly payments at 6% APR as 6/4*100). Nper is the total number of payment periods for the
investment. Pmt is the payment made during each period; it must be entered as a negative
figure and cannot change over the lifetime of the investment. You may also specify pv (the
present value of the series of future payments) and type (whether payments are made at the
beginning (1) or end (0) of each period); both of these optional arguments are automatically set
to 0 if you do not specify them. For example, FV(0.025,5,-120) gives 630.76, the result of
saving $120 annually for 5 years at an interest rate of 2.5%. Note that the payment figure
(money out) is negative whereas the end result (money in) is positive.
NOMINAL(effect_rate,npery) returns the annual nominal interest rate based on the effective
interest rate and the number of compounding periods in the year. Effect_rate is the effective
interest rate and must be entered as a decimal figure. Npery is the number of compounding
periods per year. For example, NOMINAL(0.0511,12) returns 0.05. In other words, a yearly
return of 0.0511 (5.11%) is equivalent to 0.05 (5%) if compounding is done monthly. This
function is the reverse of EFFECT, above.
PV(rate,nper,pmt,[fv],[type]) returns the amount you would need to invest today in order to
match a series of future payments. The arguments are the same as for FV, above, except the
optional argument fv which you can use to indicate the future value or cash balance you want
to attain. As an example of how to use the PV function, suppose you have the choice of
receiving a life insurance payout of $10,000 now or 10 annual payments of $1,200 a year.
Which would be the better option, supposing the annual interest rate over the 10 years to be
4% (0.04)? The calculation PV(0.04,10,-1200) gives a result of $9,733 which is the amount that
would need to be invested today for 10 years in order to match the value of the 10 annual
payments of $1200, assuming 4% interest. In other words the lump sum of $10,000 is better.
Note that the payment figure (money out) is negative whereas the end result (money in) is
positive.
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Functions in the Other group
The functions in the Other group allow you to carry out logical tests of values or expressions,
convert date and time entries to and from the MindView date-time format, and show the working
hours or days for specific periods.
To show dates and times without a thousands separator and decimals in the calculation fields,
use the Defaults dialog as described under "Entering defaults" in "Inserting calculation values".
DATE(year,month,day) returns the date you enter as a number in the MindView date-time
format.
DAY(number) returns the day of the month (a number from 1 to 31) from a MindView date-time
number.
DAYS(end_date,start_date) returns the number of days between two dates. You can use other
functions for the arguments start_date and end_date, or provide them in the MindView datetime format. For example, DAYS(TODAY,START) returns the number of days between the task
start date and the current date.
DAYSPERMONTH returns the number of default working days per month. The result is based
on the working days defined in the project calendar.
HOUR(number) returns the hour (a number from 0 (12:00 AM) to 23 (11:00 PM) from a
MindView date-time number.
HOURSPERDAY returns the number of default working hours per day in minutes. The result is
based on the working hours defined in the project calendar.
HOURSPERWEEK returns the number of default working hours per week in minutes. The
result is based on the working hours defined in the project calendar.
IF(logical_test,value_if_true,value_if_false) checks whether a condition is met. It returns one
value if the condition is met and another if it is not. Logical_test is the logical test to be made,
and the two value arguments specify what values should be returned if the logical test is true or
false. Both value arguments are optional; if you do not specify these, the function returns 1 if
true, and 0 if false. You can evaluate any value or expression using the logical test, and you
can reference other calculation fields. For example, IF({sales price}>1000,50,25) returns 50 if
the value of the calculation field {sales price} is above 1000, and 25 if the value is 1000 or
lower.
MINUTE(number) returns the minutes (a number from 0 to 59) from a MindView date-time
number.
MONTH(number) returns the month (a number from 1 to 12) from a MindView date-time
number.
NOW returns the current date and time (as provided by the system clock) as a MindView datetime number. Once the function is inserted in a calculation field, the value of the function is
updated every time the document is opened, and whenever the calculation value or one of its
dependencies changes.
SECOND(number) returns the seconds (a number from 0 to 59) from a MindView date-time
number.
TIME(hours,minutes,seconds) converts hours, minutes and seconds to a MindView date-time
number. Hours must be entered using the 24-hour system; in other words as a figure from 0 to
23. For example, TIME(16,22,56) returns the MindView date-time value for 22 minutes and 56
seconds past 4 PM.
TODAY returns the current date (as provided by the system clock) as a MindView date-time
number. Once the function is inserted in a calculation field, the value of the function is updated
every time the document is opened.
WORKDAYS(end_date,start_date) returns the number of working days between two dates.
The number of working days is based on the project calendar. You can use other functions for
the arguments start_date and end_date, or provide them in the MindView date-time format. For
example, WORKDAYS(TODAY,START) returns the number of working days from the task start
date to the current date; the same period as defined for DAYS above but excluding nonworking days such as weekends and holidays defined in the project calendar.
YEAR(number) returns the year from a MindView date-time number. The year returned is
between 1984 and 2049.
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Shortcuts
Keyboard shortcuts
The table below lists all the keyboard shortcuts provided by MindView.
Keyboard shortcut

Description

Enter

Add a new branch at the same level as the selected branch

Insert

Add a new sub-branch to the selected branch

Shift + Enter

Add a new branch just before the selected branch

Delete

Delete the selected branch or element

Ctrl + Shift + Delete

Delete the selected branch without deleting its sub-branches. The
sub-branches become attached to the parent of the deleted branch.

Up

Select the branch placed above the currently selected branch

Down

Select the branch placed below the currently selected branch

Left

Select the branch to the left of the currently selected branch in the
map

Right

Select the branch to the right of the currently selected branch in the
map

F1

Help

F2

Edit the name of the selected branch or the selected floating
comment

F3

Toggle Focus Mode on and off

F4

Resize the map so that it fits entirely in the workspace

F5

Read out aloud the selected branch, comment or text note
(AT Edition only)

F6 / Shift + F6

Move the focus between the active tabs, panels or status bars in the
mind map

Alt + F6

Apply branch focus to restrict the display to the selected branch

Alt + Shift + F6

Remove branch focus to display the entire map again

F7

Spellcheck the document

Ctrl + F7

Spellcheck the selected element

F8

Toggle between selected branch and Text Note editor

Ctrl + F8

Create a new text note

F9

Toggle Full Screen Mode on and off

F11

Insert or edit a pop-up comment on the selected branch

F12

Specify a start time for the selected branch

Ctrl + F12

Specify an end time for the selected branch

Ctrl + A

Select all branches

Ctrl + F

Find and replace text in document

Ctrl + N

Create a new document

Ctrl + O

Open and browse for an existing document

Ctrl + P

Print the active document

Ctrl + S

Save the active document

Ctrl + Z

Undo the last action
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Ctrl + Y

Reverse the last Undo

Ctrl + C

Copy the selected data to the clipboard

Ctrl + X

Cut the selected data to the clipboard

Ctrl + V

Paste the data contained in the clipboard to the selected destination

Ctrl + B

Toggle bold face on and off on branch labels and in the text note
editor

Ctrl + I

Toggle italics on and off on branch labels and in the text note editor

Ctrl + U

Toggle underlining on and off on branch labels and in the text note
editor

Ctrl + Shift + C

Copy the formatting from one element to another with the Format
Painter

Ctrl + Shift + B

Select the branch data for editing

Home

Save edited data when editing branch data. Select the branch
containing the branch data when pressed a second time

Ctrl + Tab

Open the Windows Navigator

Ctrl + F6

Go from one open document to the next

Ctrl + F8

Open the Text Note editor to create a new text note

Ctrl + Up

Move the selected floating image or floating comment up

Ctrl + Down

Move the selected floating image or floating comment down

Ctrl + Left

Move the selected floating image or floating comment left
Collapses the selected branch (Outline view only)

Ctrl + Right

Move the selected floating image or floating comment right
Expands the selected branch (Outline view only)

Ctrl + Home

Go to the root of the mind map

Ctrl + End

Go to the last cell of the Outline (Outline view, Timeline view, Gantt
view)

Ctrl + "+"

Zoom in

Ctrl + mouse wheel
Ctrl + "-"

Zoom out

Ctrl + mouse wheel
Shift + mouse wheel

Scroll the workspace horizontally

Shift + drag

Navigate the mind map by panning the view within the workspace

Ctrl + Space

Toggle Predictive Suggestions on or off when editing branch labels
or text notes

Ctrl + 1

Show only the main branches

Ctrl + 2, 3, 4

Show only two, three or four levels of branches

Ctrl + 5

Show all levels of branches

Ctrl + Shift + "+"

Expands the selected branch

Ctrl + Shift + "-"

Collapses the selected branch

Ctrl + Shift + 1

Display the document in Mind Map view

Ctrl + Shift + 2

Display the document in Top Down view

Ctrl + Shift + 3

Display the document in Left/Right view

Ctrl + Shift + 4

Display the document in Timeline view

Ctrl + Shift + 5

Display the document in Outline view

Ctrl + Shift + 6

Display the document in Gantt view
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Ctrl + F2

Link tasks (Gantt view only)

Ctrl + Shift + F2

Unlink tasks (Gantt view only)

Shift + F2

Open the Task Information dialog (Gantt view only)

Alt + Shift + Right

Indent the selected branch (Outline view) or task (Gantt view)

Alt + Shift + Left

Outdent the selected branch (Outline view) or task (Gantt view)
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Index
#NAN .............................................................88

Auto-recovery feature ............................. 43, 49

#NULL! ..........................................................88

AVG ............................................................ 342

.msi file ..........................................................24

Backstage view ................................. 43, 47, 51

.mvdx .............................................................49

Backup files................................................... 49

.mvtx ..............................................................49

BASELINECOST ........................................ 342

ABS .............................................................342

BASELINEDURATION ............................... 342

Accelerators ................................................346

BASELINEEND ........................................... 342

Access keys ..................................................37

Baselines .................................................... 228

Activating .....................................................109

comparing project progress with ............. 232

a branch connection ................................115

saving ...................................................... 228

a hyperlink ...............................................113

using in project reports ............................ 150

an object ..................................................109

BASELINESTART....................................... 342

Active documents, switching between ..........60

BASELINEWORK ....................................... 342

ACTUALCOST - see also Resources cost 208,
342

Bibliography ................................................ 117

ACTUALWORK - see also Resources
work .................................................208, 342

creating.................................................... 117

citations ................................................... 122
exporting.................................................. 247

Additional folders ........................ 146, 246, 269

importing.................................................. 117

Agile project management ....................74, 150

sources .................................................... 117

Alt picture tag ..................... 265, 327, 331, 337

Bookmarks .................................................... 60

Animation (effect) ..........................................43

Branch ........................................................... 53

Antialiasing ....................................................43

attaching objects ..................................... 109

APA Word template.....................................247

auto-layout....................................... 102, 323

Arranging .....................................................161

branch picture............................................ 76

branches ..................................................102

citation ..................................................... 122

objects in the Object list...........................161

collapsing .................................................. 53

As Late As Possible ....................................224

copying .............................................. 53, 102

As Soon As Possible ...................................224

creating...................................................... 53

Aspect ratio of a picture ............. 327, 331, 337

cutting ................................................ 53, 102

Attaching objects .........................................109

data ........................................... 97, 100, 332

Attachment - see Object..............................109

deleting ...................................................... 53

Audio notes .................................................111

detaching ................................................. 138

copying ....................................................111

editing .................................................. 52, 97

deleting ....................................................111

expanding .................................................. 53

inserting ...................................................111

finding text ............................................... 128

moving .....................................................111

focusing ............................................. 51, 104

playing .....................................................111

formatting ............................................ 56, 97

properties ................................ 111, 158, 338

inserting ..................................................... 53

AutoCorrect list ....................................239, 242

locking ..................................................... 169

Auto-layout of branches ......................102, 323

moving ..................................................... 102

Automatic sum ..............................................88
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navigating ..................................................53
pasting ...............................................53, 102

Capture toolbar - see Capturing text and
images ..................................................... 125

properties 158, 322, 323, 328, 330, 331, 332

Capturing text and images .......................... 125

replacing text ...........................................128

CEILING ...................................................... 342

selecting several ........................................97

Changes ...................................................... 140

shape ...................................................56, 97

Checking a mind map ................................. 145

showing/hiding .......................... 53, 104, 105

Citation ........................................................ 122

spellchecking ...........................................239

adding ...................................................... 122

word wrapping .........................................322

deleting .................................................... 122

Branch connection ......................................115

editing ...................................................... 122

activating .................................................115

exporting.................................................. 247

creating ....................................................115

inserting ................................................... 122

curve ........................................................115

sources .................................................... 117

deleting ....................................................115

Clipart .................................................... 76, 152

properties .........................................158, 340

Collapsing ..................................................... 53

showing/hiding .........................................323

a branch .................................................... 53

start and end branch................................115

a mind map.......................................... 53, 60

Branch label ..................................................52

Color dialog ................................................. 158

narrating ....................................................52

Columns, rearranging in Outline view ......... 187

using predictive suggestions for ..............130

Comment (floating) - see Floating comment 71

Branch picture ...............................................76

Comment (pop-up) - see Pop-up comment .. 71

deleting ......................................................76

Compacting a mind map ............................... 56

detaching ...................................................76

COMPLETION ............................................ 342

dragging .....................................................76

Completion status ................................. 80, 228

inserting .....................................................76

using in filters .......................................... 105

properties ................................ 158, 327, 331

Compressing a mind map ........................... 146

replacing ....................................................76

Constants ...................................................... 88

Built-in filters ................................................105

Constraints .......................................... 224, 232

Bulleted lists ..................................................66

As Late As Possible ................................ 224

Buttons navigation.......................................269

As Soon As Possible ............................... 224

in HTML export ........................................269

Finish No Earlier Than ............................ 224

Calculation panel...........................................88

Finish No Later Than ............................... 224

Calculation value ...........................................88

Must Finish On ........................................ 224

constants ...................................................88

Must Start On .......................................... 224

default ........................................................88

Start No Earlier Than .............................. 224

display order ..............................................88

Start No Later Than ................................. 224

editing on branch .....................................100

Context menu, accessing in Touch Mode .. 318

format.........................................................88

Conversion from older versions .................... 51

inserting .....................................................88

Copying a branch .................................. 53, 102

number or text ...........................................88

from an external application ...................... 53

showing/hiding ...........................................88

from MindView................................... 53, 102

Calendar ......................................................200

COST - see also Resources cost ....... 208, 342

default ......................................................200

COUNT ....................................................... 342

project ......................................................200

Creating ........................................................ 47

resources .........................................200, 208

a bibliography source .............................. 117

344

a branch .....................................................53

Data ............................................................ 100

a branch connection ................................115

editing branch .......................................... 100

a branch picture .........................................76

selecting for display in mind map .............. 60

a calculation value .....................................88

Data files ..................................................... 145

a citation ..................................................122

Database, using a suggestion source......... 132

a filter .......................................................105

DATE .......................................................... 342

a floating comment ....................................71

Dates ....................................... 80, 84, 180, 192

a floating picture ........................................76

in a project plan ................. 80, 192, 199, 204

a formula ....................................................88

in a task list................................................ 80

a hyperlink ...............................................113

in a timeline ....................................... 84, 180

a legend ...................................................141
a mind map ........................................47, 137

Date-time format - see MindView date-time
format ...................................................... 342

a new root ................................................137

DAY ............................................................. 342

a PDF document......................................286

DAYS .......................................................... 342

a pop-up comment.....................................71

DAYSPERMONTH...................................... 342

a PowerPoint presentation ......................252

Deadline .............................................. 224, 228

a project plan ............................ 80, 192, 198

Default calendar .......................................... 200

a report ....................................................150

Default task mode ....................................... 204

a resource list ..........................................208

Default value ................................................. 88

a RTF document ......................................287

Deleting ......................................................... 53

a spreadsheet ..........................................257

a bibliography source .............................. 117

a suggestion source ................................132

a branch .................................................... 53

a task list ....................................................80

a branch connection ................................ 115

a text note ..................................................66

a branch picture......................................... 76

a timeline ...........................................84, 180

a branch section ........................................ 53

a web site ................................................265

a citation .................................................. 122

a Word document ....................................247

a filter ....................................................... 105

an attachment ..........................................109

a floating comment .................................... 71

an Excel spreadsheet ..............................257

a floating picture ........................................ 76

an outline .................................................187

a hyperlink ............................................... 113

Critical path .........................................228, 232

a pop-up comment .................................... 71

filtering .....................................................232

a suggestion source ................................ 132

showing/hiding .................................228, 232

a template.................................................. 49

total slack .................................................232

a text note.................................................. 66

Currency options .........................................208

an attachment.......................................... 109

Custom dictionaries.............................239, 242

an icon ....................................................... 74

Custom icons - see Icons ..............................74

Dependencies - see Relationships ............. 219

Custom Style Designer .................................56

Designing a mind map .................................. 56

Customizing ..........................................37, 192

Desktop search ........................................... 128

map styles .................................................56

Detaching ........................................ 71, 76, 138

the Gantt chart .................................192, 228

a branch .................................................. 138

your preferences........................................43

a branch picture......................................... 76

your workspace .........................................37

a floating comment .................................... 71

Cutting a branch ..........................................102

a floating picture ........................................ 76

Daily timescale ..............................................84

Dictionaries ................................................. 239
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AutoCorrect list ................................239, 242

FTP Upload Manager .............................. 283

custom .............................................239, 242

overview .................................................. 245

language ..................................................239

packing .................................................... 146

standard ...................................................239

Quick Export .................................... 245, 267

Distributing a mind map ..............................146

to HTML................................... 265, 267, 269

Docking panels ........................................37, 43

to Microsoft Excel .................................... 257

Document - see Mind map ............................47

to Microsoft Outlook ................................ 261

Document properties ............ 43, 322, 323, 324

to Microsoft PowerPoint .......................... 252

Dragging a picture .........................................76

to Microsoft Project ................................. 264

Dragon NaturallySpeaking ..........................313

to Microsoft Word .................................... 247

Duration .......................... 80, 84, 180, 192, 204

to PDF ..................................................... 286

of a task .................................... 80, 192, 204

to RTF ..................................................... 287

of an event .........................................84, 180

to XML ..................................................... 291

DURATION (function) .................................342

Extracting installer package contents ........... 24

Duration bars .......................................180, 192

FAQ Knowledge Base .................................. 26

in the Gantt view ..............................192, 204

Filter ............................................................ 105

in the Timeline view .................................180

applying ................................................... 105

Editing ...........................................................53

clearing .................................................... 105

a bibliography source ..............................117

defining .................................................... 105

a branch ...............................................52, 97

deleting .................................................... 105

a citation ..................................................122

Filter Highlighter .......................................... 105

a floating comment ....................................71

Filtering a Gantt chart ................................. 232

a hyperlink ...............................................113

Filtering a mind map ............................. 51, 105

a pop-up comment.....................................71

Finding and replacing text ........................... 128

a root....................................................52, 97

in branch names ...................................... 128

a task .......................................................204

in floating comments ............................... 128

a text note ..................................................66

in object names ....................................... 128

branch data ..............................................100

in pop-up comments ................................ 128

EFFECT ......................................................342

in text notes ............................................. 128

Effort-driven scheduling ..............................208

Finish No Earlier Than ................................ 224

END .............................................................342

Finish No Later Than .................................. 224

End times definitions .............................84, 180

Finish to Finish ............................................ 219

Entering and editing tasks ...........................204

Finish to Start .............................................. 219

EULA - see License agreement ....................11

Fixed cost.................................................... 204

Excel - see Microsoft Excel .................257, 300

Fixed Duration task ..................................... 216

Expanding .....................................................53

Fixed Units task .......................................... 216

a branch .....................................................53

Fixed Work task .......................................... 216

a mind map ..........................................53, 60

FIXEDCOST ............................................... 342

Exporting .....................................................245

Floating comment ......................................... 71

a calendar ................................................200

creating...................................................... 71

a project plan ...........................................237

deleting ...................................................... 71

a resources list ........................................208

detaching ................................................... 71

a task list ..........................................173, 261

editing ........................................................ 71

as picture .................................................292

finding text ............................................... 128

Export Wizard ..................................245, 269

formatting .................................................. 71
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inserting .....................................................71

DAYSPERMONTH .................................. 342

narrating ..............................................60, 71

DURATION.............................................. 342

properties ................................ 158, 334, 335

EFFECT .................................................. 342

replacing text ...........................................128

END ......................................................... 342

spellchecking ...........................................239

FIXEDCOST ............................................ 342

Floating picture ..............................................76

FLOOR .................................................... 342

deleting ......................................................76

FV ............................................................ 342

detaching ...................................................76

HOUR ...................................................... 342

dragging .....................................................76

HOURSPERDAY..................................... 342

inserting .....................................................76

HOURSPERWEEK ................................. 342

properties ................................ 158, 336, 337

IF 342

replacing ....................................................76

INT ........................................................... 342

Floating toolbar 43, 66, 97, 176, 177, 178, 180,
187, 192

LN ............................................................ 342

FLOOR ........................................................342

MAX ......................................................... 342

Focus mode ..................................................60

MIN .......................................................... 342

Focusing on a branch............................51, 104

MINUTE................................................... 342

Folder structure .......................... 146, 246, 269

MOD ........................................................ 342

Format Painter ........................................66, 97

MONTH ................................................... 342

Formatting .....................................................97

NOMINAL ................................................ 342

a branch .....................................................97

NOW ........................................................ 342

a comment .................................................71

NUMRESOURCES ................................. 342

a root or branch label.................................97

POWER ................................................... 342

a text note ..................................................66

PRIORITY ............................................... 342

Formula .........................................................88

PV ............................................................ 342

FreeMind .....................................................307

REMAININGCOST .......................... 208, 342

LOG ......................................................... 342

FTP Upload Manager ..................................283

REMAININGWORK ......................... 208, 342

Full Screen mode ..........................................64

SECOND ................................................. 342

Functions .......................................................88

SQRT ...................................................... 342

ABS..........................................................342

START..................................................... 342

ACTUALCOST ................................208, 342

SUM ........................................................ 342

ACTUALWORK ...............................208, 342

TIME ........................................................ 342

AVG .........................................................342

TODAY .................................................... 342

BASELINECOST .....................................342

WORK ............................................. 208, 342

BASELINEDURATION ............................342

WORKDAYS ........................................... 342

BASELINEEND .......................................342

YEAR ....................................................... 342

BASELINESTART ...................................342

FV................................................................ 342

BASELINEWORK ....................................342

Gantt chart .................................................. 192

CEILING ..................................................342

customizing ............................................. 192

COMPLETION .........................................342

filtering ..................................................... 232

COST ...............................................208, 342

reports ..................................................... 150

COUNT ....................................................342

timescale ................................................. 192

DATE .......................................................342

viewing .................................................... 192

DAY .........................................................342

Gantt Tools tab ........................................... 192

DAYS .......................................................342

Gantt view ................................................... 192
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Geological timescale .....................................84

constraints ............................................... 224

Gestures ......................................................308

deadlines ................................................. 228

Help ...............................................................26

Ink data ....................................................... 308

Hiding a task .......................................192, 228

Inserting ........................................................ 53

Hiding/Showing - see Showing/Hiding ..........53

attachments ............................................. 109

Historic timescale ..........................................84

audio notes .............................................. 111

HOUR ..........................................................342

branch connections ................................. 115

HOURSPERDAY ........................................342

branch pictures .......................................... 76

HOURSPERWEEK .....................................342

branches.................................................... 53

HTML...........................................................265

calculation values ...................................... 88

exporting ................................. 265, 267, 269

citations ................................................... 122

Hyperlink ...............................................66, 113

floating comments ..................................... 71

activating .................................................113

floating pictures ......................................... 76

copying ....................................................113

formulas..................................................... 88

creating ....................................................113

functions .................................................... 88

deleting ....................................................113

hyperlinks ................................................ 113

editing ......................................................113

icons .......................................................... 74

in text notes ...............................................66

main branches ........................................... 53

moving .....................................................113

pop-up comments...................................... 71

properties .........................................158, 339

pre-branches ............................................. 53

to online workspaces .........................66, 113

sub-branches............................................. 53

Icons ..............................................................74

task data ............................................ 80, 192

deleting ......................................................74

text notes ................................................... 66

inserting .....................................................74

timeline information ........................... 84, 180

replacing ....................................................74

values ........................................................ 88

using in filters ...........................................105

Installation ..................................................... 24

IF 342

INT .............................................................. 342

Image, capturing .........................................125

Interactive whiteboard ................................. 308

img folder.....................................................265

Inviting other users to collaborate ............... 169

Importing .....................................................293

Kanban board ............................................. 150

a calendar ................................................200

Keyboard shortcuts ..................................... 346

a resources list ........................................208

Lag time ...................................................... 219

a task list ..........................................173, 303

Language .................................................... 239

from FreeMind .......................... 51, 306, 307

changing the dictionary ........................... 239

from Microsoft Excel ................................300

Layouts ......................................................... 56

from Microsoft Outlook ............................303

Lead time .................................................... 219

from Microsoft PowerPoint ......................297

Learning Management System - see LMS . 269

from Microsoft Project..............................305

Left/Right view ............................................ 178

from Microsoft Word ................................294

Legend ........................................................ 141

from MindManager ................... 51, 306, 307
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